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USER GUIDE  
This guide is intended for users of all levels of expertise. The guide describes in detail Sitefinity user interface - from logging to 

completing a project. Use it to learn how to create pages and structure the sitemap, create layout for the pages and populate it 

with widgets. Learn to use the content modules to create content, such as news, forms, and events, and upload different kinds of 

media and files. Add languages and translate both pages and content items and use a sophisticated publishing system to manage 

the workflow of your pages and content items. 

| How to read Sitefinity offline documentation [2] | 

 Login [3] 

Learn how to login to Sitefinity and what possible errors you can get if you do not have proper permissions. 

 Dashboard and main navigation [4] 

Learn how to use Sitefinity's main navigation and Dashboard to access all Sitefinity features and functions. You use the main 

menu as the primary navigation in Sitefinity administration. 

 Pages [5] 

Learn how to create the pages of your website, how to structure them, how to edit their content and properties, manage 

permissions for pages, and more. 

 Website content [26] 

After you have created your page layout, learn how to populate your pages with content by creating and publishing reusable 

content, such as news, events, images, videos and more and how to organize content with the help of classifications. 

 Email campaigns [144] 

Learn how to create email campaigns, manage lists of subscribers to email campaigns, and to compare email campaigns. 

 Workflows [158] 

Learn how to create a workflow for managing the lifecycle of content items and pages. You do that by creating first and 

second level of approval for content items and pages. 

 Widgets [172] 

Learn how to add widgets on your page and how to configure them. To display content you use widgets, which you drop on 

the page and configure them to display already existing content. 

 Personalization of the website content [241] 

Learn how to personalize your site. Personalization allows different content to be served to different types of users (user 

segments). You can build set of rules on which the user segments are based. You can then create different versions of the 

pages of your website. 

 Basic settings [245] 

Learn how to use the Basic Settings page to easily change the most important and commonly used settings. 

  

DISCLAIMER: You can download the latest version of this document at www.sitefinity.com/documentation   

 
  

file://telerik.com/Resources/Sitefinity/Documentation/v.4.x/Q2/www.sitefinity.com/documentation
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HOW TO READ SITEFINITY OFFLINE DOCUMENTATION 

IMPORTANT: If you are viewing the document in PDF/A mode, you will not be able to use the hyperlinks. To change the viewing mode, see  

http://help.adobe.com/en_US/Acrobat/9.0/Standard/WS3E0E8467-B787-4020-A1D3-6BC762A42DF2.w.html.  

TEXT FORMATTING CONVENTIONS 

The following table contains examples and descriptions of all the styles you will encounter in the Sitefinity offline documentation: 
 

Format Meaning Example 

Example Hyperlink 

A clickable text that is link to another topic from the 

documentation or an external resource. 

Link to a topic in the same guide: 

For more information, see Creating pages. 

Link to an external resource:  

For more information, see  Google Analytics 

Help. 

Example [#] Hyperlink to a screenshot. 

A clickable screen title that links to a screenshot in the 

appendix. The number of the screenshot in the appendix is 

superscripted. 

Click Create. 

The Create an event [21] screen appears. 

Example Words or characters that appear on the screen. 

For example, menu and button labels, titles of windows, etc. 

Click Administration » Roles and in Assign to 

dropdown box, select Backend users. 

Example Important text that needs to be emphasized 

Titles of tables and of table columns 

Titles of charts. 

Make sure you have selected at least one 

checkbox. 

Example Source code, names of files and folders. The error.log file is located in folder Logs. 

Example Exact user entry. 

Enter the text in the system, exactly as it appears in the 

documentation. 

In the input field that appears, enter 23 

kilograms and click Next. 

<Example> Variable user entry 

Replace the text in the brackets with the appropriate entry. 

In the input field, enter <your age>. 

EXAMPLE Key on your keyboard When you are finished, press ENTER. 

NOTE: The above styles do not apply to Sitefinity Developer’s Guide. 

NAVIGATING THE DOCUMENTATION 

NAVIGATION PANE 

Sitefinity PDF documentation support bookmark links. To use navigation to all topics of a document, you must open the navigation pane. For more 

information, see your PDF reader documentation. 

In you are using Adobe Reader, you open the navigation pane, by clicking  icon in the upper-left part of the window. 

USING TABLE OF CONTENTS AND SECTION CONTENTS 

The documentation is divided in topics. Topics are organized in section topics. If a topic is a section topic and it has subtopics, it contains a Section 

contents. The Section contents contains links to its subtopics. Using the breadcrumb, you can navigate from each subtopic to its section topic. 

NOTE: In Table of contents, all topics and subtopics are displayed with their page number in squared parentheses.  

USING THE BREADCRUMBS 

Each topic has breadcrumb links at the end of the topic. Following is an example of breadcrumbs: 

| Structuring the pages of your website | Pages | Table of contents | 

You can use the bread crumbs to navigate to the section topic and all existing levels of topics above the section topic up to the section of contents. 

NAVIGATING BETWEEN DIFFERENT GUIDES AND TUTORIALS 

You can download all offline versions of Sitefinity documentation from  http://www.sitefinity.com/documentation/. 

http://help.adobe.com/en_US/Acrobat/9.0/Standard/WS3E0E8467-B787-4020-A1D3-6BC762A42DF2.w.html
http://www.sitefinity.com/documentation/
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LOGIN 

1. You login to Sitefinity, in one of the following ways, depending on the rights you have: 

 Open your webpage and in the address bar of your browser, after the address of your webpage, enter /Sitefinity. 

 Open the Sitefinity Project Manager, select the project you want to edit and click Go to Administration button in the 

toolbar of the manager. For more information about Sitefinity Project Manager, see Sitefinity Installation and 

Administration Guide » Create a project. 

The following login screen appears: 

 

2. Enter your username and password and click Login. 

You can change your password on the Profile page. 

The Dashboard and main navigation Sitefinity open. 

PERMISSIONS 

 If you do not have the proper permission to access the website, when you try to login the system displays a message 

informing you about this  

For more information, contact your system administrator. 

 Depending on the permission settings of your website, your administrator may have not granted you permissions for all of the 

tabs, described above. In this case, tabs, for which you do not have permissions, are not visible when you login. In addition, 

your license may not include all the above mentioned tabs. For more information, see  

http://www.sitefinity.com/purchase/license-comparison.aspx. 

NOTE: If you or somebody else has logged in Sitefinity using your credentials, the following screen appears: 

 

You can choose whether you want to display this dialog.  

For more information, see Sitefinity Installation and Administration Guide  Settings  Security  Configure the self-logout dialog 

recurrence and Configure authentication expiration. 

Section contents 

 Frontend login page 

Frontend login is the page that your registered site users use to login when you require authentication for your site. 

 Editing your profile and changing your password 

You can view the information of your profile and change your password on the Profile page. 

http://www.sitefinity.com/purchase/license-comparison.aspx
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FRONTEND LOGIN PAGE 

Frontend login is the page that your registered site users use to login when you require authentication for your site. For example, 

you may want all users who can leave comments to be logged in; or you can require everybody who checks out products to be 

registered and logged in. Your frontend login page is different than the login page that you use to login in Sitefinity backend. 

To organize login for your users, you must use the Registration and the Login widget. You must create a page where the login 

widget is located. 

You must also configure the URL of the login page, so that each time a user must authenticate, Sitefinity will redirect to the 

frontend login page.  

Set the URL of the frontend login page, by performing one of the following: 

Click Administration » Settings » Advanced » Project » DefaultSite and fill out one of the following fields: 

 If you know the GUID of the frontend login page, enter it in FrontEndLoginPageId. 

 If you only know the absolute URL of the frontend login page, enter it in FrontEndLoginPageUrl. 

EDITING YOUR PROFILE AND CHANGING YOUR PASSWORD 

You can view the information of your profile and change your password on the Profile page. 

1. To open the profile page, click Profile link in the upper right corner of the page. 

The Profile page appears where you can view your profile information. 

NOTE: You cannot change the username. You can delete the current user and create a new one. 

2. To change your password, click Change password button. 

3. Enter your old and new password, confirm it and click Change password. 

4. To change your profile details, click Edit Profile. 

You can enter a new first or last name, or change your photo, by clicking Change photo » Select. 

To be able to change user details, you must have the proper permissions. For more information, see Sitefinity Installation and 

Administration Guide » Users, roles, and permissions » Modifying users » Changing user details. 

5. Click Save changes. 

DASHBOARD AND MAIN NAVIGATION 

Sitefinity main menu gives you access to all Sitefinity features and functions. You use the main menu as the primary navigation in 

Sitefinity administration (backend). 

The main menu is divided in the following sections, represented by tabs: 

 Pages 

Use this tab to create, edit, and delete pages and page templates. You can change the status and properties of pages and 

manage the sitemap. 

For more information, see Pages. 

 Content 

Use this tab to create and classify reusable content items, such as news, events, blog posts, etc. You can also upload different 

kind of media and documents. 

This guide describes the actions which you can perform on this tab. 

For more information, see Website content. 

 Ecommerce 

Use this tab to create and manage your online store.  

For more information, see Sitefinity Ecommerce Guide. 

 Design 

Use this tab to create and design page and widget templates and themes. 

For more information, see Sitefinity Designer’s Guide. 

 Administration 

Use this tab to activate and manage your license, to manage roles, users, and permissions, and to perform various 

administration tasks. 
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For more information, see Sitefinity Installation and Administration Guide. 

 Marketing 

Use this tab to track your website traffic and marketing effectiveness as well as to configure Sitefinity personalization and 

Email campaigns. 

For more information, see Sitefinity Tools » Sitefinity Analytics, Personalization of the website content, and Email campaigns. 

THE DASHBOARD 

The Dashboard is the welcoming page of Sitefinity administration. 

The Dashboard is preconfigured to display useful links and widgets. You can also customize it, according to your specific needs. 

DEFAULT DASHBOARD DISPLAY 

By default the Dashboard displays the following widgets: 

 Content block widget 

The widget displays the title of the page – Dashboard. 

 Sitefinity Welcome widget 

The widget contains useful links to video tutorials and getting started documentation. 

 Analytics Timeline widget 

The Analytics Timeline widget is configured to display a graph of the New Visits metric and a link to the Analytics module. 

 Recent items widget 

 An instance of the Recent items widget, configured to display all recently modified content items and pages, with all 

statuses, modified by the currently logged user. 

 An instance of the Recent items widget, configured to display all recently modified content items and pages, with all 

statuses, modified by all users. 

 An instance of the Recent items widget, configured to display all recently modified blog posts, with all statuses, modified 

by the all users. 

 Configure Dashboard widgets widget 

A widget displaying a link to customizing the widget displayed on the Dashboard. 

CUSTOMIZE THE DASHBOARD 

You can customize the content displayed on the Dashboard. You can delete and reorganize existing widgets and also add and 

configure new widgets. There is a dedicated Dashboard widget group that contains widgets used to customize the Dashboard only. 

You cannot use these widgets on frontend pages. You can also add all other existing widgets to the Dashboard, such as Content 

widgets or Search widgets. 

The Dashboard is a backend page. To customize it, perform the following: 

1. In the main menu, click Administration » Backend Pages » OK, Continue. 

2. Expand Sitefinity and Dashboard group pages. 

3. Click Dashboard page to open it for editing. 

4. To modify the layout of the Dashboard, in the upper-right corner of the page, click Layout. 

For more information, see Modifying the layout. 

5. After completing the changes to the layout of the page, you can add and remove widgets. 

For more information, see Add widgets on your page or template. 

6. You can add and configure both Dashboard specific widgets and all other types of widgets. 

For more information about Dashboard specific widgets, see Dashboard widgets group 

For more information about all other widget groups, see Widgets. 

7. After you have finished modifying the page, perform procedure Setting the status of a new page or content item. 

PAGES 

There are two types of pages in Sitefinity. You can manage both types of pages using Sitefinity: 

 Frontend pages 
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These are all publicly visible pages from the project.  

To edit frontend pages, in the main menu at the top, click Pages. 

 Backend pages 

These are all views in the administrative backend of a Sitefinity project, such as the Dashboard, Content, Administration, and 

so on.  

To edit backend pages, in the main menu at the top, click Administration » Backend Pages. 

The structure of the backend opens in Pages page, after you confirm the warning. 

The following screenshot displays Pages page, containing the structure of pages, toolbar with buttons, language translations 

(if any), and additional functions: 

 

NOTE: If you are not using multiple languages, the language translations icons are not displayed on Pages page and there is 

no Languages dropdown box in the right side of the page. The system displays the multilingual mode automatically when you 

add an additional frontend language. For more information, see Languages. 

On Pages page you can create and edit pages, browse and organize the structure of your website. 

NOTE: Before editing a page, on Pages page, you can preview it by clicking View link of the respective page.  

Section contents 

 Create a new page 

Use this section to create pages and set the different properties of the page. 

 Translate a page 

Use this section to create a new language translation of an existing page. 

 Edit pages 

Use this section to edit the properties or the content of a page. 

 Personalize a page 

Use this feature to be able to serve different content to different types of users. 

 Structure the pages of your website 

Use this section to structure and organize your website. Create subpages and move pages in the hierarchy. 

 Duplicating pages 

If you have similar pages on your site, you can use the Duplicate function for pages.  
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 Revision history of a page 

Use this section to view and compare different versions of a page. 

 Sort and filter pages 

Use this section to sort and filter the pages on Pages page. 

 Set permissions for pages 

Use this section to set permissions for all pages, as well as to set different permissions for each individual page. 

 Other functions for pages 

Learn about other functions, such as deleting and duplicating a page, changing page author, and more. 

 Page layout 

Learn how to create a layout for your page that helps you display content on the page. You can work with predefined layouts, 

modify the predefined layouts, create your own layouts, or upload custom layout templates and themes. 

CUSTOM FIELDS FOR PAGES 

You can add a custom field to all pages. A custom field is a field that you create. For each page there are default fields, such as 

title, URL, etc. If you need to add different than the already existing fields, you must create a custom field.  

With custom fields for pages you can specify additional page details via the backend interface. You can also customize the page 

rendering based on the new custom fields. 

Following are examples of custom fields that you can add to a page: 

 Links to images – in the navigation, image icons can be displayed next to the tile of each page. 

 Links to CSS or JavaScript files – when the page is loaded, links to those files are inserted in the HTML. 

 Meta Data – pages have Title and Keywords. Additional meta data can be added as well. 

 Links to classifications, such as Tags and Categories - pages can be categorized using a classification and filtered based on in 

in the navigation widget. 

To manage the custom fields of a page, on Pages page, click Custom Fields link in the right pane of the page. 

For more information, see Custom fields. 

Related links: 

 Creating pages programmatically: Pages. 

 Sitefinity Installation and Administration Guide » Settings » Content » Add a flat taxonomy as a custom attribute to a page 

CREATING A NEW PAGE 

1. In the main menu at the top of the screen, click Pages. 

The Pages page appears, displaying one of the following: 

 If you have not created any pages, the system displays the following in the center of the screen: 

 

NOTE: If you are working in multilingual mode, the first page you create is in the default language.  

 If you have already created one or more pages, the system displays the sitemap and the following button in the toolbar of 

Pages page: 

 

NOTE: If you are working in multilingual mode, before creating a page, you must first choose the language, in which you 

want to create the page. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

2. To create a new page, click the Create a page. 

The Create a page page appears. 

http://www.sitefinity.com/documentation/documentationarticles/developers-guide/sitefinity-essentials/pages
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3. Enter the following information for the new page: 

Name 

(mandatory field) 

The page name that you choose is used by the system to create auto-generated navigation links. The 

name must be as concise as possible. 

EXAMPLE: Company Info 

Put this page… 

radio button group 

Use this radio button group to select the new page's parent page. The section determines where the 
page sits in the hierarchy of pages. 

Choose between the following: 

 At the top level 

This will be a top level page that has no parent. 

 Under parent page… 

A treeview with existing pages appears. 

Select the page that will be parent of the page you are creating. 

NOTE: If you have not created any pages yet, choose At the top level button. You can make the 

page a subpage of another page later, using drag and drop.  

For more information, see Structuring the pages of your website. 

URL  The URL is automatically generated based on the page name that you have chosen and the hierarchy 
of the page (the URL of its parent). The URL determines the new page's website address.  

You can choose a custom URL by clicking Change button and entering the new name in the input 
field that appears. 

This overwrites the automatically generated URL. When you enter a custom URL, the URL of the page 

no longer changes when the place of the page in the hierarchy changes. 

To restore the automatically generated URL of the page, click Change » Edit URL structure » Restore 

to default structure. 

Show in navigation If you deselect the Show in navigation checkbox, the page is not displayed in the automatically 
generated navigation. The page can be viewed only if linked or accessed directly. You can also 
control the page access by the page's permissions.  

For more information, see Setting permissions for pages. 

Group page If you select the Use this page only to group other pages checkbox, the page you are creating is 

going to be a group page. 

Group pages serve as containers for other pages. Group pages do not have their own content. When 

you open a group page it redirects to its first subpage (child). 

Page redirect If you select This page redirects to another page checkbox, it means the page you are creating does 
not have its own content. When a user opens the page, it redirects to another page or an external 
page. 

To select the page, which this page will redirect to, perform the following: 

 Click Set page to redirect to button. 

 Select one of the following: 

 Page from this site 

Click a page from the sitemap. 

 Web address 

Enter the URL address of the external page and select, if you want to Open this link in a 

new window. 

 Click Done. 

Title for search 
engines 

The title used by search engines is automatically generated based on the page name you have 

chosen. 

You can choose another title by entering a new title or deleting the automatically generated one. 

The page title that you enter in this field is used in search engine results, web browser bookmarks 
and the web browser's title. The title must be descriptive.  
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EXAMPLE: XYZ Company - Company Information. 

NOTE: By default, the title of the page is overridden by the title of the content it displays. You can 

change this behavior in the advanced mode of the respective widget, by changing property 

PageTitleModes to one of the following: 

 Replace  

The page title is replaced by the item title. 

 DoNotSet 

The page title is not altered. 

 Append 

The item title is appended to the page title. 

Template In this radio button group you choose the layout of the new page.  

Select one of the following: 

 Use template 

This option is selected by default. 

Under the radio button the system displays the template that will be used for the page. 

To change the template, click Select another Template button.  

A list of all available templates appears. 

a. Select a template in one of the following ways: 

 Click one of the templates displayed. 

You can customize or change the layout template at a later time.  

For more information, see Page layout. 

 Upload your own .master file by clicking Use your own .master file. 

Select a master file from the App_Master folder and click Use Selected. 

To select a master file from another folder, in the upper-right corner of the window, 

click Browse other folders button. 

For more information, see Sitefinity Designer’s Guide » Page templates. 

For more information about .master files, see Sitefinity Designer’s Guide » Page 

templates »Creating a template using Master pages. 

For more information about the App_Master folder, see Sitefinity Designer’s Guide » 

Website templates file structure. 

b. Click Done. 

 Don’t use template (start from scratch) 

The page does not have a template. You can add a template later. 

Description To add a description of the page, click Description, Keywords. 

The description that you enter is added to the page's header. The description is often used by search 
engines to provide a summary of the webpage.  

EXAMPLE: Information about XYZ Company's locations, history, corporate directory, employment 
opportunities, etc. 

Keywords To add keywords, click Description, Keywords. 

The keywords that you choose are conveying additional meaning to search engines and may have 
SEO benefits. 

EXAMPLE: The keywords for the page XYZ Company - Company Information can be XYZ Company, 
History, Hiring, Employment, Locations, Contact Information. When you enter the keywords for your 
page in the Keywords input field, separate them with commas. 

Advanced options By expanding this node, you can configure the following: 

 Allow site search to index this page 
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This option is selected by default and you must deselect it, only if you do not want the internal 

site search to find your page. 

For more information, see Search indexes. 

Allow external search engines to index this page This option is selected by default and you must 

deselect it, only if you do not want search engines, such as Google, to find your page. 

 Require SSL 

Improve security by requiring Secure Sockets Layer (SSL) protocol to communicate with the 

server. 

 Enable ViewState 

EnableViewState stores the current state of the page and its objects, such as text boxes, 

buttons, and tables. It helps you not to lose the state of the page during the requests, but it 

slows down the browser. 

 Include RadScriptManager 

For more information, see  http://www.telerik.com/help/aspnet-ajax/radscriptmanager.html.  

 Allow multiple URLs for this page 

a. To configure a page to have more than one URL, select Allow multiple URLs for this page 

checkbox. 

b. In the input box, enter the additional URLs that you want this page to have. 

Enter one URL per line. 

c. If you want all the URLs that you have entered to point to the default URL of the page, 

select All additional URLs redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the page without redirecting. 

 Caching options 

Configuring caching can increase your performance.  

Select one of the following: 

 As set for the whole site. 

The caching type that is applied to the whole website is applied to this page also. 

 No caching 

NOTE: You must not use caching for e-commerce pages. 

 Standard caching 

 Long caching 

For more information about applying caching to the entire site or changing the parameters of 

short and long caching, see Sitefinity Installation and Administration Guide » Settings » 

Configuring caching.  

 HTML included in the <head> tag 

If you want to include any additional HTML in the <head> tag of the page, enter the HTML in 

the textbox. 

 Code behind type 

To specify the code behind type for the page, enter it in the field. Use the fully qualified name of 

the type. 

4. If you have added any custom fields for pages, all created fields are displayed in a separate section. 

Using custom fields, you can, for example, add a custom field Tags to the page. 

IMPORTANT: Some of the above fields may not be displayed when you create a page, because they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

5. After you have entered all the information, required to create a page, click one of the following: 

 Create and go to add content 

The page is created and the system opens the page in content editing mode. 

In content editing mode you can customize the layout of the page, add content by adding widgets, and apply themes. 

For more information, see Modifying the layout, Add widgets on your page or template, and Applying a template to a 

page. 

http://www.telerik.com/help/aspnet-ajax/radscriptmanager.html
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After you have finished modifying the page, perform procedure Setting the status of a new page or content item. 

 Create and return to Pages 

The page is created and saved in status Draft. The system returns you to Pages page. 

 Back to Pages 

You return to Pages page without creating and saving the page. 

PREVIEW A PAGE ON A MOBILE DEVICE 

You can view how a page will look like on a mobile device. You can do this in page editing mode. 

1. Open a page for editing. 

2. Click More actions » Preview on Smartphones & Tablets. 

A set of predefined mobile devices appears as thumbnails. 

3. Click a device to see how the page will look like on it. 

You can also view the page in Portrait or in Landscape mode. 

To configure how to display pages on mobile devices, see Sitefinity Designers Guide » Displaying pages on mobile devices. 

| Pages | Table of contents | 

TRANSLATING A PAGE 

You can create a new language translation of an existing page. The system displays all language translations, in which a page 

exists in the following way: 

 On Pages page: 

 

NOTE: If you have added more than six language translation, on Pages page the system displays only the first six language 

icons. To view all created languages, click More translations… link of the respective page. To display all languages for all 

pages, click Show all translations link in the upper-right corner of the page. 

For each page, languages are displayed in the following way: 

 

To display back only the first six translations, click Basic translations only… of the respective page or, if you have expanded all 

translations of all pages, click Show basic translations only link in the upper-right corner of the page. 

 In page editing mode: 

 

 Language translations of pages, whose language icons are dark blue, already exist. 

 Language translations of pages, whose icons are light blue, have not been created yet. 

NOTE: Before you create a page in a different than the default language, you must have added this language in the settings of 

Sitefinity. For more information, see Languages. 

Section contents 

 Translating an existing page 

 Editing and deleting a translation of a page 

For more information about creating a new page in different languages, see Creating a new page. 
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The system displays pages that exist in multiple languages in the following way: 

 The following screenshot displays the English version of a sitemap: 

 

NOTE: In Languages dropdown box in the right pane, English is selected. 

 The following screenshot displays the Spanish version of the same sitemap: 

  

NOTE: In Languages dropdown box in the right pane, español is selected. 

The pages that appear inactive have no translation in the language, selected in Languages dropdown. 
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NOTE: Different language translations of one page can be in different statuses, and can be at a different stage in the lifecycle 

workflow.  

For more information about synchronizing translations, see Translating an existing page » Step 3. 

For more information, see Workflows. 

NOTE: The content items, which are displayed on the page, can also have language translations. When a content item exists in 

different languages, each translation is displayed with its respective page translation. 

For example, a news item in Spanish is displayed in the News widget in the Spanish version of the page, the English news item is 

displayed in the English version of the page. If the French translation of the page contains the News widget, but there is no French 

version of the news, the widget does not display anything. For more information, see Translating content items and classifications. 

To switch between different language translations in the public part of your website, you must add and configure the Language 

selector widget to the page. 

| Pages | Table of contents | 

TRANSLATING AN EXISTING PAGE 

Perform the following procedure: 

1. You create a new language translation of an existing page in one of the following ways: 

 On Pages page, click the Add link under the respective language icon. 

 Open the page in page editing mode and in the upper-left corner of the page, click the Add link of the respective 

language.  

 On Pages page, in Languages field on the right, select the desired language and click the name of the page, which you 

want to translate. 

The name of the page appears inactive, to show that the page has no translation in the selected language. 

2. Perform procedure Creating a new page » Step 3 (only the relevant fields) and Step 4. 

NOTE: When you create a translation of an existing page, the system does not display the Template section. You do not 

select a layout at this step, but at Step 3 of the current procedure, where you must choose whether you want to use the 

current template of the page or design a new one, just for this translation.  

Depending on what you select in Step 4 of Creating a new page procedure, perform the following: 

 If you do not select Create and go to add content, the layout of the translated page is not determined until you open the 

page for editing.  

 If you select Create and return to Pages, skip the rest of this procedure and perform it when you open the translation of 

the page for editing. 

3. Before opening the new page for editing, the system asks you to select one of the following: 

 Copy from another language version 

A window appears where you select Keep all language versions synced as one page checkbox and click Done. 

This means that all created language versions of the page will have the same layout and widgets, but the widgets can be 

configured differently. Any changes to any of the translations will apply to all other translations. 

After that, every other language translation you create is synchronized with the existing and the system does not ask 

you, if you want to copy or create a new language translation. 

When you choose this option, when a language translation of the page is opened in page editing mode, the system 

displays the following in the upper part of the page: 

 

 If you want to stop the synchronization between the different language translations, click Stop syncing.  

After that, you can edit each page translation separately. 

NOTE: Once you stop the synchronization between the different languages, you cannot synchronize them again. You 

have different versions of one page. 

 To display the icons of all language versions, click Show other translations. 

The icons appear and from there you can add new language translations for this page. 

NOTE: If you have language versions of a page that are not synchronized and are different, after adding another 

language from the system settings and creating a new language translation in this language, you can choose if you want 
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the new translation to have the same layout and widgets as some of the existing translations. In this case, if you have 

more than one existing translations, the dropdown box is active and you can choose an already existing language version. 

NOTE: Syncing of translations does not depend on page hierarchy. You can have a parent page whose translations are 

not synced, but the translations of its child pages can by synced. 

 Start from scratch 

Click this link, if you want the different language translations to have different layouts and status. 

The language translation of the page is created and the system opens the page in content editing mode. 

4. Use the content editing mode to customize the layout of the page, add content by adding widgets, and apply themes. 

For more information, see Modifying the layout, Add widgets on your page or template, and Applying a template to a page. 

NOTE: If your pages are synchronized, any modifications to the layout or the widgets are applied to all existing language 

translations of the page. 

When you choose to display content items that have different translations, the translation displayed depends on the page 

translation, which you are working with. 

For example, if you have added the News widget to a German translation of a page, the widget displays only the news items 

that have German translation. If for the items, you have chosen, no German translation exists, nothing is displayed. 

5. When you are finished editing, perform procedure Setting the status of a new page or content item. 

| Translating a page | Pages | Table of contents | 

EDITING AND DELETING A TRANSLATION OF A PAGE 

EDITING THE PROPERTIES OF A TRANSLATED PAGE 

Perform the following procedure: 

1. In the Languages dropdown box, select the language, in which you want to edit the page. 

2. Perform procedure Editing a page » Editing the properties of a page. 

EDITING THE CONTENT OF A TRANSLATED PAGE 

Perform the following procedure: 

1. You edit a language translation of a page in one of the following ways: 

 On Pages page, click the Edit link under the respective language icon. 

 On Pages page, in Languages field on the right, select the desired language and click the name of the page, which you 

want to edit. 

2. Perform procedure Editing a page » Edit the content of a page. 

NOTE: If when creating the language translation of the page, you have clicked Create and return to Pages without going to 

content editing mode, before performing Step 2 of the above procedure, you must perform Translating an existing page » Step 3. 

DELETING A LANGUAGE TRANSLATION OF A PAGE 

On Pages page, you delete a language translation by selecting the respective language in Languages dropdown box and 

performing one of the following: 

 Select the page(s), whose translation(s) you want to delete and click Delete button in the toolbar. 

 Click the Actions link of the respective page and click Delete. 

IMPORTANT: The system asks you, if you want to delete only the current translation of the page or all translations of this page. 

| Translating a page | Pages | Table of contents | 

EDITING A PAGE 

There are two ways to edit a page. You can edit the properties of a page, such as name, title, description and you can edit the 

content of a page, such as adding layout elements and widgets. 
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EDITING THE PROPERTIES OF A PAGE 

You can edit the properties of a page, such as title, keywords, name, etc. 

1. Edit the properties of a page in one of the following ways: 

 On Pages page, click the Actions link of the respective page and in the dropdown list, click Title & Properties. 

 In page content editing mode, click Title & Properties link in the toolbar. 

The Edit a page page appears. 

2. Perform procedure Creating a new page » Step 3. 

NOTE: The system does not display the selection of template section. You can change the template directly from the page 

content editing mode by clicking Layout and then Select another template… button in the lower-right corner of the page. 

Perform procedure Applying a template to a page » Step 2 and Step 3. 

3. When you are finished, click Save changes. 

The system returns you either to Pages page or to page editing mode, depending on where you have started. 

EDIT THE CONTENT OF A PAGE 

You can edit the content of a page, such as layout elements and widgets. 

1. To do this, on Pages page, perform one of the following: 

 Click the name of the page. 

NOTE: If the page you have clicked is a group page, the system opens the Edit a page page, where you can edit the 

properties of the page. 

 Click the Actions link of the respective page and click Content. 

NOTE: A group page has no content and under Actions there is no Content link. 

The page opens in content editing mode. 

In content editing mode you can modify the layout and apply a template to a page. 

2. When you are finished editing the page, perform one of the following: 

 If you have opened for editing a page in status Draft, Unpublished, or Rejected, perform procedure Managing a page or 

content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a page in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing a page in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing a page in status Published or Scheduled, perform procedures Managing a page or content 

item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published page, the system saves a draft of that page, but the published version is still visible on the 

webpage. To see, which version is the currently published one, see Revision History. 

NOTE: In page content editing mode, you can see a preview of the page by clicking Preview button in the toolbar. The preview of 

the page is not a fully functioning page as it will appear on the life site. Use it to get an overall idea of how the page will look like. 

If you want to test how the page will look like and work of the life site, publish the page and click Life site in the upper-right corner 

of the screen. For example, if you use the preview mode, links to content items do not work. 

| Pages | Table of contents | 

PERSONALIZE A PAGE 

Personalizing a page gives you the opportunity to serve different content to different types of users (user segments). You can build 

set of rules on which the user segments are based. You can then create different versions of the pages of your website.  

You must first create the user segments and then personalize your pages. You can then use the personalization preview tool to 

view the website from different user perspectives. 
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Personalizing a page means that you create one or more different versions of a page. These versions are associated with the user 

segments you have created. 

PREREQUISITES: You have created one or more user segments. For more information, see Personalization of the website 

content. 

1. You personalize a page, in one of the following ways: 

 On Pages page, click the Actions link of the page you want to personalize and in the dropdown menu, click Personalize. 

 In page editing mode, click Personalize this page link in the toolbar. 

The Create a personalized page page appears. 

2. In the dropdown box, select the user segment that will see this personalized version of the page. 

3. Click Create and go to edit content. 

The page opens in page editing mode. 

Initially the personalized page is an exact copy of the original page. 

4. You can use the page editing mode to customize the layout of the page, add content by editing widgets, change the template, 

or apply themes. 

For more information, see Modifying the layout, Add widgets on your page or template, and Applying a template to a page. 

5. After you have personalized your page, perform procedure Setting the status of a new page or content item. 

NOTE: The original page, as well as all of its personalized versions cannot have different statuses.  

For example, if you publish a personalized version of the page, the page and all of its versions are also published. 

After a page is personalized, the system displays Personalized link in the pages grid. If you click the link, you can see all available 

personalization versions of a page. To view a personalized version of the page in a browser, click it. 

If you want to view the entire site from the perspective of a user segment, you can use the Personalization preview tool. 

DELETE A PERSONALIZED VERSION OF A PAGE 

On Pages page, click the Personalized link of the page whose personalized version you want to delete. 

Click  of the version that you want to delete. 

| Pages | Table of contents | 

STRUCTURING THE PAGES OF YOUR WEBSITE 

You structure the pages of your website by using parent and child pages and group pages. A parent page is a page that has its 

own content, but also serves as a node in the hierarchy of pages and has subpages (children).  

A group page plays the role of container for pages. It does not have its own content and redirects to its first child page. Group 

pages can contain both pages and other group pages. You use group pages to facilitate your website navigation.  

On Pages page a group page is represented by  icon. 

EXAMPLE: In your company website project you create a group page named About us. Under the group page you create pages 

Our mission, People, and Contact us. If you put page Our mission first in the list of pages under the group page, when the group 

page is clicked, it redirects to page Our mission. 

You manage the structure of your website on Pages page. The following screenshot shows a typical hierarchy of pages (sitemap), 

displayed on Pages page: 



 

17 

 

NOTE: On Pages page, if  is displayed next to a page’s icon, it means that this page has subpages. You can expand and collapse 

the group of pages, by clicking the arrow. 

Section contents 

You create and manage the hierarchy of pages, when you: 

 Create a child page 

 Move pages in the hierarchy 

 | Pages | Table of contents | 

CREATING A CHILD PAGE 

You can create a child page both of normal pages and of group pages. 

1. On Pages page, you create a child of a page in the following ways: 

 Using the toolbar button. 

a. Select the parent page of which you want to create a subpage. 

b. Click Create a child of the selected page button. 

 Using the Actions link. 

a. Click the Actions link of the page of which you want to create a subpage. 

b. In the dropdown menu, click Create a child page. 

The Create a page page appears.  

2. Perform procedure Creating a new page » Step 3 and Step 4. 

NOTE: When you create a page using the above procedure, on Create a page page, in Under parent page… radio button and the 

parent page, which you selected in Step 1, is automatically selected. You can change the parent page using the Change button. 

| Structuring the pages of your website | Pages | Table of contents | 

MOVING PAGES IN THE HIERARCHY 

You can move pages up and down on the same hierarchical level and assign pages to different parent pages on different level of 

hierarchy. You move pages around the structure of pages using drag and drop.  

You can also move pages without using drag and drop. For more information, see Moving pages without using drag and drop. 

On Pages page, click a page and drag it to one of the following places: 

 Inside another page. 

The following screenshot shows dragging and dropping a page inside another page: 
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The dragged page becomes the last child of the page where you drop it. 

 Between two pages 

The following screenshot shows dragging and dropping a page between two pages: 

 

The dragged page becomes a sibling of the pages, where you have dropped it. 

| Structuring the pages of your website | Pages | Table of contents | 

MOVING PAGES WITHOUT USING DRAG AND DROP 

You move pages up or down or change their parent to change the order, in which they are displayed, in the website navigation 

without using drag and drop. 

REORDERING PAGES ON THE SAME HIERARCHICAL LEVEL 

1. To move a page up or down, on Pages page, click the Actions link of the respective page. 

2. Select Up or Down respectively. 

The system move the page one position up or down on the same hierarchical level, which the page was initially on. 

You can only reorder subpages (children) of one parent page. You cannot move pages across different parent pages using the 

Up and Down functions. 

NOTE: If the page was last in the list of pages on its hierarchical level, you cannot move this page down; if it was first – you 

cannot move it up. 

MOVING PAGES ON DIFFERENT HIERARCHICAL LEVELS 

To move a page on different hierarchical level, you change the parent of the page or you put the page at top level. 

1. Click the Actions link of the page which you want to move. 

2. In the dropdown menu click Title & Properties. 
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The Edit a page page appears.  

Perform one of the following: 

 If you want to move the page at top level, select At the top level radio button. 

 If you want to change the parent page of the page, perform the following: 

a. Select Under parent page… radio button.  

b. From the treeview that appears, select the new parent page and click Done. 

3. Click Save changes. 

The system moves the page on the respective level, under the selected parent page. 

| Moving pages in the hierarchy | Structuring the pages of your website | Pages | Table of contents | 

DUPLICATE PAGES 

If you have similar pages on your site, you can use the Duplicate function for pages.  

If you have personalized versions of the page you want to duplicate, these versions are not duplicated. 

For more information, see Personalize a page. 

If you have multiple languages, you duplicate each translation of the page separately. 

You first select the language that you want to duplicate from the Languages dropdown in the right. 

For more information, see Languages. 

DUPLICATE A PAGE WITHIN THE SAME SITE 

To duplicate a page or a translation of a page, perform the following: 

1. On Pages page, click the Actions link of the page you want to duplicate and click Duplicate. 

The Create a page page appears containing all the properties of the page you are duplicating. 

2. You can change some properties or create the duplicated new page with the same properties. 

NOTE: You must change the URL of the duplicated page, because you cannot have more than one page with the same URL. 

You can do that either by changing the name of the new page or by clicking Change button under URL and entering a new 

URL for the duplicated page. 

3. Click one of the following: 

 Create and go to add content 

The page opens in page editing mode. It has the same content as the original page. You can change the content and 

save the page in different status. 

 Create and return to Pages 

The duplicate page you have created has the same content as the original page and is saved in status Draft, regardless of 

the status of the original page. 

For more information, see Creating a new page. 

DUPLICATE A PAGE FROM ONE SITE TO ANOTHER IN A MULTISITE INSTANCE 

If you have a multisite license, you can duplicate a page from one site on another site. 

For more information, see Sitefinity Installation and Administration Guide  Multiple site management. 

1. Perform the procedure above. 

In the beginning of the Create page page, the Site dropdown appears.  

2. Click Change and select another site. 

DUPLICATE ALL PAGES FROM ONE SITE IN ANOTHER SITE 

When you create a site in a multisite Sitefinity instance, you can copy all pages, together with their translations from an existing 

site within the multisite. 

You must have the same languages installed on both sites. For more information, see Sitefinity Installation and Administration 

Guide  Multiple site management  Creating a site. 
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REVISION HISTORY OF A PAGE 

Use this function to view different versions of a page. Every time you edit a page, a version of this page is saved by the system. 

To view the history, perform one of the following: 

 On Pages page, click the Actions link of the respective page and click Revision History. 

 In page content editing mode, in the toolbar, click Revision History. 

The Revision History page appears, containing a list of all versions of the page: 

 

In case the page has been published, the system indicates which version of the page is published, by displaying  next to this 

version. 

 You can view a previous version of the page by clicking the version. 

A preview of the page opens. You can revert to a previous version of the page by clicking Revert to this version button in the 

upper-left corner of the page. 

The system makes the selected version of the page the current one. 

 You can delete versions of the page, by selecting them and clicking Delete. 

NOTE: You cannot delete the version that is currently published. 

 You can add note to each version, by clicking the Write note link of the respective version. 

An input field appears where you enter and save the note. 

The note is displayed in the Revision History page. You can Edit and Delete the note. 

| Pages | Table of contents | 

SORTING AND FILTERING PAGES 

The Pages page displays all created pages by all users. 

FILTERING PAGES 

In the right side of the page, under Filter pages, you can use the following filtering options: 

 To filter pages created by you, click My pages. 

 You can filter pages according to their status by clicking it. 

 To display only pages with missing properties, click With no Descriptions or With no Keywords. 

 To filter pages according to the date they were modified, click by Date modified… 

The Display pages modified in… pane appears. 

 When you click a time interval, the system displays all the pages modified during this time interval. The last modified are 

the first in the list. You can change the sorting. 

 To display pages modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 
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NOTE: When you apply filtering to the pages, the system displays the result of the filtering in a list. The hierarchy of the pages is 

not depicted. Under the name of the page, the system displays the name of the page’s parent page. 

SORTING PAGES 

Use the Sort pages dropdown box in the toolbar of Pages page to sort the list of pages. 

There are the following sorting options: 

 by Hierarchy 

The system displays pages in a treeview, using the hierarchy, which was originally defined.  

This is the default display of Pages page. 

When you select this option all previous sorting and filtering is removed. 

 Last created on top 

The system displays the last pages that were created on the top of the list. 

You can use this sorting option on filtered pages. 

 Last modified on top 

The system displays the last pages that were modified on the top of the list. 

You can use this sorting option on filtered pages. 

 Alphabetically (A-Z) and Alphabetically (Z-A) 

The system displays the pages in alphabetic order starting with A or with Z. 

You can use this sorting option on filtered pages. 

 Custom sorting… 

A window appears where you perform the following: 

1. Select sorting criterion from the dropdown box and choose between Ascending and Descending order in the radio button. 

2. You can also and add more than one criterion by clicking Add another sorting rule link and you can remove sorting criteria 

by clicking Remove link. 

3. When you are finished, click Save. 

The system sorts the pages according to the custom sorting. 

4. To edit a custom sorting that you have created, select Edit custom sorting… from the Sort pages dropdown box. 

You can use this sorting option on filtered pages. 

| Pages | Table of contents | 

SETTING PERMISSIONS FOR PAGES  

You can set permission for all pages and you can set individual permissions for each page. 

 To change the permissions for all pages, on Pages page, click Permissions for all pages link in the right side of the page. 

The Permissions for all pages page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions »Changing global and section permissions » Step 2 to Step 4. 

 To set individual permissions for a certain page, on Pages page, click the Actions link of the page and click Permissions. 

For more information, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » Managing 

permissions » Changing permissions of an individual item » Step 2 to Step 4. 

When you are finished setting permissions, click Back to Pages link to return to Pages page. 

| Pages | Table of contents | 

OTHER FUNCTIONS FOR PAGES 

MAKING A PAGE A HOMEPAGE 

On Pages page, the homepage of your website is represented by  icon. 

For example, . 
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To make a page your homepage, on Pages page, click the Actions link of the respective page and click Set as Homepage. 

The system sets the page as the website’s homepage and displays the icon above. 

NOTE: If you do not explicitly set a page as homepage, the first page you have created is automatically set as your homepage. 

NOTE: You cannot set a group page as a homepage. 

IMPORTANT: You cannot delete the page set as homepage, unless it is the last page in the sitemap. To delete this page, set 

another page as homepage. 

SEARCHING FOR PAGES 

1. To search for a particular page, on Pages page, click Search… 

A search field appears. 

2. Enter the name or part of the name of the page you want to find and click Search. 

The system displays a list of all pages whose name contains the search word. 

3. When finished searching, click Close search. 

The Search field is case insensitive. 

DELETE PAGES 

To delete a page perform one of the following: 

 On Pages page, select one or more pages to delete and click Delete button. 

 On Pages page, click the Actions link of the page you want to delete and click Delete. 

A dialog box appears where you must confirm the deletion. 

IMPORTANT: You cannot delete a parent page. If you want to do this, you must first move or delete all of its children. 

IMPORTANT: If the page has translations, the system asks you, if you want to delete only the current translation of the page or 

all translations of this page. 

CHANGING THE OWNER OF A PAGE 

1. On Pages page, click the Actions link of the page and click Owner. 

A list of users appears. 

2. Select the new owner and click Done. 

SHARING A LINK TO A PAGE TO UNAUTHORIZED USERS 

Backend users can share a link to a page that is visible only to registered users who have permissions to view the page. 

For example, a page’s permissions can be set to allow the page to be visible only to users belonging to a certain role. You can still 

share the page to an anonymous user. You must set an expiration period for the links. 

To allow page sharing and to set the expiration period, perform the following: 

1. Click Administration  Settings  Advanced. 

2. In the treeview, click Pages. 

3. Select Allow backend users to share link to preview pages checkbox. 

This option is applied to all pages in Sitefinity. 

4. In Expiration time for shared links, enter the expiration period in hours. 

You can use a decimal point. 

5. Save your changes. 

6. Click Pages. 

7. Click the Actions link of the page for which you want to share a preview. 

8. Click Share preview link… 

A window that displays the link appears. 

VIEWING A PAGE AND ALL THE PERSONALIZED VERSIONS OF A PAGE 
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To display a particular page in a browser, on Pages page, click the View link of the respective page. 

If a page is personalized on Pages page the system displays Personalized link.  

If you click the link, you can see all personalized versions of the page.  

When you click a version, it opens in a browser. 

| Pages | Table of contents | 

PAGE LAYOUT 

Before you populate your page with content, you create a layout that helps the display of content. For example you allocate space 

for the navigation, the title, and the content blocks. To do this, you use predefined or custom templates, which you can modify if 

needed. 

Section contents 

To create your page layout, you do the following: 

 Apply a template to a page 

Use this procedure, if you have not selected a template for your page during its creation or if you want to change the selected 

template. See how you can upload a custom template. 

 Modify the layout 

Use this procedure to customize the template which you have selected for the page. You can add columns, change their size, 

and more. 

IMPORTANT: Templates are shared across different sites. If you are using multiple sites, changing a template on one site will 

change the template on every other site that uses it. 

For more information about applying a theme to the entire website, see Sitefinity Designer’s Guide » Themes. 

| Table of contents | 

APPLYING A TEMPLATE TO A PAGE 

If you have not selected a layout template when creating the page or, if you want to change the template you have selected, 

perform one of the following: 

1. Select a template in one of the following ways: 

 On Pages page, click the Actions link of the page, whose template you want to change, click Template. 

 In page content editing mode, click Layout button in the toolbar and, in the lower-right corner of the page, click Select 

another template… button. 

The Select a template  page appears, containing both predefined and custom layout templates. 

2. Perform one of the following: 

 Click one of the templates displayed. 

You can customize or change the layout template later.  

For more information, see Page layout. 

 Upload your own .master file by clicking Use your own .master file. 

Select a master file from the App_Master folder and click Use Selected. 

To select a master file from another folder, in the upper-right corner of the window, click Browse other folders button. 

For more information about .master files, see Sitefinity Designer’s Guide » Page templates » Creating a template using 

Master pages. 

For more information about the App_Master folder, see Sitefinity Designer’s Guide » Website templates file structure. 

For more information about using custom templates, see Creating or uploading a custom template. 

3. Click Done. 

The template is applied to the page.  

CAUTION: If you want to change the existing layout template of a page, the system replaces the old template with the new one. 

All modifications of layout and content are preserved and the new layout is appended to the existing. 
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| Page layout | Table of contents | 

CREATING OR UPLOADING A CUSTOM TEMPLATE 

If the predefined templates of Sitefinity do not suit your design, you can create a custom template using Sitefinity or you can 

upload an already created template and use it. 

CREATING A CUSTOM TEMPLATE 

If the predefined templates do not suit your style, you can create a new template. 

1. In the main menu, click Design » Page Templates. 

A list of existing templates appears. 

2. Click Create a template button in the toolbar. 

The Create a template  page appears. 

3. In Name input field, enter a name for the new template, 

4. In Template radio button group, select one of the following: 

 Use template  

Select this, if you want to create a template based on an existing template.  

 Don’t use template 

Select this, if you want to start from scratch. 

For more information, see Sitefinity Designer’s Guide » Page templates » Create a template using the Layout editor. 

UPLOADING A CUSTOM TEMPLATE 

If you have a ready template, which you want to apply to a page, you can upload it and use it. 

For more information, see Sitefinity Designer’s Guide » Page templates » Creating a template using Master pages. 

| Applying a template to a page | Page layout | Table of contents | 

MODIFYING THE LAYOUT 

After you have chosen a layout template for your page, you can modify it to add more layout elements or edit the already added 

elements. 

You can modify the layout template, if you need more columns to present the information you want. You modify the layout using 

Layout elements. Each layout element splits the box where you drop it into columns.  

Section contents 

You can modify the layout in page content editing mode. 

 Adding layout elements 

Use this procedure to add layout elements that split the template element into columns. 

 Editing layout elements 

Use this procedure to modify the columns you have added. 

| Page layout | Table of contents | 

ADDING LAYOUT ELEMENTS 

1. In page content editing mode, click Layout button in the upper-right corner of the page. 

A list of layout elements appears. 

2. Drag a layout element in a box from the page layout. 

The following screenshot shows dragging and dropping a layout element in an empty screen element: 
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NOTE: You can drag a layout element outside a box from the layout template, which you are using. Select an element and 

drag it to the desires place. The system suggests you where you can drop the layout element. 

3. If you need to further split a box into columns, you can nest layout elements. 

| Modifying the layout | Page layout | Table of contents | 

EDITING LAYOUT ELEMENTS 

To edit a predefined layout element, click Edit at the upper-right corner of the element. 

The Edit layout element box appears where you can perform the following: 

MODIFY COLUMN WIDTH 

The following screenshot shows the two ways you can change column width – by dragging the columns’ border or by entering 

widths in the input fields: 

 

To modify column width, perform the following: 

1. Click Sizes tab. 

In section Widths, a number of input fields appear. The number of input fields corresponds to the number of columns you 

have chosen – from one to five. 

2. Choose the unit of measurement between percentages and pixels in Show sizes in radio button. 

3. In Column 1 input field, enter the desired column width for the first column in the chosen unit of measurement. 

If you have chosen a layout with more than two columns, you must enter the width for all of them except for the last one, 

which is automatically calculated by the system. 



 

26 

EXAMPLE: If you have chosen a layout element with three columns, you must enter the size for Column 1 and Column 2. You 

cannot enter in Column 3 – the size of the third column is automatically calculated. 

You can change the automatically calculated column by performing the following: 

a. Click Change auto-sized column. 

b. Click Make this auto-sized link of the column you want to be automatically calculated. 

c. Click Cancel changing auto-sized column. 

4. You can resize the width of the columns by dragging their borders. 

In the layout element at the left, grab the line dividing the columns and grad it to the desired place. 

In each column, the system displays the width in the chosen unit of measurement. 

MODIFY SPACING BETWEEN COLUMNS 

1. To modify spaces between columns, click Spaces and choose the unit of measurement between percentages and pixels in 

Show spaces in radio button. 

2. You can specify the following types of spaces: 

 Space between columns 

 Space above and below columns 

3. Enter the spaces in the chosen unit of measurement 

The system applies equal spaces to all columns. You can adjust spaces between columns individually by clicking Individual 

spaces per column link. 

For each column you can specify individual spacing on the Top, Right, Bottom, and Left.  

ASSiGNING CLASSES TO COLUMNS 

You can choose a new or change the class name for each column, if later you want to set a CSS style for this particular column.  

When you finish with editing sizes, spaces, and classes, click Done button. 

After you have created the layout, you can add content widgets to each box. 

For more information, see Widgets. 

| Modifying the layout | Page layout | Table of contents | 

WEBSITE CONTENT 

After you have created the layout of your page, you proceed with populating the page with content. To display content you use 

widgets. The widgets are controls which you drop on the page (in page content editing mode) and configure them to display 

already existing content. If you do not create content first, the widgets have nothing to display.  

You create content using the content modules on the Content tab. The content you create using content modules is reusable – 

once you create news, an event, or other content item, it is stored in the Sitefinity project and other users can view, use, and edit 

that content. There are predefined modules, such as News and Events, and you can also create your own modules, using the 

Module Builder. 

You display the content you have created with these content modules using the widgets. You can configure the widgets to display 

different part of content, by combining widgets and by tagging and classifying content. 

For more information about using widgets, see Widgets. 

Section contents 

 Built-in modules 

Use this procedure to create reusable content items, such as news and events, or to upload images and videos. Use it to 

manage permission for each content item and to publish them on the website. 

 Dynamic modules 

Use this procedure to create reusable content items with dynamic modules that you have created.  

 Browse and edit 

Use this procedure to create, edit, and upload content while you are browsing the website. You do not need to open the 

website in the backend; you can use the inline editing function to edit your website directly while browsing it. 
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 Revision history 

Use this procedure to view and compare different versions of a content item. 

 Comments and ratings 

Use this procedure to hide and publish, edit and delete comments that are left for content items on the website. 

 Custom fields 

Use this procedure to add a custom field to a content item, such as news, events, or images. A custom field is a field that you 

create. 

 The text editor  

Use this procedure to learn how to use the functions of the Text Editor. Use the editor to enter and format text, tables, and 

more. You can also insert already created text. 

 Classifying content 

Use this procedure to classify the content items you have created by categorizing and tagging them. Classify your content 

items helps you organize them and you can use tags and categories to filter the content items when displaying them. 

 Translating content items and classifications 

Use this procedure to create a new language translation of an existing content item or classification. 

 Feeds 

Use feeds to publish frequently updated information. You can publish an RSS or Atom feed for a blog, news, or events on the 

website and the users can subscribe to this feed. This way they will receive updates of that blog, news, or events without 

having to visit the website. 

 Search indexes 

You use search indexes to define different sets of content to be searched, using the internal search of your website. To 

configure your website’s internal search, you must first define a search index and then drop the Search and Search results 

widget somewhere on your website. 

| Table of contents | 

BUILT-IN MODULES 

The content modules are located under the content tab. Use the Content tab to create reusable content. Once you create news, an 

event, or other content item, it is stored in the Sitefinity project and other users can view, use, and edit this content. The content 

items are displayed on one or more pages of your website using widgets. Each content item has a widget that is used to display 

only that specific content item. For example, the events are displayed on the website using the Events widget. 

For more information about using widgets, see Widgets. 

The content tab has the following dropdown menu, displaying all content modules: 

   

Section contents 

In Sitefinity you can create and use the following types of content (alphabetically ordered): 

 Blogs and blog posts 

Use this content type to create blogs, in which you create blog posts. 
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 Content blocks 

Use this content type to create content blocks when you need to display various kinds of nonspecific information (all 

information different than the predefined content types, such as news or event announcements). Content blocks are very 

useful when you need to create text that will be used on many pages of your website. For example, company address.  

You create content blocks using the text editor. 

 Documents and files 

Use this section to upload and organize documents, links to which you can then display on pages of the website.  

You can also insert links to uploaded documents in the text editor. 

 Events 

Use this content type to create events to be announced on the website. 

 Forms 

Use this section to create custom forms to be displayed on the website. 

 Forums 

Use this section to create forums, threads, and forum posts and to manage them. 

 Images 

Use this section to upload and organize images, which you can then display on pages of the website individually or in galleries. 

You can also insert uploaded images in the text editor. 

 Lists 

Use this content type to create lists and list items. You can use lists for various purposes. For example, you can create a list 

for your FAQ section. 

 News 

Use this content type to create all kind of news. 

 Videos 

Use this section to upload and organize videos, which you can then display on pages of the website individually or in galleries. 

You can also insert uploaded videos in the text editor. 

After you have created a content item you can make it visible on the website, you can manage comments for that item or set 

specific permission. 

In addition to the standard Sitefinity built-in modules, you can create your own dynamic modules. To do this, you use the Module 

Builder. For more information, see Sitefinity Installation and Administration Guide » Modules & Services » Dynamic modules. 

REVISION HISTORY 

Built-in modules have version history. Use this function to view and compare different versions of a content item. Every time you 

edit a content item, a version of that content item is saved by the system. 

For more information, see Revision history. 

CONTENT MODULES AND MULTIPLE SITES 

In case you have multiple sites, before you create or view any content items, you must choose the site where you want to work. 

You do this using the selector in the upper-left corner of the page. Different sites can have different modules. 

Each site that uses the module has its own data source that can be shared with other sites, if you make the proper configurations. 

Each module can use more than one data source. For example, the News module of site A can use news created with site A or site 

B. Therefore, creating content items for one site allows you to use these items in all other sites. If you have configured a module 

to use more than one source, when opening the module, you can choose news from which source to display. All available sources 

are displayed in the toolbar of the page.  

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

URL GENERATION FOR IMAGES, VIDEOS, DOCUMENTS AND FILES 

The automatic generation of the URL for a file uses the following convention: 

http://<my site URL>/<X>/<the URL name of the data source>/<the URL name of the library>/<the 

URL name of the document or file>.<the file extension> where X is docs for documents and files, images for 

images, and videos for videos. 

 The URL name of the data source 

The URL name of the default data source is default-source. 
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You can change the URL name of the data source in the following way: 

1. In the main menu, click Administration » Settings. 

2. Click Advanced link. 

3. In the tree on the left, click Libraries » Providers. 

4. Select the provider whose URL you want to change and click Parameters » urlName. 

5. In Value, enter the new URL. 

If you enter “”, then the URL name of the data source is not included in the URL of the item. 

6. Click Save changes and restart the application. 

IMPORTANT: You must not change the provider URL name after you have uploaded items, because this can break the URLs 

of the already uploaded items. 

NOTE: The documents from upgraded projects have URLs that are generated without the data source name. They will still 

work and will use the default library provider for the system. 

 The URL name of the library 

The URL name of the default library is default-document-library for documents, default-album for images, and 

default-video-library for videos. 

The URL names of the other libraries are their names. 

 The URL name of the item 

You can change the URL name of an item by editing its properties. 

| Website content | Table of contents | 

CREATING AND EDITING BLOGS AND BLOG POSTS 

You manage blogs and their posts on the Blogs  page. 

To open the Blogs page, in the main menu in the upper part of the screen, click Content » Blogs. 

The Blogs page appears, displaying a list of all created blogs with the number of posts in each blog and the date of the last post, 

together with actions you can perform on them. 

When you open a blog you can view all posts in this blog. 

To open the page with a blog’s posts, perform one of the following: 

 On Blogs page, click the blog whose post you want to view. 

 On Blogs page, click Edit posts link of the respective blog. 

A page, displaying all posts in the selected blog, appears. 

To navigate back to Blogs page, click All blogs link in the upper-left part of the page. 

Section contents 

On this page you can do the following: 

 Create a blog 

 Edit blogs 

 Search and filter blogs 

 Create a blog post 

 Edit blog posts 

 Search and filter blog posts 

 Create blog posts with Windows Live Writer 

COMMENTS FOR POSTS 

On the page with all the posts for a blog, you can view all comments for a particular post by clicking the number in Comments 

column of the respective blog. 

All comments that have been submitted for this post appear. 

For more information about comments, see Comments and ratings. 
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PERMISSIONS FOR BLOGS AND BLOG POSTS 

You can set permission for all blogs and blog posts and you can set individual permissions for each blog or blog post. 

 To change the permissions for all blogs, on Blogs page, click Permissions link in the right side of the page. 

The Permissions page appears. 

 To change the permissions for all blog posts, on the blog post page, click Permissions for posts in the right side of the page. 

The Permissions for posts page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR BLOGS AND BLOG POSTS 

You can add a custom field to all blogs or to all posts. A custom field is a field that you create. For each blog and blog post there 

are default fields, such as author, title, etc. If you need to add different than the already existing fields, you must create a custom 

field.  

 To manage the custom fields of blogs, on Blogs page, click Custom fields for blogs link in the right pane of the page. 

 To manage the custom fields of blog posts, on the page with all posts, click Custom Fields for Posts link in the right pane of 

the page. 

For more information, see Custom fields. 

You then display a custom field for blog posts on your website by adding it to a template for displaying blog posts. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

DISPLAYING BLOGS AND BLOGS POSTS ON YOUR WEBSITE 

To display a list of blogs on your website, you must use the Blogs list widget and you must configure it. 

For more information, see Blogs list widget. 

To display blog posts on your website, you must use the Blog posts widget and you must configure it. 

For more information, see Blog posts widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way blog posts are displayed by changing the template which the Blog posts widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

For more information about the pages where the blog posts are displayed, see Default pages for content items. 

| Using the content modules | Website content | Table of contents | 

CREATING A BLOG 

1. If you have multiple sites, on Blogs page select the site where you want to create blogs, using the selector in the upper-left 

corner of the page.  

If your site uses more than one source for blogs, you must choose the source where you want to create the blog. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Perform one of the following: 

 If you have not created any blogs, the system displays the following in the center of the screen: 

 

 If you have already created one or more blogs, the system displays a list all created blogs and the following button in the 

toolbar of Blogs page: 
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3. Click Create a blog. 

The Create a blog page appears. 

4. In Title, enter the title for the blog. 

5. Under Default page, you select the page, in which the blog opens by default. 

Click Select a page button, select a page from the sitemap, and click Done. 

This page is also used when an RSS link to this blog is clicked and it is also used by Windows Live Writer to associate blog 

posts with a particular page. 

6. You can change the automatically generated URL of the blog by clicking Change button under Blog URL and entering the new 

URL in the input field that appears. 

7. To allow or forbid comments for the blog, select or deselect the Allow comments checkbox. 

If you have selected the checkbox, under Who can post comments, select one of the following: 

 Anyone 

 Only registered users 

If you want comments not to be publically visible until the responsible user publishes them, select Comments have to be 

approved before appear on the site checkbox. 

If you select this checkbox, comments that are left on the website are initially saved in status Hidden. 

8. You can choose if you want an RSS feed to be generated for this blog by clicking Alternative publishing (RSS) and selecting 

RSS feed checkbox. 

Feeds are used to publish frequently updated information, such as blogs, news, etc. You can publish an RSS or Atom feed for 

the blog on the website and the users can subscribe to this feed. This way, they will receive updates of the blog without 

having to visit the website. 

You can change the settings of the automatically generated RSS feed. 

Click Change button and perform the following procedure: 

a. In RSS or Atom to generate? radio button group, select the format for the feed. 

b. In URL name, enter a URL of the feed. 

c. Choose how many items to include in the feed by selecting one of the following radio buttons: 

 Include the newest <number> items 

In the input field, enter how many of the published items you want to display. 

 Include all published items 

The feed displays all items that are published. 

d. Choose how to display the items in the feeds by selecting one of the following: 

 Title and content. 

 Title and first <number> characters. 

 Title only. 

e. To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To these fields, you can map 

fields of the RSS or Atom feed.  

When you are finished with the mapping of fields, click Accept changes. 

f. Click Done. 

For more information, see Feeds. 

You can display the RSS feed for the blog using the Feed widget.  

For more information, see Feed widget. 

9. If you have added any custom fields for blogs, all created fields, appear after the Alternative publishing section. 

IMPORTANT: Some of the above fields may not be displayed when you create a blog, because they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

10. Click Create this blog. 
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The system creates the blog and takes you to create posts in this blog. 

 If you want to create a blog post now, click Create a post. 

For more information, see Creating a blog post. 

 If you want to go back to Blogs page, without creating a post, click All blogs link at the upper-left part of the page. 

| Creating and editing blogs and blog posts | Using the content modules | Website content | Table of contents | 

EDITING BLOGS 

EDITING THE PROPERTIES OF A BLOG 

1. Open a blog for editing in one of the following ways: 

 On Blogs page click the Actions link of the respective blog. 

From the dropdown list click Title & Properties. 

 On the blog’s posts page, click Title & Properties link in the right pane. 

The Edit a blog page appears. 

2. Perform procedure Creating a blog » Step 3 to Step 6 and Step 8. 

3. When you are finished, click Save changes. 

DELETING BLOGS 

You can delete a blog in the following ways: 

 On Blogs page, select one or more blogs and click Delete button in the toolbar. 

 On Blogs page, click the Actions link of the respective blog. 

From the dropdown list, click Delete. 

 On Edit a blog page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing blogs and blog posts | Using the content modules | Website content | Table of contents | 

SEARCHING AND FILTERING BLOGS 

SEARCHING FOR BLOGS 

To search for a particular blog, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the blog you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING BLOGS 

 Filter by ownership. 

To display blogs, created only by your user, in the right side of the Blogs page, click My blogs link under Filter blogs. 

 Special filtering 

You can also filter only the blogs that have no posts in them by clicking Blogs without posts.  

| Creating and editing blogs and blog posts | Using the content modules | Website content | Table of contents | 

CREATING A BLOG POST 

1. On Blogs page perform one of the following: 

 Click Create a post link under the name of the blog. 

 Click the blog. 
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The blog posts page appears, displaying one of the following: 

 If you have not created any posts, the system displays the following in the center of the screen: 

 

NOTE: If you are working in multilingual mode, the first blog post you create is in the default language. 

 If you have already created one or more posts, the system displays a list all created posts and the following button in 

the toolbar of the page: 

 

NOTE: If you are working in multilingual mode, before creating a blog post, you must first choose the language in 

which you want to create the post. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

2. Click Create a post button. 

The Create a post page appears. 

3. In the Title input field, enter the title of the post. 

4. In the text editor, enter the post itself. 

For more information, see The text editor. 

5. In Summary input field, you can enter a summery for the post. 

6. You can classify your blog post using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

7. By clicking More options, you can change the following: 

 The automatically generated URL of the post.  

To change it, click Change and enter a new URL name. 

 Allow or forbid comments. 

To allow or forbid users to leave comments about the post, select or deselect the Allow comments checkbox. 

 Configure multiple URLs for the blog post 

a. To configure a blog post to have more than one URL, select Allow multiple URLs for this item... checkbox. 

b. In the input box, enter the additional URLs that you want this blog post to have. 

Enter one URL per line. 

c. If you want all the URLs that you have entered to point to the default URL of the post, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the blog post without redirecting. 

8. If you have added any custom fields for blog posts, all created fields, appear after the More actions section. 

Using custom fields, you can, for example, add an image to the blog post. 

IMPORTANT: Some of the above fields may not be displayed when you create a blog posts, because they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

9. Before you finish creating a blog post, you can preview it by clicking the Preview button in the toolbar.  

The blog post opens in its default page. If there is no default page, it means the blog post is not displayed anywhere on the 

site and you cannot preview it. 

To see which the default page for the blog post is, expand Pages in the right side. The page on the top of the list is the default 

page. For more information about viewing and setting default pages, see Default pages for content items. 

10. When you are finished creating the blog post, you must set its status, using the buttons on top and at the bottom of the blog 

post. For more information, see Setting the status of a new page or content item.  

NOTE: While creating you blog post, you can use the Preview button to see a preview of the blog post and its properties.  
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EDITING BLOG POSTS 

EDITING, APPROVING, AND PUBLISHING THE CONTENT OF A BLOG POST 

1. Go to the blog’s post page and open a blog post for editing in one of the following ways: 

 Click the blog post you want to edit. 

 Click the Actions link of the respective post. 

From the dropdown list, click Content. 

The Edit a post page appears. 

NOTE: In the right of the page you can see the current status of the post that you have opened for editing. You can also see 

the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Perform procedure Creating a blog post » Step 3 to Step 9. 

3. When you are finished, perform one of the following: 

 If you have opened for editing a blog post in status Draft, Unpublished, or Rejected, perform procedure Managing a page 

or content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a blog post in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing a blog post in status Awaiting publishing, perform procedure Managing a page or 

content item that is Awaiting publishing.  

 If you have opened for editing a blog post in status Published or Scheduled, perform procedures Managing a page or 

content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published blog post, the system saves a draft of that news, but the published version is still visible on 

the webpage. To see which version is the currently published one, see Revision History. 

UNPUBLISHING AND SCHEDULING A PUBLISHED POST 

After a blog post has been published, you can change the status of the blog post. 

For more information, see Managing a page or content item that is Published. 

DELETING POSTS 

You can delete posts in the following ways: 

 On blog’s post page, select one or more blog posts and click Delete button in the toolbar. 

 On blog’s post page, click the Actions link of the respective post. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing blogs and blog posts | Using the content modules | Website content | Table of contents | 

SEARCHING AND FILTERING BLOG POSTS 

SEARCHING FOR BLOG POSTS 

To search for a particular post, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the post you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING BLOG POSTS 

 Filter by ownership. 
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To display posts, created only by your user, in the right side of the page, click My posts link under Filter posts. 

 Filter by workflow status. 

You can filter blog posts by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter posts by categories, tags, and custom classifications. 

If you have added a custom classification field to blog posts, it appears in the filter options. For more information, see Custom 

fields. 

 Filter by date. 

To filter posts by the date they were modified, click by Date modified… 

 When you click a time interval, the system displays all the posts updated during this time interval. The last updated are 

the first in the list.  

 To display posts modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 
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CREATING BLOG POSTS WITH WINDOWS LIVE WRITER 

Windows Live Writer is a desktop application for publishing blog posts. You can use Windows Live Writer to create and publish 

blog posts in Sitefinity. It allows you to create, edit, and manage blog posts without having to login to Sitefinity and using a web 

browser.  

PREREQUISITES: To use Live Writer with Sitefinity you must have created a blog and added the Blog posts widget to a published 

page. You must set the page as Default page for that blog. For more information about setting default page, see Creating a blog » 

Step 4. 

You must also have the proper permission to create, view, and modify blogs and posts, image libraries, and classifications. For 

more information about permissions, see Sitefinity Installation and Administration Guide » Manage users, roles, and permissions » 

Manage permissions. 

SETTING UP WINDOWS LIVE WRITER 

1. In Sitefinity main menu, click Administration » Settings. 

2. On the Basic Settings page that appears, click Advanced. 

3. In the tree on the left, click Blogs. 

4. Select AllowBlogging checkbox and click Save changes. 

5. Logout from Sitefinity. 

6. Download and install Window Live Writer from  http://explore.live.com/windows-live-writer?os=other. 

NOTE: You do not need to install all Windows Live Essentials. You need to install only the Writer. 

7. Open Windows Live Writer. 

If this is the first time you open it, you are asked whether you want to add a blog account. 

8. In What blog service to use? window, select Other services, and click Next. 

9. In Web address of your blog, enter the URL of the page, where your blog is published. 

10. Enter the credentials you use to login to Sitefinity, select Remember my password checkbox, and click Next. 

If you have more than one blog, select the blog where you want to post. 

Later you can setup to post in more than one blogs using Windows Live Writer. 

The wizard asks you if you want to download the theme of the page containing your blog. This way you will be able to see a 

preview of the posts you write. 

11. Select the image library where images added to your post will be stored. 

If there is more than one library, click the one with the name of the blog, which you have selected. 

http://explore.live.com/windows-live-writer?os=other
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The library is automatically created in Sitefinity and images are uploaded in this library. 

NOTE: During the upload, you must not be logged in Sitefinity. 

12. Enter a nickname for the blog and click Finish. 

Your blog is saved and you can use Windows Live Writer to publish posts in it. All posts you published with Windows Live 

Writer are also stored in Sitefinity. You cannot use schedule posts for publishing via Windows Live Writer. 

For more information about setting up and using Windows Live Writer, visit Windows Live Writer Help Center at 

 http://explore.live.com/windows-live-writer-help-center. 
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CREATING AND EDITING CONTENT BLOCKS 

You create content blocks when you need to display various kinds of nonspecific information (all information different than the 

predefined content types, such as news or event announcements). Content blocks are very useful when you need to create text 

that will be used on many pages of your website. For example, company address. 

You manage content blocks on the Content blocks shared across pages page.  

To open the page, in the main menu in the upper part of the screen, click Content » Content blocks. 

The Content blocks shared across pages page appears, displaying a list of all created content blocks together with actions you can 

perform on them. 

Use this page to create, edit, and manage shared content blocks, which you can then reuse on as many pages as needed. 

Section contents 

On this page you can do the following: 

 Create a content block 

 Edit content blocks 

 Search and filter content blocks 

DISPLAYING CONTENT BLOCKS ON YOUR WEBSITE 

To display content blocks on your website, you must use the Content block widget and you must configure it. 

For more information, see Content block widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way blocks are displayed by changing the template which the Content block widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

IMPORTANT: Shared content blocks do not have workflow. When you edit a content block, the change is immediately visible on 

all pages that use the content block. 
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CREATING A CONTENT BLOCK 

1. If you have multiple sites, on Content blocks shared across pages page select the site where you want to create content 

blocks, using the selector in the upper-left corner of the page.  

If your site uses more than one source for content blocks, you must choose the source where you want to create the content 

block. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Perform one of the following: 

 If you have not created any content blocks, the system displays the following in the center of the screen: 

  

http://explore.live.com/windows-live-writer-help-center
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NOTE: If you are working in multilingual mode, the first content bock you create is in the default language.  

 If you have already created one or more content blocks, the system displays a list all created content blocks and the 

following button in the toolbar of the page: 

  

NOTE: If you are working in multilingual mode, before creating a content block, you must first choose the language in 

which you want to create it. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages. 

3. Click Create a content block. 

The Create a content block page appears. 

4. In Title, enter a title for the content. 

5. In the text editor, enter the content itself. 

For more information, see The text editor. 

6. To save your work, click Create this content block.  

Your shared content block is created and you can display it on as many pages as needed, using the Content block widget. 
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EDITING CONTENT BLOCKS 

EDITING THE CONTENT OF A CONTENT BLOCK 

1. Go to the Content blocks shared across pages page and open a content block for editing in one of the following ways: 

 Click the content block you want to edit. 

 Click the Actions link of the respective content block. 

From the dropdown list, click Content. 

The Edit a content block page appears. 

2. Perform procedure Creating a content block » Step 3 to Step 4. 

3. When you are finished, click Save changes. 

DELETING A CONTENT BLOCK 

You can delete a content block in the following ways: 

 On Content blocks shared across pages page, select one or more content blocks and click Delete button in the toolbar. 

 On Content blocks shared across pages page, click the Actions link of the respective content block. 

From the dropdown list, click Delete. 

IMPORTANT: Shared content blocks do not have workflow. When you edit a content block, the change is immediately visible on 

all pages that use the content block. 

For more information, see Workflows. 
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SEARCHING AND FILTERING CONTENT BLOCKS 

SEARCHING FOR CONTENT BLOCKS 

To search for a particular content block, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the block you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 
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FILTER CONTENT BLOCKS 

 Filter by ownership. 

To display content blocks, created only by your user, in the right side of the page, click My content blocks link under Filter 

shared content. 

 Special filtering. 

You can filter content blocks that are not displayed on any page or template by clicking Content blocks not used on any page 

or template 
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UPLOADING AND EDITING DOCUMENTS AND FILES 

You manage documents and files on the Documents & Files page. 

To open the Documents & Files page, in the main menu in the upper part of the screen, click Content » Documents & Files. 

The Documents & Files page appears, displaying a list of all created libraries together with actions you can perform on them. 

Use this page to manage document libraries and upload and edit documents or files. 

Section contents 

On this page you can do the following: 

 Upload documents and files  

 Edit the properties of documents and files  

 Sort, filter, and find documents and files  

 Manage document and file libraries 

PERMISSIONS FOR DOCUMENTS, FILES, AND LIBRARIES 

You can set permission for all documents, files, and libraries and you can set individual permissions for each document, file, or 

library. 

To change the permissions for all documents and files, on Documents & Files page, click Permissions link in the right side of the 

page. 

The Permissions for Documents page appears. 

To change permissions for all libraries, in the main menu, click Administration » Permissions » by Section » Libraries. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions for documents, files, and libraries, see Sitefinity Installation and 

Administration Guide » Users, roles, and permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR DOCUMENTS AND FILES 

You can add a custom field to all documents and files. A custom field is a field that you create. For each document or file there are 

default fields, such as author, title, etc. If you need to add different than the already existing fields, you must create a custom 

field.  

To manage the custom fields of documents and files, on Documents & Files page, click Custom Fields link in the right pane of the 

page. 

For more information, see Custom fields. 

You then display a custom field on your website by adding it to a template for displaying documents and files. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates.  

DISPLAYING DOCUMENTS AND FILES ON YOUR WEBSITE 

To display the documents and files you have uploaded on your website, you must use the Document link widget and the Download 

list widget and configure them to display the document or file. 

For more information, see Document link widget and Download list widget. 

For more information, see Add widgets on your page or template. 

You can then choose the way documents and files are displayed by changing the template, which the Document link and Download 

list widget uses. 
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For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

LINKING OR EMBEDDING A DOCUMENT OR FILE 

On Documents & Files page click Embed link to this file link of the respective document or file. 

 To link a document or file, copy the content of the Link input field. 

For example you can copy the link and paste it in an e-mail. 

 To embed a link to a document or file in HTML, copy the content of the Embed field and paste it in HTML code. 

For example, you can embed a link to a document in the text, using the text editor in HTML mode.  
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UPLOADING DOCUMENTS AND FILES 

1. If you have multiple sites, on Documents & Files page select the site where you want to upload documents or files, using the 

selector in the upper-left corner of the page.  

If your site uses more than one source for documents and files, you must choose the source where you want to upload the 

documents and files. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Click the library where you want to upload documents or files. 

3. Perform one of the following: 

 If you have not uploaded any documents or files in the selected library, the system displays the following in the center of 

the screen: 

  

NOTE: If you are working in multilingual mode, the first document or file you upload is in the default language. 

 If you have already uploaded one or more documents or files in the selected library, the system displays all uploaded 

documents and files and the following button in the toolbar of Documents & Files page: 

  

NOTE: If you are working in multilingual mode, before uploading a document or file, you must first choose the language 

in which you want to upload the document or file. Select the language from Languages dropdown box in the right of the 

page. 

For more information about different languages, see Languages. 

4. Click Upload documents or other files. 

The Upload documents or other files page appears. 

5. Drag the files, you want to upload or click Select documents from your computer and browse your computer to find the 

document or file you want to upload and click Open. 

You can select more than one document or file. 

The name of the document or file and its size appear in Upload documents or other files page.  

6. To upload more documents or files, click Add more documents and files . 

7. In Where to store uploaded documents or other files?, select the library, where you want to store the document(s) or file(s), 

by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

If you have not created any libraries, you can only choose Default Library, which exists by default. 

If you want to create another library, perform the following: 

a. Click Create a new library. 
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b. Enter the name of the library and click Create this library. 

The new library appears in the dropdown box. 

For more information about creating libraries, see Managing document and file libraries. 

8. You can classify your documents and files using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

9. When you are finished, perform procedure Setting the status of a new page or content item. 

Uploading status bars appear on the page and after the system has uploaded the documents or files, a massage appears 

informing you about the result of the upload. 

10. When upload is finished, choose between the following: 

 View all items 

Returns you to Documents & Files page. 

 Upload more documents or other files 

The system opens Upload documents or other files page, where you can upload new documents and files.  

Perform Step 3 to Step 8. 

NOTE: If you are in multilingual mode, on Documents & Files page, the system displays all available languages next to the 

document or file. You cannot have different documents or files in different languages, but you can have different titles for each 

language. To do this, click the Add link of the respective icon. 

NOTE: On Documents & Files page you can also download an already uploaded document or file, by clicking its Actions link and 

then Download. 
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EDITING THE PROPERTIES OF DOCUMENTS AND FILES 

EDITING PROPERTIES AND ADDING DETAILS TO A DOCUMENT OR FILE 

1. To edit and add details to an already uploaded document or file, on Documents & Files page perform one of the following: 

 Click the document or file you want to edit. 

 Click the Actions link of the respective document or file and then click Edit Properties. 

The Edit properties page appears. 

NOTE: In the right of the page you can see the current status of the document or file that you have opened for editing. You 

can also see the author, the time and date of the last update, the publication date, and a link to all existing versions of the 

item. 

2. Change the title, by entering the new title in Title input field. 

3. Open the document or file with the respective program by clicking Open the file button below the Title input field. 

The document is downloaded to your computer. 

4. Replace the document or file with another by clicking Replace the file button bellow the Title input field. 

The Select document or other file link appears. Click the link, browse your computer to find the new document or file, and click 

Open. 

The system replaces only the document or file, but not its title and other properties. 

5. Change the library, which the document or file belongs to, by clicking Change button and selecting the new library from the 

dropdown box that appears. 

6. Change the categories and the tags, which the document or file is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

7. To add details to the document or file, click Details. 

The following input fields appear: 

 Author 

Enter an author of the document or file.  

 Description 

 Other details 
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You can enter additional information about the document or file. 

8. Using the Advanced section, you can configure the following: 

 Change the URL of the document or file by clicking Advanced. 

The automatically generated URL of the document or file appears.  

To change it, click Change and enter a new URL name. 

 Configure additional URLs for the document or file. 

a. Select Allow multiple URLs for this item... checkbox 

b. Enter the URLs one per line, using the following convention /docs/<URL name> 

c. If you want all the URLs that you have entered to point to the default URL of the document, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the document without redirecting. 

9. If you have added any custom fields for documents and files, all created fields appear after the Advanced section. 

Using custom fields, you can, for example, add a custom field Last updated on…to the document or file. 

IMPORTANT: Some of the above fields may not be displayed when you edit the properties of a document or file, because 

they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

10. Before you finish editing the document or file, you can preview it by clicking the Preview button in the toolbar.  

The document opens in its default page. If there is no default page, it means the document is not displayed anywhere on the 

site and you cannot preview it. 

To see which the default page for the document is, expand Pages in the right side. The page on the top of the list is the 

default page. For more information about viewing and setting default pages, see Default pages for content items. 

11. When you are finished, perform one of the following: 

 If you have opened for editing a document or file in status Draft, Unpublished, or Rejected, perform procedure Managing 

a page or content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a document or file in status Awaiting approval, perform procedure Managing a page or 

content item that is Awaiting approval. 

 If you have opened for publishing a document or file in status Awaiting publishing, perform procedure Managing a page or 

content item that is Awaiting publishing.  

 If you have opened for editing a document or file in status Published or Scheduled, perform procedures Managing a page 

or content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published document or file, the system saves a draft of it, but the published version is still visible on 

the webpage. To see which version is the currently published one, see Revision History. 

EDIT TITLES OF MANY DOCUMENTS AND FILES AT THE SAME TIME 

You can edit the properties of many documents and files at the same time. To do this, perform the following: 

1. On Documents & Files page, select the documents or files you want to edit and click More actions » Bulk edit titles, categories, 

tags. 

The Bulk edit page appears displaying all the selected documents and files. 

2. You can apply the following to all selected documents and files: 

 Common library 

Click Change library and select a library from the dropdown box that appears. 

All documents and files are moved to that library. 

 Common categories 

Click Click to add common categories link. 

For more information, see Adding categories. 

 Common tags 

Click Click to add common tags. 

For more information, see Adding tags. 

3. For each of the selected documents or files, you can change the following: 

 Title 
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 Description 

4. When finished, click Save changes. 

The system returns you to Documents & Files page. 

MOVING AND DELETING A DOCUMENT OR FILE 

 To move one or more documents or files to another library, on Documents & Files page, select the documents and the files 

and in the toolbar click More actions » Move to another library. 

A window appears where you select the library, where you want to move the document(s) or file(s) and click Move. 

 To delete a document or file, perform one of the following: 

 On Documents & Files page, select one or more documents or files you want to delete and click Delete button in the 

toolbar. 

 On Documents & Files page, click the Actions link of the document or file you want to delete and then click Delete.  

 On Edit properties page of the respective document or file, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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SORTING, FILTERING, AND FINDING DOCUMENTS AND FILES 

The Documents & Files page displays all created document libraries. To view documents in a library, click it. 

DISPLAY DOCUMENTS AND FILES BY LIBRARIES 

To display documents and files only from a specific library, click the library thumbnail in the right side of Documents & Files page. 

NOTE: For each document or file, you can see a link to the library, which it belongs to. If you click the link to the library, all 

documents and files from this library appear. 

For more information, see Managing document and file libraries. 

FILTER DOCUMENTS AND FILES 

To display the filtering options, click Filter documents & files. 

 Filter by ownership. 

To display documents and files, uploaded only by your user, in the right side of Documents & Files page, click My items link 

under Filter Documents & Files. 

 Filter by workflow status. 

You can filter documents by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter documents by categories, tags, and custom classifications. 

If you have added a custom classification field to documents, it appears in the filter options. For more information, see Custom 

fields. 

 Filter by date. 

To filter documents and files by the date they were modified, click by Date … 

The Display items modified in… pane appears. 

 When you click a time interval, the system displays all documents and files modified during this time interval. The last 

modified are the first in the list. You can further sort them. 

 To display documents and files modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 

SORT DOCUMENTS AND FILES 

You can sort documents and files using the Sort items: dropdown box in the toolbar of the page. 

There are the following sorting options: 
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 Last uploaded on top 

Sorts documents and files in descending order according to the time of upload. 

 Last modified on top 

Sorts documents and files in descending order according to time of modification. 

 Custom Sorting… 

A window appears where you perform the following: 

1. Select sorting criterion from the dropdown box and choose between Ascending and Descending order in the radio button. 

2. You can also and add more than one criterion by clicking Add another sorting rule link and you can remove sorting criteria 

by clicking Remove link. 

3. When you are finished, click Save. 

The system sorts the documents and files according to the custom sorting. 

4. To edit a custom sorting that you have created, select Edit custom sorting… from the Sort items: dropdown box. 

SEARCHING FOR DOCUMENTS AND FILES 

To search for a particular document or file, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the document or file you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all documents and files, click Close search button in the toolbar. 
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MANAGING DOCUMENT AND FILE LIBRARIES 

You display and manage all created libraries on Documents & Files page. 

The Documents & Files page displays the number of documents or files in each library, the date of the last uploaded document or 

file, and where those documents and files are stored. 

DISPLAYING AND EDITING THE DOCUMENTS AND FILES IN A LIBRARY 

1. You can display all documents, files, and sub-libraries in a library in one of the following ways: 

 On Libraries page, click the library whose documents and files you want to display. 

All documents and files in the library appear. 

 On Documents & Files page, click the library thumbnail in the right side of page. 

The system displays a page with all the documents and files from the selected library together with the Library actions 

link. 

2. To edit the documents or the files in the library, perform procedure Editing the properties of documents and files. 

3. To go back to all documents and files, click All items link in the right side of the page or in the main menu in the upper part of 

the screen, click Content » Documents & Files. 

CREATING A DOCUMENT AND FILE LIBRARY 

1. On Documents & Files page, click Create a library button in the toolbar. 

The Create a library page appears. 

2. Enter a name for the library. 

3. To add a description of the library, click Click to add a description. 

NOTE: The information you provide here is not public, it is for your reference only. 

4. You can define the maximum size of the library and of each document and file in the library by clicking Advanced. 

The Max library size and the Max document/file size input fields appear. There you enter the limit of the size in MB and KB 

respectively. 

5. Under URL name, you can change the URL of the library. 
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The automatically generated URL of the library appears.  

To change it, click Change and enter a new URL name. 

6. Under Parent library, choose where to create the library: 

Select one of the following: 

 No parent 

This will be a top level library that has no parent. 

 Select parent library… 

A treeview with existing libraries appears. 

Select the library that will be parent of the library you are creating. 

NOTE: If the library you are creating is located in another library, it has the same settings as its parent. You can only set 

cache options, storage providers, and resizing options for a root library, located at top level. 

7. If in Step 6, you have chosen your library to be a top level library that has no parent, under Root library settings, you can 

configure the following: 

 You can set the maximum size of the library in MB and of each image in the library in KB. 

 You can choose where to store the documents and files uploaded in this library. 

For example, you can store them on the database, in the file system, or in an external storage. 

In Storage provider dropdown box, select where to store the documents and files. 

The list that appears contains all available storage providers. For more information, see Storage providers for libraries. 

 You can configure the server and browser caching. 

Configuring caching can increases your performance.  

8. When you are finished, click one of the following: 

 Create and go upload documents 

The system creates the library and takes you to upload documents or files. 

Perform procedure Uploading documents and files » Step 3 to Step 9. 

 Create this library 

The system creates the library and returns you to Libraries page or Documents & Files page, depending on where you 

have started creating the library. 

 The Back to link 

The system does not save the library you were working on and returns you to Libraries page or Documents & Files page, 

depending on where you have started creating the library. 

CHOOSING THE UPLOAD MODE OF THE LIBRARY 

You can change the method by which items are uploaded into libraries. Sitefinity supports HTML5 and Silverlight upload. 

For more information, see Sitefinity Installation and Administration Guide » Settings » Libraries upload mode. 

EDITING DOCUMENT AND FILE LIBRARIES 

1. To edit the library properties, on Documents & Files page click the Actions link of the library you want to edit. 

2. From the dropdown box, click Edit Properties. 

The Edit a library page appears. 

3. Perform Step 2 to Step 7 of the above procedure. 

NOTE: If you are changing the URL of the library, Sitefinity changes the URLs of the items one by one. In case of external 

storage, changing the library URL may cause data transfer from one storage to another. In case of failure, some of the items 

might keep their previous URLs and some of the items will have the updated URLs. You can try to resume to get the rest of 

the items relocated. 

4. Click Save changes. 

The system returns you to Documents & Files page. 

CHANGING THE PARENT LIBRARY OF A DOCUMENTS AND FILES LIBRARY 

Once created, a library can be moved together with all of its content to another library, by changing its parent library. 

To do this, perform the following: 

1. Click the Actions link of the library that you want to move and from the dropdown, select Move to… 
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The Change parent library dialog appears. 

2. Select the new parent library and click Move. 

MOVING DOCUMENTS AND FILES TO ANOTHER STORAGE 

You can change the blob storage provider of a library, which moves all items in a different storage. For example, an image library 

kept in the database can be moved to the cloud, or a library from one cloud account can be moved to another. 

To do this, perform the following: 

1. Click the Actions link of the library whose items you want to move and from the dropdown, select Move to another storage. 

In the Blob storage provider dropdown box all available storage providers appear. 

2. Select where you want to move the items from the library and click Move to another storage. 

Sitefinity processes the library items one by one and displays a progress indicator in the grid. You can stop and resume the 

operation. 

NOTE: In case of failure before the operation is completed, some of the library items may remain in the target storage, while the 

rest will stay in the source storage. You can try to resume the operation. 

IMPORTANT: During the process of moving to another storage, you are not able to edit or delete the library items. 

For more information, see Storage providers for libraries. 

DELETING DOCUMENT AND FILE LIBRARIES 

To delete a library, perform one of the following: 

 On Documents & Files page, select one or more libraries you want to delete and click Delete button in the toolbar. 

 On Documents & Files page, click the Actions link of the library you want to delete and then click Delete. 

 On Edit a library page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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CREATING AND EDITING EVENTS 

You manage events on the Events page. 

To open the Events page, in the main menu in the upper part of the screen, click Content » Events. 

The Events page appears, displaying a list of all created events together with actions you can perform on them. 

Use this page to create, edit, and manage events. 

Section contents 

On this page you can do the following: 

 Create an event 

 Edit events 

 Search and filter events 

 Managing event calendars 

COMMENTS FOR EVENTS 

On Events page, you can view all the comments for events by clicking Comments for events link on the right side of the page. 

All comments that have been submitted for all the events appear. 

For more information about comments, see Comments and ratings. 

PERMISSIONS FOR EVENTS 

You can set permission for all events and you can set individual permissions for each event. 

To change the permissions for all events, on Events page, click Permissions link in the right side of the page. 

The Permissions page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 
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For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR EVENTS 

You can add a custom field to all events. A custom field is a field that you create. For each event there are default fields, such as 

author, title, etc. If you need to add different than the already existing fields, you must create a custom field.  

To manage the custom fields of events, on Events page, click Custom Fields for events link in the right pane of the page. 

For more information, see Custom fields. 

You then display a custom field on your website by adding it to a template for displaying events. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

EVENT CALENDARS 

You can organize you events in calendars, you can color-code the calendars and then display them on the website in Month, Week, 

or Day view. For more information, see Managing event calendars. 

DISPLAYING EVENTS ON YOUR WEBSITE 

To display events on your website, you must use the Events widget and you must configure it. 

For more information, see Events widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way events are displayed by changing the template which the Events widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 
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CREATING AN EVENT 

1. If you have multiple sites, on Events page select the site where you want to create events, using the selector in the upper-left 

corner of the page.  

If your site uses more than one source for events, you must choose the source where you want to create the event. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Perform one of the following: 

 If you have not created any events, the system displays the following in the center of the screen: 

 

NOTE: If you are working in multilingual mode, the first event you create is in the default language. 

 If you have already created one or more events, the system displays a list of all created events and the following button 

in the toolbar of Events page: 

 

NOTE: If you are working in multilingual mode, before creating an event, you must first choose the language in which 

you want to create the event. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages. 

3. Click Create an event. 

The Create an event  page appears. 

4. In the Title input field, describe the event. 

5. In the text editor enter information for the event. 

For more information, see The text editor. 

6. To enter a summary of the event, click Click to add summary. 
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7. Select whether you want to make this even recurrent or not. 

In the Repeat event dropdown box, choose one of the following: 
 

None To schedule the starting and the ending date and time of the event, use the Event start and Event end 

input fields. 

Daily  Choose the Start time and the End time of the event. 

 Under Repeat…, select the interval of repetition. 

 You can enter an interval. 

For example, if you enter 2, the event will be repeated every other day. 

 You can also select to repeat the event every day, except the weekend. 

 In Event start, select the date of the first occurrence of the event. 

 In Event end…, you can choose to end the event after: 

 A selected number of repeated. 

 On a particular date. 

 Do not end the event. 

Weekly  Choose the Start time and the End time of the event. 

 Under Repeat…, select the interval of repetition. 

For example, if you enter 2, the event will be repeated every other week. 

 Select the weekdays when the event will occur. 

 In Event start, select the date of the first occurrence of the event. 

 In Event end…, you can choose to end the event after: 

 A selected number of repeated. 

 On a particular date. 

 Do not end the event. 

Monthly  Choose the Start time and the End time of the event. 

 Under Repeat…, perform one of the following: 

 Enter the day of the month when the event will occur and enter the interval of repetition. 

For example, if you enter 5 and 2, the event will occur on the fifth date of every other month. 

 Select the week of the month that the event will occur, then select either the exact weekday or 

select between day, weekday, and weekend day. Enter the interval of repetition. 

For example, you can select the third Monday of every second month. 

 In Event end…, you can choose to end the event after: 

 A selected number of repeated. 

 On a particular date. 

 Do not end the event. 

Yearly  In Event start, select the date of the first occurrence of the event. 

 Under Repeat…, perform one of the following: 

 Select the month and enter the day.  

The event will occur annually on this date. 

 Select the week of the month that the event will occur, then select either the exact weekday or 

select between day, weekday, and weekend day. Select the month. 

For example, you can choose the first Sunday of April. 

 In Event end…, you can choose to end the event after: 

 A selected number of repeated. 
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 On a particular date. 

 Do not end the event. 

8. For every type of recurrence, you can select whether the event is an All day event. 

This way you do not have to fill out the starting and ending time of the event. 

9. For every type of recurrence, you can select a time zone for the event that is different than the default one. 

You use the Time zone dropdown box. 

You configure the default time zone using the Basic settings. 

Sitefinity automatically handles daylight saving time. 

10. You can classify your event using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

11. Use the Calendar dropdown box to select the calendar that the event belongs to. 

The dropdown box contains a list of all created calendars. For more information, see Managing event calendars. 

12. To assign a location of the event, click Location. 

In the input fields that appear, enter the address of the event. 

13. To provide contact information for the event, click Contact information. 

In the input fields that appear, enter contact details. 

14. By clicking More options, you can change the following: 

 The automatically generated URL of the event.  

To change it, click Change and enter a new URL name. 

 Allow or forbid comments. 

To allow or forbid users to leave comments about the event, select or deselect the Allow comments checkbox. 

 Configure multiple URLs for the event 

a. To configure an event to have more than one URL, select Allow multiple URLs for this item... checkbox. 

b. In the input box, enter the additional URLs that you want this event to have. 

Enter one URL per line. 

c. If you want all the URLs that you have entered to point to the default URL of the event, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the event without redirecting. 

15. If you have added any custom fields for events, all created fields are displayed after the More actions section. 

Using custom fields, you can, for example, add a custom field Dresscode to the event. 

IMPORTANT: Some of the above fields may not be displayed when you create an event, because they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

16. Before you finish creating an event, you can preview it by clicking the Preview button in the toolbar.  

The event opens in its default page. If there is no default page, it means the event is not displayed anywhere on the site and 

you cannot preview it. 

To see which the default page for the event is, expand Pages in the right side. The page on the top of the list is the default 

page. For more information about viewing and setting default pages, see Default pages for content items. 

17. When you are finished creating the event, you must set its status, using the buttons on top and at the bottom of the event. 

For more information, see Setting the status of a new page or content item.  

| Creating and editing events | Using the content modules | Website content | Table of contents | 

EDITING EVENTS 

EDITING, APPROVING, AND PUBLISHING THE CONTENT OF AN EVENT 

1. Go to the Events page and open the event for editing in one of the following ways: 

 Click the event you want to edit. 

 Click the Actions link of the respective event. 
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From the dropdown list, click Content. 

The Edit an event page appears. 

NOTE: In the right of the page you can see the current status of the event that you have opened for editing. You can also see 

the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Perform procedure Creating an event » Step 4 to Step 17. 

3. When you are finished, perform one of the following: 

 If you have opened for editing an event in status Draft, Unpublished, or Rejected, perform procedure Managing a page or 

content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving an event in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing an event in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing an event in status Published or Scheduled, perform procedures Managing a page or 

content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published event, the system saves a draft of that event, but the published version is still visible on the 

webpage. To see which version is the currently published one, see Revision History. 

DELETING AN EVENT 

You can delete an event in the following ways: 

 On the Events page, select one or more events and click Delete button in the toolbar. 

 On the Events page, click the Actions link of the respective event. 

From the dropdown list, click Delete. 

 On Edit an event page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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MANAGING EVENT CALENDARS 

DISPLAYING ALL EVENT CALENDARS 

1. To display and manage all created calendars, go to Events page. 

2. In the right side of the page, under Event by calendar, click Manage calendars link. 

Calendars  page appears where you can view and manage all calendars. 

NOTE: The Calendar page displays the number of events in each calendar and Actions you can perform with the calendar. 

CREATING A CALENDAR 

1. On Calendars page, in the toolbar, click Create a calendar button. 

The Create a calendar  page appears. 

2. Enter the name of the calendar. 

3. To add a description of the calendar, click Click to add summary. 

NOTE: The information you provide here is not public, it is for your reference only. 

4. You can color code your calendars by assigning colors to them using the Color dropdown. 

5. Under URL name, you can change the URL of the calendar. 

The automatically generated URL of the calender appears.  

To change it, click Change and enter a new URL name. 

6. Click Create this calendar. 

EDITING IMAGE LIBRARIES 

7. On Calendars page click the Actions link of the calendar you want to edit. 

8. From the dropdown box, click Edit. 



 

50 

The Edit a calendar page appears. 

9. Perform Step 2 to Step 5 of the above procedure. 

10. Click Save changes. 

The system returns you to Calendars page. 

DELETING IMAGE LIBRARIES 

To delete a calendar, on Calendars page, click the Actions link of the library you want to delete and then click Delete. 

A dialog box appears where you must confirm the deletion. 
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SEARCHING AND FILTERING EVENTS 

SEARCHING FOR EVENTS 

To search for a particular event, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the event you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING EVENTS 

 Filter by ownership. 

To display events, created only by your user, in the right side of the Events page, click My events link under Filter events. 

 Filter by workflow status. 

You can filter events by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter events by categories, tags, and custom classifications. 

If you have added a custom classification field to events, it appears in the filter options. For more information, see Custom 

fields..  

 Filter by date. 

To filter events by the date they were modified, click by Date modified… 

 When you click a time interval, the system displays all the events updated during this time interval. The last updated are 

the first in the list.  

 To display events modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 

 Special filtering 

You can filter events by their due date. The filter is grouped in the following options: 

 Current events 

 Upcoming events 

 Past event 

 Filter by calendar 

You can filter events by the calendar, which they are assigned to. 

| Creating and editing events | Using the content modules | Website content | Table of contents | 
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CREATING AND EDITING FORMS 

You manage forms on the Forms  page. 

To open the Forms page, in the main menu in the upper part of the screen, click Content » Forms. 

The Forms page appears, displaying a list with all created forms together with actions you can perform on them. 

Use this page to create, design, and edit forms and manage responses to forms. 

Section contents 

On this page you can do the following: 

 Create a form 

 Design a form 

 Configure form widgets 

 Edit a form 

 Manage responses to a forms 

 Duplicate and share forms 

 Setup email notification for form responses 

 Search and filter forms 

PERMISSIONS FOR FORMS 

You can set permission for all forms and you can set individual permissions for each form. 

To change the permissions for all forms, on Forms page, click Permissions for forms link in the right side of the page. 

The Permissions for forms page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

DISPLAYING FORMS ON YOUR WEBSITE 

To display the forms you have created on your website, you must use the Form widget and configure it. 

For more information, see Form widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 
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CREATING A FORM 

1. On Forms page perform one of the following: 

 If you have not created any forms, the system displays the following in the center of the screen: 

 

 If you have already created one or more forms, the system displays a list of all created forms and the following button in 

the toolbar of Forms page: 

 

NOTE: If you are working in multilingual mode, before creating a form, you must first choose the language in which you 

want to create the form. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

2. Click Create a form.  

The Create a form  page appears. 

3. In the Title input field, enter the name of the form. 
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4. You can change the automatically generated name for developers by clicking Change and entering the new name in the input 

field that appears. 

This is the name of the form that is used by developers to refer to the form in the code. 

5. If your license has Marketo add-on, the Advanced section appears. 

The section allows you to link the form to Marketo.  

For more information, see Sitefinity Installation and Administration Guide » Synchronization of data » Synchronizing Sitefinity 

with Marketo » Connecting a Sitefinity form to Marketo. 

6. When you are finished, click one of the following: 

 Create and go to add content 

The form is created and the system opens the form in content editing mode. 

In content editing mode you design the layout of the form and add content using widgets. 

For more information, see Designing a form. 

 Create and return to Forms 

An empty form is created and the system returns you to Forms page. 

 Back to Forms 

You return to Forms page without creating and saving the form. 
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DESIGNING A FORM 

You design forms in content editing mode using the Layout builder and forms widgets. 

1. To open a form in content editing mode, on Forms page, perform one of the following: 

 Click the form you want to edit. 

 Click the Actions link of the respective form. 

From the dropdown list click Content. 

The form opens in content editing mode. 

2. To design the layout of the form, click Layout button in the upper-right corner of the page. 

The Layout builder appears, displaying a list of layout elements on the right. 

You edit the layout of forms the same ways you edit the layout of pages.  

For more information, see Modifying the layout. 

3. To add content to the form, click Content button in the upper-right corner of the page. 

A list of form widgets appears on the right.  

You add and use widgets in forms the same way you do in pages. 

For more information, see Add widgets on your page or template. 

To configure the widgets to display what you require, see Configuring form widgets. 

4. To change the setting of a form, click Settings button in the upper-right corner of the page. 

You can change the following settings: 

 Restrictions 

In this radio button group you can control the responses to the form. Choose one of the following: 

 One entry per IP 

The form can be filled out and submitted only once from a particular IP. If the user tries to submit the form more 

than once from the same IP address, the system displays an error massage. 

 One entry per username 

The form can be filled out and submitted only once by a particular user. If the same user tries to submit the form 

more than once, the system displays an error massage. 

Use this option only if there is user registration prior to submitting the form. 

 No restrictions: Everyone can submit unlimited number of entries 

The form can be submitted unlimited number of times from the same user and IP. 

 Confirmation options 

In this radio button group, you choose what happens after a user submits the form. Select one of the following: 



 

53 

 Show message for success 

A textbox appears, where you define the success message that appears when a user submits the form. 

 Redirect to a page… 

After submitting the form the system redirects the user to another page of the website. 

In the input field that appears, enter the URL of the page from your website, which you want to open when the form 

is submitted. For example, About-us. 

 Label placement 

Choose where to display the label of the elements, such as textboxes, checkboxes, and multiple choices. 

Select one of the following: 

 Top aligned 

 Left aligned 

 Right aligned 

 CSS Class 

You can choose a class name for each form, if later you want to set a CSS style for this particular form. 
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CONFIGURING FORM WIDGETS 

You populate forms with content using form widgets. Form widgets are added on the form the same way regular widgets are 

added on a page. For more information, see Add widgets on your page or template. 

When you open a form to edit its content, the following list of form widgets appear on the right of the page, when you click the 

Content button: 

  

Section contents 

You can use the following widgets to design your form: 

 Textbox 

Use this widget to give the user the opportunity to enter free text no longer than a line, such as street address, e-mail, etc. 

 Multiple choice 

Use this widget to ask the user a question and give the user the opportunity to select only one out of several predefined 

answers. 

 Checkboxes 

Use this widget to ask the user a question and give the user the opportunity to select one or more of the predefined answers. 

 Paragraph box 

Use this widget to give the user the opportunity to enter free text longer than one line, such as customer feedback. 

 Dropdown list 

Use this widget to ask the user a question and give the user the opportunity to select only one of many predefined answers. 
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 Section header 

Use this widget to display form or section headings. 

 Instructional text 

Use this widget to display instructions and explanatory text for the entire form or for a particular part of the form. 

 File upload 

Use this widget to give the user the possibility to upload one or more file attachments to the form.  

 Submit button 

Use this widget to display the button that the user uses to submit the form. 

After you have dragged a widget in the form, click the Edit button in the upper-right corner of the widget to configure it. Note that 

the Submit button widget is automatically added by the system when you drop the first widget in the form. 

ADDING CUSTOM WIDGETS TO THE FORMS TOOLBOX 

If the build-in Sitefinity form widgets do not meet your requirements, you can create and use custom widgets. If you have a 

custom form widget that you want to use in Sitefinity, you must first register the widget in the toolbox. 

For more information, see Sitefinity Installation and Administration Guide » Settings » Registering a new widget in Sitefinity. 
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TEXTBOX 

Use this widget to give the user the opportunity to enter free text no longer than a line, such as street address, e-mail, etc. 

After you have dragged the Textbox form widget in your form, click the Edit button in the upper-right corner of the widget. 

The Textbox window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

1. In Label input field enter the label of the textbox. 

For example, Address or E-mail. 

The label is displayed above, to the right, or to the left of the textbox, depending on what settings you have made for the 

form. For more information, see Designing a form » Step 4. 

2. In Instructional text, enter instructions or explanatory text for the textbox, if needed.  

The text is displayed bellow the textbox. 

3. In Predefined value, enter a predefined value for the textbox that is displayed in the box by default and the user can 

change it, if required. 

4. Select the Make required checkbox, if you want to make the textbox mandatory. 

A textbox appears, where you enter the error message that is displayed, if the user does not fill out the textbox. 

5. If you click Advanced: Name for developers, you can change the automatically generated name that is used to refer to the 

widget in the code. To change it, click Change and enter the new name. 

NOTE: You can add validation to the textbox. For example, you can require the user enters a valid email address.  

For more information, see Validating the user input. 

 Limitations 

On this tab, perform the following: 

1. In Range input fields, enter the minimum and maximum number of characters that a user can enter in the textbox. 

If you do not want to impose limits to the textbox, leave the Max input field empty and the Min input field 0. 

2. Enter an error message that is displayed, if the user enters less than or more than the defined limits. 

 Appearance 

On this tab, perform the following: 

1. In Textbox size dropdown, select the size of the textbox. 

The textbox is always one line. The size of the textbox refers to its length. 

2. In CSS class input field, you can choose a class name for the textbox, if later you want to set a CSS style for this particular 

textbox. 

When you are finished, click Save. 
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For more information about advanced configuration options, see Advanced configuration of widgets. 
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MULTIPLE CHOICE 

Use this widget to ask the user a question and give the user the opportunity to select only one of several predefined answers. A 

multiple choice is a radio button group and the label of the group is the question that you want to ask. 

After you have dragged the Multiple choice form widget in your form, click the Edit button in the upper-right corner of the widget. 

The Multiple choice window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

1. In Label (Question) input field enter the label of the radio button group. 

The label of a multiple choice is a question, which possible answers are given in predefined radio buttons. 

For example, Which is your favorite color? or Color preferences. 

The label is displayed above, to the right, or to the left of the radio button group, depending on what settings you have 

made for the form. For more information, see Designing a form » Step 4. 

2. In Choices input fields, enter the possible answers to the question you have defined. 

By default there are three input fields. In each input field, enter an answer (choice). If you need more or less choices, add 

and remove input fields by clicking  and  buttons of the respective field.  

You must have at least two choices. 

3. If you select Add "Other" as a last choice checkbox, the system adds another undefined choice to the multiple choices. If 

you select the checkbox, the system displays an input field where you enter the label for that choice. For example, you 

can enter Other or Enter another, etc. 

When the user selects that last choice, an input field is displayed, where the user enters another answer different from 

the predefined multiple choices. 

4. In Default selected choice, select one of the following: 

 The first one 

The first choice you have listed is selected by default. 

 None 

No choice is selected by default. 

The user can change the choice selected by default. 

5. If you click Advanced: Name for developers, you can see the automatically generated name that is used to refer to the 

widget in the code. To change it, click Change and enter the new name. 

 Appearance 

On this tab, perform the following: 

1. Choose the number of columns that you want to use to display the choices you have defined.  

You can choose between the following: 

 One column 

 Two columns 

 Three columns 

 Inline (side by side) 

No columns are used; the radio buttons are displayed in a line. 

2. In CSS class input field, you can choose a class name for the multiple choice, if later you want to set a CSS style for this 

particular widget. 

When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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CHECKBOXES 

Use this widget to ask the user a question and give the user the opportunity to select one or more of the predefined answers. The 

Checkboxes widget is a checkbox group and the label of the group is the question that you want to ask. 

After you have dragged the Checkboxes form widget in your form, click the Edit button in the upper-right corner of the widget. 

The Checkboxes window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

1. In Label (Question) input field enter the label of the checkbox group. 

The label is a question, which possible answers are given in predefined checkboxes. The user can select more than one of 

the checkboxes. 

For example, Which of the foods do you consume daily? or Daily consumption of foods. 

The label is displayed above, to the right, or to the left of the checkbox group, depending on what settings you have 

made for the form. For more information, see Designing a form » Step 4. 

2. In Choices input fields, enter the possible answers to the question you have defined. 

By default there are three input fields. In each input field, enter an answer (choice). If you need more or less choices, add 

and remove input fields by clicking  and  buttons of the respective field.  

3. If you want the choices you have defined to be sorted alphabetically, select the Sort choices alphabetically checkbox. 

4. Select the This is a required field checkbox, if you want to make the checkbox group mandatory. 

The user must select at least one checkbox. 

5. If you click Advanced: Name for developers, you can change the automatically generated name that is used to refer to the 

widget in the code. To change it, click Change and enter the new name. 

 Appearance 

On this tab, perform the following: 

1. Choose the number of columns that you want to use to display the choices you have defined.  

You can choose between: 

 One column 

 Two columns 

 Three columns 

 Inline (side by side) 

No columns are used; the radio buttons are displayed in a line. 

2. In CSS class input field, you can choose a class name for the checkbox group, if later you want to set a CSS style for this 

particular widget. 

When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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PARAGRAPH BOX 

Use this widget to give the user the opportunity to enter free text longer than one line, such as customer feedback. 

After you have dragged the Paragraph box form widget in your form, click the Edit button in the upper-right corner of the widget. 

The Paragraph text box window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

1. In Label input field enter the label of the paragraph box. 

For example, Feedback or Comments. 

The label is displayed above, to the right, or to the left of the paragraph box, depending on what settings you have made 

for the form. For more information, see Designing a form » Step 4. 

2. In Instructional text, enter instructions or explanatory text for the paragraph box, if needed. The text is displayed bellow 

the paragraph box. 
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3. In Predefined value, enter a predefined value of the paragraph box that is displayed in the box by default and the user 

can change it, if required. For example, enter Type your feedback here… 

4. Select the Make required checkbox, if you want to make the paragraph box mandatory. 

A textbox appears, where you enter the error message that is displayed, if the user does not fill out the paragraph box. 

5. If you click Advanced: Name for developers, you can change the automatically generated name that is used to refer to the 

widget in the code. To change it, click Change and enter the new name. 

NOTE: You can add validation to the paragraph box. For example, you can require the user enters a valid email address.  

For more information, see Validating the user input. 

 Limitations 

On this tab, perform the following: 

1. In Range input fields, enter the minimum and maximum number of characters that a user can enter in the paragraph box. 

If you do not want to impose limits to the paragraph box, leave the Max input field empty and the Min input field 0. 

2. Enter an error message that is displayed, if the user enters less than or more than the selected limits. 

 Appearance 

On this tab, perform the following: 

1. In Paragraph Text box size dropdown, select the size of the box. 

2. In CSS class input field, you can choose a class name for the paragraph box, if later you want to set a CSS style for this 

particular box. 

When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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DROPDOWN LIST 

Use this widget to ask the user a question and give the user the opportunity to select only one of many predefined answers. Use 

this widget, if the list of answers is long. A dropdown list is a dropdown box with a predefined list of entries and the label of the 

box is the question that you want to ask. 

After you have dragged the Dropdown list form widget in your form, click the Edit button in the upper-right corner of the widget. 

The Dropdown list window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

1. In Label (Question) input field enter the label of the dropdown box. 

The label of a dropdown box is a question, which possible answers are given in a predefined dropdown list of entries. 

For example, Which country are you from? or Country. 

The label is displayed above, to the right, or to the left of the dropdown box, depending on what settings you have made 

for the form. For more information, see Designing a form » Step 4. 

2. In Choices input fields, enter the possible answers to the question you have defined. 

By default there are three input fields. In each input field, enter an answer (choice). If you need more or less choices, add 

and remove input fields by clicking  and  buttons of the respective field.  

You must have at least two choices. 

NOTE: Each input field has a radio button at the end. Use the radio button to select the choice which is displayed by 

default in the dropdown box. The user can then open the dropdown box and select another choice. 

3. If you want the choices you have defined to be sorted alphabetically, select the Sort choices alphabetically checkbox. 

4. If you click Advanced: Name for developers, you can change the name that is used to refer to the widget in the code.  

To change the automatically generated name, click Change button and enter the new name. 

 Appearance 

On this tab, perform the following: 

1. In Textbox size dropdown, select the size of the dropdown box. 

The box is always one line. The size of the box refers to its length. You choose the length of the dropdown box in 

accordance with the length of the choices you have entered. 
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2. In CSS class input field, you can choose a class name for the dropdown list, if later you want to set a CSS style for this 

particular widget. 

When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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SECTION HEADER 

Use this widget to display form or section headings. 

1. After you have dragged the Section header form widget in your form, click the Edit button in the upper-right corner of the 

widget. 

The Section header window appears, where you can perform the following: 

 On Label and texts tab, enter the text of the heading. 

 On Appearance tab, perform the following: 

a. In Title font size dropdown box, choose the font size of the heading. 

b. In CSS class input field, you can choose a class name for the section header, if later you want to set a CSS style for 

this particular widget. 

c. In Wrapping HTML tag input field, enter the HTML tag that will wrap the text. By default it is Heading 2 (H2). You 

can enter another. 

2. When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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INSTRUCTIONAL TEXT 

Use this widget to display instructions and explanatory text for the entire form or for a particular part of the form. 

1. After you have dragged the Instructional text form widget in your form, click the Edit button in the upper-right corner of the 

widget. 

The Instructional text window appears, where you can enter text using the text editor. 

For more information about the text editor, see The text editor. 

2. When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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FILE UPLOAD 

Use this widget to give the user the possibility to upload one or more file attachments to the form. 

After you have dragged the File upload form widget in your form, click the Edit button in the upper-right corner of the widget. 

The File upload window appears, displaying the following tabs: 

 Label and texts 

On this tab, perform the following: 

3. In Label input field enter the label of the upload box. 

For example, Attach a file. 

The label is displayed above, to the right, or to the left of the dropdown box, depending on what settings you have made 

for the form. For more information, see Designing a form » Step 4. 

4. In Instructional text, enter instructions or explanatory text for the textbox, if needed.  

The text is displayed bellow the textbox. 

5. Select the Make required checkbox, if you want to make the paragraph box mandatory. 

 Limitations 

1. In Min and Max input fields, enter in MB the range of the file size that you are going to accept as attachments. 
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2. Under Allowed file types, select one of the following: 

 All file types 

 Selected file types… 

A checkbox group appears where you can limit the types of files that you accept as attachments.  

You can also enter the file extension manually by selecting Other… 

3. Enter the error message that will appear, if the attached file does not meet the specified criteria. 

4. If you want the user to be able to attach more than one file, select Allow multiple file attachment checkbox. 

 Appearance 

On this tab, you can specify a CSS wrapper class that will determine the appearance of the widget. 

When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

STORAGE 

File attachments are stored in a dedicated library in User files. For each form there is a different library. The libraries are 

automatically created when the first file is uploaded and attached. 

To manage the files in a form library, click Administration » User files and select the library of the form. 

For more information, see Managing document and file libraries.  

PERMISSIONS 

If you want a user to be able to see the library with form attachments, you must grand explicit permissions to this user to work 

with the form’s library. It is not enough the user to have permissions to manage forms. 

NOTE: On User files page there is a library created by default – Downloadable goods. This library is used by the Ecommerce 

module and its content is restricted. Items of this library are only visible to users that have purchased them. 
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SUBMIT BUTTON 

Use this widget to display the button that the user uses to submit the form.  

You must have a Submit button widget in your form. The widget is automatically added by the system when you drop the first 

widget in the form. 

1. Click the Edit button in the upper-right corner of the widget. 

The Submit button window appears. 

2. In Label input field, enter the label of the button. 

By default the button is labeled Submit. 

3. In Button size dropdown box, choose the size of the button. 

4. In CSS class input field, you can choose a class name for the button, if later you want to set a CSS style for this particular 

widget. 

5. When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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VALIDATING THE USER INPUT 

You can add validation of the user input in textboxes and paragraph boxes. For example, you can make required that the user 

enters an email address in a certain textbox. 

To do this, perform the following: 

1. In the lower-right corner of the Textbox or the Paragraph box widgets, click Advanced button. 

2. Under ValidatorDefinition, click ValidatorDefinition button. 

3. In input field ExpectedFormat, enter one of the following: 
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Value Purpose 

None none by default 

AlphaNumeric Validates alphanumeric input 

Currency Validates currency 

EmailAddress Validates email addresses 

Integer Validates integers 

InternetUrl Validates internet URLs 

NonAlphaNumeric Validates non-alphanumeric input 

Numeric Validates numbers 

Percentage Validates percentages 

USSocialSecurityNumber Validates US social security numbers 

USZipCode Validates US zip codes 

Custom Validates against custom regular expression 

GetRelatedItem Gets the item (live, temp, or master) that is related with the specified item by lifecycle 

status. The method supports only items of type Content and ILifecycleDataItem 

SetUIStatus Sets the UI status of a content object depending on whether this object also implements 

ILifecycleDataItemGeneric 

GetUIStatus Gets the UI status of a content object depending on whether this object also implements 

ILifecycleDataItemGeneric 

GetLanguageVersion Gets the language version. 

GetLanguageVersionRaw Gets the language version for the specified culture. 

GetWrapperValue Gets the wrapper value. 

GetPropertyValue  Gets the property value. 

CopyPropertiesFrom Copies all the properties of the from object to this object, if they exist. 

CopyPropertiesTo  Copies all the properties of this object to the to object 

4. You can also use this section to enter a custom error massage. 

For example, if you are validating that the user entered an email address, you can also enter a custom error message in 

EmailAddressViolationMessage field. 

5. Click Save to return to the Simple editing mode of the widget. 
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EDITING A FORM 

There are two ways to edit a form. You can edit the properties of a form, such as title, categories and tags and you can edit the 

content of a form by adding layout elements and form widgets. 

EDITING THE PROPERTIES OF A FORM 

You can edit the properties of a form in the following way: 

1. On Forms page, click the Actions link of the respective form and in the dropdown list, click Properties. 

The Edit a form page appears. 
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2. In Title input field you can change the title of the form. 

The title of the form is used in the backend only and is not displayed on the website. 

3. In Name used in code you can change the automatically generated name that is used to refer to the form in the code. 

4. When you are finished, click Save changes. 

EDIT THE CONTENT OF A FORM 

You can edit the content of a form, such as layout elements and widgets. 

To do this, on Forms page, click the form or click the Actions link of the respective page and then click Content. 

The form opens in content editing mode. 

For more information, see Designing a form and Configuring form widgets. 

PUBLISHING AND DELETING A FORM 

 Publishing and unpublishing a form. 

After you have chosen whether to publish or save as draft a form when editing its content, you can change the status of the 

form. 

 To publish a form in status Draft or Unpublished, perform one of the following: 

 On Forms page, select one or more forms and in the toolbar click More actions » Publish. 

 On Forms page, click the Actions link of the form and then click Publish. 

 In content editing mode, click Publish. 

 To unpublish a published form, perform one of the following: 

 On Forms page, select one or more forms and in the toolbar click More actions » Unpublish. 

 On Forms page, click the Actions link of the form and then click Unpublish. 

 In content editing mode, click More actions » Unpublish. 

 Delete a form 

You can delete a form in the following ways: 

 On Forms page, select one or more forms and click Delete button in the toolbar. 

 On Forms page, click the Actions link of the respective form. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing forms | Using the content modules | Website content | Table of contents | 

MANAGING RESPONSES TO A FORM 

When you create and publish a form on the website, the users can fill it out and submit their answers. The responses you get to a 

form are visible in the backend and you can see them via the Forms page. 

1. To manage the responses to a form, on Forms page, click <number> responses link of the respective form. 

The Responses page appears: 
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The page displays all submitted responses in a grid. The columns of the grid are the labels of the parts of your form, such as 

labels of textboxes, questions with multiple choice answers, etc. Each response is a line in the grid, containing the number of 

the response, the date when it was submitted, and the answers to all parts of the form. 

 You can export all the data in a Comma-separated values (CSV) file by clicking Export as CSV button. 

 You can create responses to the form using the Create a Response button. 

In this case the artificially created response is numbered null in the list of all responses. 

 You can see a preview of the form with the responses to each question, if you select the line in the grid. 

The filled out form together with the exact time and date and the IP address appears on the right side of the page. 

 You can edit a response or its attachments, by clicking the Edit button in the response preview. 

 You can delete one or more submitted responses by selecting the responses in the grid and clicking Delete button in the 

toolbar of the page. 

 You can search for responses using the Search button in the toolbar of the page. 

2. To go back to Forms page, click Back to forms link above the toolbar of the page. 
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DUPLICATE AND SHARE FORMS  

You can duplicate an existing form and save it with a different name. This is useful when you want to have similar forms and do 

not want to create them from scratch.  

If you have a multisite license, you can share one form in more than one site. When you make changes to a shared form in any of 

the sites, the changes are applied everywhere the form is shared. 

When you duplicate or share a form, you have the option to set the confirmation message for each form individually, regardless of 

whether it is duplicated or shared. One and the same form can have different confirmations when used with different widgets. You 

set this using the Forms widget. 

DUPLICATE A FORM WITHIN THE SAME SITE 

When you duplicate a form, Sitefinity copies its layout, all the widgets and their configuration, the form’s permissions, and all the 

form’s settings. The only setting that is not duplicated is the list of email subscribers. For more information, see Setup email 

notification for form responses. Form responses are not duplicated. 

Perform the following: 

1. Click Content  Forms. 

2. Click the Actions link of the form that you want to duplicate and click Duplicate. 

3. In Title, enter a name for the form that is different from the original form. 

4. Click one of the following: 

 Create and go to add content 

The form opens in editing mode. It has the same content and layout as the original form. You can change the content, 

the layout, and the settings and save the form in a different status than the original form. 
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 Create and return to Forms 

The duplicated form that you have created has the same content and layout as the original one and is saved in status 

Draft, regardless of the status of the original form.  

SHARE A FORM BETWEEN SITES IN MULTISITE INSTANCE 

PREREQUISITES: You must have Multisite license. For more information, contact sales@sitefinity.com.  

If you want to use the same form on more than one site in a multisite Sitefinity instance, you can create the form on any of the 

sites and share it on the others. Any changes that you make to the form are visible on every site where the form is shared. 

To share a form, perform the following: 

1. Click Content  Forms. 

2. Click the Actions link of the form that you want to share and click Share with… 

A list of all site available in your multisite instance appears. 

3. Select the sites where you want the form to be visible and click Done. 

NOTE: If you deselect all the sites where a form is visible, you can still see the form on the Forms page by clicking Not shared with 

any site filter in the right pane of the page. 

SETUP EMAIL NOTIFICATION FOR FORM RESPONSES 

You can choose to notify the currently logged user(s) via email when a response to a form is submitted.  

To do this, perform the following: 

1. In the system settings, add a notifications profile. 

Perform the following: 

a. In the main menu, click Administration » Settings » Advanced. 

b. In the treeview on the left, click Notifications » Profiles » Create new » SmtpSenderProfileElement. 

c. Configure the following properties: 
 

DefaultSenderEmailAddress Enter the email address that will appear to the recipients. 

Host Enter the name or IP address of the host used for notifications. 

Port Enter the port used for notifications. 

UseAuthentication Select if you want to authenticate when you login to the server. 

Username and Password Enter the credentials of the account that you use to connect to the server 

Use SSL Select if you want Sitefinity to use Secure Sockets Layer (SSL) to encrypt the connection. 

ProfileName Enter a name for the profile. 

d. Click Save changes. 

2. Enable notification for forms. 

Perform the following: 

a. In the main menu, click Administration » Settings » Advanced. 

b. In the treeview on the left, click Forms » Notifications. 

c. Select Enabled checkbox.  

d. In SenderProfile, enter the profile name that you selected above. 

e. Click Save changes. 

3. You subscribe yourself (the currently logged user) for forms notification, in one of the following ways: 

 In the Forms grid 

a. In the main menu, click Content » Forms. 

mailto:sales@sitefinity.com
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b. Click the Actions link of the form, which responses you want to subscribe to. 

c. In the dropdown menu, click Subscribe. 

 In form’s editing mode 

a. In the main menu, click Content » Forms. 

b. Click the form, which you want to subscribe to. 

c. In the right of the toolbar, click Settings. 

d. Under Send email notification for responses to..., select My email address. 

e. Click Publish. 

4. You subscribe other users for form responses, in the following way: 

a. In the main menu, click Content » Forms. 

b. Click the form, which you want to subscribe users for. 

c. In the right of the toolbar, click Settings. 

d. Under Send email notification for responses to..., select List of email addresses... 

e. Enter the email addresses of the users that you want to subscribe. 

Enter each email address on a new line. 

f. Click Publish. 

The subscribed users will receive email notification whenever a response is submitted to a form. 

SEARCHING AND FILTERING FORMS 

SEARCHING FOR FORMS 

To search for a particular form, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the form you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING FORMS 

 Filter by ownership. 

To display forms, created only by your user, in the right side of the Forms page, click My Forms link under Filter forms. 

 Filter by workflow status. 

You can filter forms by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Special filtering 

You can filter forms that are not shared on any site and are, therefore, not visible in the grid. To do this, click Not shared with 

any site. 

CREATING AND EDITING FORUMS 

You manage forums using the Forums module. 

The module is organized in the following way: 

 Forums page 

To open the Forums page, in the main menu in the upper part of the screen, click Content » Forums. 

The Forums page appears, displaying an expandable list of all created forums, grouped in forum groups, with the number of 

threads and posts in each forum, together with actions you can perform on them. 

 Forum threads page 
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When you click a forum, you can view a list of all threads in this forum and the number of posts in each thread, together with 

actions you can perform on each thread. 

 Forum posts page 

When you click a thread, the Posts page opens, where you can view a list of all posts in this thread, together with actions you 

can perform on each post. 

Section contents 

With the forums module you can do the following: 

 Create a forum 

 Edit forums 

 Create a forum group 

 Edit forum groups 

 Create a thread 

 Edit threads 

 Create and edit posts 

 Forum attachments 

PERMISSIONS FOR FORUMS 

You can set permission for all forums and you can set individual permissions for each forum. 

To change the permissions for all forums, on Forums page, click Permissions link in the right side of the page. 

The Permissions for all forums page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

To change the permissions of a particular forum, click its Actions link and from the dropdown box, click Permissions. 

For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

DISPLAYING FORUMS ON YOUR WEBSITE 

To display forums on your website, you must use the Forums widget and you must configure it. 

For more information, see Forums widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way forums, threads, and posts are displayed by changing the templates which the Forums widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

| Using the content modules | Website content | Table of contents | 

CREATING A FORUM 

1. If you have multiple sites, on Forums page select the site where you want to create forums, using the selector in the upper-

left corner of the page.  

If your site uses more than one source for forums, you must choose the source where you want to create the forum. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Perform one of the following: 

 If you have not created any forums, the system displays the following in the center of the screen: 
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 If you have already created one or more forums, the system displays a list of all created forums, grouped in forum 

groups, and the following button in the toolbar of Forums page: 

 

3. Click Create a forum. 

The Create a forum page appears. 

4. In the Title input field, describe the forum. 

5. In Forum group dropdown box, select which group the forum will belong to.  

If the forum is not a specialized one, you can select General discussions forum group, which exists by default. 

If you want to add the forum to a group that does not exist, you can create it by clicking Create a new forum group link. For 

more information, see Creating a forum group. 

6. Under Default page, you select the page, in which the forum opens by default. 

Click Select a page button, select a page from the sitemap, and click Done. 

This page is also used when an RSS link to this forum is clicked. 

7. To change the automatically generated URL of the forum, click Change and enter the new URL. 

8. To enter a description of the forum, click Click to add description. 

9. To manage the files that can be attached in the forum posts, expand File attachments. 

You can change the following: 

 Select if you want to Allow users to upload file attachments in posts. 

 Choose whether Everyone or Authenticated users only can view the attachments. 

 In the dropdown box, select the Sitefinity library where you want to store the uploaded attachments. 

 Choose what types of files you want to be allowed as attachments, by selecting one of the following: 

 Default types 

These are the types that you have defined in Sitefinity Installation and Administration Guide » Settings » Content 

settings » Configure forum attachment extensions. 

 Define manually… 

Enter additional file extensions that you want to allow, separated by commas. 

10. You can choose if you want an RSS feed to be generated for this forum by clicking Alternative publishing (RSS) and selecting 

RSS feed checkbox. 

Feeds are used to publish frequently updated information, such as blogs, news, forum posts, etc. You can publish an RSS or 

Atom feed for the forum on the website and the users can subscribe to this feed. This way, they will receive updates of the 

forum without having to visit the website. 

You can change the settings of the automatically generated RSS feed. 

Click Change button and perform the following procedure: 

a. In RSS or Atom to generate? radio button group, select the format for the feed. 

b. In URL name, enter a URL of the feed. 

c. Choose how many items to include in the feed by selecting one of the following radio buttons: 

 Include the newest <number> items 

In the input field, enter how many of the published items you want to display. 

 Include all published items 

The feed displays all items that are published. 

d. Choose how to display the items in the feeds by selecting one of the following: 

 Title and content. 

 Title and first <number> characters. 

 Title only. 

e. To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To these fields, you can map 

fields of the RSS or Atom feed.  
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When you are finished with the mapping of fields, click Accept changes. 

f. Click Done. 

For more information, see Feeds. 

You can display the RSS feed for the forum using the Feed widget.  

For more information, see Feed widget. 

11. When you are finished creating the forum, click Create this forum. 

The forum is created and the system displays the Forums page. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

EDITING FORUMS 

EDITING THE PROPERTIES OF A FORUM 

1. Open a forum for editing by clicking its Actions link and then clicking Title & Properties. 

The Edit a forum page appears. 

2. Perform procedure Creating a forum » Step 3 to Step 9. 

3. When you are finished, click Save. 

DELETING FORUMS 

You can delete a forum in the following ways: 

 On Forums page, select one or more forums and click Delete button in the toolbar. 

 On Forums page, click the Actions link of the respective forum. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

CREATING A FORUM GROUP 

Forum groups are used to gather similar forums in groups. For example, you can have a Support forum group, which contains 

several forums, discussing support issues. 

1. To create a forum group, on Forums page click Create a forum group button in the toolbar of the page. 

2. Enter the title of the group. 

For example, General discussions or Support. 

3. If you want to add a description of this group, click Click to add description. 

4. Click Create this forum group. 

The group is created and the system returns you to Forums page. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

EDITING FORUM GROUPS 

EDITING THE PROPERTIES OF A FORUM GROUP 

1. Open a forum group for editing by clicking its Actions link and then clicking Title & Properties. 

The Edit a forum group page appears. 

2. Edit the Title and the Description of the group as needed. 

3. When you are finished, click Save. 

DELETING FORUMS GROUPS 

You can delete a forum group in the following ways: 

 On Forums page, select one or more forum groups and click Delete button in the toolbar. 

 On Forums page, click the Actions link of the respective forum group. 

From the dropdown list, click Delete. 



 

68 

A dialog box appears where you must confirm the deletion. 

NOTE: You cannot delete forum groups which contain forums. To do this you must move or delete the forums in the. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

CREATING A THREAD 

1. To create a forum thread, click the forum where you want to create a forum thread. 

 If you have not created any threads, the system displays the following in the center of the screen: 

 

 If you have already created one or more threads, the system displays a list of all created threads and the following button 

in the toolbar of the page: 

 

2. Click Create a thread. 

The Create a thread page appears. 

3. Enter the title of the post in the thread. 

4. In the text editor, enter the post itself. 

For more information, see The text editor. 

5. By clicking More options, you can change the following: 

 The priority of the thread. 

In the dropdown box, choose whether you want to Stick this thread to the top of a list of all displayed forum threads. 

This way the thread will always appear on the top of the list of thread, regardless of how many newer threads are 

created. 

 Disable further post in the thread 

You can disable posting in this thread. To do this, select Close this thread to disable posting.  

You can use this option, for example, to avoid unwanted comments. 

 The automatically generated URL of the thread.  

To change it, click Change and enter a new URL name. 

6. You can choose if you want an RSS feed to be generated for this forum thread by clicking Alternative publishing (RSS) and 

selecting RSS feed checkbox. 

Feeds are used to publish frequently updated information, such as blogs, news, forum posts, etc. You can publish an RSS or 

Atom feed for the forum thread on the website and the users can subscribe to this feed. This way, they will receive updates of 

the thread without having to visit the website. 

You can change the settings of the automatically generated RSS feed. 

Click Change button and perform the following procedure: 

a. In RSS or Atom to generate? radio button group, select the format for the feed. 

b. In URL name, enter a URL of the feed. 

c. Choose how many items to include in the feed by selecting one of the following radio buttons: 

 Include the newest <number> items 

In the input field, enter how many of the published items you want to display. 

 Include all published items 

The feed displays all items that are published. 

d. Choose how to display the items in the feeds by selecting one of the following: 

 Title and content. 

 Title and first <number> characters. 

 Title only. 
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e. To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To these fields, you can map 

fields of the RSS or Atom feed.  

When you are finished with the mapping of fields, click Accept changes. 

f. Click Done. 

For more information, see Feeds. 

You can display the RSS feed for the thread using the Feed widget.  

For more information, see Feed widget. 

7. When you are finished, click Create this thread. 

The thread with its first post is created and appears in the list of all threads. 
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EDITING THREADS 

EDITING THE PROPERTIES OF A FORUM THREAD 

1. Open a forum thread for editing by clicking its Actions link and then clicking Title & Properties. 

The Edit a thread page appears. 

2. Perform procedure Creating a thread » Step 3, Step 5, and Step 6. 

3. When you are finished, click Save. 

DELETING THREADS 

You can delete a thread in the following ways: 

 Select one or more threads and click Delete button in the toolbar. 

 Click the Actions link of the respective thread. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 
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CREATING AND EDITING POSTS 

CREATING A POST 

1. To create a post, click the thread where you want to post. 

The Posts page opens, displaying all the posts in the thread. 

2. Click Post a replay button in the toolbar. 

3. Use the text editor to create your post. 

4. When finished, click Publish. 

EDITING POSTS 

You can perform the following actions with posts: 

 Editing 

To edit the content of a post, click its Edit link and use the text editor to change what is required. 

 Publish or unpublish a post. 

A forum post can be in status Published or Unpublished. Depending on its current status, for each post, the system displays a 

Publish or Unpublish links. 

 Mark as featured. 

To mark a particular post as featured, click its More action link and then click Mark as featured. 

 Mark as spam 

If a post is spam, you can mark it as such, which will automatically unpublish it.  

To do this, click its More action link and then click Mark as spam. 

 Delete 
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To delete a post, click its Delete link and confirm the deletion. 

POST COUNTERS 

On Posts page, for each post the system displays the user that posted it and a counter for the total number of posts of this user. If 

a certain post is deleted the counter is not updated, because the purpose of the counter is to show the activity of the user, 

regardless of whether the posts exist or has been deleted. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

FORUM ATTACHMENTS 

Forum attachments are files attached to a particular forum post. You can allow or restrict the users from attaching files to forum 

threads and posts. For more information, see Creating a forum. 

Forum attachments are stored in a dedicated library in User files. For each forum there is a different library. The libraries are 

automatically created when the first file is uploaded and attached. 

To manage the files in a forum library, click Administration » User files and select the library of the forum. 

For more information, see Managing document and file libraries. 

NOTE: On User files page there is a library created by default – Downloadable goods. This library is used by the Ecommerce 

module and its content is restricted. Items of this library are only visible to users that have purchased them. 

| Creating and editing forums | Using the content modules | Website content | Table of contents | 

UPLOADING AND EDITING IMAGES 

You manage images on the Images  page. 

To open the Images page, in the main menu in the upper part of the screen, click Content » Images. 

The Images page appears, displaying a list of all created libraries together with actions you can perform on them. 

Use this page to manage image libraries and upload and edit images. 

Section contents 

On this page you can do the following: 

 Upload images 

 Edit images 

 Display, sort, filter, and find images 

 Manage image libraries 

 Display and order the images in an image library 

PERMISSIONS FOR IMAGES AND IMAGE LIBRARIES 

You can set permission for all images and image libraries and you can set individual permissions for each image or library. 

To change the permissions for all images, on Images page, click Permissions link in the right side of the page. 

The Permissions for all images page appears. 

To change permissions for all libraries, in the main menu, click Administration » Permissions » by Section » Libraries. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions »Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions for images and image libraries, see Sitefinity Installation and 

Administration Guide » Users, roles, and permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR IMAGES 

You can add a custom field to all images. A custom field is a field that you create. For each image there are default fields, such as 

author, title, etc. If you need to add different than the already existing fields, you must create a custom field.  

To manage the custom fields of images, on Images page, click Custom Fields link in the right pane of the page. 

For more information, see Custom fields. 

You then display a custom field on your website by adding it to a template for displaying images. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates.  
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DISPLAYING IMAGES ON YOUR WEBSITE 

To display the images you have uploaded on your website, you must use the Image widget or the Image gallery widget and 

configure them to display images. 

For more information, see Image widget or Image gallery widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way images are displayed by changing the template, which the Image or Image gallery widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

LINKING OR EMBEDDING AN IMAGE 

On Images page click Embed this image link of the respective image. 

 To link an image, copy the content of the Link input field. 

For example you can copy the link and paste it in an e-mail. 

 To embed an image in HTML, copy the content of the Embed field and paste it in HTML code. 

For example you can embed an image in the text, using the text editor in HTML mode.  

| Using the content modules | Website content | Table of contents | 

UPLOADING IMAGES 

1. If you have multiple sites, on Images page select the site where you want to upload images, using the selector in the upper-

left corner of the page.  

If your site uses more than one source for images, you must choose the source where you want to upload the image. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Click the library where you want to upload images. 

3. Perform one of the following: 

 If you have not uploaded any images in the selected library, the system displays the following in the center of the screen: 

   

NOTE: If you are working in multilingual mode, the first image you upload is in the default language. 

 If you have already uploaded one or more images in the selected library, the system displays all uploaded images and the 

following button in the toolbar of Images page: 

  

NOTE: If you are working in multilingual mode, before uploading an image, you must first choose the language, in which 

you want to upload the image. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages. 

4. Click Upload images. 

The Upload Images  page appears. 

5. Drag the images, you want to upload or click Select images from your computer and browse your computer to find the image 

you want to upload and click Open. 

You can select more than one image. 

The file name of the image and its size appear in Upload images page.  

6. To upload more images, click Add more images . 

7. In Where to store the uploaded images?, select the library where you want to store the image(s), by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

If you have not created any libraries, you can only choose Default Library, which exists by default. 
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If you want to create another library, perform the following: 

a. Click Create a new library. 

b. Enter the name of the library and click Create this library. 

The new library appears in the dropdown box. 

For more information about creating libraries, see Managing image libraries. 

8. You can classify your image using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

9. When you are finished, perform procedure Setting the status of a new page or content item. 

Uploading status bars appear on the page and after the system has uploaded the images, a massage appears informing you 

about the result of the upload. 

10. When upload is finished, choose between the following: 

 View all images 

Returns you to Images page. 

 Upload more images 

The system opens Upload Images page, where you can upload new images. 

Perform Step 3 to Step 8. 

NOTE: If you are in multilingual mode, on Images page, the system displays all available languages next to the image. You cannot 

have different images in different languages, but you can have different titles for each language. To do this, click the Add link of 

the respective icon. 

NOTE: On Images page you can also download an already uploaded image, by clicking the Actions link of the image and then 

Download. 

EDITING IMAGES 

EDITING PROPERTIES AND ADDING DETAILS TO AN IMAGE 

1. To edit and add details to an already uploaded image, on Images page perform one of the following: 

 Click the image you want to edit. 

 Click the Actions link of the respective image and then click Edit Properties. 

The Edit image  page appears. 

NOTE: In the right of the page you can see the current status of the image that you have opened for editing. You can also 

see the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Change the title of the image, by entering the new title in Title input field. 

3. View the image in its original size as it would appear in a browser by clicking View in original size button below the preview of 

the image. 

4. Replace the image by clicking Replace Image button below the image preview. 

The Select image link appears. Click the link, browse your computer to find the new image, and click Open. 

The system replaces the image, but not its title and other properties. 

5. To edit the image, click Crop/Resize/Rotate… 

The Edit image window opens.  

a. Use the button to crop, resize or rotate by 90 degrees the image. 

b. When finished editing the image you can save the changes by clicking Save or save the edited image as a new image by 

clicking Save as and entering a new name. 

6. Change the library which the image belongs to, by clicking Change button and selecting the new library from the dropdown 

box that appears. 

7. Add alternative text to the image, under Alternative text, click Click to add alternative text and enter the text in the input field 

that appears. 

The text that you enter in Alternative text is used for accessibility reasons and by search engines. 

8. Change the categories and the tags which the image is assigned to, by clicking Categories and tags. 
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For more information, see Adding categories and tags to a content item. 

9. To add details to the image, click Details. 

The following input fields appear: 

 Author 

Enter an author of the image.  

 Description 

The description you enter in this input field appears as a tooltip for the image in browsers that support ToolTips feature. 

When the image is opened, the description appears under the image. 

10. By clicking Advanced, you can change the following: 

 The automatically generated URL of the image.  

To change it, click Change and enter a new URL name. 

 Configure additional URLs for the image. 

a. Select Allow multiple URLs for this item... checkbox 

b. Enter the URLs one per line, using the following convention /images/<URL name> 

c. If you want all the URLs that you have entered to point to the default URL of the image, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the image without redirecting. 

11. If you have added any custom fields for images, all created fields, appear after the Advanced section. 

IMPORTANT: Some of the above fields may not be displayed when you edit the properties of an image, because they have 

been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields.  

NOTE: In the right you can see the following information about the image: 

 Its status, when the status was last changed and the user that changed the status. 

 The dimensions of the image and its size in bytes. 

 Links, which you can use to link or embed the image. 

12. In the right side of the page, you can see the dimensions of the image and customize them. 

To do this click Customize embedded image link and select the new size of the image. 

13. Before you finish editing the image, you can preview it by clicking the Preview button in the toolbar.  

The image opens in its default page. If there is no default page, it means the image is not displayed anywhere on the site and 

you cannot preview it. 

To see which the default page for the image is, expand Pages in the right side. The page on the top of the list is the default 

page. For more information about viewing and setting default pages, see Default pages for content items. 

14. When you are finished, perform one of the following: 

 If you have opened for editing an image in status Draft, Unpublished, or Rejected, perform procedure Managing a page or 

content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving an image in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing an image in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing an image in status Published or Scheduled, perform procedures Managing a page or 

content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published image, the system saves a draft of that image, but the published version is still visible on 

the webpage. To see which version is the currently published one, see Revision History.  

EDIT MANY IMAGES AT THE SAME TIME 

You can edit the properties of many images at the same time. To do this, perform the following: 

1. On Images page, select the images you want to edit and click More actions » Bulk edit titles, categories, tags. 

The Bulk edit page appears displaying all the selected images. 
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2. You can apply the following to all selected images: 

 Common image library 

Click Change library and select the library from the dropdown box that appears. 

All images are moved to that library. 

 Common categories 

Click Click to add common categories link. 

For more information, see Adding categories. 

 Common tags 

For more information, see Adding tags. 

3. For each of the selected images, you can change the following: 

 Title 

 Alternative text 

The text that you enter in Alternative text is used for accessibility reasons and by search engines. 

 Description 

The description you enter in the input field appears as a tooltip for the image in browsers that support ToolTips feature. 

4. When finished, click Save changes. 

The system returns you to Images page. 

MOVING AND DELETING AN IMAGE 

 To move one or more images to another library, on Images page, select the images and in the toolbar click More actions » 

Move to another image library. 

A window appears where you select the library where you want to move the images and click Move. 

 To delete images, perform one of the following: 

 On Images page, select one or more images you want to delete and click Delete button in the toolbar. 

 On Images page, click the Actions link of the image you want to delete and then click Delete. 

 On Edit image page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 

| Uploading and editing images | Using the content modules | Website content | Table of contents | 

DISPLAYING, SORTING, FILTERING, AND FINDING IMAGES 

The Images page displays all created image libraries. To view images in a library, click it. 

CHANGING THE DISPLAY MODE OF IMAGES 

To change the view of the images and the corresponding information, in the toolbar of Images page, click one of the following: 

 Click  (Thumbnails view) to view images and information in boxes. 

 Click  (List view) to view images and the information in a grid. 

DISPLAY IMAGES BY LIBRARIES 

To displaying images only from a specific library, click the library thumbnail in the right side of Images page. 

NOTE: If you use  button to view images, for each image, the system displays a link to the library in the grid. If you click the 

link to the library, the system displays all images from this library. 

For more information, see Managing image libraries. 

FILTER IMAGES 

To display the filtering options, click Filter images. 

 Filter by ownership. 

To display images, uploaded only by your user, in the right side of the Images page click My images link under Filter images. 

 Filter by workflow status. 
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You can filter images by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter images by categories, tags, and custom classifications. 

If you have added a custom classification field to images, it appears in the filter options. For more information, see Custom 

fields. 

 Filter by date. 

To filter images by the date they were modified, click by Date … 

The Display images modified in… pane appears. 

 When you click a time interval, the system displays all the images modified during this time interval. The last modified are 

the first in the list. You can further sort them. 

 To display images modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 

SORT IMAGES 

You can sort images using the Sort images dropdown box in the toolbar of Images page. 

There are the following sorting options: 

 Last uploaded on top 

Sorts images in descending order according to the time of upload. 

 Last modified on top 

Sorts images in descending order according to time of modification. 

 Custom Sorting… 

A window appears where you perform the following: 

1. Select sorting criterion from the dropdown box and choose between Ascending and Descending order in the radio button. 

2. You can also and add more than one criterion by clicking Add another sorting rule link and you can remove sorting criteria 

by clicking Remove link. 

3. When you are finished, click Save. 

The system sorts the images according to the custom sorting. 

4. To edit a custom sorting that you have created, select Edit custom sorting… from the Sort images dropdown box. 

SEARCHING FOR IMAGES 

To search for a particular image, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the image you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all images, click Close search button in the toolbar. 

| Uploading and editing images | Using the content modules | Website content | Table of contents | 

MANAGING IMAGE LIBRARIES 

You display and manage all created libraries on Images page. 

The Images page displays the number of images in each library, the date of the last uploaded image, and where those images are 

stored. 

CREATING AN IMAGE LIBRARY 
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1. On Images page, in the toolbar, click Create a library button. 

The Create a library  page appears. 

2. Enter the name of the library. 

3. To add a description of the library, click Click to add a description. 

NOTE: The information you provide here is not public, it is for your reference only. 

4. You can define the maximum size of the library in MB and of each image in the library in KB by clicking Advanced. 

The Max album size and the Max image size input fields appear. There you enter the limit of the size in MB and KB 

respectively. 

5. Under URL name, you can change the URL of the library. 

The automatically generated URL of the library appears.  

To change it, click Change and enter a new URL name. 

6. Under Parent library, choose where to create the library: 

Select one of the following: 

 No parent 

This will be a top level library that has no parent. 

 Select parent library… 

A treeview with existing libraries appears. 

Select the library that will be parent of the library you are creating. 

NOTE: If the library you are creating is located in another library, it has the same settings as its parent. You can only set 

cache options, storage providers, and resizing options for a root library, located at top level. 

7. If in Step 6, you have chosen your library to be a top level library that has no parent, under Root library settings, you can 

configure the following: 

 You can choose whether you want to resize the images in the library when they are uploaded. 

To do this, select Resize images so their width won’t be larger than… radio button and select the maximum width in the 

dropdown box. 

 You can choose whether you want to generate one or more thumbnail sizes for each image in the library. 

To do this, select Generate thumbnails with selected sizes… radio button, click Select button and select one or more 

thumbnail sizes.  

For more information, see Thumbnails. 

This way, for each image the system generated different thumbnail sizes. You can later change these settings. 

 You can set the maximum size of the library in MB and of each image in the library in KB. 

 You can chose where to store the images uploaded in this library. 

For example, you can store them on the database, in the file system, or in an external storage. 

In Storage provider dropdown box, select where to store the images. 

The list that appears contains all available storage providers. 

For more information, see Storage providers for libraries. 

 You can configure the server and browser caching. 

Configuring caching can increases your performance.  

Expand Advanced and in Server caching and Browser caching dropdown boxes, select one of the following: 

 As set for the whole site. 

The caching type that is applied to the whole website is applied to this page also. 

 No caching 

 Standard caching 

 Long caching 

For more information about applying caching to the entire site or changing the parameters of short and long caching, see 

Sitefinity Installation and Administration Guide » Settings » Configuring caching.  

8. When you are finished, click one of the following: 

 Create and go to upload images 

The system creates the library and takes you to upload images. 
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Perform procedure Uploading images » Step 3 to Step 9. 

 Create and go back to all images 

The system creates the library and returns you to Images page or Image Libraries page, depending on where you have 

started creating the library. 

 The Back to link 

The system does not save the library you were working on and returns you to Images page or Image Libraries page, 

depending on where you have started creating the library. 

CHOOSING THE UPLOAD MODE OF THE LIBRARY 

You can change the method by which items are uploaded into libraries. Sitefinity supports HTML5 and Silverlight upload. 

For more information, see Sitefinity Installation and Administration Guide » Settings » Libraries upload mode. 

EDITING IMAGE LIBRARIES 

1. On Images page click the Actions link of the library you want to edit. 

2. From the dropdown box, click Edit Properties. 

The Edit an image library page appears. 

3. Perform Step 2 to Step 7 of the above procedure. 

NOTE: If you are changing the URL of the library, Sitefinity changes the URLs of the items one by one. In case of external 

storage, changing the library URL may cause data transfer from one storage to another. In case of failure, some of the items 

might keep their previous URLs and some of the items will have the updated URLs. You can try to resume to get the rest of 

the items relocated. 

4. Click Save changes. 

The system returns you to Images page. 

CHANGING THE PARENT LIBRARY OF AN IMAGE LIBRARY 

Once created, a library can be moved together with all of its content to another library, by changing its parent library. 

To do this, perform the following: 

1. Click the Actions link of the library that you want to move and from the dropdown, select Move to… 

The Change parent library dialog appears. 

2. Select the new parent library and click Move. 

MOVING IMAGES TO ANOTHER STORAGE 

You can change the blob storage provider of a library, which moves all items in a different storage. For example, an image library 

kept in the database can be moved to the cloud, or a library from one cloud account can be moved to another. 

To do this, perform the following: 

1. Click the Actions link of the library whose items you want to move and from the dropdown, select Move to another storage. 

In the Blob storage provider dropdown box all available storage providers appear. 

2. Select where you want to move the items from the library and click Move to another storage. 

Sitefinity processes the library items one by one and displays a progress indicator in the grid. You can stop and resume the 

operation. 

NOTE: In case of failure before the operation is completed, some of the library items may remain in the target storage, while the 

rest will stay in the source storage. You can try to resume the operation. 

IMPORTANT: During the process of moving to another storage, you are not able to edit or delete the library items. 

For more information, see Storage providers for libraries. 

DELETING IMAGE LIBRARIES 

To delete a library, perform one of the following: 

 On Images page, select one or more libraries you want to delete and click Delete button in the toolbar. 

 On Images page, click the Actions link of the library you want to delete and then click Delete. 

 On Edit an image library page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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| Uploading and editing images | Using the content modules | Website content | Table of contents | 

DISPLAYING AND ORDERING THE IMAGES IN AN IMAGE LIBRARY 

DISPLAYING AND EDITING THE IMAGES OF A SINGLE LIBRARY 

1. To display all images and sub-libraries in a library, on Images page, click the library whose images you want to display. 

All images in the library appear. 

2. To edit the images in the library, perform procedure Editing images. 

3. To go back to all libraries click All libraries link above the toolbar or in the main menu, click Content » Images. 

ORDERING IMAGES IN A LIBRARY 

1. To order the images in a library, on Images page, click the library which images you want to reorder. 

All images in the library appear. 

2. Click Reorder images button in the toolbar of the page. 

The Reorder images in <library name> library page appears. 

3. You reorder images by dragging and dropping the image thumbnails in the desired order. 

4. When you are finished, click Save changes. 

| Uploading and editing images | Using the content modules | Website content | Table of contents | 

CREATING AND EDITING LISTS 

You manage lists and their lists items on the Lists  page. 

You can use lists for various purposes. For example, you can create a list for your FAQ section, where each question is one list item 

and the content of the list item is the answer to the question. 

To open the Lists page, in the main menu in the upper part of the screen, click Content » Lists. 

The Lists page appears, displaying all created lists with the number of list items in each list together with actions you can perform 

on them. 

When you open a list you can view all items in this list. 

To open the page with the list items, perform one of the following: 

 On Lists page, click the list which items you want to view. 

 On Lists page, click Edit list link of the respective list. 

A page , displaying all items in the selected list, appears. 

To navigate back to Lists page, click All lists link in the upper-left part of the page. 

Section contents 

On this page you can do the following: 

 Create a list 

 Edit lists 

 Search and filter lists 

 Create a list item 

 Edit list items 

 Order, search, and filter list items 

PERMISSIONS FOR LISTS AND LIST ITEMS 

You can set permission for all lists and list items and you can set individual permissions for each list or each item of a list. 

To change the permissions for all lists, on Lists page, click Permissions link in the right side of the page. 

The Permissions page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 
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For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR LISTS 

You can add a custom field to lists items. A custom field is a field that you create. For each list item there are default fields, such 

as description, title, etc. If you need to add different than the already existing fields, you must create a custom field.  

To manage the custom fields of list items, on the list items page, click Custom fields for list items link in the right pane of the page. 

For more information, see Custom fields. 

You then display a custom field for a list on your website by adding it to a template for displaying lists. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

DISPLAYING LISTS ON YOUR WEBSITE 

To display lists on your website, you must use the List widget and you must configure it. 

For more information, see List widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way lists are displayed by changing the template which the List widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

| Using the content modules | Website content | Table of contents | 

CREATING A LIST 

1. If you have multiple sites, on Lists page select the site where you want to create lists, using the selector in the upper-left 

corner of the page.  

If your site uses more than one source for lists, you must choose the source where you want to create the list. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Perform one of the following: 

 If you have not created any lists, the system displays the following in the center of the screen: 

 

 If you have already created one or more lists, the system displays all created lists and the following button in the toolbar 

of Lists page: 

 

3. Click Create a list. 

The Create a list  page appears. 

4. In Title, enter the title for the list. 

5. To change the automatically generated URL, click Change and enter the new URL of the list. 

6. Click Create this list. 

The system creates the list and takes you to create items in this list. 

 If you want to create a list item now, click Create a list item. 

For more information about how to create list items, see Creating a list item. 

 If you want to go back to Lists page, without creating a list item, click All lists link at the upper-left part of the page. 

| Creating and editing lists | Using the content modules | Website content | Table of contents | 

EDITING LISTS 

CHANGING THE TITLE OF A LIST 
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1. On Lists page click the Actions link of the respective list. 

2. From the dropdown list click Title & Properties. 

The Edit list page appears. 

3. Perform procedure Creating a list » Step 3 and Step 4. 

4. When you are finished, click Save changes. 

DELETING LISTS 

You can delete a list in the following ways: 

 On Lists page, select one or more lists and click Delete button in the toolbar. 

 On Lists page, click the Actions link of the respective list. 

From the dropdown list, click Delete. 

 On Edit list page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing lists | Using the content modules | Website content | Table of contents | 

SEARCHING AND FILTERING LISTS 

SEARCHING FOR LISTS 

To search for a particular list, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the list you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING LISTS 

To display lists, created only by your user, in the right side of the Lists page, click My lists link under Filter lists. 
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CREATING A LIST ITEM 

1. On Lists page perform one of the following: 

 Click Add new list item link under the name of the list. 

 Click the list. 

The list items page appears, displaying one of the following: 

 If you have not created any list items, the system displays the following in the center of the screen: 

 

NOTE: If you are working in multilingual mode, the first lists item you create is in the default language. 

 If you have already created one or more list items, the system displays all created list items and the following button 

in the toolbar of the page: 

  

NOTE: If you are working in multilingual mode, before creating a list item, you must first choose the language in 

which you want to create the item. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  
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2. Click Create a list item or Create new list item respectively. 

The Create a list item  page appears. 

3. In the Title input field, enter the title of the list. 

4. In the text editor enter the content of the item itself. 

For more information, see The text editor. 

5. If you have added any custom fields for the list items, all created fields are displayed after the text editor. 

6. Before you finish creating a list item, you can preview it by clicking the Preview button in the toolbar.  

The list item opens in its default page. If there is no default page, it means the list item is not displayed anywhere on the site 

and you cannot preview it. 

To see which the default page for the list item is, expand Pages in the right side. The page on the top of the list is the default 

page. For more information about viewing and setting default pages, see Default pages for content items. 

7. When you are finished creating the list item, you must set its status, using the buttons on top and at the bottom of the item. 

For more information, see Setting the status of a new page or content item.  

NOTE: While creating you list item, you can use the Preview button to see a preview of the list item and its properties.  
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EDITING LIST ITEMS 

EDITING, APPROVING, AND PUBLISHING THE CONTENT OF A LIST ITEM 

1. Go to the list items’ page and open a list item for editing in one of the following ways: 

 Click the list item you want to edit. 

 Click the Actions link of the respective list item. 

From the dropdown list, click Edit. 

The Edit list item page appears. 

NOTE: In the right of the page you can see the current status of the list item that you have opened for editing. You can also 

see the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Perform procedure Creating a list item » Step 3 and Step 5. 

3. When you are finished, perform one of the following: 

 If you have opened for editing a list item in status Draft, Unpublished, or Rejected, perform procedure Managing a page 

or content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a list item in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing a list item in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing a list item in status Published or Scheduled, perform procedures Managing a page or 

content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published list item, the system saves a draft of that list item, but the published version is still visible 

on the webpage. To see which version is the currently published one, see Revision History. 

DELETING LIST ITEMS 

You can delete items in the following ways: 

 On list items page, select one or more list items and click Delete button in the toolbar. 

 On list items page, click the Actions link of the respective list item. 

From the dropdown list, click Delete. 

 On Edit list item page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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ORDERING, SEARCHING, AND FILTERING LIST ITEMS 

ORDERING LIST ITEMS 

To order list items in a list, click Order button in the toolbar. You can choose between the following ordering options: 

 Manually 

Use drag and drop to order the list. 

 Alphabetically ascending or descending. 

 Last modified on top or on bottom. 

SEARCHING FOR LIST ITEMS 

To search for a particular list item, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the list item you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING LIST ITEMS 

 Filter by ownership. 

To display list items, created only by your user, in the right side of the page, click My list items link under Filter. 

 Filter by workflow status. 

You can filter list items by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter items by categories, tags, and custom classifications. 

If you have added a custom classification field to list items, it appears in the filter options. For more information, see Custom 

fields. 

CREATING AND EDITING NEWS 

You manage news on the News  page. 

To open the News page, in the main menu in the upper part of the screen, click Content » News. 

The News page appears, displaying a list with all created news together with actions you can perform on them. 

Use this page to create, edit, and manage news.  

Section contents 

On this page you can do the following: 

 Create news 

 Edit news 

 Search and filter news 

COMMENTS FOR NEWS 

On News page, you can view all the comments for news by clicking Comments for news link on the right side of the page. 

All comments that have been submitted for all the news appear. 

For more information about comments, see Comments and ratings. 

PERMISSIONS FOR NEWS 

You can set permission for all news and you can set individual permissions for each news. 

To change the permissions for all news, on News page, click Permissions link in the right side of the page. 

The Permissions page appears. 
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For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR NEWS 

You can add a custom field to all news items. A custom field is a field that you create. For each news item there are default fields, 

such as author, title, etc. If you need to add different than the already existing fields, you must create a custom field.  

To manage the custom fields of news, on News page, click Custom Fields for news link in the right pane of the page. 

For more information, see Custom fields. 

You then display a custom field on your website by adding it to a template for displaying news items. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

DISPLAYING NEWS ON YOUR WEBSITE 

To display the news you have created on your website, you must use the News widget and configure it. 

For more information, see News widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way news items are displayed by changing the template which the News widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 
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CREATING A NEWS ITEM 

1. If you have multiple sites, on News page select the site where you want to create news, using the selector in the upper-left 

corner of the page.  

If your site uses more than one source for news, you must choose the source where you want to create the news. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management.  

2. Perform one of the following: 

 If you have not created any news, the system displays the following in the center of the screen: 

 

NOTE: If you are working in multilingual mode, the first news item you create is in the default language. 

 If you have already created one or more news, the system displays a list all created news and the following button in the 

toolbar of News page: 

 

NOTE: If you are working in multilingual mode, before creating a news item, you must first choose the language in which 

you want to create the news item. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

3. Click Create a news item.  

The Create a news item  page appears. 

4. In the Title input field, enter the name of the news. 

5. In the text editor enter the news itself. 

For more information, see The text editor. 

6. In Summary input field, you can enter a summery for the news. 

To do this, click Click to add Summary. 
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7. You can classify your news using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

8. To provide additional information about the author and the source of the news, click Additional info. 

In the input fields that appear, enter the author and/or the source. 

9. By clicking More options, you can change the following: 

 The automatically generated URL of the news.  

To change it, click Change and enter a new URL name. 

 Allow or forbid comments. 

To allow or forbid users to leave comments about the news, select or deselect the Allow comments checkbox. 

 Configure multiple URLs for the news item 

a. To configure a news item to have more than one URL, select Allow multiple URLs for this item... checkbox. 

b. In the input box, enter the additional URLs that you want this news items to have. 

Enter one URL per line. 

c. If you want all the URLs that you have entered to point to the default URL of the news, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the news item without redirecting. 

10. If you have added any custom fields for news items, all created fields appear after the More actions section. 

Using custom fields, you can, for example, add a custom field Breaking news to the news. 

IMPORTANT: Some of the above fields may not be displayed when you create a news item, because they have been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

11. Before you finish creating a news item, you can preview it by clicking the Preview button in the toolbar.  

The news item opens in its default page. If there is no default page, it means the news item is not displayed anywhere on the 

site and you cannot preview it. 

To see which the default page for the news item is, expand Pages in the right side. The page on the top of the list is the 

default page. For more information about viewing and setting default pages, see Default pages for content items. 

12. When you are finished creating the news item, you must set its status, using the buttons on top and at the bottom of the 

news item. For more information, see Setting the status of a new page or content item.  

NOTE: While creating your news, you can use the Preview button to see a preview of the news and its properties.  
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EDITING NEWS 

EDITING, APPROVING, AND PUBLISHING THE CONTENT OF A NEWS ITEM 

1. Go to the News page and open a news item for editing in one of the following ways: 

 Click the news item you want to edit. 

 Click the Actions link of the respective news. 

From the dropdown list, click Content. 

The Edit a news page appears. 

NOTE: In the right of the page you can see the current status of the news that you have opened for editing. You can also see 

the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Perform procedure Creating a news item » Step 3 to Step 11. 

3. When you are finished, perform one of the following: 

 If you have opened for editing a news item in status Draft, Unpublished, or Rejected, perform procedure Managing a page 

or content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a news item in status Awaiting approval, perform procedure Managing a page or 

content item that is Awaiting approval. 
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 If you have opened for publishing a news item in status Awaiting publishing, perform procedure Managing a page or 

content item that is Awaiting publishing.  

 If you have opened for editing a news item in status Published or Scheduled, perform procedures Managing a page or 

content item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published news item, the system saves a draft of that news, but the published version is still visible on 

the webpage. To see which version is the currently published one, see Revision History. 

DELETING A NEWS ITEM 

You can delete news in the following ways: 

 On News page, select one or more news and click Delete button in the toolbar. 

 On News page, click the Actions link of the respective news. 

From the dropdown list, click Delete. 

 On Edit a news page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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SEARCHING AND FILTERING NEWS 

SEARCHING FOR NEWS 

To search for a particular news item, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the news you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all items, click Close search button in the toolbar. 

FILTERING NEWS 

 Filter by ownership. 

To display news, created only by your user, in the right side of the News page, click My news link under Filter news. 

 Filter by workflow status. 

You can filter news by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter news by categories, tags, and custom classifications. 

If you have added a custom classification field to news items, it appears in the filter options. For more information, see 

Custom fields. 

 Filter by date. 

To filter news by the date they were modified, click by Date modified… 

 When you click a time interval, the system displays all the news updated during this time interval. The last updated are 

the first in the list.  

 To display news modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 
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UPLOADING AND EDITING VIDEOS 

You manage videos on the Videos  page. 

To open the Videos page, in the main menu in the upper part of the screen, click Content » Videos. 

The Videos page appears, displaying a list of all created libraries together with actions you can perform on them. 

Use this page to manage image libraries and upload and edit videos. 

Section contents 

On this page you can do the following: 

 Upload videos 

 Edit videos 

 Display, sort, filter, and find videos 

 Manage video libraries 

 Display and order the videos in a video library 

PERMISSIONS FOR VIDEOS AND VIDEO LIBRARIES 

You can set permission for all videos and video libraries and you can set individual permissions for each video or library. 

To change the permissions for all videos, on Videos page, click Permissions link in the right side of the page. 

The Permissions for videos page appears. 

To change permissions for all libraries, in the main menu, click Administration » Permissions » by Section » Libraries. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions »Changing global and section permissions » Step 2 to Step 4. 

For more information about setting individual permissions for videos and video libraries, see Sitefinity Installation and 

Administration Guide » Users, roles, and permissions » Managing permissions » Changing permissions of an individual item. 

CUSTOM FIELDS FOR VIDEOS 

You can add a custom field to all videos. A custom field is a field that you create. For each video there are default fields, such as 

author, title, etc. If you need to add different than the already existing fields, you must create a custom field.  

To manage the custom fields of videos, on Videos page, click Custom Fields link in the right pane of the page. 

For more information, see Custom fields. 

You then display a custom field on your website by adding it to a template for displaying videos. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates.  

DISPLAYING VIDEOS ON YOUR WEBSITE 

To display the videos you have uploaded on your website, you must use the Video widget or the Video gallery widget and 

configure them to display videos. The widget uses Telerik RadMedia Played, which is an HTML5 video player. It supports WebM 

(.webm), Ogg (.ogv), and MP4 (.mp4) file formats. 

PREREQUISITE: Your video library must support HTML5 mode. For more information, see Sitefinity Installation and 

Administration Guide  Settings  Libraries and Storage  Libraries upload mode. 

For more information, see Video widget or Video gallery widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way videos are displayed by changing the template which the Video and Video gallery widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

LINKING OR EMBEDDING A VIDEO 

On Videos page click Embed this video link of the respective video. 

 To link a video, copy the content of the Link input field. 

For example you can copy the link and paste it in an e-mail. 

 To embed a video in HTML, copy the content of the Embed field and paste it in HTML code. 

For example you can embed a video in the text, using the text editor in HTML mode.  
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UPLOADING VIDEOS 

1. If you have multiple sites, on Videos page select the site where you want to upload videos, using the selector in the upper-left 

corner of the page.  

If your site uses more than one source for videos, you must choose the source where you want to upload the video. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 

source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Click the library where you want to upload videos. 

3. Perform one of the following: 

 If you have not uploaded any videos in the selected library, the system displays the following in the center of the screen: 

  

NOTE: If you are working in multilingual mode, the first video you upload is in the default language. 

 If you have already uploaded one or more videos in the selected library, the system displays all uploaded videos and the 

following button in the toolbar of Videos page: 

  

NOTE: If you are working in multilingual mode, before uploading a video, you must first choose the language, in which 

you want to upload the video. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages. 

4. Click Upload videos. 

The Upload videos page appears. 

5. Drag the videos, you want to upload or click Select videos from your computer and browse your computer to find the video 

you want to upload and click Open. 

You can select more than one video. 

The file name of the video and its size appear in Upload Videos page.  

6. To upload more than one video, click Add more videos. 

7. In Where to store the uploaded videos?, select the library where you want to store the video(s), by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

If you have not created any libraries, you can only choose Default Library, which exists by default. 

If you want to create another library, perform the following: 

a. Click Create a new library. 

b. Enter the name of the library and click Create this library. 

The new library appears in the dropdown box. 

For more information about creating libraries, see Managing video libraries. 

8. You can classify your video(s) using the Categories and tags section. 

For more information, see Adding categories and tags to a content item. 

Classifying content helps you organize it. For more information about classifications, see Classifying content. 

9. When you are finished, perform procedure Setting the status of a new page or content item. 

Uploading status bars appear on the page and after the system has uploaded the video, a massage appears informing you 

about the result of the upload. 

10. When upload is finished, choose between the following: 

 View all videos 

Returns you to Videos page. 
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 Upload more videos 

The system opens Upload videos page, where you can upload new videos. 

Perform Step 3 to Step 8. 

NOTE: If you are in multilingual mode, on Videos page, the system displays all available languages next to the video. You cannot 

have different videos in different languages, but you can have different titles for each language. To do this, click the Add link of the 

respective icon. 

NOTE: On Videos page you can also download an already uploaded video, by clicking the Actions link of the video and then 

Download. 
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EDITING VIDEOS 

EDITING PROPERTIES AND ADDING DETAILS TO A VIDEO 

1. To edit and add details to an already uploaded video, on Videos page perform one of the following: 

 Click the video you want to edit. 

 Click the Actions link of the respective video and then click Edit Properties. 

The Edit video  page appears.  

NOTE: In the right of the page you can see the current status of the video that you have opened for editing. You can also see 

the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Change the title of the video, by entering the new title in Title input field. 

3. Play the videos using the integrated player below the Title field. 

NOTE: You can also play the video in your own player or save the video on your computer. 

To do this, click Open the file button. 

In the dialog box that appears, select if you want to Save or Open the video. 

4. Change the video with another video by clicking Replace the file. 

a. Click Select video from your computer. 

b. Browse your computer to find the video you want to upload and click Open. 

Uploading status bar appears on the page and after the system uploads the video, you can play it in the integrated player. 

5. Create a thumbnail for the video by performing one of the following in Thumbnail section: 

 Click Capture video frame. 

The Capture thumbnail window appears where the system plays the videos. 

a. Whenever you want to capture an image for the video thumbnail, click Get currently displayed frame button. 

You can capture as many thumbnails as you want and you can replay the video, if needed. 

b. Select the image that you want to display in the thumbnail and click Done. 

The system returns you to Edit video page and changes the thumbnail. 

 Click Upload custom image. 

Use this option, if you want the thumbnail of the video to be an image that is not a frame in the video. 

Use the image selector to choose an image for the video thumbnail. 

6. Change the library which the video belongs to, by clicking Change button and selecting the new library from the dropdown box 

that appears. 

7. Change the categories and the tags which the video is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

8. To add details to the video, click Details. 

The following input fields appear: 

 Author 

Enter an author of the video.  

 Description 

The description you enter in the input field appears as a tooltip for the video in browsers that support ToolTips feature. 

When the video is opened, the description appears under the video. 



 

89 

9. By clicking Advanced, you can change the following: 

 The automatically generated URL of the video.  

To change it, click Change and enter a new URL name. 

 Configure additional URLs for the video. 

a. Select Allow multiple URLs for this item... checkbox 

b. Enter the URLs one per line, using the following convention /videos/<URL name> 

c. If you want all the URLs that you have entered to point to the default URL of the video, select All additional URLs 

redirect to the default one checkbox. 

If you uncheck the checkbox, each URL will display the video without redirecting. 

10. If you have added any custom fields for videos, the Custom fields section, displaying all created fields, appears. 

IMPORTANT: Some of the above fields may not be displayed when you edit the properties of a video, because they have 

been hidden. 

For more information about creating custom fields and hiding default fields, see Custom fields. 

11. Before you finish editing the video, you can preview it by clicking the Preview button in the toolbar.  

The video opens in its default page. If there is no default page, it means the video is not displayed anywhere on the site and 

you cannot preview it. 

To see which the default page for the video is, expand Pages in the right side. The page on the top of the list is the default 

page. For more information about viewing and setting default pages, see Default pages for content items. 

12. When you are finished, perform one of the following: 

 If you have opened for editing a video in status Draft, Unpublished, or Rejected, perform procedure Managing a page or 

content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving a video in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing a video in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing a video in status Published or Scheduled, perform procedures Managing a page or content 

item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published video, the system saves a draft of that video, but the published version is still visible on the 

webpage. To see which version is the currently published one, see Revision History.  

EDIT MANY VIDEOS AT THE SAME TIME 

You can edit the properties of many videos at the same time. To do this, perform the following: 

1. On Videos page, select the videos you want to edit and click More actions » Bulk edit titles, categories, tags. 

The Bulk edit page appears displaying all the selected videos. 

2. You can apply the following to all selected videos: 

 Common library 

Click Change library and select a library from the dropdown box that appears. 

All videos are moved to that library. 

 Common categories 

Click Click to add common categories link. 

For more information, see Adding categories. 

 Common tags 

Click Click to add common tags. 

For more information, see Adding tags. 

3. For each of the selected videos, you can change the following: 

 Title 

 Description 

The description you enter in the input field appears as a tooltip for the video in browsers that support ToolTips feature.  

4. When finished, click Upload. 
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The system returns you to Videos page. 

MOVING AND DELETING A VIDEO 

 To move one or more videos to another library, on Videos page, select the videos and in the toolbar, click More actions » 

Move to other library. 

A window appears where you select the library where you want to move the videos and click Move. 

 To delete videos, perform one of the following: 

 On Videos page, select one or more videos you want to delete and click Delete button in the toolbar. 

 On Videos page, click the Actions link of the video you want to delete and then click Delete. 

A dialog box appears where you must confirm the deletion. 
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DISPLAYING, SORTING, FILTERING, AND FINDING VIDEOS 

The Videos page displays all created video libraries. To view videos in a library, click it. 

CHANGING THE DISPLAY MODE OF VIDEOS 

To change the view of the videos and the corresponding information, in the toolbar of Videos page, click one of the following: 

 Click  (Thumbnails view) to view videos and information in boxes. 

 Click  (List view) to view videos and the information in a grid. 

DISPLAY VIDEOS BY LIBRARIES 

To displaying videos only from a specific library, click the library thumbnail in the right side of Videos page. 

NOTE: If you use  (List view) button to view videos, for each video, the system displays a link to the library in the grid. If you 

click the link to the library, the system displays all videos from this library. 

For more information, see Managing video libraries. 

FILTER VIDEOS 

To display the filtering options, click Filter videos. 

 Filter by ownership. 

To display videos, uploaded only by your user, in the right side of Videos page, click My videos link under Filter videos. 

 Filter by workflow status. 

You can filter videos by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter videos by categories, tags, and custom classifications. 

If you have added a custom classification field to videos, it appears in the filter options. For more information, see Custom 

fields. 

 Filter by date. 

To filter videos by the date they were modified, click by Date … 

The Display Videos modified in… pane appears. 

 When you click a time interval, the system displays all the videos modified during this time interval. The last modified are 

the first in the list. You can further sort them. 

 To display videos modified during some custom period of time, click Custom range… link. 

To define a custom filtering interval, use the From and To input fields. 

Click Filter. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else or 

until you refresh your screen by pressing F5. 

SORT VIDEOS 
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You can sort videos using the Sort videos dropdown box in the toolbar of the page. 

There are the following sorting options: 

 Last uploaded on top 

Sorts videos in descending order according to the time of upload. 

 Last modified on top 

Sorts videos in descending order according to time of modification. 

 Custom sorting… 

A window appears where you perform the following: 

1. Select sorting criterion from the dropdown box and choose between Ascending and Descending order in the radio button. 

2. You can also and add more than one criterion by clicking Add another sorting rule link and you can remove sorting criteria 

by clicking Remove link. 

3. When you are finished, click Save. 

The system sorts the videos according to the custom sorting. 

4. To edit a custom sorting that you have created, select Edit custom sorting… from the Sort videos dropdown box. 

SEARCHING FOR VIDEOS 

To search for a particular video, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the video you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all videos, click Close search button in the toolbar. 

| Uploading and editing videos | Using the content modules | Website content | Table of contents | 

MANAGING VIDEO LIBRARIES 

You display and manage all created libraries on Videos page. 

The Videos page displays the number of videos in each library, the date of the last uploaded videos, and where those videos are 

stored. 

CREATING A VIDEO LIBRARY 

1. On Libraries page or on Videos page, click Create a library button in the toolbar. 

The Create a library  page appears. 

2. Enter a name for the library. 

3. To add a description of the library, click Click to add a description. 

NOTE: The information you provide here is not public, it is for your reference only. 

4. You can define the maximum size of the library and of each video in the library by clicking Advanced. 

The Max library size and the Max video size input fields appear. There you enter the limit of the size in MB and KB 

respectively. 

5. Under URL name, you can change the URL of the library by clicking Advanced. 

The automatically generated URL of the library appears.  

To change it, click Change and enter a new URL name. 

6. Under Parent library, choose where to create the library: 

Select one of the following: 

 No parent 

This will be a top level library that has no parent. 

 Select parent library… 

A treeview with existing libraries appears. 

Select the library that will be parent of the library you are creating. 
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NOTE: If the library you are creating is located in another library, it has the same settings as its parent. You can only set 

cache options, storage providers, and resizing options for a root library, located at top level. 

7. If in Step 6, you have chosen your library to be a top level library that has no parent, under Root library settings, you can 

configure the following: 

 You can set the maximum size of the library in MB and of each video in the library in KB. 

 You can chose where to store the videos uploaded in this library. 

For example, you can store them on the database, in the file system, or in an external storage. 

In Storage provider dropdown box, select where to store the videos. 

The list that appears contains all available storage providers. 

For more information, see Storage providers for libraries. 

 You can configure the browser caching. 

Configuring caching can increases your performance.  

8. When you are finished, click one of the following: 

 Create this library 

The system creates the library and returns you to Videos page or Libraries page, depending on where you have started 

creating the library. 

 Create and add another library 

The system saves the library and displays a new Create a library page. 

 The Back to link 

The system does not save the library you were working on and returns you to Videos page or Libraries page, depending 

on where you have started creating the library. 

CHOOSING THE UPLOAD MODE OF THE LIBRARY 

You can change the method by which items are uploaded into libraries. Sitefinity supports HTML5 and Silverlight upload. 

For more information, see Sitefinity Installation and Administration Guide » Settings » Libraries upload mode. 

EDITING VIDEO LIBRARIES 

1. To edit the library properties, on Videos page click the Actions link of the library you want to edit. 

2. From the dropdown box, click Edit Properties. 

The Edit a library page appears. 

3. Perform Step 2 to Step 7 of the above procedure. 

NOTE: If you are changing the URL of the library, Sitefinity changes the URLs of the items one by one. In case of external 

storage, changing the library URL may cause data transfer from one storage to another. In case of failure, some of the items 

might keep their previous URLs and some of the items will have the updated URLs. You can try to resume to get the rest of 

the items relocated. 

4. Click Save changes. 

The system returns you to Videos page. 

CHANGING THE PARENT LIBRARY OF A VIDEO LIBRARY 

Once created, a library can be moved together with all of its content to another library, by changing its parent library. 

To do this, perform the following: 

1. Click the Actions link of the library that you want to move and from the dropdown, select Move to… 

The Change parent library dialog appears. 

2. Select the new parent library and click Move. 

MOVING VIDEOS TO ANOTHER STORAGE 

You can change the blob storage provider of a library, which moves all items in a different storage. For example, an image library 

kept in the database can be moved to the cloud, or a library from one cloud account can be moved to another. 

To do this, perform the following: 

1. Click the Actions link of the library whose items you want to move and from the dropdown, select Move to another storage. 

In the Blob storage provider dropdown box all available storage providers appear. 
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2. Select where you want to move the items from the library and click Move to another storage. 

Sitefinity processes the library items one by one and displays a progress indicator in the grid. You can stop and resume the 

operation. 

NOTE: In case of failure before the operation is completed, some of the library items may remain in the target storage, while the 

rest will stay in the source storage. You can try to resume the operation. 

IMPORTANT: During the process of moving to another storage, you are not able to edit or delete the library items. 

For more information, see Storage providers for libraries. 

DELETING VIDEO LIBRARIES 

To delete a library, perform one of the following: 

 On Videos page, select one or more libraries you want to delete and click Delete button in the toolbar. 

 On Videos page, click the Actions link of the library you want to delete and then click Delete. 

 On Edit a library page, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 

| Uploading and editing videos | Using the content modules | Website content | Table of contents | 

DISPLAYING AND ORDERING THE VIDEOS IN A VIDEO LIBRARY 

DISPLAYING AND EDITING THE VIDEOS OF A SINGLE LIBRARY 

 To display all video and sub-libraries in a library, on Videos page, click the library whose videos you want to display. 

All videos in the library appear. 

 

 To edit the videos in the library, perform procedure Editing videos. 

 To go back to all libraries click All libraries link above the toolbar or in the main menu, click Content » Videos. 

ORDERING VIDEOS IN A LIBRARY 

1. To order the videos in a library on Videos page, click the library whose videos you want to reorder. 

All videos in the library appear. 

2. Click Reorder videos button in the toolbar of the page. 

The Reorder videos page appears. 

3. You reorder videos by dragging the videos thumbnails in the desired order. 

4. When you are finished, click Save changes. 

NOTE: You can also reorder videos using the sorting function. 

| Uploading and editing videos | Using the content modules | Website content | Table of contents | 

DYNAMIC MODULES 

After you have defined and activated your dynamic module, you can use it to create content in the backend and display the 

created content on your website. The dynamic content types belonging to your module appear under the Content tab and the 

widgets appear in page editing mode under the Content widgets group. You use your module to create dynamic content items. The 

fields you have defined for the content types appear when you create a dynamic content items. 

For more information about creating and installing a dynamic module, see Sitefinity Installation and Administration Guide » 

Modules & Services » Dynamic modules. 

CREATING AND EDITING DYNAMIC CONTENT ITEMS 

You manage the dynamic content items on a separate page dedicated to each content type of your module. 

To open the page, in the main menu in the upper part of the screen, click Content » <Content type>. 

The <Module name> page appears, displaying a list of all created content items of the selected content type together with actions 

you can perform on them. You can manage what columns and information the page displays. For more information, see Editing the 

module and the module screens. 
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Use this page to create, edit, and manage dynamic content items. 

Section contents 

On this page you can do the following: 

 Create a dynamic content item 

 Edit dynamic content items 

 Sort, filter , and search dynamic content items 

REVISION HISTORY 

Dynamic modules have version history. Use this function to view and compare different versions of a content item. Every time you 

edit a content item, a version of that content item is saved by the system. 

For more information, see Revision history. 

PERMISSIONS FOR DYNAMIC CONTENT ITEMS 

You can set permission for dynamic content items of a certain type and you can set individual permissions for each field of a 

dynamic type. For example, some users can change the answer to an FAQ, others can only view it, but can create questions. To be 

able to set permissions for individual fields, you must have enabled this when creating the content type in Step 6. 

To change the permissions for all items, click Content » <Content type>. On your dynamic content type page, click Permissions 

link in the right side of the page. 

The Permissions page appears. 

For more information about changing permissions, see Sitefinity Installation and Administration Guide » Users, roles, and 

permissions » Managing permissions » Changing global and section permissions » Step 2 to Step 4. 

DISPLAYING DYNAMIC ITEMS ON YOUR WEBSITE 

To display dynamic content items on your website, the system generates a separate widget for each content type. It is added to 

the Content widgets group. There are two types of dynamic content type widgets – content widgets and hierarchical widgets. The 

content widgets display content types, the hierarchical widgets display parent content types. These are content types that have 

children, such as blogs that have blog posts and forums that have forum threads.  

For example, if you have two content types at top level, the system creates two separate content widgets. If you have two content 

types, but one is a parent of the other – the system generates only one hierarchical widget that is used to display both types. 

For more information, see Dynamic content widgets and Dynamic hierarchical widgets. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way items are displayed by changing the template which the widget uses. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

WORKING WITH THE MODULE PROGRAMMATICALLY 

If you are developer, you can use the code reference for each module. It contains code examples for the most common operations 

you can perform with the module.  

1. To view the code samples, click Administration » Module Builder.  

2. In the list of all created modules, click the module, whose code reference you want to see. 

3. Click Code reference for <module name> link. 

| Creating and using custom modules | Website content | Table of contents | 

CREATING A DYNAMIC CONTENT ITEM 

1. Open the page of your dynamic content type by clicking Content » <Dynamic type>. 

2. If you have multiple sites, on the page of your module, select the site where you want to create the item, using the selector in 

the upper-left corner of the page.  

If your site uses more than one source for this content type, you must choose the source where you want to create the item. 

If you have more than one sources configured, all available sources are displayed in the toolbar, where you can select the 
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source of your choice. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

3. Click Create a <item name>. 

NOTE: If you are working in multilingual mode, before creating a content item, you must first choose the language in which 

you want to create it. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

4. Fill out all fields that you have created when defining the dynamic module. 

For more information, see Creating a content type. 

5. Before you finish creating the dynamic item, you can preview it by clicking the Preview button in the toolbar.  

The item opens in its default page. If there is no default page, it means the item is not displayed anywhere on the site and 

you cannot preview it. 

To see which the default page for the dynamic item is, expand Pages in the right side. The page on the top of the list is the 

default page. For more information about viewing and setting default pages, see Default pages for content items. 

6. When you are finished creating the item, you must set its status, using the buttons on top and at the bottom of the item. For 

more information, see Setting the status of a new page or content item.  

| Using your custom module | Creating and using custom modules | Website content | Table of contents | 

EDITING A DYNAMIC CONTENT ITEM 

EDITING, APPROVING, AND PUBLISHING THE CONTENT OF A DYNAMIC CONTENT ITEM 

1. On your dynamic content type page, open the dynamic item for editing in one of the following ways: 

 If the item does not have children items, click the item you want to edit. 

 If the item is a parent of other items, click the Actions link of the respective item. 

From the dropdown list, click Properties. 

NOTE: In the right of the page you can see the current status of the item that you have opened for editing. You can also see 

the author, the time and date of the last update, the publication date, and a link to all existing versions of the item. 

2. Edit the field that you want. 

3. When you are finished, perform one of the following: 

 If you have opened for editing an item in status Draft, Unpublished, or Rejected, perform procedure Managing a page or 

content item that is Draft, Unpublished, or Rejected. 

 If you have opened for approving an item in status Awaiting approval, perform procedure Managing a page or content 

item that is Awaiting approval. 

 If you have opened for publishing an item in status Awaiting publishing, perform procedure Managing a page or content 

item that is Awaiting publishing.  

 If you have opened for editing an item in status Published or Scheduled, perform procedures Managing a page or content 

item that is Published or Managing a page or content item that is Scheduled respectively. 

If you are editing a published item, the system saves a draft of that item, but the published version is still visible on the 

webpage. To see which version is the currently published one, see Revision History. 

DELETING A DYNAMIC CONTENT ITEM 

You can delete an item in the following ways: 

 On your dynamic content type page, select one or more items and click Delete button in the toolbar. 

 On your dynamic content type page, click the Actions link of the respective item. 

From the dropdown list, click Delete. 

 When you edit an item, click More actions » Delete. 

A dialog box appears where you must confirm the deletion. 
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SORT, FILTER, AND SEARCH DYNAMIC CONTENT ITEMS 

You can search, sort, and filter dynamic content items on the page of the dynamic module, where all created dynamic content 

types are located. For example, if you have a module Brands, open the page where all created brands are. You can see Filter 

Brands section in the right pane. 

FILTER DYNAMIC CONTENT ITEMS 

 Filter by ownership. 

To display dynamic content items, uploaded only by your user, in the right side of the page, click My <content type> link 

under Filter <content type>. 

 Filter by workflow status. 

You can filter dynamic content items by their status. For example, Published or Draft. 

For more information, see Workflow status of content items and pages. 

 Filter by classifications. 

You can also filter dynamic content items by categories, tags, and custom classifications. 

To display the filter, you must first add a classification field to the dynamic content type. For more information, see Sitefinity 

Installation and Administration Guide  Modules & Services  Dynamic modules  Creating the dynamic module  Creating 

a content type  Step 4. 

SORT DYNAMIC CONTENT ITEMS 

You can sort dynamic content items using the Sort dropdown box in the toolbar of the page. 

There are the following sorting options: 

 Last uploaded on top 

Sorts dynamic content items in descending order according to the time of upload. 

 Last modified on top 

Sorts dynamic content items in descending order according to time of modification. 

 Custom Sorting… 

A window appears where you perform the following: 

1. Select sorting criterion from the dropdown box and choose between Ascending and Descending order in the radio button. 

2. You can also and add more than one criterion by clicking Add another sorting rule link and you can remove sorting criteria 

by clicking Remove link. 

3. When you are finished, click Save. 

The system sorts the dynamic content items according to the custom sorting. 

4. To edit a custom sorting that you have created, select Edit custom sorting… from the Sort items: dropdown box. 

SEARCHING FOR DYNAMIC CONTENT ITEMS 

To search for a particular dynamic content item, use the search option.  

1. Click the Search… button in the toolbar. 

A search field opens. 

2. Enter the name or part of the name of the dynamic content items you are searching for.  

The search field is case insensitive. 

3. Click Search. 

A list of results matching your search appears.  

To return to the list of all dynamic content items, click Close search button in the toolbar. 

DEFAULT PAGES FOR CONTENT ITEMS 

Sitefinity keeps track of each content item and the default page where it is displayed. This way, Sitefinity knows the URL of each 

item at any time, regardless of whether the item is published or saved as draft. This is called Canonical URL service. It makes 

possible for you to preview an item, as it will appear on the website, even before the item is published. Also, each item, at any 

time has one default page associated with it, therefore its URL is always known. 
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Content items are displayed on pages using widgets. Each type of content item has one or more widgets used to display it. For 

example, events are displayed on the website using the Events widget. A page is associated with a content item when you drop the 

respective widget on the page.  

EXAMPLE: You create three events, but you have no page where you have added the Events widget. These events do not have a 

default page, because they are not displayed anywhere on the site. You cannot preview the events, because Sitefinity does not 

know where they will be displayed. You cannot know their exact URL, because it depends on the page where they will be 

published.  

When you create a page and add the Events widget on the page, this page automatically becomes the default page for the events 

that you have created. If you, however, configure this Events widget to display only one of the three created events, this page 

becomes default only for the event that it displays. For example, you can use categories to narrow the displayed events. If you 

create a second page, which also contains the Events widget, you can set manually, which is the default page for the events, using 

priorities. 

CONFIGURING THE DEFAULT PAGES 

You can configure default pages on content type level.  

To view and configure the default pages for all content items of a particular type, perform the following: 

1. Open the page for the content type. 

For example, open the Events page. 

2. In the lower-right corner of the page, click Pages where <Content type name> are published. 

For example, Pages where Events are published. 

You can see a page, displaying all pages where the respective widget is dropped and configured to display the content type. 

For example, all pages that contain the Events widget. 

3. To set the priority, click the Actions link of a page and use the Up or Down functions. 

The page on the top is the one with highest priority. The page with highest priority is the default page. 

For example, if two pages are configured to display all events, the default page for all events is the page whit the higher 

priority. However, if you have two pages, of which one is configured to display only events from Sports category and the other 

– only events from Business category, the default page for events with Category set to Sports will be the first page and for the 

business events will have the second page, even if you have set the first page with higher priority. 

NOTE: The default page for a content item is the page with the highest priority, where this item is displayed. If there is a 

page with higher priority that has the respective widget, but is not configured to display the content item, it is not set as its default 

page. 

NOTE: If you have multiple sites, and the content items of one site are displayed on pages of another site, these pages also 

appear on the list of default pages for the items and you can set their priority. For more information about multiple sites and 

multiple data sources, see Sitefinity Installation and Administration Guide » Multiple site management » Creating a site. 

For example, if you configure the provider for events of site A to be also the provider for the events in site B and you create a page 

that has the Events widget in site B and this widget is configured to display the events created in site A, when you go to site A and 

open the page with the list of default pages for events, the page from site B will also be present in the list and you can set it as 

page with highest priority. This way, an event from site A can open by default on a page from site B. 

PREVIEWING AN ITEM AND VIEWING ITS DEFAULT PAGES 

You can preview an item in one of the following ways: 

 On the home page of the content type, click Actions link of the respective content item and then click View. 

 When you are creating or editing a content item, in the toolbar, click Preview. 

The item opens in its default page. If the item is not displayed anywhere on the site and does not have a default page, you cannot 

view or preview it. 

When you open an item for editing, you can view the pages where it appears by expanding Pages on the right. The page on the 

top of the list is the default page for the item. 

SCOPE OF CANONICAL URLS 

Content types that are covered by the feature are: 

 News 
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 Event 

 Blog Post 

 Image 

 Video 

 Document & File 

 List Item 

 Ecommerce Products 

 Dynamic content types 

 Forums posts are only partially covered by the feature – they have canonical meta tags inserted, but the preview is not 

available for them. 

INLINE EDITING 

Use this procedure to edit and upload content while you are browsing the website. You do not need to open the website in the 

backend; you can use the inline editing function to edit your website directly while browsing it. Using the direct inline editing, you 

can see how the items you are editing look in the context of the website. 

PREREQUISITES:  

 To use inline editing, you must be logged in Sitefinity backend. 

 To publish content after editing it, you must have publishing permissions. If your site has an active workflow, the process 

of editing and uploading content follows the rules of the workflow. For more information, see Workflows and Workflow 

status of content items and pages. 

 You can edit only the currently published version of content. You cannot edit items that are in status Awaiting approval, 

Awaiting publishing, Rejected. Draft and Scheduled content is not displayed on the frontend.  

INLINE EDITING PROCEDURE 

To directly edit your website, perform the following: 

1. Open the inline editing, login to Sitefinity, and open the website in a browser. 

The system opens the website and displays the following icon in the right of the page: 

 

When the system displays this icon, it means that you can edit content directly in the browser. 

2. Click the icon and in the dropdown menu, click Edit content. 

A banner appears on top of the page, displaying publishing options.  

When you are in inline editing mode, the system indicates this by changing the color of icon as in the following screenshot: 

 

3. You edit content by clicking it. 

On mouse-over, the system colors the content that can be edited in yellow. 

For more information about which content can be edited directly in the browser, see Covered content section below. 

4. Save the edited content as draft or publish it. 

For more information, see Saving and publishing section below. 

5. To exit the inline editing mode, in the toolbar, click EXIT EDITING. 

If you have unsaved content, the system prompts you. 

NOTE: To see which user is logged and can use the inline editing icon. The system displays the user that is currently logged in 

Sitefinity. You can use the icon button to logout after you finish the changes.  

COVERED CONTENT 

The following table lists all content items that you can edit directly in the browser, together with editing actions available for each 

content type: 
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Widget Available actions 

Content block  Edit content 

 Edit all properties (in the backend) 

For more information, see Editing content blocks. 

News  Edit title 

 Edit content 

 Edit all properties (in the backend) 

For more information, see Editing news. 

Blog list  Edit titles 

 Edit all properties (in the backend) 

For more information, see Editing blogs. 

Blog post  Edit title 

 Edit content 

 Edit all properties (in the backend) 

For more information, see Editing blog posts. 

Events  Edit title 

 Edit event description 

 Edit all properties (in the backend) 

For more information, see Editing events. 

Lists  Edit list title 

 Edit list items 

 Edit all properties (in the backend) 

For more information, see Editing lists and Editing list items. 

Image  Change image 

 Edit title 

 Edit alternative text 

 Edit display size 

 Edit all properties (in the backend) 

For more information, see Editing images. 

Dynamic widgets  Edit title 

 Edit all properties (in the backend.) 

For more information, see Editing a dynamic content item. 

EDITING TOOLS 

 You edit titles by directly inputting text in the input field. 

 You edit content and descriptions, using the text editing tools that appear in the toolbar. 

For more information, see The text editor. 

There is a separate toolset for the text editor in inline editing mode. For more information about configuring the toolsets, see 

Text editor. 

 To edit an image, click the image and then click   icon. 

 To edit all properties of an item, you must open it for editing in the backend.  

To do this, click the item on the frontend and then in the toolbar, click  » Edit all properties. 
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SAVING AND PUBLISHING 

 Publishing a single item. 

When you are editing a single item, for example the news title, you can publish this item only. To do this, in the toolbar click 

 » Publish <item name>. 

 Publishing all changes on the page. 

To do this, click PUBLISH ALL button in the toolbar. 

NOTE: If the items that you try to publish are subject to a workflow, the system displays a notification, informing you about 

the new status of the content items and displays a link to editing the items in Sitefinity backend.  

For example, if an item must be approved before publishing,  the system inform you that the item you are editing cannot be 

published, the status of the item is changed to Awaiting approval, and there is a link you can follow to edit the item in the 

backend. 

 Saving all items on the page as draft. 

To do this, click SAVE AS DRAFT button in the toolbar. 

All items on the page are saved in status Draft (newer than published). 

NOTE: If not all items on the page are published, the system displays Mark not published content link in the toolbar. When you 

click the link, next to each item, the system displays its status. 

OTHER INLINE EDITION OPTIONS 

When you click  icon, you can use the following options: 

 Edit widgets and layout 

The system opens the page in page editing mode. 

For more information, see Page layout and Widgets. 

 Page Analytics 

The system open the analytics data for the current page. 

You must have configured the Analytics module. 

For more information, see Sitefinity Tools  Sitefinity Analytics. 

REVISION HISTORY 

Use this function to view and compare different versions of a content item. Every time you edit a content item, a version of that 

content item is saved by the system. 

To view the history, perform one of the following: 

 Click the Actions link of the respective item and click Revision History. 

 To open the item for editing, in the right of the page click Revision History. 

The Revision History page appears, containing a list of all versions of the item. 

The following screenshot displays three versions of event MyEvent: 
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In case the item has been published, the system indicates which version of the item is published, by displaying  next to this 

version. 

On Revision History page, you can do the following: 

 You can view a previous version of the item by clicking the version. 

A preview of the page opens. You can revert to a previous version of the page by clicking Revert to this version button. 

The system makes the selected version of the item the current one. 

 You can compare two versions of an item, by selecting them and clicking Compare. 

 The system displays both the content and the properties of the two versions. 

 You can delete versions of the item, by selecting them and clicking Delete. 

 You can add note to each version, by clicking the Write note link of the respective version. 

An input field where you enter and save the note appears. 

The note is displayed in the Revision History page. You can edit and delete the note. 

| Website content | Table of contents | 

COMMENTS AND RATINGS  

When you publish a content item on your website, users can leave comments and rate it. You can also drop the Comments widget 

anywhere on the page. You can then manage these comments and ratings, using the Comments module. The Comments page 

contains all comments and ratings for content types or pages. For example, comments for news or ratings of a product. 

Users can leave comments for the following content types: 

 Pages 

 News 

 Blog posts 

 Events 

 Images 

 Videos 

 Documents and other files 

 List items 

 Products 

 Dynamic content types 

All of the above, except pages, have a built-in comments widget. For pages, you must drop the Comments widget where you want 

to display comments functionality. 

For each content item or page, users can read and leave comments. If you have enabled ratings, for each item, the average rating 

is automatically calculated and displayed. 

Section contents 

 Enable comments and ratings 

 Comments and ratings for dynamic content types 

 Submitted comments and ratings 

ENABLE COMMENTS AND RATINGS 

By default, comments are enabled for all commentable types of content and pages. Ratings are enabled, by default, only for 

products. 

To enable and disable comments and ratings, perform the following: 

1. Click Content » Comments. 

2. In the right pane, click Settings. 
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The Settings page appears. 

3. In the left pane, expand CommentsModule » Commentable types. 

All commentable types appear. 

4. Click the type whose setting you want to change. 

You can configure the following: 

 AllowComments 

Enable and disable the comments for this type of content. 

For example, if you have selected the checkbox in the News content type, when you read a news item on the frontend, 

you see Leave a comment link. When you click it, a textbox and a submit button appears. 

 Requires authentication 

If you select this setting, only logged in users are able to leave comments and ratings. 

When a user that is not logged clicks the comments link, Sitefinity redirects to the frontend login page. 

For more information, see Frontend login page. 

 Requires approval 

When a comment is submitted on your site, it is not automatically published and is not visible before you approve it. 

The comment appears in the Comments module in status Waiting for approval. To make it visible, you must manually 

publish it. 

 Enable email subscription 

When enabled, it allows users to subscribe for email notifications. After the comment text box, the system displays 

Subscribe to new comments link. If a user click it, an email is sent for each newly submitted comment for the particular 

content item. 

Only authenticated users can subscribe. The link is not displayed to anonymous users. 

When a user is subscribed for the comments of a particular content item, the system displays a link to unsubscribe. 

Before Sitefinity can send emails, you must configure the Default notification profile. For more information, see Sitefinity 

Installation and Administration Guide » Settings » System » Configuring notification profiles. 

 Enable user ratings as part of the comments 

In addition to comments, you can display ratings. Users can write a review and leave a rating. 

If you want to enable ratings, you must also select the AllowComments link. 

NOTE: If you have enabled rating, the system displays the Write a review link, instead of the Leave a comment link. 

COMMENTS AND RATINGS FOR DYNAMIC CONTENT TYPES 

By default, comments are enabled for each newly created dynamic module. You can control the comments settings for newly 

created modules from Comments module Default settings. The default settings are the settings that each newly created dynamic 

module inherits. 

To view and change the Default setting for comments, click Administration » Settings » Advanced » CommentsModule » Default 

settings. 

For more information about the setting, see Enable comments and ratings. 

After you create a dynamic module, you can change its comments settings individually. To do this, you must add its type to the 

commentable types. 

Perform the following: 

1. Click Administration » Settings » Advanced » DynamicModules » Controls. 

2. Click the type of content that you want to add to comments module administration. 

You can see the exact type of the content. 

3. Copy the content of input field The type of the Content items. 

4. In the tree on the right, click CommentsModule » Commentable types » Create new. 

5. In Friendly name, enter a the name of the content type that is displayed in the backend. 

6. In Item type, enter the content you copied in Step 3. 

7. Configure the comments settings. 

For more information, see Enable comments and ratings. 
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8. Save your changes. 

The dynamic content type is added to the commentable types and you can configure its comments settings individually. 

It is also added as a filter option in the Comments page. You are able to filter comments left for this dynamic content type. 

SUBMITTED COMMENTS AND RATINGS 

VIEW SUBMITTED COMMENTS AND RATINGS 

You can view all comments submitted on the site for all types of content and pages on the Comments page. 

To open the Comments page, in the main menu click Content » Comments. 

All submitted comments appear.  

You can filter comments using the following options: 

 Comment’s status 

A comment can be one of the following statuses: 

 Published 

The comment is publicly visible on the website. 

 Waiting for approval 

The comment is submitted, but requires approval before being published. 

 Hidden 

Use this option if you do not want a comment to be visible on the website, but you do not want to delete it. 

 Spam 

Use this option to mark a comment as spam and activate the spam filters. 

 Date modified 

 Content type 

If you want to filter by a dynamic content type, you must add it to the commentable types, for more information, see 

Comments and ratings for dynamic content types. 

EDIT A COMMENT 

1. To open a comment for editing, click the Edit link of the particular comment. 

The Edit comment page appears. 

2. You can edit the text of the comment using the text editor. 

3. You can edit the rating of a comment. 

4. You can change the status of a comment. 

For more information, see the procedure bellow. 

5. When finished editing, click Save changes. 

The system returns you to Comments page. 

CHANGE THE STATUS OF COMMENTS 

You can change the status of a comment in one of the following ways: 

 On Comments page, select one or more comments and click the respective button in the toolbar of the page. 

You can choose Hide, More options » Mark as spam, or Publish. 

 To hide a comment, click the Hide link of the respective comment. 

 To mark a comment as spam, click the More actions link of the respective comment and click Mark as spam. 

DELETE COMMENTS 

You can delete a comment in one of the following ways: 

 Select one or more comments and click Delete button in the toolbar of the page. 

 Click the Delete link of the respective comment. 

A dialog box appears where you must confirm the deletion. 
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CUSTOM FIELDS 

Use this procedure to add a custom field to a content item or page. A custom field is a field that you create. For each content item 

or page there are default fields, such as author, title, etc. If you need to add different than the already existing fields, you must 

create a custom field, for example, price. A custom field is associated with the content type or page. The field appears in the 

backend when somebody is creating that content type. The custom field can then be filled out by the creator and then displayed 

on the public part by adding it to the widget template, which is used to display that content type. 

EXAMPLE: When creating an event you can enter its location, starting and ending time, and other predefined parameters. For 

each event you can add a custom field, for example Dress code. Afterwards, each time an event is created, the creator can fill out 

this Dress code field. You can make this field to be a multiple choice. You can also choose where or whether to display this field on 

the website together with each event by modifying the template that is used to display events.  

Section contents 

 Creating a new custom field 

Use this procedure to create a custom field if the predefined default fields do not suit your needs. 

 Editing an existing data field 

Use this procedure to edit a custom field or a predefined default field. 

DISPLAYING INFORMATION ENTERED IN A CUSTOM FIELD 

After you have created a custom field, everybody who is creating or editing the content items for which you have added a custom 

field can enter information in that field. If for the content type you are creating there are any created custom fields, a Custom 

fields section appears at the end of the page and the created fields appear in this section. 

To display a custom field in the public side of your website, you must add the field to the widget template which you use to display 

that content type. For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » 

Creating and editing widget templates. 

For more information about including a custom field in search indexes, see Search indexes. 

For more information about working with custom fields programmatically, see Custom fields. 

| Website content | Table of contents | 

CREATING A NEW CUSTOM FIELD 

To add a custom field to a content item, perform the following: 

1. Open the module where you want to add a custom field. 

If you want to add a custom field for pages, in the main menu, click Pages. 

For example, open the Images page or the Events page, or click Pages. 

2. In the right side of the screen, click Custom Fields link. 

The <Content type> data fields  page appears. The system displays a list of all custom and default fields for that content type 

or page. 

For example, on News page, click Custom fields for news link and the News data fields page appears. On Pages page, click 

Custom fields. 

NOTE: You can add and delete custom fields, but you cannot add or delete default fields. 

3. To add a custom field, in Custom fields section, click Add a field… button. 

A window opens. 

4. In Type dropdown box, select what type of input will be entered in this custom field. 

Different types of input require the use of different widgets for entering data. 

 If you choose Number type of field, the Decimal places dropdown box appears. 

Select the number of decimal places after the decimal point that can be entered in this field. 

 If you choose Classification type of field, the Classification dropdown box appears. 

Select the type of classification you want to create. 

The dropdown box contains the predefined types of classifications – Categories and Tags, and any other custom 

classifications you have created. For more information, see Creating custom classifications. 

 If you choose Related data, proceed to Related data custom field. 

http://www.sitefinity.com/documentation/documentationarticles/developers-guide/deep-dive/dynamic-data/dynamic-fields
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 If you choose Related media, proceed to Related media custom field. 

5. Enter a name for the field.  

The name of the field is different from its label. The name of the field serves as reference for that field in the backend. 

6. If you select This is a hidden field checkbox, the custom field is not visible on the website or in the backend, you can only use 

it in the code. 

You can later unhide the field, by clicking it in section Custom fields and changing the selection on Appearance tab. 

7. In Interface widget for entering data dropdown box, you select the widget which the creator or editor of the content item or 

page will use to complete the field. 

Each type of field you select in Type dropdown box has a default widget(s) for entering data. The following table contains the 

list of all types of fields together with a description of what is displayed when creating and editing the content item, for which 

the field is created: 
 

Type of field Appearance of the custom field 

Short text An input field with labels and instructions, which you add in Step 9. 

Long text The text editor. For more information, see The text editor. 

NOTE: If you are adding the long text field to a dynamic content type, created with the Module 

Builder, that you want to use for entering some system content, such as java scripts or kendo UI 

templates, you can disable the parsing of any links, including image links. If the link is a link to an 

image, the system displays the full path to the image, which means that the link will be broken, if you 

change the host. 

You do this by selecting More options » Disable Link Parser. 

Multiple choice Radio buttons with labels, which you add in Step 9. 

Yes / No A checkbox, which you select for Yes and deselect for No. 

Currency An input field with labels and instructions, which you add in Step 9. 

Date and Time An input field with labels and instructions, which you add in Step 9. 

Number An input field with labels and instructions, which you add in Step 9. 

Classification  If in Interface widget for entering data dropdown box, you have selected Textbox selector, the 

system displays an input field where you type new classifications or a link where you select from 

the existing classifications.  

For more information, see Adding categories and tags to a content item » Adding tags. 

 If in Interface widget for entering data dropdown box, you have selected Tree-like selector, the 

system displays a tree structure of existing classifications, from which you can select.  

For more information, see Adding categories and tags to a content item » Adding categories. 

Related data A content items selector, which you use to associate the content item that you are creating with 

another content item of different type. 

For more information, see Related data custom field. 

Related media A content items selector, which you use to associate the content item that you are creating with a 

media type. 

This field gives you the option to add images, videos, and documents to a content item or page using a 

selector widget. 

For more information, see Related media custom field. 

Address NOTE: This field is available only for dynamic modules. For more information see Address custom filed. 
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8. Expand the Advanced section if you want to change the database and the SQL database type of the custom field, if you want 

to specify the name of the column of the database table where the custom field is added, and if you want to make additional 

advanced settings. 

If the Allow empty values checkbox is selected, it means that the field is not required and can be left empty. If you deselect it, 

the field becomes mandatory. 

9. Click Continue. 

A window appears where you must configure the appearance of the custom field, such as labels and instructions. 

10. Perform one of the following: 

 If in Type input field, you have selected Short text, Long text, Yes / No, Currency, Date and Time, Number, or 

Classification, perform the configuration procedure for Textbox » Label and texts and Limitations tabs. 

 If in Type input field, you have selected Multiple choice, perform the configuration procedure for Checkboxes » Label and 

texts tabs. 

11. Click Appearance tab and select where you want to display the custom field you have created. 

 If you do not want to display the custom field on all screens where you work with the content item, you can select the 

checkboxes of only those screens where you want the field to be displayed. To do this, select Some screens where you 

work with <content type> in the Backend… and select the screens where you want the custom fields to appear. 

NOTE: When you are adding a custom field to Images, Videos, or Document, this field is displayed on the upload screen, 

when you upload items via the Image, Video, or Document link widgets. If you do not want to display the custom fields, 

deselect the upload screens. 

 If in Step 6 you have made the field a hidden field, radio button Nowhere. This is a hidden field is selected on Appearance 

tab when you open the field for editing. If you change the selection, the field is no longer hidden. 

 If the field is not hidden, you can hide it by selecting Nowhere. This is a hidden field radio button. 

12. On Appearance tab, in CSS class input field, you can choose a class name for the custom field if later you want to set a CSS 

style for this particular field. 

13. Click Done. 

The new field appears in Custom fields section. 

If you want to delete a custom field, click . 

14. Click Save changes. 

To go back to the page with the content items, click Go back.  

RELATED DATA CUSTOM FIELD 

The Related data custom field gives you the possibility to relate one content item to another. Then, you can make related items to 

be displayed as a link on the frontend. 

EXAMPLE: Use the Module Builder to create a dynamic module Authors. The module will store information about different 

authors. Create a page where you drop the Authors widget. Open the News module and created a custom field of type Related 

data and Data type Authors. In the backend, when you create a news item, you see the custom field added. There you can choose 

an author that will be related to the news item. Then, you add the Authors field to the widget template of the News widget. When 

you open the site and click a news item, you will see the details of the news item and the link to the author’s details. 

To add a Related data custom field, perform the following: 

1. Perform procedure Creating a new custom field » Step 1 to Step 5. 

2. In Data type dropdown box, select the data type which you want to relate. 

You can select dynamic data types, built-in data types, and pages. 

For example, you can relate Events to News or Pages, or you can relate them to a dynamic type, created with the Module 

builder. 

3. In Source, select the provider where you want to store the related media items. 

4. Click Continue. 

5. Under Interface widget for uploading or selecting items, select the widget that you want to use in the backend to select the 

related item. 

Depending on the data type, it can be a content or page selector. 
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6. In Label input field enter the label of the selector. 

This label is displayed when you create a content item in the backend. 

For example, Related items. 

7. In Instructional text, enter instructions or explanatory text for the custom field, if needed.  

8. Select the This is a required field checkbox, if you want to make the custom field mandatory. 

9. Under Display selected items on the frontend using..., select the widget that you want to use to display the selected data type 

on the frontend of your site. 

By default, the related item is displayed as a link. When you click the link, the system take you to the default page for 

displaying the related data type. For more information, see Default pages for content items. 

For example, if you are creating a custom field for the News module that is data type Authors. The link to the author will be 

displayed with each news item. When you click it, the system takes you to the default page for displaying authors. 

You can also use the built-in widget of the content type for which you are creating the custom data field. 

For example, if you are a custom field for the News module that is data type Authors, you can use the News widget to display 

the authors. 

10. In Label input field enter the label of the link that will be displayed on the frontend. 

For example, See authors details. 

11. Click Done. 

The new field appears in Custom fields section. 

If you want to delete a custom field, click . 

12. Click Save changes. 

13. Insert the custom field in the respective widget template. 

For example, if you want to relate News to Author, you must insert the Authors custom field in the widget template that you 

use to display news items. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

NOTE: When you delete an item that has related data custom field added to it, you can choose to display a warning message. 

This way, you can avoid breaking links from other content items or pages.  

To do this, perform the following: 

1. Click Administration  Settings  Advanced. 

2. In the tree on the left, click RelatedData and select Display a warning message to prevent users from deleting items that are 

related to another items checkbox. 

3. Save your changes. 

RELATED MEDIA CUSTOM FIELD  

You use this field to add an option to attach a media to a content item in the backend and then display the media together with 

the item on the frontend. 

EXAMPLE: You add an image custom field to the News module. Then, you create a news item. You can see the custom field and 

you can use it to add one or more images to the news item. Then, you must add the image custom field to the widget template of 

the News widget. When you drop the widget on a page, the website displays news, together with images. 

You can add a media field to built-in and dynamic modules, as well as pages. The supported media types are images, videos, and 

files. 

To add a media field to a module or page, perform the following: 

1. Perform procedure Creating a new custom field » Step 1 to Step 5. 

2. In Type, select Related media. 

3. In What kind of media this field will manage?, select one of the following: 

 Images 

 Videos 

 Documents and other files 

4. In Source, select the provider where you want to store the related media items. 
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5. Click Continue. 

6. Under Display selected items on the frontend using..., select the widget that you want to use in the backend to upload or 

select an uploaded media file. 

By default, images are uploaded with the Image selector, videos – with the Videos selector, documents and other files – with 

File selector. 

7. In Label input field enter the label of the textbox. 

This label is displayed when you create a content item in the backend. 

For example, News images. 

8. In Instructional text, enter instructions or explanatory text for the custom field, if needed.  

9. Select the This is a required field checkbox, if you want to make the custom field mandatory. 

10. Click Limitations tab. 

11. In How many files can be uploaded or selected? radio button, select if you want to allow multiple media files to be uploaded. 

12. In Max file size can be uploaded field, enter the maximum file size in MB. 

13. Under Allowed file types, perform one of the following: 

 If you are adding images or videos as related media, select the checkboxes of the file types that you allow. If the files 

that you want to allow are not in the list, enter them in a comma-separated list in Other textbox. 

 If you are adding documents and other files as related media, select whether you want to allow all file types or only 

selected file types. If the files that you want to allow are not in the list of selected file types, enter them in a comma-

separated list in Other textbox. 

14. Click General tab. 

15. Under Frontend widget for displaying selected <media type>, select the widget that you want to use to display the selected 

media type on the frontend of your site 

The following table lists the default widget for each media type: 
 

Media type Default widget 

Single image Image 

Multiple images Image gallery 

Single video Video 

Multiple videos Video gallery 

Single file Document link 

Multiple files Downloadable list 

16. In Label input field enter the label of the media widget. 

For example, Watch video. 

17. Click Done. 

The new field appears in Custom fields section. 

If you want to delete a custom field, click . 

18. Click Save changes. 

19. Insert the custom field in the respective widget template. 

For example, if you want to relate News to Images, you must insert the images custom field in the widget template that you 

use to display news items. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

ADDRESS CUSTOM FIELD 

The Address custom field is available only when you create dynamic modules. For more information, see Sitefinity Installation and 

Administration Guide » Modules & Services » Creating the dynamic module. 
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The field gives the user the opportunity to select an address of the dynamic content item. 

To add an address field, perform the following: 

1. On Step 4 of procedure Sitefinity Installation and Administration Guide » Modules & Services » Creating the dynamic module » 

Creating a content type, click Add a field… 

2. Enter the name of the address field. 

For example Location. 

3. In Type dropdown box, select Address. 

4. In Interface widget for entering data, select Address and map. 

5. Click Continue. 

6. Select the method for entering the address by choosing one of the following: 
 

Address form only When creating a dynamic item you can enter the Country, the City, the Zip, and the Street. 

Map only When creating a dynamic item you can pinpoint the address on the world map. 

Address form and map When creating a dynamic item you can enter the Country, the City, the Zip, and the Street 

and also pinpoint the address on the world map. 

NOTE: In order to use a map for entering the address, you must setup Google Maps. 

For more information, see Google maps. 

7. Click Done. 

The new field appears in Custom fields section. 

If you want to delete a custom field, click . 

8. Click Save changes. 

To go back to the page with the content items, click Go back.  

EDITING AN EXISTING DATA FIELD 

To edit a custom or default field of a content item or page, perform the following: 

1. Open the page of that content type. 

For example, open the Images page or the Events page. 

2. In the right side of the page, click Custom Fields for <content type> link. 

The <Content type> data fields page appears. The system displays a list of all custom and default fields for that content type. 

For example, on News page, click Custom fields for news link and the News data fields page appears. 

NOTE: For custom fields, you can only edit how the field looks like and where it is displayed, you cannot change its type or 

the widget it uses. For default fields, you can only edit where the field is displayed. You cannot delete a default field. 

3. To edit a custom field, in Custom fields section, click the name of the field you want to edit. 

The Settings window appears. 

Perform procedure Creating a new custom field » Step 10 to Step 13. 

4. To edit a default, in Default fields section, click the name of the field you want to edit. 

The Edit a field window appears. 

Perform procedure Creating a new custom field » Step 11 and Step 13. 

5. To save your work, click Save changes. 

| Custom fields | Website content | Table of contents | 

THE TEXT EDITOR 

Use the text editor to create text, which can then be published on the website. 

The text editor is available to create content blocks, blog posts, events, news, and more. 

The following screenshot shows the text editor in advanced mode, displaying all formatting options: 
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Section contents 

 Formatting text 

You can enter text directly in the editor and use the editor’s formatting text functions. 

 Formatting paragraphs 

Using the text editor you can also format paragraphs. 

 Copying and pasting 

You can insert already created content from another source using editor’s different pasting functions. 

 Inserting and removing hyperlinks 

You can create hyperlinks to webpages, e-mails, and anchors in the text. 

 Inserting objects 

You can insert various objects, such as tables, images, documents, symbols, and more.  

 Undoing, redoing, and other shortcut key functions 

The text editor also has functions that are not part of the toolbar, such as undoing and redoing. 

 Other toolbar functions 

You can use additional toolbar and shortcut key functions, such as spellchecking, printing, finding and replacing, and more. 

 Use the text editor in HTML mode 

You can enter and edit text as HTML code. 

The functions in the toolbar are divided in two types of modes – basic mode and advanced mode.  

To switch between the two modes, use the button in the upper-right corner of the text editor. 

 If you are in basic mode, click More formatting options. 

The advanced mode of the text editor is displayed. 

 If you are in advanced mode click Basic formatting options. 

The basic mode of the text editor appears. 

 Toolbar buttons reference 

A complete list of all toolbar functions and in which section you can find information about them. 

| Table of contents | 

FORMATTING TEXT 

Using the Text Editor, you can change the font and the size of the text, make text bold or italic, and superscript and subscript text. 

You can also change the color of the text and apply background color. 

To do this you use the following toolbar functions, which are displayed as buttons in the toolbar of the text editor: 
 

Button 

Quick info 

text  

Procedure Example 

 Use this button to apply bold formatting to the text. 

6. Select the text which you want to make bold or place the cursor inside a word. 

Normal text 

Bold text 
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Bold 

(CTRL+B) 

7. Click Bold button. 

The system makes the selected text bold. 

 
Italic 

(CTRL+I) 

Use this button to apply italic formatting to the text. 

1. Select the text which you want to make italic or place the cursor inside a word. 

2. Click Italic button. 

The system makes the selected text italic. 

Normal text 

Italic text 

Bold and italic 

text 

NOTE: The above toolbar functions are displayed in the toolbar of the text editor in basic mode. If you need more formatting 

functions, click More formatting options button in the upper-right corner of the editor. 

For more information, see Additional text formatting functions. 

| Using the text editor | Table of contents | 

ADDITIONAL TEXT FORMATTING FUNCTIONS 

The following formatting options appear in the toolbar of the text editor when you click More formatting options button in the 

upper-right corner of the editor. 
 

Button 

Quick info 

text  

Procedure Example 

 

Font Name 

(CTRL+SHIF

T+F) 

Use this button to change the font of text. 

1. Select the text which font you want to change or place the cursor inside a word. 

2. Click the Font Name dropdown box and select the desired font. 

The system changes the font of the selected text. 

Text in Times New 

Roman font. 

Text in 

Courier New 

font 

 

Real font 

size 

Use this button to change the font size of text. 

1. Select the text which size you want to change or place the cursor inside a word. 

2. Click the Real font size dropdown box and select the desired font size. 

The system changes the size of the selected text. 

Text 10 pixels big 

Text 20 

pixels big 

 

Foreground 

Color 

Use this button to change the color of the selected text. 

Select the text which color you want to change and do one of the following: 

 If the already selected color is the color you want to use, click the letter . 

In this example the already selected color is green. 

 If you want to use different from the already selected color, click the arrow  . 

In the dropdown box that appears, click the color which you want to use as text color. 

The system colors the text in the selected color. 

Text colored red 

Text colored blue 

 

Background 

Color 

Use this button to change the background color of the selected text. 

Select the text which background you want to color and do one of the following: 

 If the already selected color is the color you want to use, click the bucket . 

In this example the already selected color is yellow. 

 If you want to use different from the already selected color, click the arrow  . 

In the dropdown box that appears, click the color which you want to use as background. 

The system colors the background of the selected color. 

Text with green 

background 

Text with yellow 

background 

 Use this button to make the text appear smaller and above the line of text. NormalSuperScript 
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SuperScript 
1. Select the text you want to superscript or place the cursor inside a word. 

Usually you do not need to have a space between the normal text and the superscripted 

text. 

2. Click SuperScript button. 

The system makes the selected text appear smaller and above the line of the normal 

text. 

Click the button again to switch to normal text typing. 

25th of May 

 

Subscript 

Use this button to make the text appear smaller and below the line of text. 

1. Select the text you want to subscript or place the cursor inside a word. 

Usually you do not enter a space between the normal text and the subscripted text. 

2. Click Subscript button. 

The system makes the selected text appear smaller and below the line of the normal 

text. 

3. Click the button again to switch to normal text typing. 

NormalSubscript 

Sx>1 

NOTE: To go back to basic mode of the text editor, click Basic options only button in the upper-right corner of the text editor. 

| Formatting text | Using the text editor | Table of contents | 

FORMATTING PARAGRAPHS 

Using the Text Editor, you can make numbered and bulleted lists, align paragraphs, and change the style of paragraphs.  

To do this you use the following toolbar functions, which are displayed as buttons in the toolbar of the text editor: 
 

Button 

Quick info 

text  

Procedure Example 

 
Numbered 

List 

 

Use this button to create and remove numbered lists. 

CREATING A NUMBERED LIST 

1. Select two or more consecutive paragraphs you want to be numbered and click 

Numbered List. 

The system inserts a number to each paragraph, starting from one. 

2. If you need the paragraph(s) following the numbered list to be also part of the list, 

select the paragraph(s) and click Numbered List. 

INSERTING MORE NUMBERED PARAGRAPHS 

If you want to insert a numbered paragraph inside a numbered list, perform the following: 

 To insert a number at the beginning of the list, place the cursor at the beginning of 

the first paragraph and press ENTER. 

The system inserts a new paragraph numbered 1 and adjusts the following numbers. 

 To insert a number in the middle of a numbered list, place the cursor at the end of 

the paragraph after which you want to insert the new numbered paragraph and press 

ENTER. 

The system inserts a new paragraph with the respective number and adjusts the 

following numbers. 

 To insert a number in the end of a numbered list, place the cursor at the end of the 

last paragraph and press ENTER. 

The system inserts a new paragraph with the respective number. 

REMOVING NUMBERING 

The following is a 

numbered list: 

1. Step one 

2. Step two 

3. Step three 

The following is a 

numbered list that 

has been 

discontinued by a 

non-numbered 

paragraph: 

1. Step one. 

2. Step two. 

3. Step three 

A non-numbered 

paragraph. 

1. Step four. 

2. Step five. 

The following is a 

numbered list with 

second level 

numbered list. 

1. Step one. 

2. Step two. 

1. Step 

one of 
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 If you want to remove the numbering, select the paragraph(s) which you do not want 

to be numbered and click Numbered List again. 

 If you want to end your numbered list and continue with normal paragraphs, place 

the cursor at the end of the last numbered paragraph and press ENTER twice. 

You cannot have an unnumbered paragraph inside the numbered list. If you remove the 

numbering of a paragraph that is in the middle of a numbered list, the system restarts the 

numbering for the paragraphs following this paragraph. 

CREATING SUB LIST OF A NUMBERED LIST 

To make a numbered list to have more than one level of numbering, perform the 

following: 

1. Select the numbered paragraph which you want to become a sub list of the numbered 

paragraph above it and click  Indent button. 

The system moves the selected numbered paragraph to the right and restarts the 

numbering of this paragraph from 1. The numbering of the rest of the paragraphs is 

adjusted accordingly. 

2. To continue the numbering at that second level, either select the next paragraph and 

perform Step 1, or, if you need new paragraph, place the cursor at the end of the 

second level numbered paragraph and press ENTER. 

3. To return on the first level of numbering, select the second level numbered paragraph 

and click  Outdent button. 

step 

two. 

2. Step 

two of 

step 

two. 

3. Step three 

 
Bullet List 

Use this button to create and remove bulleted lists. 

CREATING A BULLETED LIST 

1. Select two or more paragraphs you want to be bulleted list and click Bullet List. 

The system indents the paragraphs to the right and inserts a bullet to each 

paragraph. 

2. If you need the paragraph(s) following the bulleted list to be also part of the list, 

select the paragraph(s) and click Bulleted List. 

INSERTING MORE BULLETED PARAGRAPHS 

If you want to insert a bulleted paragraph inside a bulleted list, perform the following: 

 To insert a bullet at the beginning of the list, place the cursor at the beginning of the 

first paragraph and press ENTER. 

The system inserts a new paragraph with a bullet. 

 To insert a bullet in the middle of a bulleted list, place the cursor at the end of the 

paragraph after which you want to insert the new bulleted paragraph and press 

ENTER. 

The system inserts a new paragraph with a bullet. 

 To insert a bullet in the end of a bulleted list, place the cursor at the end of the last 

paragraph and press ENTER. 

The system inserts a new paragraph with a bullet. 

REMOVING BULLETS 

 If you want to remove a bullet, select the paragraph(s) which you do not want to be 

bulleted and click Bullet List. 

 If you want to end your bulleted list and continue with normal paragraphs, place the 

cursor at the end of the last bulleted paragraph and press ENTER twice. 

CREATING SUB LIST OF A BULLETED LIST 

The following is a 

bulleted list: 

 Item one 

 Item two 

 Item three 

The following is a 

bulleted list with 

second level 

bulleted list. 

 Item one. 

 Item two. 

 Item 

one of 

Item 

two. 

 Item 

two of 

Item 

two. 

 Item three 
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To make a bulleted list to have more than one level of bullets, perform the following: 

1. Select the bulleted paragraph which you want to become a sub list of the bulleted 

paragraph above it and click  Indent button. 

The system moves the selected bulleted paragraph to the right and changes the type 

of bullets used. 

2. To insert more bullets at that second level, either select the next paragraph and 

perform Step 1, or, if you need new paragraph, place the cursor at the end of the 

second level bulleted paragraph and press ENTER. 

To return at the first level of bullets, select the second level bulleted paragraph and click 

 Outdent button. 

NOTE: The above toolbar functions are displayed in the toolbar of the text editor in basic mode. If you need more formatting 

functions, click More formatting options button in the upper-right corner of the editor. 

For more information, see Additional paragraph formatting functions. 

| Using the text editor | Table of contents | 

ADDITIONAL PARAGRAPH FORMATTING FUNCTIONS 

The following formatting options appear in the toolbar of the text editor when you click More formatting options button in the 

upper-right corner of the editor. 
 

Button  

Quick info 

text  

Procedure Example 

 
Align Left 

Use this button to align a paragraph to the left. 

1. Select the paragraph you want to align or place the cursor inside the 

paragraph. 

2. Click Align Left button. 

The system aligns only the selected paragraph to the left.  

You can align all paragraphs at once by pressing CTRL+A and clicking Align Left 

button. 

This is a paragraph aligned 

to the left. It means that in 

the left side of the 

paragraph, all words are 

vertically aligned. 

 
Align Right 

Use this button to align a paragraph to the right. 

1. Select the paragraph you want to align or place the cursor inside the 

paragraph. 

2. Click Align Right button. 

The system aligns only the selected paragraph to the right.  

You can align all paragraphs at once by pressing CTRL+A and clicking Align Right 

button. 

This is a paragraph aligned 

to the right. It means that in 

the right side of the 

paragraph, all words are 

vertically aligned. 

 
Align Center 

Use this button to align a paragraph around the center of the screen. 

1. Select the paragraph you want to align or place the cursor inside the 

paragraph. 

2. Click Align Center button. 

The system centers the paragraph and distributes all words evenly to the right and 

to the left.  

You can align all paragraphs at once by pressing CTRL+A and clicking Align 

Center button. 

This is a centered 

paragraph. It means that 

with respect to the center of 

the screen, all words are 

distributed evenly to the 

right and to the left. 

 Use this button to align both the left and the right side of a paragraph. This is a justified paragraph. 

Both its right and left sides 
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Justify 1. Select the paragraph you want to justify or place the cursor inside the 

paragraph. 

2. Click Justify button. 

The system aligns both sides of the paragraph and automatically adds spaces 

where needed so that the paragraph looks uniformly distributed.  

You can justify all paragraphs at once by pressing CTRL+A and clicking Justify 

button. 

are aligned and spaces are 

added where needed. 

 
Indent 

Use this button to move a paragraph to the right.  

1. Select the paragraph you want to indent or place the cursor inside the 

paragraph. 

2. Click Indent button. 

The system moves the paragraph to the right regardless of its alignment. Each 

time you click this button, the paragraph is indented further to the right. 

This is a normal paragraph 

with no indents. 

This is a paragraph 

indented once. 

 

 
Outdent 

Use this button to reverse the indentation of a paragraph and move it to the left. 

1. Select the paragraph you want to outdent or place the cursor inside the 

paragraph. 

To outdent a paragraph it must have been indented first. 

2. Click Outdent button.  

The system moves the paragraph to the left regardless of its alignment. Each time 

you click this button, the paragraph is outdented further to the left until it 

becomes a normal paragraph with no indents. 

This is a paragraph 

indented once. 

This is the above paragraph 

outdented once. It is again 

a normal paragraph aligned 

to the right.  

 
Paragraph 

Style 

Use this button to set predefined style to certain types of paragraphs. This saves 

time to format each paragraph separately and makes your text styling look 

consistent. If the predefined style from the Paragraph Style dropdown changes, all 

paragraphs, which are formatted with this style, change. To change predefined 

styles, you need to be an advanced user or developer and need to have the proper 

permissions. For more information, see the  RadEditor developer’s 

documentation. 

1. Select a paragraph to which you want to apply a standard style or place the 

cursor inside the paragraph. 

2. Open the Paragraph Style dropdown box by clicking it. 

A list of predefined styles appears. 

3. Select the predefined style. 

The system applies the predefined style to the paragraph. 

Before formatting: 

 
 

After formatting: 

 

 
New 

Paragraph 

Use this button to insert a new paragraph. It is not the same as pressing ENTER. 

By pressing ENTER you create a new paragraph, but the system keeps the 

alignment of the previous paragraph. 

By clicking New Paragraph you create a new paragraph with default left alignment. 

This is a right aligned 

paragraph. 

After pressing ENTER I 

keep the alignment. 

After pressing New 

Paragraph the alignment 

changes to left. 

NOTE: To go back to basic mode of the text editor, click Basic options only button in the upper-left corner of the text editor. 

| Formatting paragraphs | Using the text editor | Table of contents | 

http://www.telerik.com/help/aspnet-ajax/paragraphstyles.html
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COPYING AND PASTING  

The following formatting options are used to insert content in the text editor from another location and to move and copy content 

within the text editor. You can use these functions by selecting them from the context menu in the text editor. Function Paste from 

Word is available as a button in the basic mode of the toolbar. 
 

Button 

Quick info 

text  

Procedure Example 

 
Cut 

CTRL+X 

Use this function to move content from one place on the page 

to another place on the page or to another location. 

1. Select the content which you want to relocate. 

2. Open the context menu and select Cut or press CTRL+X. 

The system removes the selected content and copies it to 

the clipboard. 

3. Place the cursor where you want the content to appear 

and choose one of the paste options bellow. 

NOTE: Only the last piece of content you cut can be pasted. If 

you cut something and then you copy or cut another thing. The 

first thing you cut is lost. 

 

 
Copy 

CTRL+C 

Use this function to copy content from one place on the page 

to another place on the page or to another location. 

1. Select the content which you want to copy. 

2. Open the context menu and select Copy or press CTRL+C. 

The system removes the selected content and copies it to 

the clipboard. 

3. Place the cursor where you want the content to appear 

and choose one of the paste options above. 

NOTE: Only the last piece of content you copy can be pasted. 

If you copy something and then you copy or cut another thing. 

The first thing you copied is lost. 

 

 
Paste form 

Word 

Use this button to paste text or tables from Microsoft Word. 

The editor automatically removes all unnecessary Microsoft 

Office related tags. 

1. Copy or cut text or tables from Microsoft Word. 

2. In the text editor, place the cursor where you want the 

text to appear and click Paste from Word.  

NOTE: If you are pasting Word content using only Paste 

function or CTRL+V, a dialog box appears where you must 

confirm that you want to clean all unnecessary Microsoft Office 

related tags. 

Text on the clipboard (copied from 

Word): 

Heading 

Paragraph text, some of which is italic, other 

bold. 

Text pasted from Word (appears the 

same, but is cleaned from Microsoft Word 

tags): 

Heading 

Paragraph text, some of which is italic, other 

bold. 

 
Paste  

CTRL+V 

Use this button to paste content from the clipboard in the text 

editor. 

1. Copy or cut content. 

2. In the text editor, place the cursor where you want the 

content to appear. 

Text on the clipboard (copied from a 

browser):  

Heading 

Paragraph text, some of which is italic, other 
bold.  
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3. Press CTRL+V or open the context menu and select 

Paste. 

Text pasted: 

Heading 

Paragraph text, some of which is italic, other 
bold.  

 
Paste Plain 

Text 

Use this button to paste content without keeping its formatting 

from the clipboard in the text editor. 

1. Copy or cut content. 

2. In the text editor, place the cursor where you want the 

content to appear. 

3. Open the context menu and select Paste Plain Text. 

The text editor removes all the formatting from the content and 

pastes only plain text, but keeps the line breaks. 

Text on the clipboard:  

Heading 

Paragraph text, some of which is italic, other 

bold. 

Text pasted as plain text: 

Heading  

Paragraph text, some of which is italic, 

other bold.  

 
Paste As 

Html 

Use this button to paste content from the clipboard as HTML 

code. 

1. Copy or cut content. 

2. In the text editor, place the cursor where you want the 

content to appear. 

3. Open the context menu and select Paste As Html. 

The text editor pastes the content in the form of HTML 

code. 

Text on the clipboard: Basic options 

Text pasted as HTML: 

<P style="MARGIN: 6pt 0in 0pt" 

class=MsoNormal><FONT size=2><FONT 

face=Arial>Basic 

options<?xml:namespace prefix = o 

ns = "urn:schemas-microsoft-

com:office:office" 

/><o:p></o:p></FONT></FONT></P> 

| Using the text editor | Table of contents | 

INSERTING AND REMOVING HYPERLINKS 

Use hyperlinks to forward the reader of the text to specific websites, documents, other places in the text, or an e-mail address. 

You can also write tooltips. You use the Hyperlink Manager to set such hyperlinks, anchors in text, and tooltips.  

To set and remove hyperlinks, use the following buttons, which are part of the basic display mode of the toolbar: 
 

Button  

Quick info 

text  

Procedure Example 

 
Hyperlink 

Manager 

(CTRL+K) 

SETTING A HYPERLINK TO A WEBPAGE 

1. Select a word or phrase which you want to make a hyperlink. 

2. Click Hyperlink Manager or press CTRL+K. 

A window appears. 

3. On Hyperlink tab, perform the following: 

a. In URL input field, enter the address of the webpage, which you want to 

reference. 

For example, www.sitefinity.com. 

b. In Link Text input field, enter the name of the link as you want it to appear on 

your webpage. 

By default the word or phrase that you have selected appears in the field. You 

can change the word that appears as a hyperlink on your webpage. 

c. In Target dropdown box, select the way you want the linked website to open 

when clicked. 

For example, in a New Window or in the Same Window. 

Link Text: 

Enter the following 

sentence in the text 

editor: 

Use Sitefinity to 

develop webpages. 

Select Sitefinity and 

open the Hyperlink 

Manager. 

In Link Text input field 

the word Sitefinity 

appears. 

If you leave it like this, 

on your webpage the 

following will appear: 
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d. In Tooltip input field, you can enter a tooltip text that appears as the user 

hovers over the hyperlink. 

e. In CSS Class you can change the formatting of the link by applying a specific 

CSS. 

4. When finished, click OK. 

The system sets the hyperlink and changes its formatting. 

NOTE: If you do not select a word or phrase, but only place the cursor where you want 

to set a hyperlink, the text that appears on the webpage as a hyperlink is the URL 

address of the webpage which you are linking.  

If you select a word or phrase, but delete the contents of the Link Text field, the URL 

address will appear instead of the selected word or phrase. 

SETTING A HYPERLINK TO AN E-MAIL ADDRESS 

1. Select a word or phrase which you want to make a hyperlink. 

When the hyperlink is clicked on the website it opens your e-mail client. 

2. Click Hyperlink Manager or press CTRL+K. 

A window appears. 

3. On E-mail tab, perform the following: 

a. In Address input field, enter the e-mail address which you want to reference. 

For example, john@sitefinity.com. 

b. In Link Text input field, enter the name of the link as you want it to appear on 

your webpage. 

NOTE: The Link Text input field appears only if you have not selected any text 

for the hyperlink. In this case you must enter text that appears as hyperlink 

text on your website. 

c. In Subject input field, enter the subject of the e-mail. 

You can predefine the subject of the e-mails. 

d. In Tooltip input field, you can enter a tooltip text that appears as the user 

hovers over the hyperlink. 

e. In CSS Class you can change the formatting of the link by applying a specific 

CSS. 

4. When finished, click OK. 

The system sets the hyperlink and changes its formatting. 

CREATING A TOOLTIP 

You can create a tooltip for a word or phrase which do not link to a website or a place in 

the text. The tooltip appears when the user hovers over the word or phrase. 

1. Select a word or phrase which you want to make a hyperlink. 

2. Click Hyperlink Manager or press CTRL+K. 

A window appears. 

3. On Hyperlink tab, in Tooltip input field, you can enter a tooltip text that appears as 

the user hovers over the hyperlink. 

4. When finished, click OK. 

NOTE: You can also set a tooltip for a hyperlink to a website or a hyperlink to an anchor 

in the text. For more information, see the above procedures. 

EDITING A HYPERLINK 

1. To edit a hyperlink, place the cursor on the hyperlink and open the context menu. 

2. Select Properties… 

The Hyperlink Manger opens. 

Use Sitefinity to develop 

webpages. 

You can then change 

the text of the 

hyperlink. For example, 

Sitefinity 4.2. 

Without link text: 

Enter the following 

sentence in the text 

editor: 

For more 

information, see 

Place the cursor at the 

end of the sentence, 

open the Hyperlink 

Manager, and enter 
www.sitefinity.co

m in the URL field. 

Leave the Link Text 

input field empty. 

The following appears 

on your webpage: 

For more information, 

see 

http://www.sitefinity.co

m 

Hyperlink to e-mail: 

Enter the following 

sentence. 

Contact us if you 

need help. 

Select Contact us, open 

the Hyperlink Manages 

and set a link to e-mail. 

In Address field enter 
john@sitefinity.c

om, in Subject field, 

enter support. 

The following will 

appear on the webpage 

Contact us if you need 

help. 

When the user clicks 

the link, her mail client 

opens a new email 

where 

john@sitefinity.com 

already appears in the 

address box and the 

subject of the e-mail is 

support. 
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For more information, see the respective procedure above. 

 
Remove Link 

(CTRL+SHIF

T+K) 

1. To remove a hyperlink to a webpage, a specific anchor in the text, an e-mail 

address, or a tooltip, place the cursor on the hyperlinked word or phrase. 

2. Click Remove Link in the toolbar, select Remove Link from the context menu of the 

link, or press CTRL+SHIFT+K. 

The system removes the link and the formatting. 

 

| Using the text editor | Table of contents | 

INSERTING OBJECTS 

Using the Text Editor, you can insert images, videos, tables and links to documents, and more in the text.  

To do this you use the following toolbar function, which is displayed as a button in the toolbar of the text editor: 
 

Button  

Quick info 

text  

Procedure 

 
Image 

Manager 

(CTRL+G) 

Use this function to insert an image in the text of the text editor. 

1. Place the cursor where you want the image to appear. 

2. Click Image Manager in the toolbar or press CTRL+G. 

The Select an image window appears where you choose between the following: 

 Select images from already uploaded 

The system displays recent images. 

a. In the right side of the window, select the library where the image you want to display is located. 

The system displays all images and libraries in this library. 

You can display all uploaded images by clicking All images. 

For more information, see Uploading and editing images. 

b. Click the image you want to display. 

c. Click Done. 

 Upload image 

a. To upload an image, drag and drop it in the window or click Select image from your computer, 

browse your computer to find the image you want to upload and click Open. 

You can select and display only one image. 

b. In Library, select the library where you want to put the image, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

NOTE: If you want to store the image in a new library, you must create it. To do this, click Create 

new library. 

c. You can change the Title of the image. 

d. In Alternative text input field, enter text that is used for accessibility reasons and by search engines. 

e. Change the categories and the tags which the image is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

f. If you have added any custom fields for images, all created fields, appear after the Categories and 

tags section. 

For more information about creating custom fields and hiding default fields, see Custom fields.  

NOTE: Some of the above fields may not be displayed when you upload an image, if the view has 

been modified. To modify the view, click Administration  Settings  Advanced  ContentView  

ImagesBackend  Views  SingleImageUploadDetailsView  Sections. 

g. Click Upload. 
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NOTE: If you are using multiple site management and the Libraries module uses data sources from more than 

one site, you must first choose the source from which you want to display images or where an image, 

uploaded from your computer, will be saved. 

To do this, use the dropdown button in the upper-right corner of the window. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

3. To change the selected image, click Change image button and perform Step 2. 

4. To edit the image, click Edit all properties. 

The Edit image window opens. Perform procedure Editing images. 

5. You can Crop/Resize/Rotate… the selected image. 

The Edit image window opens.  

a. Use the button to crop, resize or rotate by 90 degrees the image. 

b. When finished editing the image you can save the changes by clicking Save or save the edited image as a 

new image by clicking Save as and entering a new name. 

6. Choose how to align the image in the text editor. 

7. If you want to display the image in size different than its original size, in Image size, select the width to which 

you want to resize the image. 

In the dropdown box, all predefined image sizes appear. For more information, see Thumbnails. 

If you select Custom size… you can create a custom thumbnail by performing procedure Thumbnails  Step 4 

to Step 10. 

8. Expand Margin. 

Enter in pixels the margins that you want to surround the image when displayed on the site. 

9. If you want the user to be able to view the image in its original size by clicking it, select the Clicking the 

resized image opens the image in its original size checkbox. 

10. When you are finished, click Save. 

The Image window closes and the Image widget is configured to display the image you have selected.  

NOTE: To delete an already inserted image, in the text editor, click the image and press the DELETE key on your 

keyboard. 

NOTE: The above toolbar function is displayed in the toolbar of the text editor in basic mode. If you need to insert other objects, 

click More formatting options button in the upper-right corner of the editor. 

For more information, see Additional inserting functions. 

| Using the text editor | Table of contents | 

ADDITIONAL INSERTING FUNCTIONS 

The following inserting options appear in the toolbar of the text editor when you click More formatting options button in the upper-

right corner of the editor. 
 

Button  

Quick info 

text  

Procedure Example 

 
Media 

Manager 

Use this function to insert a video in the text of the text editor. 

1. Place the cursor where you want the video to appear. 

2. Click Media Manager in the toolbar. 

The Insert a video window appears where you choose between the following: 

 From your computer 

You must choose a video that has not been previously uploaded. 

a. Click Select…, browse your computer to find the video you want to upload and 

click Open. 

You can select and display only one video. 

In the text 

editor, an 

inserted video 

looks like this: 
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b. In Where to store the uploaded video?, select the library where you want to put 

the video, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

 From already uploaded  

You must choose a video that has already been uploaded. 

a. In the right side of the window, select the library where the video you want to 

display is located. 

The system displays all videos and libraries in this library. 

You can display all uploaded videos by clicking All videos. 

b. Click the video you want to display. 

For more information, see Uploading and editing videos. 

3. If you want to display the video in size different than its original size, in Resizing options, 

select Resize the video width to… radio button. 

a. From the dropdown box that appears, select the width to which you want to resize the 

video. 

b. If you select Custom size… the Width input field appears where you enter the desired 

width in pixels. 

4. When you are finished, click Insert the video. 

The Insert a video window closes.  

NOTE: To delete an already inserted video, in the text editor, click the video and press the 

DELETE key on your keyboard. 

 
Document 

Manager 

Use this function to insert a video in the text of the text editor. 

1. Place the cursor where you want the document link to appear. 

2. Click Document Manager in the toolbar. 

The Insert a document window appears where you choose between the following: 

 From your computer 

You must choose a document that has not been previously uploaded. 

a. Click Select…, browse your computer to find the document you want to upload 

and click Open. 

You can select and display only one document. 

b. In Where to store the uploaded document?, select the library where you want to 

put the document, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

 From already uploaded  

You must choose a document that has already been uploaded. 

a. In the right side of the window, select the library where the document you want 

to display is located. 

The system displays all documents and libraries in this library. 

You can display all uploaded documents by clicking All documents. 

b. Click the document you want to display. 

For more information, see Uploading and editing documents and files. 

c. If you want the link to the document to display a name different than the 

document’s name, in What title to display for this document? input field, enter the 

text on the document link. 

3. When you are finished, click Insert the document. 

The Insert a document window closes. The document arrears as a link. When you click the 

link, a download window appears. 

NOTE: To delete an already inserted link to a document, in the text editor, use the Remove 

Link button in the toolbar. 

In the text 

editor, an 

inserted 

document 

appears in the 

following way: 

Text, text, text 

MyDocument text 

text text. 
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Insert Table 

Use this function to insert a table in the text. 

For more information, see Insert a table in the text. 

Not available. 

 
Insert 

Symbol 

Use this function to insert symbols in the text. 

Put the cursor on the place where you want to insert a symbol and do one of the following: 

 If you want to use the last symbol you have selected, click the omega . 

 If you want to use different from the last symbol you have used, click the arrow  . 

In the dropdown box that appears, click the symbol which you want to insert in the text. 

The system inserts the symbol on the place you have put the cursor. 

 

 
Horizontal 

Rule 

Use this function to insert a horizontal line. The horizontal line serves as a border line for the 

paragraph after which it has been inserted. 

 To insert a horizontal line, perform the following: 

1. Place the cursor at the end of the paragraph which you want to separate with a 

horizontal line. 

2. Click Horizontal Rule button. 

If you have placed the cursor on a new line, the system inserts the horizontal line below 

the new line. 

If you have placed the cursor in the middle of a paragraph, the system splits the 

paragraph and inserts the line. 

 You can change the thickness, the length, and the color of the horizontal line.  

1. Select the line, by clicking it. 

2. Use the endpoints to drag the line to the size you desire. 

3. To change the color select the line and see Additional text formatting functions » 

Foreground Color. 

A horizontal 

line: 

 

Selecting the 

line: 

 

Adjusting the 

size by 

dragging 

endpoints: 

 

 

NOTE: To go back to basic mode of the text editor, click Basic options only button in the upper-right corner of the text editor. 

| Inserting objects | Using the text editor | Table of contents | 

INSERT A TABLE IN THE TEXT 

To insert a table in the text, perform the following: 

1. Place the cursor where you want to insert the table. 

In the toolbar, click  (Insert Table). 

A grid with box and table functions appear in a dropdown menu. 

2. To choose the size of the table, hover over the desired size in the grid and then click. 

NOTE: If your table is bigger that the grid cells available, use the Table Design tab of the Table Wizard to define the number 

of rows and columns. 

The table is inserted in the text. 

MODIFY THE SIZE OF THE TABLE 

 To increase the number of rows or columns, perform one of the following: 

 To add a row, perform the following: 

a. In the text editor, right-click the row where you want to insert the new row. 

A dropdown menu appear. 

b. Click either Insert Row Above or Insert Row Below. 

The new row in inserted above or below the selected row. 

 To add a column, perform the following: 
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a. In the text editor, right-click the column where you want to insert the new column. 

A dropdown menu appear. 

b. Click either Insert Column to the Left or Insert Column to the Right. 

The new column in inserted to the right or to the left of the selected column. 

 To decrease the  number of rows or columns, perform one of the following: 

 To delete a row, perform the following: 

a. In the text editor, right-click the row that you want to delete. 

A dropdown menu appear. 

b. Click Delete Row. 

c. The selected row is removed from the table. 

 To delete a column, perform the following: 

a. In the text editor, right-click the column that you want to delete. 

A dropdown menu appear. 

b. Click either Delete Column. 

The selected column is removed from the table. 

NOTE: You can also modify the size of the table on the Table Design tab of the Table Wizard. 

MERGE AND SPLIT CELLS 

 To merge cells, in the text editor, right-click the cell, which you want to merge. 

 To merge the selected cell horizontally, with the cell to the right, click Merge Cells Horizontally. 

 To merge the selected cell vertically, with the cell under, click Merge Cells Vertically. 

 To split a cell, in the text editor, right-click the cell, which you want to split. 

 To split a cell horizontally, click Split Cell Horizontally. 

 To split a cell vertically, click Split Cell. 

NOTE: You can also merge and split cells of the table on the Table Design tab of the Table Wizard. 

| Additional inserting functions | Inserting objects | Using the text editor | Table of contents | 

THE TABLE WIZARD 

You use the table wizard to configure table and cell settings, to change the design of the table, and to configure accessibility 

options. 

The Table Wizard contains the following tabs: 

 Table Design 

On this tab you can add and remove rows and merge and split cells. 

 To add or remove rows and columns, use Columns and Rows. 

Select a cell in the table by clicking it. 

a. To add a row, click  (Increase). 

The new row is inserted under the row which cell, you have selected. 

b. To add a column, click  (Increase). 

The new column is inserted to the right of the column which cell, you have selected. 

c. To delete a row, click   (Decrease). 

The selected row is deleted. 

d. To delete a column, click  (Decrease). 

The selected column is deleted. 

 To merge and split cells, use Column Span and Row Span. 

Select a cell, which you want to merge, by clicking it. 

 To merge the selected cell horizontally, with the cell to the right, in Column Span, click  (Increase). 
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 To merge the selected cell vertically, with the cell under, in Row Span, click  (Increase). 

 To split a horizontally merged cell, select it and in Column Span, click  (Decrease). 

 To split a vertically merged cell, select it and in Row Span, click  (Decrease). 

When finished designing the table, click OK. 

 Table Properties 

To modify the properties of the entire table, perform the following: 

1. In the text editor, right-click the table. 

A dropdown menu appear. 

2. Click Table Properties. 

You can change the following properties: 

 Height and width. 

 Cell spacing, padding, and alignment. 

 Apply a CSS class and background image 

3. When finished configuring the table properties, click OK. 

 Cell Properties 

To modify the properties of a single cell, perform the following: 

1. In the text editor, right-click the cell. 

A dropdown menu appear. 

2. Click Cell Properties. 

3. In the left, select one or more cells, which properties you want to modify. 

You can change the following properties for the selected cells: 

 Height and width. 

To enter the height or width as percentage, after the number, enter %. 

 Alignment. 

 Apply a CSS class and background image. 

 Select whether to wrap the text in the selected cells. 

4. When finished configuring the table properties, click OK. 

| Additional inserting functions | Inserting objects | Using the text editor | Table of contents | 

UNDOING, REDOING, AND OTHER SHORTCUT KEY FUNCTIONS 

The following are functions that are not displayed as buttons in the toolbar of the text editor, but you can use them with their 

shortcut key combinations. 
 

Command 

SHORTCUT KEY 

Procedure 

Undo 

CTRL+Z 

To reverse your last action, press CTRL+Z.  

You can reverse more than one action. 

Redo 

CTRL+Y 

To reverse your last Undo, press CTRL+Y.  

You can reverse more than one action that has been undone. 

You can use Redo command only after Undo command. 

Select all 

CTRL+A 

To perform a function on all the content in the text editor, you need to select it all. 

Place the cursor anywhere in the text editor and press CTRL+A. 
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Full screen 

F11 

To view the text editor in full screen mode, press F11. 

To exit the full screen mode, press F11 again. 

| Using the text editor | Table of contents | 

OTHER TOOLBAR FUNCTIONS 

The following options appear in the toolbar of the text editor when you click More formatting options button in the upper-right 

corner of the editor. 
 

Button  

Quick info 

text  

Procedure 

 
AJAX 

Spellchecker 

Use this function to check the text, which you have entered in the text editor, for spelling mistakes. 

 
Format 

Stripper 

Use the Format Stripper to remove certain types of formatting from the whole or portions of text. 

Select the text from which you want to remove formatting and perform the following: 

If you do not select any text the function is applied to all the content. 

 If you want to use the last format strip type, click the brush , which can be one of the following, 

depending on which one is last used: 

  with the quick info text Strip All Formatting. 

Removes all formatting from the text.  

The text appears in the default font and font size. Line breaks and indents are not preserved. 

  with the quick info text Strip CSS Formatting. 

Removes the CSS formatting from the selected text. 

  with the quick info text Strip Font Elements. 

Removes all fonts and font sizes. 

After you strip the font elements, the text appear in the default font and font size. 

  with the quick info text Strip Span Elements. 

Removes span elements from HTML code.  

A span element is an HTML tag that surrounds a text. This tag allows you to manipulate the text inside the 

span tag. For example, apply CSS or JavaScript. 

  with the quick info text Strip Word Formatting. 

Removes Microsoft Word formatting that is not suitable for the web. 

 If you want to use a strip function different from the last one you used, click the arrow . 

A dropdown list appears where you select one of the above stripping options. 

 
Find And 

Replace 

(CTRL+F) 

Use this button to find a word or phrase or part of a word in the text. You open the find and replace dialog by 

clicking Find And Replace or pressing CTRL+F. 

FINDING AN EXPRESSION 

1. To find a piece of text, on Find tab, in the Find input field, enter the word, part of it, or a phrase. 

 If you want the results of your search to be the exact case as the expression you have entered, select the 

Match case checkbox. 

 The expression you have entered can be a whole word, but can also be part of another word, if you want 

only whole words to appear in your search, select Match whole words checkbox. 

 You can also choose the direction in which to search – Up in the page or Down in the page from the point 

where the cursor is. 

2. Click Find. 
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The text editor highlights the first instance of the search expression. 

3. To find the next, click Find again. 

Repeat this step until you find what you are looking for. 

NOTE: If the expression you are searching for is not contained in the text, a dialog box appears informing you 

about this. 

FINDING AND REPLACING AN EXPRESSION WITH ANOTHER EXPRESSION 

To find a piece of text and replace it with another, on Replace tab, in the Find input field, enter the word, part of it, 

or a phrase. 

NOTE: If you have already used the Find tab to search for this expression, when you click the Replace tab, the 

Find input field already contains this expression. 

On Replace tab, you can perform the following: 

 Change some occurrences of the search expression with another expression. 

To do this, perform the following: 

1. In Replace With input field, enter the expression with which you want to change the search expression. 

2. Click Find Next. 

The text editor highlights the first occurrence in the page. 

3. If you want to change this occurrence of the expression with the one you have entered in Replace With 

input field, click Replace, else click Find Next until you find the expression you want to change. 

NOTE: You can change the expression in Replace input field and go to Step a. 

 Change all occurrences of the search expression with another expression at once. 

To do this, perform the following: 

1. In Replace With input field, enter the expression with which you want to change all occurrences of the 

search expression. 

2. Click Replace All. 

All occurrences of the search expression are changed and a dialog box appears informing you about their 

number. 

 
Print 

(CTRL+P) 

To print the content of the text editor, click Print or press CTRL+P. 

The system opens your browser’s default print dialog. 

 
Toggle Full 

Screen Mode 

(F11) 

Use this button to switch the text editor between normal and full screen mode. 

NOTE: To go back to basic mode of the text editor, click Basic options only button in the upper-right corner of the text editor.  

| Using the text editor | Table of contents | 

USING THE HTML MODE 

You can enter and edit text as HTML code by clicking HTML at the bottom of the text editor. 

If you have sufficient HTML knowledge, you can directly modify the text, by modifying the HTML code. 

EMBEDDING IMAGES, VIDEOS, AND DOCUMENTS 

You can make the text editor to display images, videos, and links to documents by embedding them in the HTML. 

To embed an object, perform the following: 

1. Open the Images, Videos, or Documents page respectively. 

2. Click Embed this images, Embed this video, or Embed link to this file respectively and copy the string of Embed input field. 

3. In the text editor, switch to HTML mode and paste the string where you want the object to appear. 
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To switch back to Design mode, click Design at the bottom of the text editor. 

| Using the text editor | Table of contents | 

TOOLBAR BUTTONS REFERENCE 

The buttons in this section work on a selected portion of text. For some tools, it is enough to position the mouse cursor in a word 

to apply the necessary formatting.  
 

Button Quick info text (SHORTCUT 

KEY) 

More information 

 

Bold (CTRL+B) Formatting text  

 

Italic (CTRL+I) Formatting text  

 

Numbered List Formatting paragraphs  

 

Bullet List Formatting paragraphs  

 

Hyperlink Manager (CTRL+K) Inserting and removing hyperlinks  

 

Remove Link (CTRL+SHIFT+K) Inserting and removing hyperlinks  

 

Image Manager (CTRL+G) Inserting objects  

 

AJAX Spellchecker Other toolbar functions 

 

Paste form Word Copying and pasting  

 

Align Left Additional paragraph formatting functions  

 

Align Right Additional paragraph formatting functions  

 

Align Center Additional paragraph formatting functions  

 

Justify Additional paragraph formatting functions  

 

Indent Additional paragraph formatting functions  

 

Outdent Additional paragraph formatting functions  

 

Font Name (CTRL+SHIFT+F) Additional text formatting functions 

 

Real font size Additional text formatting functions 

 

Paragraph Style Additional paragraph formatting functions  

 

Foreground Color Additional text formatting functions 

 

Background Color Additional text formatting functions 

 

Media Manager Additional inserting functions 

 

Document Manager Additional inserting functions 

 

New Paragraph Additional paragraph formatting functions  

file://telerik.com/Resources/Sitefinity/Documentation/v.5.x/Word%20files/Content_Writer's_Guide_5.0.docx%23_Additional_inserting_functions_1
file://telerik.com/Resources/Sitefinity/Documentation/v.5.x/Word%20files/Content_Writer's_Guide_5.0.docx%23_Additional_inserting_functions_1
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Insert Table Additional inserting functions 

 

Insert Symbol Additional inserting functions 

 

Horizontal Rule  Additional inserting functions 

 

SuperScript Additional paragraph formatting functions 

 

Subscript Additional text formatting functions 

 

Format Stripper Other toolbar functions 

 

Find And Replace (CTRL+F) Other toolbar functions 

 

Print (CTRL+P) Other toolbar functions 

 

Toggle Full Screen Mode Other toolbar functions 

| Using the text editor | Table of contents | 

CLASSIFYING CONTENT 

Using classifications, you can organize content items, such as news, events, and comments. 

  

In Sitefinity, there are two types of classifications: 

 Simple list 

Simple lists group content into a controlled set of categories. There is no relation between the classifications of the simple list. 

They are equal members of a single structure. 

 Hierarchical list  

By using this kind of classification, you can group content in hierarchy on more than one level. Relationship between a top 

level entry and a subentry in the hierarchy can mean group membership or refinement of the top classification by a particular 

characteristic or feature. 

EXAMPLE: Dogs can be one tag and Cats can be another. Both Dogs and Cats are simple lists, meaning that all items tagged 

with Dogs are equal members of Dogs structure, there are no relationships between dogs. On the other hand, you can have a 

category Animals, which has subcategories Dogs and Cats. This means that all cats are Cats and all dogs are Dogs, but also all 

cats and dogs are Animals. 

IMPORTANT: Classifications are shared across different sites. If you are using multiple sites, changing a classification on one site 

will change the classification on every other site that uses it. 

Section contents 

In Sitefinity there are two types of predefined classifications: 

file://telerik.com/Resources/Sitefinity/Documentation/v.5.x/Word%20files/Content_Writer's_Guide_5.0.docx%23_Additional_inserting_functions_1
file://telerik.com/Resources/Sitefinity/Documentation/v.5.x/Word%20files/Content_Writer's_Guide_5.0.docx%23_Additional_inserting_functions_1
file://telerik.com/Resources/Sitefinity/Documentation/v.5.x/Word%20files/Content_Writer's_Guide_5.0.docx%23_Additional_inserting_functions_1
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 Tags 

The tags are representing a simple list. 

 Categories 

The categories are presenting a hierarchical list. 

To view, create, edit, delete, and manage classifications, click Content » All classifications. 

The system displays a list of the predefined classifications – tags and categories, together with all created custom classifications. 

You add tags and categories to content items either while creating them or after that in the following way: 

 Adding categories and tags to a content item 

Use this procedure to add categories and tags to a content item either when creating it or when editing it. 

 Creating custom classifications 

In addition to Tags and Classifications, you can create custom classification. You can create either simple lists or hierarchical 

lists. 

| Website content | Table of contents | 

USING TAGS 

You use tags to filter content items according to some criterion. By clicking on different tags from the list of tags displayed on the 

webpage, the user can filter the content on the page. You can apply tags both to built-in types, such as news and events, as well 

as to dynamic types – types that you have created. 

You manage tags on the Tags  page. 

To open the Tags page, in the main menu in the upper part of the screen, click Content » Tags. 

The Tags page appears, displaying a list of all created tags together with actions you can perform on them.  

EXAMPLE: If you have a list of news, some of which are news about the weather and you have tagged them with the tag 

weather, and some news are about the traffic and you have tagged them with tag traffic, by adding the Tags widget to your page, 

you give the users the opportunity to filter only traffic or only weather news by clicking the respective tag. 

To display list of tags on your website, you must use the Tags widget and you must configure it. 

For more information, see Tags widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

Section contents 

On the Tags page you can perform the following: 

 Create a tag 

 Edit tags 

| Classifying your content | Website content | Table of contents | 

CREATING A TAG 

1. To create a tag, click Content » Tags. 

2. On Tags page perform one of the following: 

 If you have not created any tags, the system displays the following in the center of the screen: 

 

 If you have already created one or more tags, the system displays a list all created tags and the following button in the 

toolbar of Tags page: 

 

NOTE: If you are working in multilingual mode, before creating a tag, you must first choose the language in which you 

want to create the tag. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  
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3. Click Create a tag. 

The Create a tag  page appears. 

4. Enter the name of the tag. 

5. In Description input field, enter a description of the tag. 

6. You can change the automatically generated URL of the tag by clicking Change button and entering the new URL in the input 

field that appears. 

7. By clicking Advanced, you can perform the following: 

 Enter synonyms of the tag.  

You can filter your content items by the tag name or by the tag synonyms. 

 Change the automatically generated name used in the code by developers to refer to the tag, by clicking Change. 

8. When you are finished click one of the following: 

 Create 

The tag is created and the system returns you to Tags page. 

 Create and add another. 

Use this button if you want to create more tags. 

| Using tags | Classifying your content | Website content | Table of contents | 

EDITING TAGS 

EDITING A SINGLE TAG 

1. Go to the Tags page and open the tag for editing in one of the following ways: 

 Click the tag you want to edit. 

 Click the Actions link of the respective tag. 

From the dropdown list, click Properties. 

The Edit a tag page appears. 

2. Perform procedure Creating a tag » Step 4 to Step 7. 

3. When you are finished, click Save changes. 

EDITING ALL TAGS AT ONCE 

You can edit the URL name and the synonyms of all tags at the same time.  

1. To do this, click Bulk edit (URLs and synonyms) button in the toolbar of the page. 

The Bulk edit URLs and Synonyms page appears, displaying a list of all tags together with their URLs and synonyms. 

If you do not select any tags, all created tags appear in the page.  

2. Edit URLs and synonyms, by entering in the input fields of the respective tags. 

3. Click Save changes 

The system returns you to Tags page. 

DELETING TAGS 

1. To delete a tag, on Tags page perform one of the following: 

 Select the tag and click Delete button in the toolbar. 

 Click the Actions link of the tag you want to delete and click Delete. 

2. In the dialog box that appears confirm the deletion. 

BROWSING ITEMS THAT ARE TAGGED WITH A SPECIFIC TAG  

Use this function to view all items that are tagged with a tag and to remove the tag from items. 

 On Tags page, in column APPLIED TO, click <number> items link of the tag you want to explore. 

A list of items belonging to the selected tag appears. The list is divided according to content type.  

To view items of different content type, click the respective link above the list of the items. For example, Blog posts, News 

items. 
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 To remove the selected tag from one or more items, select the items and click Remove Tag <tag name> from the selected 

items button in the toolbar of the page. 

For example, Remove Tag Traffic from the selected item. 

 To view and change the properties of the tag, click Tag <category name> properties button in the toolbar of the page. 

For example, Tag Traffic properties.  

The Edit a tag page appears. 

For more information, see procedure Editing a single tag above. 

| Using tags | Classifying your content | Website content | Table of contents | 

USING CATEGORIES 

You use categories to filter content. By clicking different categories from the treeview displayed on the webpage, you can filter the 

content of the page. By using hierarchy of categories, you can filter content items according to more general or more specific 

criteria. You can apply categories both to built-in types, such as news and events, as well as to dynamic types – types that you 

have created. 

You manage categories on the Categories  page. 

To open the Categories page, in the main menu in the upper part of the screen, click Content » Categories. 

The Categories page appears, displaying a list of all created categories together with actions you can perform on them. 

EXAMPLE: You can have a list of events categorized according to their location. Some of the events are held in Europe, some in 

Asia. Some of the European events are held in Italy, some in France. If you have added category Italy to the Italian events and 

category France to the French and you have created those two categories as child categories of category Europe, then by adding a 

Categories widget to your page, you give the users the opportunity to filter all European events by clicking category Europe, which 

include both French events and Italian event, but also to go in depth and filter events with more specific locations, such as events 

held in France, by clicking France category. 

To display list of categories on your website, you must use the Categories widget and you must configure it. 

For more information, see Categories widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

Section contents 

On the Categories page you can perform the following: 

 Create a category 

 Structure the list of categories 

 Edit categories 

| Classifying your content | Website content | Table of contents | 

CREATING A CATEGORY 

1. To create a category, click Content » Categories. 

2. On Categories page perform one of the following: 

 If you have not created any categories, the system displays the following in the center of the screen: 

 

 If you have already created one or more categories, the system displays all created categories and the following button in 

the toolbar of Categories page: 

 

NOTE: If you are working in multilingual mode, before creating a category, you must first choose the language in which 

you want to create the news item. Select the language from Languages dropdown box in the right of the page. 

For more information about different languages, see Languages.  

3. Click Create a category or Create a Category respectively. 
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The Create a category  page appears. 

4. Enter the name of the category.  

5. Choose between the following radio buttons: 

 No parent 

The category you want to create is a top level category. 

 Select a parent… 

The category you want to create is under another category. For example, animals can be the parent category of 

mammals, and mammals can be the parent category of cats. 

A list of existing categories appears. Select the parent category of the new category and click Done. 

6. To add a description for the category, click Click to add a description. 

In the input field that appears, enter the description of the category. 

7. In URL name, you can change the automatically generated URL of the category by clicking Change button and entering the 

new URL in the input field that appears. 

8. By clicking Advanced, you can perform the following: 

 Enter synonyms of the category. 

You can filter your content items by the name of the category or by its synonyms. 

 Change the name used in the code by developers to refer to the category, by clicking Change. 

9. When you are finished click one of the following: 

 Create 

The category is created and the system returns you to Categories page. 

 Create and add another. 

Use this button if you want to create more categories. 

| Using Categories | Classifying your content | Website content | Table of contents | 

STRUCTURING THE LIST OF CATEGORIES 

Use this procedure to group content in hierarchy on more than one level.  

REORDERING CATEGORIES ON THE SAME HIERARCHICAL LEVEL 

To move a category up or down in the list of categories, click the Actions link of the respective category and then click Up or Down. 

The Create a category page appears. 

For more information, see Creating a category. 

MOVING CATEGORIES ON DIFFERENT HIERARCHICAL LEVELS 

 To create a sub category of a category, click the Actions link of the respective category and click Create a child category. 

The Create a category page appears. In section Parent category, the parent of the new category is already selected. 

For more information, see Creating a category. 

 To change the parent of a category, click the Actions link of the category which parent you want to change and then click 

Change parent category. 

A window appears, where you can choose between the following radio buttons and click Save changes: 

 No parent 

You choose this if you want the category to be a top level category. 

 Select a parent 

A list of existing categories appears. Select the new parent category of the category. 

| Using Categories | Classifying your content | Website content | Table of contents | 

EDITING CATEGORIES 

EDITING A CATEGORY 

1. To edit an already existing category, perform one of the following: 

 Click the category you want to edit. 
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 Click the Actions link of the respective category and then click Properties. 

The Edit a category page appears. 

2. Perform procedure Creating a category » Step 4 to Step 8. 

3. Click Save. 

The system returns you to Categories page. 

DELETING A CATEGORY 

1. To delete a category, on Categories page perform one of the following: 

 Select the category and click Delete button in the toolbar of the page. 

 Click Actions button of the category you want to delete and click Delete. 

2. In the dialog box that appears confirm the deletion. 

BROWSING ITEMS THAT BELONG TO A SPECIFIC CATEGORY 

Use this function to view all items that belong to a category and to remove items from a category  

 On Categories page, in column APPLIED TO, click <number> items link of the category you want to explore. 

A list of items belonging to the selected category appears. The list is divided according to content type.  

To view items of different content type, click the respective link above the list of item. For example, Blog posts, News items. 

 To remove one or more items from the selected category, select the items and click Remove Category <category name> from 

the selected items button in the toolbar of the page. 

For example, Remove Category Mammals from the selected items. 

 To view and change the properties of the category, click Category <category name> properties button in the toolbar of the 

page. 

For example, Category Mammals properties. 

The Edit a category page appears. 

For more information, see procedure Editing a category above.  

| Using Categories | Classifying your content | Website content | Table of contents | 

ADDING CATEGORIES AND TAGS TO A CONTENT ITEM 

You can add categories and tags to a content item either when creating it or when editing it. You do this by clicking Categories 

and tags section on the page where you create, upload, or edit a content item. 

ADDING CATEGORIES 

1. In Category section, click Click to add categories link. 

A treeview with all existing categories appears. 

2. You assign your content item to one or more categories by selecting their checkboxes and clicking Done button. 

3. If you have not still created any categories, or need another category for your content item, perform the following: 

c. Click Create a category link. 

The Create a category window appears. 

d. Enter the name of the category and choose between the following radio buttons: 

 No parent 

The category you want to create is a top level category. 

 Select a parent 

The category you want to create is under another category. For example, animals can be the parent category of 

mammals, and mammals can be the parent category of cats. 

A list of existing categories appears. Select the parent category of the new category. 

e. Click Create this category 

The new category you have created automatically appears as a selected category for the content item. 

4. To add more categories for the content item, click Change and perform Step 1 and Step 2. 

5. To delete categories assigned to the content item, click  (Remove this category). 
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ADDING TAGS 

In Tags section, perform one of the following: 

 In the input field that appears, enter a new tag name and click Add. 

 Click Select from existing link. 

From the list of all existing tags that appears, click the tags with which you want to tag the content item. 

To delete a tag assigned to the content item, click  (Remove this tag). 

| Classifying your content | Website content | Table of contents | 

CREATING CUSTOM CLASSIFICATIONS 

In addition to Tags and Classifications, you can create custom classification. You can create either simple lists or hierarchical lists. 

For example, you can create a custom classification Price range that is simple list and Location classification, which is hierarchical 

list of regions, where each region contains a list of countries.  

USING A CUSTOM CLASSIFICATION WITH CONTENT ITEMS AND PRODUCTS 

To classify a content item or product with a custom classification, you must add the classification as a custom field of a content 

item or as a custom filed of the product type Make sure to enter the same name in the custom field as the name of the 

classification. Finally, when you create or edit a content item or product, you must select the custom classification. 

To use custom classification to filter content items or products on the website, you must use the Classification or the Tags widget. 

You manage custom classifications on the Classifications  page. 

To open the Classifications page, in the main menu in the upper part of the screen, click Content » All classifications. 

The Classifications page appears, displaying a list of all created build-in and custom classifications together with actions you can 

perform on them. 

Section contents: 

 Creating and editing a custom classification 

 Creating and editing single classification items 

| Classifying your content | Website content | Table of contents | 

CREATING AND EDITING A CUSTOM CLASSIFICATION 

CREATING A CUSTOM CLASSIFICATION 

To create a custom classification, perform the following: 

1. Open the Classifications page, by clicking Content » All classifications. 

2. Click Create a classification. 

The Create a classification  page appears. 

3. In Classification input field, enter the name of the classification, for example, Dress code. 

4. In Single item name, enter the name of a single item in this classification, for example, Dress code type. 

5. Choose the Type of the classification, by selecting Simple list or Hierarchical list. For more information about types of 

classification, see Classifying content. 

6. To add a description of the classification, click Click to add a description. 

7. To change the name that is used in code to refer to that classification, click Change button and add a new name. 

8. When finished, click Create this classification. 

The classification appears on Classification page and the system takes you to create your first item from this classification. For 

more information, see procedure Creating single classification items below. 

EDITING CUSTOM CLASSIFICATIONS 

1. To edit the properties of a classification, go to Classifications page. 

NOTE: You cannot edit or delete the predefined classifications Tags and Categories. 
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2. Click the Actions link of the respective classification and from the dropdown box, click Properties. 

The Edit a Classification page appears. 

3. Perform procedure Creating a custom classification above » Step 3 to Step 7. 

NOTE: You cannot change the type of the classification. 

4. When finished editing, click Save changes. 

| Creating custom classifications | Classifying your content | Website content | Table of contents | 

CREATING AND EDITING SINGLE CLASSIFICATION ITEMS 

CREATING SINGLE CLASSIFICATION ITEMS 

1. To create a single item in a classification, open the classification by clicking it on Classifications page. 

For example, if you have created a custom classification Dress code, on Classification page, click Dress code to create different 

types of dress code. 

The <Classification name>  page appears. 

2. Click Create a <name of single item>. 

For example, click Create a Dress code type, to be able to create a dress code, such as Casual. 

The Create a <name of single item>  page appears. 

3. Enter the name of the classification item. 

For example, enter Casual. 

4. To add a description of the classification item, click Click to add a description. 

5. To change the automatically generated URL, click Change button and enter the new URL. 

6. By clicking Advanced, you can perform the following: 

 Enter synonyms of the classification item. 

 Change the name used in the code by developers to refer to the classification item, by clicking Change. 

7. When finished, click one of the following: 

 Create 

You create the item and go back to the page of the classification. 

 Create and add another  

The item is created and a new Create page appears. 

 Back to <Classification name> 

You go back to the page of the classification without creating the item. 

EDITING A SINGLE CLASSIFICATION ITEM 

1. To edit a classification item, open the classification, which the item belongs to, by clicking it on Classification page. 

2. In the list of classification items, click the item you want to edit. 

3. Perform the procedure above » Step 3 to Step 6. 

4. When finished, click Save changes. 

| Creating custom classifications | Classifying your content | Website content | Table of contents | 

TRANSLATING CONTENT ITEMS AND CLASSIFICATIONS 

You can create a new language translation of an item or classification. The system displays all language translation in which an 

item or a classification exists in the following way: 

 On the respective item page, for each item, the system displays: 
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NOTE: If you have created more than six language translation, on the respective item page the system displays only the first 

six language icons. To view all created languages, click More translations… link of the respective item. To display all languages 

for all items on the page, click Show all translations link in the upper-right corner of the page. 

 On the editing page of the item, for example news, the system displays: 

 

NOTE: Other translation icons are not displayed, when you edit an ecommerce product. 

 Language translations of an item, whose language icons are dark blue and have the Edit link next to the language icon, 

already exist. 

 Language translations of an item, whose icons are light blue and have the Add link next to the language icon, have not been 

created yet. 

If you are not using multiple languages, the system does not display language icons next to items and classifications. 

NOTE: Before you create an item in a different than the default language, you must have added this language in the settings of 

Sitefinity. 

For more information, see Languages. 

CREATING A NEW ITEM IN A DIFFERENT LANGUAGE 

To create a new item in a certain language, perform the following: 

1. Go to the page of the item. 

For example, go to Events page. 

2. From the Languages dropdown box on the right, select the language, in which you want to create the item. 

3. Perform procedure for creating the respective content item. 

For example, Creating an event. 

NOTE: For ecommerce products, you must first create the product in the default language and then perform the next procedure. 

TRANSLATING AN EXISTING CONTENT ITEM 

1. You create a new language translation in one of the following ways: 

 On the respective item page, click the Add link under the respective language icon. 

 Open the item in editing mode click the Add link of the respective language.  

2. Perform procedure for creating the respective item. 

For example, Creating a news item. 

NOTE: If you click the Compare translations link, the system opens a different translation of the item. The translation serves 

only as reference. You can change the displayed translation, by selecting the respective language in the Translate from: 

dropdown box. 

NOTE: Images, videos, and documents do not differ in the different languages, but you can add different title for each image or 

video in the different languages. For example, the same image can exist in English and Spanish with different titles. 

NOTE: When an item exists in different languages, each translation is displayed with its respective page translation. 

For example, a news item in Spanish is displayed in the News widget in the Spanish version of the page, the English news item is 

displayed in the English version of the page. If the French translation of the page contains the News widget, but there is no French 

version of the news, the widget does not display anything. 

To switch between different language translations of a page you must add and configure the Language selector widget to the 

page. 

EDITING A TRANSLATION OF AN ITEM 

Perform the following procedure: 

1. You edit a language translation of an item in one of the following ways: 

 On the page of the respective item, click the Edit link under the respective language icon. 
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 On the page of the respective item, in Languages field on the right, select the desired language and click the name of the 

item, which you want to edit. 

2. Perform the procedure for editing the respective item. 

For example, perform procedure Editing events. 

DELETING A LANGUAGE TRANSLATION OF A CONTENT ITEM 

On the page of the respective content item, you delete a language translation by selecting the respective language in Languages 

dropdown box and performing one of the following: 

 Select the content item(s), whose translation(s) you want to delete and click Delete button in the toolbar. 

 Click the actions link of the respective content item and click Delete. 

IMPORTANT: The system asks you if you want to delete only the current translation of the item or all translations of this item. 

| Website content | Table of contents | 

FEEDS 

Use feeds and notifications to publish frequently updated information. You can publish an RSS feed for a blog, news, or events on 

the website and the users can subscribe to this feed. This way they will receive updates of the blog, news, or events without 

having to visit the website. You can also publish content you create in Sitefinity as tweets via a Twitter account. 

NOTE: Feeds are shared across different sites. If you are using multiple sites, changing a feed on one site will change the feed on 

every other site that uses it.  

INCLUDED CONTENT 

You can publish as feed one of the following types of content: 

 Sitefinity content 

For example, you can publish a news or a blog post as RSS feed or as a tweet in Twitter. 

 External RSS feed 

For example, you can use an external RSS feed and publish it as news in Sitefinity. 

 Mail content 

For example, you can use the email messages of a particular mail account and publish them as an RSS feed on you website. 

 Forum 

For example, you can publish forum threads as RSS feed. 

PUBLISHED CONTENT 

You can publish the included content in one of the following types:  

 Sitefinity content 

 RSS feed 

 Twitter feed 

You manage feeds on Feeds & Notifications  page. 

To open the page in the main menu at the top, click Administration » Feeds & Notifications. 

You display the RSS feed in your website using the Feed widget. For more information, see Feed widget. 

For more information about caching the feed output, see Sitefinity Installation and Administration Guide » Settings » Configuring 

caching » Output caching for RSS. 

Section contents 

On Feeds & Notifications page you can do the following: 

 Create a feed 

 Edit, delete, and filter feeds 

| Website content | Table of contents | 
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CREATING A FEED 

1. On Feeds & Notifications page perform one of the following: 

 If you have not created any feeds, the system displays the following in the center of the screen: 

 

 If you have already created one or more feeds, the system displays a list all created feeds and the following button in the 

toolbar of Feeds & Notifications page: 

. 

2. Click Create a feed. 

The Create a feed  page appears. 

3. Enter the following information for the new page: 

Title In this input field, enter a title for the feed. 

The title is publicly visible and will be the title for the whole feed in the RSS reader. 

Description In this input field, enter description for the feed. 

The description is not publically visible. 

Active checkbox Select or deselect the Active checkbox to make the feed active or inactive. 

When a feed is active, new items that are created, such as events or news, are published in the 

feed.  

When you make a feed inactive, the newly published items do not become part of the feed. 

Change Data 

structure…button 

Click this button if you want to change the way fields are recorded in the database or if you want to 

create a new field that you will map to an existing field of the content you want to publish and to a 

field form the content type in which you want to publish. 

Content to include 

section 

In this section, you can choose the content that will serve as source content for the feed.  

By default the content that is selected to be included in the feed is Posts from all blogs.  

 You can delete the automatically selected content or other selected content by clicking  

(Remove).  

 You can change the settings of the selected content by clicking Change… button.  

 You can add more content by clicking Add another content type… button.  

The Select content source window appears. Select one of the following radio buttons: 

SITEFINITY CONTENT 

In this section, choose which Sitefinity items to include in the feed. 

By default the new feed includes blog posts from all blogs. 

 In Content type dropdown box, select the type of content include in the feed. 

If you have selected Blogs, in Which blog posts to display? radio button group, select one of 

the following: 

 From all blogs 

All published posts are included in the feed. 

 From selected blogs only… 

Click Select a blog. From the list that appears, select the blog whose posts you want to 

include in the feed and click Done selecting. 

 Select the page where the content is published, by clicking Select a page button. 

 To change the mapping of data fields, click Mapping Settings button. 
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In the window that appears, you have a list of the data fields of the feed you are creating. To 

these fields, you can map existing fields of the content type you have selected.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map a field from the content type to that newly created field. The content type 

fields, which can be mapped, can be both predefined and custom fields. For more information, 

see Custom fields. 

When you are finished with the mapping of fields, click Accept changes. 

NOTE: If you are using a dynamic module, the mappings are not predefined and you must 

explicitly set them. 

 Click Done. 

NOTE: Only published content is included in the feed. 

EXTERNAL RSS/ATOM FEED 

You can use as source content an external RSS feed.  

 Enter the URL of the external RSS or Atom feed. 

 Choose how many items to include by selecting one of the following radio buttons: 

 Include the newest <number> items 

In the input field, enter how many of the external RSS or Atom items you want to display. 

 Include all published items 

The feed displays all items from the external RSS or Atom feed. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To 

these fields, you can map existing fields of the RSS or Atom feed you have selected.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map a field from the RSS or Atom feed to that newly created field 

When you are finished with the mapping of fields, click Accept changes. 

 Click Done. 

MAIL CONTENT 

 Enter the name of the POP3 server. 

 Enter the port used by the server. 

 Select if you want Sitefinity to use Secure Sockets Layer (SSL) to encrypt the connection. 

 Enter the user name of the account that you use to connect to the mail server. 

 Enter the password of the account that you use to connect to the mail server. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To 

these fields, you can map existing fields of the mail you have selected.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map a field from the mail to that newly created field.  

When you are finished with the mapping of fields, click Accept changes.  

 Click Done. 

NOTE: Any attachments are disregarded and are not published. 

IMPORTANT: Every mail that is successfully retrieved is deleted from the POP3 server. 

FORUM 

 Select which forum posts to publish by choosing one of the following: 

 From all forums 
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All forum posts are published. 

 From selected forums 

Select posts from which forum to publish, by clicking Select forums button, selecting one 

or more forums, and clicking Done. 

 From selected threads 

Select posts from which threads to publish, by clicking Select thread button, selecting one 

or more threads, and clicking Done. 

 Filter which posts are displayed according to their publication date. 

To do this expand Narrow selection and perform the following: 

i. Select Selection of posts: radio button. 

ii. Select by Dates… and click Select button. 

iii. Choose one of the predefined intervals or enter a custom time interval using the From and 

To fields. 

iv. Click Done. 

 Select the page where the content is published, by clicking Select a page button. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To 

these fields, you can map existing fields of the forum that you have selected.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map a field from the mail to that newly created field.  

When you are finished with the mapping of fields, click Accept changes.  

Publish as… section In this section, you can choose how to publish the content you have selected in the previous step.  

By default the content is published as RSS feed.  

 You can delete the automatically generated RSS feed or other publishing method by clicking  

(Remove).  

 You can change the settings of the publishing method by clicking Settings… button.  

 You can add another method of export by clicking Add more… button.  

The Select content export method window appears. Select one of the following radio buttons: 

SITEFINITY CONTENT 

To publish the selected content as content in Sitefinity, for example, publish blog posts as news 

items, perform the following procedure: 

 In Import data as dropdown box, select whether to publish the selected content as Blogs, 

News, or Events. 

 If you select Automatically publish imported data, the items will be imported in status 

Published, otherwise, the will be imported as Draft. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the existing data fields of the Sitefinity content 

types. To these fields, you can map fields of the feed you are creating.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map this newly created field to a field of the content type. The content type 

fields, which can be mapped, can be both predefined and custom fields. For more information, 

see Custom fields. 

When you are finished with the mapping of fields, click Accept changes. 

 Click Done. 

RSS FEED 

To publish the selected content as RSS feed, perform the following procedure: 
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 In RSS or Atom to generate? radio button group, select the format for the feed. 

 In URL name, enter a URL of the feed. 

 Choose how many items to include in the feed by selecting one of the following radio buttons: 

 Include the newest <number> items 

In the input field, enter how many of the published items you want to display. 

 Include all published items 

The feed displays all items that are published. 

 Choose how to display the items in the feeds by selecting one of the following: 

 Title and content. 

 Title and first <number> characters. 

 Title only. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the feed you are creating. To 

these fields, you can map fields of the RSS or Atom feed you.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map a field from the RSS or Atom feed to that newly created field. 

When you are finished with the mapping of fields, click Accept changes. 

 Click Done. 

TWITTER FEED 

To publish the selected content as a Twitter feed, for example, publish your blog posts as tweets, 

perform the following procedure: 

 In Which Twitter application to use? select an application via which you want to publish your 

tweets. 

The list contains all Twitter applications which you have registered in Twitter and in Sitefinity. 

For more information, see Managing Twitter applications. 

When you select an application, in Select Twitter user for publishing, a list of all Twitter users 

registered for this application appear. 

 Select the Twitter user from whose account the tweets will be published. 

For example, you can register an application MyNews, but you can associate two accounts with 

that application – sports and weather. Some people may follow only the sports other may 

follow only the weather. 

For more information about associating Twitter users accounts with an application, see 

Managing Twitter applications. 

 To change the mapping of data fields, click Mapping Settings button. 

In the window that appears, you have a list of the data fields of the Twitter feed you are 

creating. To these fields, you can map fields of the feed you are creating.  

If you have created a new data field in the previous section, using the Change Data structure… 

button, you can map this newly created field to one of the Twitter fields. 

When you are finished with the mapping of fields, click Accept changes. 

 Click Done. 

4. When you are finished, click Save changes. 

The system saves the feed and returns you to Feeds & Notifications page. 

| Creating and editing feeds | Website content | Table of contents | 
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EDITING, DELETING, AND FILTERING FEEDS 

EDITING A FEED 

1. To edit a feed, on Feeds & Notifications page, click the feed you want to edit. 

The Edit a feed page appears. 

2. Perform procedure Creating a feed » Step 3 to Step 8. 

DELETING FEEDS 

To delete one or more feeds, on Feeds & Notifications page, perform one of the following: 

 Select one or more feeds and click Delete button in the toolbar of the page. 

 Click the Actions link of the respective feed and click Delete. 

A dialog box appears where you must confirm the deletion.  

FILTERING FEEDS 

You can filter feeds, using one of the following options in the right side of Feeds & Notifications page: 

 To filter feeds created by you, under Filter feeds click My feeds. 

 To filter feeds according to their status, under Filter feeds click Active feeds or Inactive feeds. 

 To filter feeds according to the date of their last update, under Filter feeds click By last publication. 

The Display feeds last updated in... pane appears. 

 When you click a time interval, the system displays all the feeds updated during this time interval.  

 To display feeds updated during some custom period of time, click Custom range… link. 

Use the From and To input fields. 

 To go back to all filtering options, click Close dates link. 

The system displays all filtering options, but displays the last filtering you have chosen until you choose something else. 

 To filter feeds according to the content type they are displaying, under Feeds by content type click Blogs, News, or Events. 

| Creating and editing feeds | Website content | Table of contents | 

SEARCH INDEXES 

You use search indexes to define different sets of content to be searched, using the internal search of your website. To configure 

your website’s internal search, you must first define a search index and then drop the Search and Search results widget 

somewhere on your website. 

You create search indexes in one of the following ways: 

1. Open the Search indexes  page by clicking Administration » Search indexes. 

2. On Search indexes page perform one of the following: 

 If you have not created any search indexes, the system displays the following in the center of the screen: 

 

 If you have already created one or more indexes, the system displays a list all created indexes and the following button in 

the toolbar of Search indexes page: 

 

3. Click Create a search index.  

The Create a search index  page appears. 

4. In Name input field, enter the name of the search index. 
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5. In Scope section, you select which content will be indexes. 

For example, you can create a search index that contains all news. When a user enters a search word, it will be applied to all 

news items on your website. 

You can index the following: 

 News items 

 Events 

 Blog Posts 

 Content Blocks 

You can exclude from the search results only particular Content block widgets. You do this from the Advanced settings of 

the Content block widget that you want to exclude. For more information, see Content block widget. 

 Documents 

The content of all published documents is indexed. The document formats that are supported for indexing are: TXT, 

HTML, RTF, DOCX (Office Open XML – the binary DOC format is not supported), and PDF.  

 List Items 

 Products 

 Forum posts 

 Any dynamic module items 

 Static HTML in pages 

The system searches the HTML of pages. 

NOTE: The widgets in the Navigation widgets group and the widgets in the Classification widgets group are excluded 

from the site search. 

NOTE: You can control which pages to include in the internal search from the page’s properties. When you exclude a page 

from the site search, its content is not indexes and cannot be found using the internal search. 

For more information, see Creating a new page. 

6. When you are finished, click Create this search index. 

If you have created the index after you have published an item, you must reindex. You can do this on Search indexes page, by 

clicking the Actions link of the index and then clicking Reindex. 

CONFIGURE SEARCH INDEX SETTINGS FOR CONTENT ITEMS 

You can customize the search index settings to perform search based on a specific field of any content item. For example, you can 

configure the search results to only include matches for titles and to ignore matches for content. Thus, you can narrow down 

search results generated for large content items (for example, Blogs or Forums) or for frequently used terms. To do this: 

1. In Sitefinity’s backend, navigate to Administration » Settings » Advanced. 

2. Click the content item type, for which you want to configure the search index settings. 

3. Click Controls and click on the respective content item type. 

4. Click Views and the respective content item type.  

5. Click Backendlist and in the ExtendedSearchFields enter your desired search criteria, separated by comma. 

CONFIGURE SEARCH INDEX SETTINGS FOR DYNAMIC MODULES 

If you are searching in dynamic module items or custom fields created for any module, you must set the fields where you want the 

system to search. 

You do this by expanding Advanced and entering the fields where to search, separated by commas. 

For example, if you want to search your dynamic content types by Definition, enter Definition. 

You can only search in text fields. 

NOTE: You must also configure these fields in the Search results widget advanced configuration mode. For more information, see 

Search results widget. 

Related links: 

http://en.wikipedia.org/wiki/Office_Open_XML
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Index the contents of Excel files 

| Website content | Table of contents | 

EMAIL CAMPAIGNS 

You use this tab to create email campaigns, manage lists of subscribers to email campaigns, and to compare email campaigns. 

You manage email campaigns on the Email Campaign page. To open the page, click Marketing  Email Campaigns. 

Use this tab to create, edit, and manage email campaigns, mailing lists, subscribers, and compare campaigns. 

You must first create a mailing list for your campaign, then you must add subscribers to your mailing list. If you want to use a 

template for your campaign, you must create it next. When you have a mailing list with subscribers and a template for your email 

campaign, you create the campaign itself. Each campaign has one or more issues. When you create the campaign, you must 

create at least one issue of this campaign. You can use A/B test to compare the effectiveness of your campaign, by creating 

variations of one issue and sending different versions to different groups of test users and then comparing the results. 

NOTE: Email campaigns are shared across different sites. All sites that you manage using Sitefinity have the same set of email 

campaigns, subscribers, mailing lists, and message templates. 

Section contents 

On this page you can manage the following: 

 Mailing lists and subscribers 

Before you send an email campaign, you must have created a mailing list and import subscribers in this list. The mailing list is 

a list of subscribers that will receive the email campaign. 

 Message templates 

If you do not want to create a new email campaign every time you create an email campaign, you can create a template and 

use it many times. 

 Campaigns 

When you have created a mailing list with subscribers, you can create an email campaign. Each email campaign must have 

one or more issues. You can also conduct tests to compare the effectiveness of two campaigns. 

 Reports 

After you have created a campaign and its first issue, you can view statistics related to its success. 

SUBSCRIBING TO EMAIL CAMPAIGNS ON THE WEBSITE 

To allow users to subscribe and unsubscribe to your email campaign, you must use the Subscribe form widget and the Unsubscribe 

form widget and configure them. 

For more information, see Subscribe form widget and Unsubscribe form widget. 

For more information about adding widgets on your page, see Add widgets on your page or template. 

You can then choose the way subscription and unsubscription forms are displayed by changing the template which the Subscribe 

form widget and the Unsubscribe form widget use. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

| Table of contents | 

MAILING LISTS AND SUBSCRIBERS 

Use this procedure to manage Email campaign’s mailing lists and their subscribers. 

Section contents 

 Creating a mailing list 

Before you send an email campaign, you must have created a mailing list. The mailing list is a list of subscribers that will 

receive the email campaign. 

 Managing subscribers, editing and deleting mailing list 

You can import databases with subscribers to a mailing list or you can enter subscribers manually. 

 Creating a subscriber 

Use this procedure to manually create subscribers and attach them to mailing lists. 

http://www.sitefinity.com/documentation/documentationarticles/index-the-contents-of-excel-files
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 Editing subscribers 

Use this procedure to edit the names or the emails of subscribers. 

| Email campaigns| Table of contents | 

CREATING A MAILING LIST 

1. In the main menu, click Marketing » Email Campaigns » Mailing lists. 

The Mailing lists  page appears. 

Perform one of the following: 

 If you have not created any mailing lists, the system displays the following in the center of the screen: 

 

 If you have already created one or more mailing lists, the system displays a list of all created mailing lists and the 

following button in the toolbar of Mailing lists page: 

 

2. Click Create a mailing list. 

The Create a mailing list page appears. 

3. In Mailing list title, enter the title of the mailing list.  

For example, My Company Email Campaign. 

4. In From name, enter what will be displayed as sender of the email campaign.  

5. In Subject, enter what will be displayed as subject of the email with the email campaign. 

6. In Reply-to email, enter the email, to which the subscribers of the email campaign will send replies. 

You must have configured the Email campaigns settings. 

7. Remind people why they are receiving this email campaign. 

For example, enter You are receiving this email because you opted at our website. 

8. If you want to send a welcome email to new email campaign subscribers, select I'd like to welcome new subscribers with an 

email message checkbox. 

 Enter a subject for the welcome message and enter an email from which appears with the welcome message. 

 Choose a template that will be sent as welcome message. 

You must create a template first. For more information, see Creating a message template. 

9. If you want to follow up users that unsubscribe from the email campaign, select I'd like to follow up with people that 

unsubscribe checkbox. 

 Enter a subject for the follow up message and enter the email that will appear as sender email. 

 Choose a template that will be sent as follow up message. 

You must create a template first. For more information, see Creating a message template. 

10. In Connect this list section, you can connect existing subscribers to your new mailing list. 

Perform the following: 

a. Click Add connection button. 

A new window appears. 

a. In Connection source dropdown box, select from where you want to connect your mailing list. 

You can dynamically import subscribers from the following: 

 Sitefinity users 

These are all users registered in the website, both in the backend and in the frontend. 

In Connect this list to dropdown box, select the membership provider for the users which you want to add as 

subscribers. 

The dropdown box contains all created membership providers. 
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 Sitefinity forms module 

These are the responses submitted to a form on your website. For more information, see Creating and editing forms. 

In Connect this list to dropdown box, select the form, which responses you want to use as subscribers. 

b. If you want to change the automatically generated connection title, enter a new title in Connection title input field. 

For example, enter Corporate clients. 

c. Map the fields required for a subscriber to the respective form fields or the respective user fields. 

The fields required for a subscriber are First name, Last name, and Email. For each of these fields there is a dropdown 

box, containing all available fields form a form or a user record. For each of the required fields, select a corresponding 

form field or user field. 

d. When finished, click Save changes.  

Every time a Sitefinity user is created or a user completes the form, he or she is also added as a subscriber to the mailing list. 

11. When finished creating the mailing list, click one of the following buttons: 

 Create this mailing list 

The mailing list is created and the system returns you to Mailing lists page. 

 Create and add another 

The mailing list is created the form is cleared and you can create a new mailing list. To do this, go to Step 3. 

 Cancel 

The mailing list is not created and the system returns you to Mailing lists page. 

| Mailing lists and subscribers | Email campaigns| Table of contents | 

MANAGING SUBSCRIBERS, EDITING AND DELETING MAILING LIST 

IMPORTING SUBSCRIBERS TO A MAILING LIST 

1. To import subscribers to a mailing list, open the Mailing lists page and perform one of the following: 

 Click Import subscribers button in the toolbar. 

 Click the Actions link of the mailing list where you want to import subscribers. 

From the dropdown list, click Import link. 

The Import subscribers page appears. 

2. To select the file where to import subscribers from, click Browse and browse your computer to find the file. 

The file must have a .csv or a .tsv extension. 

3. Select the format of the data with subscribers. 

You can import subscribers as one of the following: 

 Comma Separated Values (CSV) file. 

Select Comma separated radio button. 

 Tab Separated Values (TSV) file. 

Select Tab separated radio button. 

4. Map the fields required for a subscriber to the respective columns in the file. 

The fields required for a subscriber are First name, Last name, and Email. For each of these fields there is a dropdown box, 

containing the available columns. For each of the required fields, select a corresponding column. 

5. If the first row of your file represents the headers, select Skip the first row checkbox. 

6. If you are importing subscribers using the toolbar button, you must select the mailing list where you want to import by clicking 

Select mailing list button. 

7. If you want the imported subscribers to replace the already existing, if their email addresses match, select Replace existing 

subscribers which have the same emails as imported subscribers radio button. Otherwise, the system does not import 

subscribers with emails that already exist. 

8. Click Import. 

EXPORTING SUBSCRIBERS 

To export the subscribers of one or more mailing lists, perform the following: 
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1. On Mailing lists page, click More actions button in the toolbar. 

2. Click Export subscribers. 

The Export subscribers window appears. 

3. Choose what to export, by selecting one of the following: 

 All subscribers 

All subscribers from all mailing list together with subscribers that do not belong to any mailing list are exported. 

 Subscribers from selected mailing lists... 

Click Select a mailing list button, select one or more mailing lists, and click Done selecting. 

 Subscribers who do not belong to any list 

All subscribers that are not assigned to any mailing list are exported. 

4. If you want to export only once a subscriber who has the same email, select Do not export subscribers with same emails 

checkbox. 

5. Choose the format which you want to export to, by selecting one of the following: 

 Comma separated 

Exports the subscribers in Comma Separated Values (.csv) file. 

 Tab separated 

Exports the subscribers in Tab Separated Values (.tsv) file. 

6. Click Export. 

ADDING A SUBSCRIBER TO A MAILING LIST 

1. To add a new subscriber to a mailing list, open the Mailing lists page. 

2. Click the Actions link of the mailing list which you want to add a subscriber to. 

3. From the dropdown list, click Create new link. 

The Create a subscriber page appears. 

4. Perform procedure Creating a subscriber » Step 3 to Step 5. 

NOTE: In Step 4 the mailing list, where the subscriber is added is already selected. 

EDITING A MAILING LIST 

1. Go to the Mailing lists page. 

2. Click the Actions link of the respective list. 

From the dropdown list, click Properties. 

The Edit mailing lists page appears. 

3. Perform procedure Creating a mailing list » Step 3 to Step 10. 

4. When you are finished, click Save changes. 

DELETING A MAILING LIST 

You can delete a mailing list in the following ways: 

 On the Mailing lists page, select one or more lists and click Delete button in the toolbar. 

 On the Mailing lists page, click the Actions link of the respective list. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Mailing lists and subscribers | Email campaigns| Table of contents | 

CREATING A SUBSCRIBER 

1. In the main menu, click Marketing » Email Campaigns » Subscribers. 

The Subscribers  page appears. 

Perform one of the following: 
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 If you have no subscribers, the system displays the following in the center of the screen: 

 

 If you have already one or more subscribers, the system displays a list of all subscribers and the following button in the 

toolbar of Subscribers page: 

 

2. Click Create a subscriber. 

The Create a subscriber page appears. 

3. Enter the email, the first and the last name of the subscriber. 

4. If you want to add the subscriber to one or more mailing lists, click Select mailing lists button. 

Select one or more mailing lists and click Done selecting. 

5. When finished, perform one of the following: 

 Create this subscriber 

The subscriber is created and the system takes you to Subscribers page. 

 Create and add another 

The subscriber is created, the form is cleared, and you can create a new subscriber. 

 Cancel 

The subscriber is not created and the system takes you back to Subscribers page. 
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EDITING SUBSCRIBERS 

EDITING A SUBSCRIBER 

1. Go to the Subscribers page and open the template for editing in one of the following ways: 

 Click the subscriber you want to edit. 

 Click the Actions link of the respective campaign. 

From the dropdown list, click Edit properties. 

The Edit subscriber page appears. 

2. Perform procedure Creating a subscriber » Step 3 and Step 4. 

3. When you are finished, click Save changes. 

VIEWING THE REPORT FROM SUBSCRIBER’S ACTIVITY 

The data about the activity of each subscriber is accumulated and you can view a report. 

To see the report of a subscriber’s activity, click the Actions link of the subscriber and then click View reports link of the respective 

campaign. 

The report contains general and detailed information about the activity of a user, such as number of clicks and a list of clicked 

links. 

DELETING A SUBSCRIBER 

You can delete a subscriber in the following ways: 

 On the Subscribers page, select one or more subscribers and click Delete button in the toolbar. 

 On the Subscribers page, click the Actions link of the respective subscriber. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Mailing lists and subscribers | Email campaigns| Table of contents | 
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MESSAGE TEMPLATES 

Use this procedure to create and manage message templates that are send with email campaigns. 

Section contents 

 Creating a message template 

If you do not want to create a new email campaign every time you create an email campaign, you can create a template and 

use it many times. 

 Editing message templates 

Every time you need to update your email campaign, you can edit its template. 

| Email campaigns| Table of contents | 

CREATING A MESSAGE TEMPLATE 

1. In the main menu, click Marketing » Email Campaigns » Message templates. 

The Message templates  page appears. 

Perform one of the following: 

 If you have not created any message templates, the system displays the following in the center of the screen: 

 

 If you have already created one or more message templates, the system displays a list of all created templates and the 

following button in the toolbar of Message templates page: 

  

2. Click Create a message template. 

The Create a message template page appears. 

3. Enter a name for the template. 

4. Select the type of template, which you want to create and click Create and go to add content. 

Choose one of the following: 

 Rich text (HTML) 

You can create text with rich formatting, such as bold, italic, and bullets. You can insert images.  

Some email clients may not interpret it correctly. 

a. Create the email campaign using the text editor. 

b. Use Insert dynamic data in the text dropdown box to insert different placeholders in your email campaign, such as 

the name and the email of the subscriber or different properties of the mailing list.  

For example, your email campaign can start like this Dear <First name of subscriber>, following is our 

<Default subject of mailing list>. The message can appear like this: Dear John, following is our Monthly 

email campaign. 

c. After you select a placeholder, click Insert. 

d. When you are finished creating the page, click Save. 

 Plain text 

You cannot use any text formatting. 

Accessible to all email clients. 

a. Create the email campaign by entering the text in the textbox. 

b. Use Insert dynamic data in the text dropdown box to insert different placeholders in your email campaign, such as 

the name and the email of the subscriber or different properties of the mailing list.  

For example, your email campaign can start like this Dear <First name of subscriber>, following is our 

<Default subject of mailing list>. The message can appear like this: Dear John, following is our Monthly 

email campaign. 
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c. After you select a placeholder, click Insert. 

d. When you are finished creating the page, click Save. 

 Like a web page 

You can use multicolumn layouts and rich design. Your email campaign will look like a webpage. 

Some email clients may not interpret it correctly. 

a. Choose the layout of the page that will be sent as email campaign. 

For more information, see Modifying the layout. 

b. To display content, add and configure widgets to your email content. 

For more information, see Adding widgets on your page and Content widgets group. 

c. When you are finished creating the page, click Save. 

| Creating and editing email campaigns |  Email campaigns | Table of contents | 

EDITING MESSAGE TEMPLATES 

EDITING A MESSAGE TEMPLATE 

Go to the Message templates page and open the template for editing in one of the following ways: 

 To edit the content of the template, click it. 

Perform procedure Creating a message template » Step 4. 

 To edit the title of the template, click the Actions link of the respective template. 

From the dropdown list, click Edit title, enter the new title and click Save changes. 

DELETING A MESSAGE TEMPLATE 

You can delete a message template in the following ways: 

 On the Message templates page, select one or more messages and click Delete button in the toolbar. 

 On the Message templates page, click the Actions link of the respective template. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Creating and editing email campaigns | Website content | Table of contents | 

CAMPAIGNS 

Use this procedure to create and manage campaigns and individual issues, as well as comparing the effectiveness of two 

campaigns. 

Section contents 

 Creating a campaign 

When you have created a mailing list with subscribers, you can create an email campaign. You do this by creating a campaign. 

 Editing and deleting a campaign 

Use this procedure to edit already existing campaigns. 

 Creating a campaign issue 

Each email campaign must have one or more issues. The issue is what is sent to customers. 

 Creating an A/B test 

An A/B test is a comparison between two issues with the same mailing lists. You use it to test the effectiveness of the issues. 

| Email campaigns| Table of contents | 

CREATING A CAMPAIGN 

PREREQUISITES: You have created at least one mailing list. For more information, see Creating a mailing list. 

1. In the main menu, click Marketing » Email Campaigns » Campaigns and perform one of the following: 

 If you have not created any campaigns, the system displays the following in the center of the screen: 
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 If you have already created one or more campaigns, the system displays a list of all created campaigns and the following 

button in the toolbar of Campaigns page: 

 

2. Click Create a campaign. 

The Create a campaign page appears. 

3. Enter a name for the campaign. 

For example, enter MyProduct Email campaign. 

4. In Template section, select how the email campaign will look like. 

Choose one of the following radio buttons: 

 Start  from scratch 

Select this if you want to create a new email campaign. 

Choose the type of email campaign you want to create, by selecting one of the following: 

 Rich text (HTML) 

You can create text with rich formatting, such as bold, italic, and bullets. You can insert images.  

Some email clients may not interpret it correctly. 

 Plain text 

You cannot use any text formatting. 

Accessible to all email clients. 

 Like a web page 

You can use multicolumn layouts and rich design. Your email campaign will look like a webpage. 

Some email clients may not interpret it correctly. 

 Use a template 

In the dropdown box, select one of the already created email campaign templates. 

For more information, see Creating a message template. 

NOTE: One you choose the format of the campaign, you cannot change it. 

5. Under Mailing list, perform the following: 

a. Click Select a mailing list button  

b. From the list of mailing lists that appears, select one mailing list that will receive the email campaign of the campaign. 

c. Click Done selecting. 

If you have not created any mailing lists, you must first create at least one mailing list and then create a campaign.  

6. The From name, and Reply to email fields contain the values that you entered when creating the mailing list. 

You can change the values if needed. 

7. If you select Enable Google Analytics tracking for this campaign checkbox, the data about the website traffic generated by this 

campaign is collected by Google Analytics and you can see it in Campaign report of the Analytics module. For more 

information, see Sitefinity Tools » Sitefinity Analytics »Information about website traffic sources » Traffic sources detailed 

reports » Campaigns. 

8. Click Create and go add the first issue. 

9. The system takes you to create the first issue of the campaign.  

For example the December Newsletter.  

If you do not want to create an issue now, on Create an issue page, click Back to campaigns. For more information, see 

Creating a campaign issue. 

| Campaigns | Email campaigns| Table of contents | 
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EDITING AND DELETING A CAMPAIGN 

EDITING A CAMPAIGN 

To edit a campaign, perform the following: 

1. In the main menu, click Marketing » Email Campaigns » Campaigns. 

2. Click the Actions link of the campaign which you want to edit. 

3. Click Edit Title & Properties. 

4. Perform procedure Creating a campaign » Step 2 and Step 4 to Step 6. 

5. Click Save changes. 

DELETING A CAMPAIGN 

You can delete a campaign in the following ways: 

 On the Campaigns page, select one or more campaigns and click Delete button in the toolbar. 

 On the Campaigns page, click the Actions link of the respective campaign. 

From the dropdown list, click Delete. 

A dialog box appears where you must confirm the deletion. 

| Campaigns | Email campaigns| Table of contents | 

CREATING A CAMPAIGN ISSUE 

Each email campaign must have one or more issues. The issue is what is sent to customers. 

For example, you can have campaign Company Newsletter and you can have the following issues – January Newsletter, May 

Newsletter, and so on. You can create multiple issues; and issue can be Draft, Scheduled, and Sent. 

1. To create a new issue, perform the following: 

 On Campaigns page, click the Actions link of the campaign which you want to create an issue of. 

From the dropdown list, select Create new issue. 

 On Campaigns page, open a campaign by clicking it. 

Click Create new issue link on the right. 

The Create an issue for <Campaign name> page appears. 

2. Enter a name for the issue. 

For example, December issue. 

3. The mailing list associated with the campaign appears under Mailing list. You can change it by clicking Change… button, 

selecting a new list and clicking Done selecting. 

4. Enter a subject of the email which you are going to send the issue with. 

For example, XYZ February Newsletter. 

5. The From name, and Reply to email fields contain the values that you entered when creating the mailing list. 

You can change the values, if needed. 

6. If you want to save the issue as Draft and return to the page of the campaign, click Create and go to <Campaign name>, 

otherwise, click Go and add content. 

The system takes you to create the content of the issue. 

a. Depending on your choice for the format of the campaign in Creating a campaign » Step 3, perform the following: 

 If you have selected Rich text, Plain text, or Like a web page, perform the respective procedure described in Creating 

a message template » Step 4. 

 If you have selected Use a template, the selected template appears and you can edit it using the respective 

procedure described in Creating a message template » Step 4. 

b. If your email campaign is not Plain text, after you create it, you must also create a plain text version. 

Select one of the following: 

 Automatically generate plain text version 
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 Manually enter plain text version 

c. When you finished, choose what to do with the issue by clicking one of the following: 
 

Send this issue The campaign issue is saved and sent to the subscribers of the mailing list. 

A confirmation message appears. 

Save as draft Saves the issue without sending it. You can manage the saved issues on the page of 

the campaign. 

More actions » Schedule 

delivery 

Select this, if you want to schedule date and time when you want to send the email 

campaign issue to the subscribers of the mailing list. 

 Click Deliver campaign on input field. 

 Use the calendar and the time slider to select the desired time and date. 

 Click Schedule this issue. 

More actions » Send check You can see how your email campaign issue looks like in an email by sending it to a 

test email. 

 In the text box, enter one or more email addresses to which you want to send a 

test message. 

Separate the email by comma. 

 Click Send test message button. 

More actions » Create an A/B 

test 

Use this function to compare the effectiveness of two issues. You do this by finding out 

which of two email versions is more successful.  You test two campaign issues on a 

sample of your subscribers and decide which performs better. The winner is send to 

the rest of your subscribers. 

Perform procedure Creating an A/B test. 

Delete The issue is not saved and is deleted. 

The system returns you to the page of the campaign. 

All created issues are displayed in Issues section and are distributed in tabs, according to their status.  

If you have chosen to save the campaign issue as draft, you can later edit and send it following the above procedure.  

| Campaigns | Email campaigns| Table of contents | 

CREATING AN A/B TEST 

Use this procedure to compare the effectiveness of two issues. You do this by finding out which of two email versions is more 

successful.  You test two campaign issues on a sample of your subscribers and decide which performs better. The winner is send 

to the rest of your subscribers. You can create an A/B test when you create an issue. 

To compare two issues, perform the following: 

1. Perform procedure Creating a campaign issue. 

2. In Step 6c, choose More actions » Create an A/B test. 

You have created the first version of the email and you must create the second version next. 

3. Depending on how different the two tested issues will be, select one of the following: 

 Copy content from <first version> 

All properties and content of the second version are copied from the first version. You can then change everything except 

the issue name and the mailing list. To compare two versions of an issue, it must be send to the same subscribers. 

 Start from scratch 

Create a completely new version. You cannot change the mailing list and the name of the issue. 

4. For the second version of the issue, perform again procedure Creating a campaign issue » Step 4 to Step 6b. 

5. When finished editing the new version, click Send this A/B test. 
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A summary of the two versions appears together with the A/B Test settings. 

6. In Test name, enter a name that serves for your convenience only. 

7. Under What are you testing? describe what exactly you want to test and what you expect to learn from this test. 

8. Under Testing sample, use the slider to determine the percentage of subscribers of the mailing list that will be used as test 

subscribers and will receive one of the test issues. 

9. Under Winning issue, select the criterion for the winning issue, by choosing one of the following radio buttons: 

 More opened emails 

The issue that is opened by more test subscribers will be send to all subscribers of the mailing list after the comparison is 

over. 

 More link clicks 

The issue where the links in the email are clicked more often by the test subscribers will be send to all subscribers of the 

mailing list after the comparison is over. 

10. Under Send this A/B test..., choose when to send the two test issues. 

Select one of the following: 

 Immediately 

The test will be send now. 

 Schedule the test to be sent on... 

You can schedule when to send the test: 

 To select the date, click  Open the calendar popup.  

 To select the end time, click  Open the time view popup. 

11. Under A/B test end, choose the end time of the test period. 

This is when the data, such as clicks and bounces, will be summed and the winning campaign will be decided. 

 To select the date, click  Open the calendar popup.  

 To select the end time, click  Open the time view popup. 

12. When you are finished, depending on your choice in Step 8, choose one of the following: 

 If you have chosen to send the issues immediately, click Send this A/B test or Save as draft. 

 If you have chosen to schedule the test, click Schedule this A/B test. 

You цan create more than one A/B test. A/B test can be Draft, Schedules, or Sent. All created A/B tests are displayed in A/B tests 

section and are distributed in tabs, according to their status. 
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REPORTS 

After you have created a campaign and its first issue, you can view statistics related to its success. Sitefinity tracts and measures 

the following metrics: 

 Delivered 

The percentage of emails that were actually delivered out of the total number of emails sent.  

If you your mailing list is not updated and contains incorrect or non-existent emails, the delivered percentage drops. 

 Opened 

The percentage of emails that were actually opened by your subscribers.  

You can increase this percentage, if you make your subject or sender email more relevant to your subscribers. 

 Clicked 

The percentage of your subscribers that opened your email campaign and actually clicked a link inside the issue.  

To improve this metric, you must make the content of your campaign issue more relevant to your subscribers. 

 Unsubscribed 

The percentage of your subscribers that unsubscribed from your email campaign after a certain issue was delivered. 

 Opened in the first 48 hrs 
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The percentage of emails that were opened during the first 48 hours after you have sent the campaign.  

To improve this metric you can change the timing of your campaign. 

 Clicks by hour 

The cumulative number of clicks made during each hour.  

For example, if today a user click one link at 3:30 PM and tomorrow, another user clicked a link at 3:45 PM, the clicks for 3 PM 

will be two. The time intervals are displayed according to local time. 

You can view an overview report of each campaign, by clicking the campaign on Campaigns page. From the overview report you 

can navigate to the details report for each issue of the campaign. From the issue report you can navigate to the report for the 

subscribers of this issue. 

NOTE: If you delete a subscriber from a mailing list, the system no longer collects data for the activity of this subscriber. 

Section contents 

 Campaigns overview report 

 Issue full report 

 Subscribers full report 

 A/B test full report 
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CAMPAIGNS OVERVIEW REPORT 

You can view an overall report for each campaign. It displays each issue sent for this campaign, together with a graphic of 

delivered and opened emails and links clicked for all issues of the campaign. You can also see overview report of any A/B test that 

you have sent. 

The following screenshot displays the overview report: 

 

In this report you also see a list of all sent issues and all sent A/B tests. When you click an issue or a test, you can view statistics 

just for this issue or A/B test. For each entry, the system displays a Full report link. If you click it, you can view detailed statistics in 

the issue full report or the A/B test full report. 

| Reports | Email campaigns| Table of contents | 
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ISSUE FULL REPORT 

The full report for an issue displays the values of the following metrics: 

 Delivered 

 Opened 

 Clicked 

 Unsubscribed 

 Opened in the first 48 hrs 

 Clicks by hour 

You can also see the following lists: 

 Last 10 subscribers who clicked 

This is a list of the last ten subscribers who clicked a link in your email, together with the links they clicked. From this list you 

can go to the full subscribers’ report, by clicking View all subscribers. 

 Clicked links 

This is the list of the last ten links in your email that were clicked by the subscribers. From this list you can view the 

subscribers who clicked these links, by clicking View subscribers. 

The following screenshot displays the detailed report for an issue: 
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SUBSCRIBERS FULL REPORT 

The subscribers report displays details about the activity of all subscribers. For each subscriber the following information is 

supplied: 
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 The state of the delivery 

Whether the email is delivered or the reason why it is not delivered. 

 Date opened 

Whether or not the email is opened and when it has been opened. 

 Clicked links 

If links in the email are clicked by the subscriber, the system displays which links are clicked and when. You can view this 

information by clicking the subscriber. 

On the right of the screen you can filter the list of subscribers according to the status of the email, according the clicked links, or 

according to the geographical location of the subscribers. 

The following screenshot displays the detailed report for the subscribers of an issue: 
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A/B TEST FULL REPORT 

The A/B test full report displays details about the two issues that were tested.  

You can see the numeric values of the following metrics for each issue: 

 Delivered 

 Opened 

 Clicked 

 Unsubscribed 

 Opened in the first 48 hrs 

Under What was tested? the system displays what you have entered when you created the A/B test. You can Edit it. 

Under Conclusion, you can write a short analysis of the test. 

The following screenshot displays the detailed report for the A/B test of two issues: 
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WORKFLOWS 

In Sitefinity you can create a workflow for managing the lifecycle of content items and pages. You do that by creating first and 

second level of approval for content items and pages, or by uploading your custom workflow. 

TYPES OF WORKFLOW 

In Sitefinity the following types of workflow exist: 
 

Type of workflow Lifecycle steps  Rights 

Standard lifecycle 

management 

Create and Publish  All users with proper permissions. 

Approval before 

publishing 

 

Create and Send for Approval » 

Publish 

 Create and send for approval 

All users with proper permissions.  

 Publish 

Users set as approvers in the workflow definition. 

2 levels of approval 

before publishing 

Create and Send for Approval » 

Send for Publishing » Publish 

 Create and send for approval  

All users with proper permissions. 

 Send for publishing 

Users set as first level of approvers in the workflow 

definition. 

 Publish 

Users set as first level of approvers in the workflow 

definition. 

By default you use the standard lifecycle workflow. 

Using Sitefinity, you can create one or two level of approval for managing the lifecycle of content items and pages. 

To define and manage workflows, in the main menu, click Administration » Workflow.  

The Workflow  page appears, displaying a list of all created workflow definitions together with actions you can perform on them. 

Use this page to create, edit, and manage workflow definitions. 

Section contents 

On this page you can do the following: 

 Define a workflow 

Use this procedure to create a workflow and set the content to which it applies and the responsible users. 

 Edit a workflow 

Use this procedure to change the properties of a workflow ant to delete workflows. 

 Activate and deactivate a workflow 

Use this procedure to make a workflow active or inactive. 
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 Workflow status of content items and pages 

In Sitefinity all content items, such as news, events, and images, comments left on the website about the content items, as 

well as pages have statuses. Statuses help you manage the lifecycle of a content item or page. 

PERMISSIONS FOR WORKFLOWS 

Only users in the Administrators role can create and edit workflows.  

NOTE: Shared content blocks do not have workflow, you can control who can edit shared content blocks by setting their 

permission. 

DEFINING A WORKFLOW 

1. On Workflows page perform one of the following: 

 If you have not created any workflows, the system displays the following in the center of the screen: 

 

 If you have already created one or more workflows, the system displays a list all created workflows and the following 

button in the toolbar of Workflows page: 

 

2. Click Define a workflow or Create a workflow respectively. 

3. In Workflow type radio button group, perform one of the following and click Continue: 

 Approval before publishing 

This workflow inserts one intermediate step of approval between the standard lifecycle workflow of creating and 

publishing. In this case the lifecycle consist of creating, approving, and then publishing a content item or page. 

 2 levels of approval before publishing  

This workflow inserts two intermediate steps of approval between the standard lifecycle workflow of creating and 

publishing. In this case the lifecycle consist of creating, first level of approving, second level of approving, and then 

publishing a content item or page. 

The Define a workflow: Properties  window appears. 

4. In Name input field, enter a name for the workflow. 

5. In Set approvers section, click Add roles or users button. 

The Select roles or users window appears. Under Roles tab, the system displays all available roles, under Users, the system 

displays all created users. 

IMPORTANT: Make sure that the users set as approvers have permissions to create and modify the respective content 

6. Select one or more Roles or Users that will have the right to approve content items or pages and click Done selecting. 

NOTE: The Administrators role is set as approver by default. It is not displayed in Select roles or users. 

You can delete selected roles or users using  button. 

7. To add more roles, click Add roles or users button again and perform Step 6. 

8. If you select Notify users by email when an item is waiting for their approval checkbox, every time an item or page is set in 

status Awaiting approval, all users assigned as approvers will receive a notification via email. 

PREREQUISITE: In order for the system to be able to send emails, you must configure the SMTP settings. For more 

information, see Sitefinity Installation and administration guide » Settings » Configuring SMTP settings. 

NOTE: If you have chosen 2 levels of approval before publishing checkbox, the system displays Set approvers for Level 1 and 

Set approvers for Level 2 sections. In both sections you perform Step 5 to Step 8. You can choose different roles or users to 

be approvers on each level. 

9. In Scope section, define where the workflow applies, by selecting one of the following: 

 All content and pages. 
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The workflow will apply to all pages and all content items created using the content modules, except Forms. This includes 

also any dynamic modules, created with the Module Builder. The workflow does not apply on categories and tags. 

 Selected only 

Select the checkboxes of the content items or pages, whose lifecycle you want to change. 

10. If you select Allow administrators to skip the workflow checkbox, the administrators will not have to go through the workflow 

when creating or editing a page or a content item. In this case, the standard lifecycle workflow will apply to administrators 

only.  

NOTE: You cannot allow approvers, selected above, to skip the workflow. The approvers must enter the workflow, but they 

will have permissions to also approve the items they have set in status Awaiting approval for the level of approval that they 

have permissions for. 

11. To apply the workflow, select Activate workflow immediately. 

The workflow becomes active immediately after you save it. 

12. Click one of the following: 

 Save workflow 

The workflow is created and the system returns you to Workflows page. 

 Back to workflow types 

The system returns you to Step 3. 

 Cancel 

The system returns you to Workflows page without saving the workflow.  

| Workflows | Table of contents | 

EDITING A WORKFLOW 

 Editing the properties of a workflow 

1. Go to the Workflows page and open the workflow for editing in one of the following ways: 

 Click the workflow you want to edit. 

 Click the Actions link of the respective workflow. 

From the dropdown list, click Properties. 

The Edit a workflow page appears. 

2. Perform procedure Defining a workflow » Step 4 to Step 12. 

3. When you are finished, click Save workflow. 

NOTE: You cannot edit the type of the workflow. If you want to change the level of approvals, you must create a new 

workflow. 

 Deleting a workflow 

To delete a workflow, on Workflows page, perform one of the following: 

 Select one or more workflows and click Delete button in the toolbar. 

 Click the Actions link of the respective workflow and click Delete. 

| Workflows | Table of contents | 

ACTIVATING AND DEACTIVATING A WORKFLOW 

1. Go to the Workflows page and open the workflow for editing in one of the following ways: 

 Click the workflow you want to edit. 

 Click the Actions link of the respective workflow. 

From the dropdown list, click Properties. 

2. To activate or deactivate the workflow, select or deselect the Activate workflow immediately checkbox. 

3. The system changes the status of the workflow to one of the following: 
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 Active, denoted by . 

 Inactive, denoted by . 

| Workflows | Table of contents | 

WORKFLOW STATUS OF CONTENT ITEMS AND PAGES 

In Sitefinity all content items, such as news, events, and images, comments left on the website about the content items, as well as 

pages have statuses. Statuses help you manage the lifecycle of a content item or page.  

In Sitefinity there are also statuses that indicate that a workflow is applied to item or page. Such statuses are Awaiting approval 

and Rejected. The workflow introduces one or two levels of approval before an item or page becomes visible on the website. For 

more information about rights to publish, see Workflows. 

Section content 

 Types of statuses 

Use this section as a reference to all types of statuses a content item can have, as well as the icons that denote different 

statuses. 

 Set the status of a new page or content item 

When you finish creating or editing your content item, in the last step, you must set its status. Use this procedure to set the 

status of content items and pages that you have just created. 

 Manage a page or content item that is Draft, Unpublished, or Rejected 

Use this procedure to set the status of the pages or content items that are in status Draft and Draft (newer than published), 

Unpublished, and Rejected. If you need to edit an item or page as first or second level of approver, use the following two 

procedures. 

 Manage a page or content item that is Awaiting approval 

Use this procedure to edit and approve content items or pages in status Awaiting approval. To be able to edit such items or 

pages you must be assigned as approver in Approval before publishing type of workflow or as first level of approver in 2 levels 

of approval before publishing type of workflow. 

 Manage a page or content item that is Awaiting publishing 

Use this procedure to edit and approve content items or pages in status Awaiting publishing. To be able to edit such items or 

pages you must be assigned as second level of approver in 2 levels of approval before publishing type of workflow. 

 Manage a page or content item that is Published 

Use this procedure to manage the status of a published item or page. To be able to manage a published item, you must have 

the rights to publish it. For more information about rights to publish, see Workflows. 

 Manage a page or content item that is Scheduled 

Use this procedure to manage the status of a scheduled item or page. To be able to manage a scheduled item, you must have 

the rights to publish it. For more information about rights to publish, see Workflows. 

| Table of contents | 

TYPES OF STATUSES 

A content item or page can be in one of following states: 

 Published 

The content is visible on the website to users with permissions to view it. 

When a content item or page is published, in the list of content items or pages, the system displays .  

 Draft 

Draft is not publically visible on the website. 

When a content item or page is a Draft, in the list of content items or pages, the system displays . 

When a content item or page is a Draft (newer than published), in the list of content items or pages, the system displays .  

 Private draft 

The private draft is not visible on the website and administration area. It can be opened only by its owner or the 

administrator. 

When a content item or page is in status Private draft, the system displays the following: 
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 To its owner:  Private draft. 

 To everybody else:  Locked by <Name of owner> | Private draft. 

NOTE: Comments left on the website cannot be with draft status. 

 Scheduled 

The content item or page has been assigned date and time when it will be automatically published or unpublished on the 

website. 

When a content item is scheduled for publishing or unpublishing, in the list of content items, the system displays . 

 Awaiting approval  

The content item or page has been sent for approval. It is not publically visible on the website. 

When a content item is Awaiting approval or Awaiting approval (newer than published), in the list of content items or pages, 

the system displays . 

NOTE: To have a content item or page in status Awaiting approval you must use Approval before publishing or 2 levels of 

approval before publishing type of workflow. 

 Awaiting publishing 

The content item is sent for publishing after it has been approved. It is not publically visible on the website. 

When a content item is Awaiting publishing or Awaiting publishing (newer than published) in the list of content items or pages, 

the system displays . 

NOTE: To have a content item or page in status Awaiting publishing you must use 2 levels of approval before publishing type 

of workflow. 

 Rejected 

The content item has been rejected by the responsible user after it has been sent for approval. 

When a content item is Rejected in the list of content items or pages, the system displays . 

NOTE: To have a content item or page in status Rejected you must use Approval before publishing or 2 levels of approval 

before publishing type of workflow. 

IMPORTANT: In next to any of the above statuses, the system displays in brackets (newer than published), it means that the 

content item or page has an older version that is published on the website. For more information about the currently published 

version, see Revision history and Revision history of a page. 

 Unpublished 

The content item or page is not publically visible. 

NOTE: You can only unpublish a content item or page that is published. 

When a content item or page is unpublished, in the list of content items or pages, the system displays . 

 Locked for editing  

The content item cannot be opened, because it is being edited by another user. 

When a content item is edited by another user, in the list of content items, the system displays  next to the item. 

NOTE: A blog does not have a status. 

NOTE: Group pages do not have status, because they do not have content. On Pages page they are represented by . 

STATUS FOR COMMENTS 

Comments left on the website can have status Publish when they are publically visible and the following statuses, when they are 

not visible on the website. 

 Hidden 

This status is only used for comments left on the website by users. A hidden comment is not publically visible on the website. 

When a comment is hidden, in the list of comments, the system displays  next to the comment. 

 Spam  

This status is only used for comments left on the website by users. A comment marked as spam is hidden and not publically 

visible on the website. 

When a comment is spam, in the list of comments, the system displays  next to the comment. 

| Status of content items and pages | Table of contents | 



 

163 

SETTING THE STATUS OF A NEW PAGE OR CONTENT ITEM 

After you have finished creating properties or the content of page or a content item, you must set its status. This procedure 

describes the options you have for publishing, scheduling, and saving your content items or pages if you are using a Standard 

lifecycle management (Standard workflow), Approval before publishing (one level of approval) type of workflow, and 2 levels of 

approval before publishing type of workflow. Use this procedure to set the status of a newly created page or content item. 

Depending on the workflow type that is active, the system will display different options for setting the status: 
 

Workflow type Procedure 

Standard lifecycle 

management 

When finished creating or editing a content item or a page, select one of the following: 

 Publish 

The content item or page is assigned status Published. 

NOTE: Only when you upload new images, videos, and documents this button is labeled Upload and 

Publish.  

 Save as Draft 

The content item or page is assigned status Draft. 

NOTE: When you upload new images, videos, and documents, this button is labeled Upload and Save 

as Draft. 

 More actions 

From the dropdown box, select one of the following: 

 Publish/Unpublish on Specific Date 

A window opens, where you use the Publication date or Date to Unpublish input fields to schedule a 

publishing and expiration (if any) date and time for the content item or page. 

When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled.  

NOTE: You can also set a publication date in the past. If you do this the item is assigned status 

Published.  

 Delete 

A dialog box appears where you must confirm the deletion. 

NOTE: This option appears only after you have saved a content item. Before you have saved a 

content item, you cannot delete it and instead of More actions button the system displays 

Publish/Unpublish on Specific Date button. 

NOTE: The More actions button does not appear when you upload images, videos, and documents. 

Approval before 

publishing 

 

When finished creating or editing a content item or page, select one of the following: 

 Send for Approval 

The content item or page is assigned status Awaiting approval. 

NOTE: When you upload new images, videos, and documents this button is labeled Upload and Send 

for Approval. 

IMPORTANT: If you are not assigned as approver in Approval before publishing type of workflow, you 

are not able to open an item after it is sent for approval. 

For more information, see Managing a page or content item that is Awaiting approval. 

 Save as Draft 

The content item or page is assigned status Draft. 

NOTE: When you upload new images, videos, and documents this button is labeled Upload and Save 

as Draft, which uploads the item in status Draft. 

NOTE: If you are an administrator and you are allowed to skip the workflow, use the procedure for standard 

lifecycle management. 



 

164 

2 levels of 

approval before 

publishing 

When finished creating or editing a content item or page, select one of the following: 

 Send for Approval 

The content item or page is assigned status Awaiting approval. 

NOTE: Only when you upload new images, videos, and documents this button is labeled Upload and 

Send for Approval. 

IMPORTANT: If you are not assigned as approver in 2 levels of approval before publishing type of 

workflow, you are not able to open an item after it is sent for approval. 

For more information, see Managing a page or content item that is Awaiting approval. 

 Save as Draft 

The content item or page is assigned status Draft. 

NOTE: When you upload new images, videos, and documents the button is labeled Upload and Save as 

Draft, which uploads the item in status Draft. 

 Delete 

A dialog box appears where you must confirm the deletion. 

NOTE: This option appears only after you have saved a content item. Before you have saved a content 

item, you cannot delete it. 

NOTE: If you are an administrator and you are allowed to skip the workflow, use the procedure for standard 

lifecycle management. 

If you are creating a page and in page content editing mode, you click Back to Pages, the system saves the page in status Draft. 

If when you are creating a content item, you click Back to <content type> without having saves the item as draft, the system does 

not save the content item you were creating. 

For more information, see Workflows. 

The following flowchart displays all available steps when you are creating a content item or page: 

 

For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 

MANAGING A PAGE OR CONTENT ITEM THAT IS DRAFT, UNPUBLISHED, OR REJECTED 

After you have finished editing the content of a page or a content item, you must set its status. This procedure describes the 

options you have for publishing, scheduling, and saving your content items or pages if you are using a Standard lifecycle 
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management (Standard workflow), Approval before publishing (one level of approval) type of workflow, and 2 levels of approval 

before publishing type of workflow. Use this procedure to set the status of the following types of content items or pages: 

 Draft and Draft (newer than published) 

 Unpublished 

 Rejected 

You can have this status of an item or page only if you are using either Approval before publishing or 2 levels of approval 

before publishing type of workflow.  

NOTE: If you want to edit a published or scheduled content item or page, you must first open it and save it as draft. If you are 

using Approval before publishing or 2 levels of approval before publishing type of workflow and you want to manage an item or 

page in status Published or Scheduled, see procedures Managing a page or content item that is Published and Managing a page or 

content item that is Scheduled respectively. 

NOTE: If you are using Approval before publishing or 2 levels of approval before publishing type of workflow and you want to 

manage an item or page in status Awaiting approval or Awaiting publishing, see procedures Managing a page or content item that 

is Awaiting approval and Managing a page or content item that is Awaiting publishing respectively. 

Depending on the workflow type that is active, the system will display different options for setting the status: 
 

Workflow type Procedure 

Standard lifecycle 

management 

When finished editing a content item or a page, select one of the following: 

 Publish 

The content item or page is assigned status Published. 

 Save as Draft 

The content item or page is assigned status Draft. 

 More actions 

From the dropdown box, select one of the following: 

 Discard Draft 

This link is available only when you have opened a page or content item in status Draft (newer than 

published). When you click it you delete the created draft and leave only the published version. 

 Publish/Unpublish on Specific Date 

A window opens, where you use the Publication date or Date to Unpublish input fields to schedule a 

publishing and expiration (if any) date and time for the content item or page. 

When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled. 

NOTE: You can also set a publication date in the past. If you do this the item is assigned status 

Published.  

 Delete 

A dialog box appears where you must confirm the deletion. 

Approval before 

publishing  

or  

2 levels of 

approval before 

publishing 

 

When finished creating or editing a content item or page, select one of the following: 

 Send for Approval 

The content item or page is assigned status Awaiting approval. 

IMPORTANT: If you are not assigned as approver in Approval before publishing type of workflow or as 

first level of approver in 2 levels of approval before publishing type of workflow, you are not able to open 

an item after it is sent for approval. 

For more information, see Managing a page or content item that is Awaiting approval. 

 Save as Draft 

The content item or page is assigned status Draft. 

 Delete 

A dialog box appears where you must confirm the deletion. 

NOTE: If you have opened a page or item in status Draft (newer than published) you have an additional 

function Discard Draft. When this option is available, the More action button appears, containing Discard 
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Draft and Delete links. When you click Discard Draft you delete the created draft and leave only the 

published version. 

NOTE: If you are an administrator and you are allowed to skip the workflow, perform the procedure for 

standard lifecycle management. 

IMPORTANT: If you have opened for editing a content item or page that has a published version, the system displays (newer 

than published) after the status of the content item or page. For more information, see Types of statuses. 

For more information, see Workflows. 

The following flowchart displays all available steps when you have opened for editing a content item or page in status Draft, 

Unpublished, Rejected: 

 

 

NOTE: If you have opened for editing an item in status Draft (newer than published), you have an additional option – Discard 

draft. If you click it, all changes since the last published version of the item are deleted and the item is left in status Published. 

For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 

MANAGING A PAGE OR CONTENT ITEM THAT IS AWAITING APPROVAL 

If you are responsible for approving content items and pages, you must open and approve items that are in status Awaiting 

approval or Awaiting approval (newer than published). Use this procedure to manage pages and content item in these statuses. 

PREREQUISITES: To have a content item or page in status Awaiting approval or Awaiting approval (newer than published) you 

must use Approval before publishing or 2 levels of approval before publishing type of workflow. To open such an item in editing 

mode you must be assigned as approver in Approval before publishing type of workflow or as first level of approver in 2 levels of 

approval before publishing type of workflow. For more information, see Workflows. 

Depending on the workflow type that is active, the system will display different options for setting the status: 
 

Workflow type Procedure 

Approval before 

publishing 

 

When you open a content item or page, which is in status Awaiting approval or Awaiting approval (newer 

than published), perform one of the following: 

1. Make changes to the content item if required. 

For more information, see the respective procedure in Built-in modules or Editing a page. 

2. Select one of the following: 

 Publish 
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The content item or page is assigned status Published. 

NOTE: If you are working in multilingual mode and you publish a translation of a content item, all 

translations of that item are published, regardless of their current status. 

 Reject 

A window appears where you can enter reasons for rejecting the content item or page. 

When you click Reject publishing, the system returns the content item or page for editing on the 

previous level. All users with the proper permissions can edit the item. 

The content item or page is assigned status Rejected. 

 More actions 

From the dropdown box, select one of the following: 

 Save as Awaiting approval 

Use this function if you have not finished approving the item and you want to keep its status. 

The content item or page is assigned status Awaiting approval. 

 Publish/Unpublish on Specific Date 

A window opens, where you use the Publication date or Date to Unpublish input fields to 

schedule a publishing and expiration (if any) date and time for the content item or page. 

When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled. 

NOTE: You can also set a publication date in the past. If you do this the item is assigned 

status Publish. 

 Delete 

A dialog box appears where you must confirm the deletion. 

2 levels of 

approval before 

publishing 

When you open a content item or page, which is in status Awaiting approval or Awaiting approval (newer 

than published), perform one of the following: 

1. Make changes to the content item if required. 

For more information, see the respective procedure in Built-in modules or Editing a page. 

2. Select one of the following: 

 Send for Publishing 

The content item or page is assigned status Awaiting publishing. 

IMPORTANT: If you are not assigned as second level of approver in 2 levels of approval before 

publishing type of workflow, you are not able to open an item after it is sent for publishing. 

For more information, see Managing a page or content item that is Awaiting publishing. 

 Reject 

A window appears where you can enter reasons for rejecting the content item or page. 

When you click Reject publishing, the system returns the content item or page for editing on the 

previous level. All users with the proper permissions can edit the item. 

The content item or page is assigned status Rejected. 

 More actions 

From the dropdown box, select one of the following: 

 Save as Awaiting approval 

Use this function if you have not finished approving the item and you want to keep its status. 

The content item or page is assigned status Awaiting approval. 

 Delete 

A dialog box appears where you must confirm the deletion. 

NOTE: If you have opened for editing a content item or page that has status Published or has an older published version, the 

system displays (newer than published) after the status of the content item or page. For more information, see Types of statuses. 

For more information, see Workflows. 

The following flowchart displays all available steps when you have opened for editing a content item or page in status Awaiting 

approval: 
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For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 

MANAGING A PAGE OR CONTENT ITEM THAT IS AWAITING PUBLISHING 

If you are responsible for publishing content items and pages, you must open and publish items that are in status Awaiting 

publishing or Awaiting publishing (newer than published). Use this procedure to manage pages and content item in these statuses. 

PREREQUISITES: To have a content item or page in status Awaiting publishing or Awaiting publishing (newer than published) 

you must use 2 levels of approval before publishing type of workflow. To open such an item in editing mode you must be assigned 

as second level of approver in 2 levels of approval before publishing type of workflow. For more information, see Workflows. 

When you open a content item or page, which is in status Awaiting publishing or Awaiting publishing (newer than published), 

perform one of the following: 

1. Make changes to the content item if required. 

For more information, see the respective procedure in Built-in modules or Editing a page. 

2. Select one of the following: 

 Publish 

The content item or page is assigned status Published. 

NOTE: If you are working in multilingual mode and you publish a translation of a content item, all translations of that 

item are published, regardless of their current status. 

 Reject 

A window appears where you can enter reasons for rejecting the content item or page. 

When you click Reject publishing, the system returns the content item or page for editing on the previous level.  

Users assigned as approver in Approval before publishing type of workflow or as first level of approver in 2 levels of 

approval before publishing type of workflow can edit the item. 

The content item or page is assigned status Awaiting approval. 

 More actions 

From the dropdown box, select one of the following: 

 Save as Awaiting publishing 

Use this function if you have not finished approving the item and you want to keep its status Awaiting publishing. 

NOTE: If you have opened a page in status Awaiting publishing, there is a separate button in the toolbar for this 

function. 

 Publish/Unpublish on Specific Date 

A window opens, where you use the Publication date or Date to Unpublish input fields to schedule a publishing and 

expiration (if any) date and time for the content item or page. 
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When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled. 

NOTE: You can also set a publication date in the past. If you do this the item is assigned status Published. 

 Delete 

A dialog box appears where you must confirm the deletion. 

NOTE: If you have opened for editing a content item or page that has status Published or has an older published version, the 

system displays (newer than published) after the status of the content item or page. For more information, see Types of statuses. 

The following flowchart displays all available steps when you have opened for editing a content item or page in status Awaiting 

publishing: 

 

For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 

MANAGING A PAGE OR CONTENT ITEM THAT IS PUBLISHED 

Use this procedure to manage the status content items or pages in status Published. Everyone, who has permission to modify 

content items, can open an item that is Published. 

USERS WHO HAVE THE RIGHT TO PUBLISH CONTENT ITEMS 

PREREQUISITES: To manage the status of a content item or page in status Published, you must have the right to publish 

content items or pages. For more information about publishing rights, see Workflows » Types of workflow. 

When you open a content item in status Published, after finished editing it, you can perform the following actions, regardless of the 

type of workflow you are using: 

 Publish 

The content item or page is assigned status Published. 

 More actions 

From the dropdown box, select one of the following: 

 Save as Draft 

The content item or page is assigned status Draft (newer than published). 

When you open a published version and save it as draft, the already published content item or page remains published on 

the webpage, only a draft of it that can be edited is created. For more information about the currently published version, 

see Revision history and Revision history of a page. 

NOTE: If you are using the standard workflow type, there is a separate button in the toolbar for this function. 

 Publish/Unpublish on Specific Date 



 

170 

A window opens, where you use the Publication date or Date to Unpublish input fields to schedule a publishing and 

expiration (if any) date and time for the content item or page. 

When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled (newer than published). 

NOTE: You can also set a publication date in the past. If you do this the item is assigned status Published. 

NOTE: You cannot schedule a form. 

 Unpublish 

The content item or page is assigned status Unpublished. 

NOTE: If you are working in multilingual mode and you unpublish a translation of a content item, all translations of that 

item are unpublished, regardless of their current status. 

 Delete 

A dialog box appears where you must confirm the deletion.  

USERS WHO DO NOT HAVE THE RIGHT TO PUBLISH CONTENT ITEMS 

If you are not assigned as approver in Approval before publishing type of workflow or as first level of approver in 2 levels of 

approval before publishing type of workflow, you can still open a Published content item. You can edit the content item and save it 

as draft. This way, the Published version of the content item remains published. By saving a content item as draft, you create 

another version of the content item that is draft and can be edited. The content item enters the workflow from the beginning.  

NOTE: Workflows do not apply on forms and you do not need special right to unpublish a form. To do this, on Forms page click 

the Actions link of the respective form and from the dropdown list, click Unpublish. 

The following flowchart displays all available steps when you have opened for editing a content item or page in status Published: 

 

For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 

MANAGING A PAGE OR CONTENT ITEM THAT IS SCHEDULED 

Use this procedure to manage the status content items or pages in status Scheduled. Everyone, who has permission to modify 

content items, can open an item that is Schedule. 

USERS WHO HAVE THE RIGHT TO PUBLISH CONTENT ITEMS 

PREREQUISITES: To manage the status of a content item or page in status Scheduled, you must have the right to publish or 

schedule a content items or pages. For more information about publishing rights, see Workflows » Types of workflow. 

NOTE: Forms cannot be scheduled to be published. 

When you open a content item in status Scheduled, after finished editing it, you can perform the following actions, regardless of 

the type of workflow you are using: 

 Publish 

The content item or page is assigned status Published. 
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 More actions 

From the dropdown box, select one of the following: 

 Stop Schedule 

If you click this link, the item is no more scheduled for publishing. It returns to its previous state: 

 Draft 

If you are using Standard workflow. 

 Awaiting approval 

If you are using Approval before publishing workflow. 

 Awaiting publishing 

If you are using 2 levels of approval before publishing workflow. 

 Save as Draft 

The content item or page is assigned status Draft. 

NOTE: If you are using the standard workflow type, there is a separate button in the toolbar for this function. 

 Publish/Unpublish on Specific Date 

A window opens, where you use the Publication date or Date to Unpublish input fields to schedule a publishing and 

expiration (if any) date and time for the content item or page. 

When you select the dates, click Schedule. 

The content item or page is assigned status Scheduled. 

NOTE: You can also set a publication date in the past. If you do this the item is assigned status Published. 

 Delete 

A dialog box appears where you must confirm the deletion. 

USERS WHO DO NOT HAVE THE RIGHT TO PUBLISH CONTENT ITEMS 

If you are not assigned as approver in Approval before publishing type of workflow or as first level of approver in 2 levels of 

approval before publishing type of workflow, you can still open a Scheduled content item. You can edit the content item and save it 

as draft. The content item enters the workflow from the beginning. 

The following flowchart displays all available steps when you have opened for editing a content item or page in status Schedule: 

 

For more information about the statuses of a content item, see Types of statuses. 

| Status of content items and pages | Table of contents | 
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WIDGETS 

To display content you use widgets. The widgets are controls which you drop on the page (in page content editing mode) and 

configure them to display already existing content. If you do not create content first, the widgets have nothing to display. You 

create content using the content modules on the Content tab.  

You display the content you have created with these content modules using the widgets. You can configure the widgets to display 

different part of content, by combining widgets and by tagging and classifying content. You display the content you have created 

on Content tab using widgets. 

Section contents 

 Add widgets on your page or template 

Use this procedure to add widget on your page and to open the configuration mode of widgets. 

 Dashboard widgets group 

The Dashboard widgets group contains widgets that can be used only on the Dashboard. You cannot use these widgets on 

frontend pages.  

For more information, see Dashboard and main navigation. 

 Content widgets group 

The Content widget group contains widgets that you use to display reusable content you have created on Content tab. 

 Navigation widgets group 

The Navigation widget group contains widgets that you use to display website navigation and archive of content items you 

have created on Content tab. 

 Data widget group 

The widgets from this widget group can be configured only in advanced mode.  

For more information, see Advanced configuration of widgets. 

 Scripts and styles widgets group 

The Scripts and Styles widgets group contains widgets that you use to apply style to the page or to enhance the page with 

additional functionality. 

 Login widgets group 

The Login widgets group contains widgets that you use to provide your website users with the ability to login, to display the 

currently logged user and login or logout links. 

 Search widgets group 

The Search widgets group contains widgets that you use to configure your website internal search. After you have created one 

or more search indexes, you use the Search widget to select indexes to be used for the search. 

 Users widgets group 

The Users widgets group contains widgets that you use to display lists of users, user registration form and provide the user 

with the ability to change profile information, such as password or email. 

 Social widgets group 

The Social widgets group contains widgets that you use to display Facebook feed and Facebook like and send buttons on the 

pages of your website. 

 Classifications widgets group 

The Classifications widgets group contains widgets that you use to display lists of categories and tags on your website. You 

use the categories and the tags to filter the content of the pages. 

 Email Campaigns widgets group 

The Email Campaigns widgets group contains widgets that you use to display subscription and unsubscription forms to the 

visitors of your website. 

 Ecommerce widget group 

The Ecommerce widget group contains widgets that you use to setup your online store. For more information, see Sitefinity 

Ecommerce Guide » Setup the ecommerce pages. 

 Advanced configuration of widgets 

In Advanced configuration mode you can configure individual properties of the widget. To use this mode you must be an 

advanced user or a developer. 

CONFIGURING WIDGETS WHILE BROWSING THE WEBSITE 
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You can create, edit, and upload content while you are browsing the website. You do not need to open the website in the backend; 

you can use the inline editing function to edit your website directly while browsing it. Using the direct inline editing, you can see 

how the items, you are editing, look in the context of the website. 

For more information about inline editing, see Browse and edit. 

ADDING CUSTOM WIDGETS TO THE TOOLBOX 

If the build-in Sitefinity widgets do not meet your requirements, you can create and use custom widgets. If you have a custom 

widget that you want to use in Sitefinity, you must first register the widget in the toolbox. 

For more information, see Sitefinity Installation and Administration Guide » Settings » Registering a new widget in Sitefinity. 

For more information about automatic generation of meta keywords and description, see Sitefinity Installation and Administration 

Guide » Settings » Automatic generation of Meta keywords and Meta description tags. 

| Table of contents | 

ADD WIDGETS ON PAGES AND TEMPLATES 

You add widgets in the editing mode of pages and templates.  

1. To edit the content of a page or template, perform one of the following: 

 Click the page or the template that you want to edit. 

 Click the Actions link of the respective page or template. 

From the dropdown list click Content. 

The editing mode opens. 

2. Click Content button in the upper-right corner of the page. 

A list of widget groups appears. 

3. Expand a widget group, choose a widget and drag it on the desired place on the page. 

The following screenshot shows dragging of the Image widget in an empty screen element: 

 
NOTE: You can drag a widget both inside a layout element and outside it. Select a widget and drag it to the desired place. 

The system suggests you where you can drop the widget. 

Once you have added widget on your page, you need to configure it to display the proper content. 

4. To do this, click Edit button in the upper-right corner of the widget. 

The following screenshot shows the Edit button: 

  

Widgets have the following ways of configuration: 

 Simple mode 
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Simple mode is the user friendly way of configuring a widget. When you click Edit button in the upper-right corner of the 

widget, the Simple configuration mode is displayed by default. 

 Advanced mode 

In Advanced configuration mode you can configure individual properties of the widget. To use this mode you must be an 

advanced user or a developer. 

NOTE: Some widgets do not have Simple configuration mode. You still can configure those widgets using the Advanced mode, 

which is displayed by default for widgets that do not have Simple mode. Some widgets can only be configured in simple mode.  

5. For more functions of the widget, click More button in the upper-right corner of the widget and select one of the following: 

 To remove the widget from the page, click Delete. 

The system removes the widget without confirmation. 

 To add the same widget once again, click Duplicate. 

The system adds the same widget, under the existing one, and duplicates also the configuration that you have made so 

far. 

 To set permissions for that particular widget, click Permissions and perform procedure Sitefinity Installation and 

Administration Guide » Changing global and section permissions » Step 2 to Step 4. 

NOTE: When you add widgets in a page template, they cannot be edited in the pages that use the template. If you want to be 

able to edit widgets, added in the template, from a page that uses the template, you must branch the widgets. To do this, when 

you add a widget in a template, in the upper-right corner of the widget, click More  Make editable on pages. 

For more information, see Template widgets editable in pages. 

TEMPLATE WIDGETS EDITABLE IN PAGES (SITEFINITY 7.0) 

When you add widgets in a page template, they cannot be edited in the pages that use the template. For example, if you add the 

Image widget in a template and configure the widget to display a certain image, this image is visible in all pages that use the 

template. You cannot change the image from a certain page, you can only change the image from the template. The change is 

applied to all pages that use the template.  

If you want to be able to edit widgets, added in the template, from a page that uses the template, you must branch the widgets. 

When a widget in a template is branched, you can edit the widget inside a page that uses the template. The widget inherits its 

configuration and contents from the template. Once you edit a branched widget inside a page, you break the inheritance. 

EXAMPLE: You place the Image widget inside a template and configure it to display Picture X. You apply the template to Page A 

and Page B. Picture X is displayed on both pages. When you branch the widget in the template, it becomes editable in the pages. 

If you open Page A and replace Picture X with Picture Y, you break the inheritance from the template and Page A. Now, Page A 

displays Picture Y, Page B – the same as the template – Picture X. If you change the image inside the template and replace Picture 

X with Picture Z, the change is applied only to pages, where the widget has never been edited – in this case, Page B.  

To branch a widget, perform the following: 

1. Open the template whose widget you want to branch. 

2. In the upper-right corner of the widget, click More  Make editable on pages. 

The system displays EDITABLE ON PAGES banner in the toolbar of the widget: 

 

NOTE: If you edit a branched widget from a page, in the toolbar of the widget, the View where this widget was edited link 

appears. You can use it to see a list of pages where the widget has been edited. These pages no longer inherit the content of 

the widget from the template. 

3. If you want to stop a widget to be editable on pages, open the template and in the upper-right corner of the widget, click 

More  Make non-editable on pages. 

Regardless of whether the widget has been edited on pages or not, it becomes non-editable everywhere. 

DASHBOARD WIDGETS GROUP 

The Dashboard widgets group contains widgets that can be used only on the Dashboard. You cannot use these widgets on 

frontend pages.  

For more information, see Dashboard and main navigation. 

Section contents 
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The following widgets are part of the Dashboard widget group: 

 Analytics Timeline 

Use this widget to display a summary of an analytics metric or a comparison between two metrics. 

 Recent items 

Use this widget to display recently modified items and pages, filtered by owner, status, or content type. 

 Sitefinity welcome 

Use this widget to display useful links to video tutorials and getting started documentation. 

 Configure Dashboard widgets 

Use this widget to give backend users the opportunity to customize the Dashboard. 

NOTE: By default, Sitefinity welcome and Configure Dashboard widgets widgets are disabled and are not visible in the toolbox. If 

you delete one of these widgets and want to add it again, you must first enable it in Sitefinity toolbox. For more information, see 

Sitefinity Installation and Administration Guide » Settings » Registering a new widget in Sitefinity  » Enabling and disabling a 

widget. 

ANALYTICS TIMELINE 

Use this widget to display a summary of an Analytics metric or a comparison between two metrics. 

PREREQUISITES: You must have configured the Analytics module. For more information, see Sitefinity Tools » Sitefinity 

Analytics. 

To configure the display of Analytics data, perform the following: 

1. Drag the Analytics Timeline widget on the Dashboard. 

2. In the upper-right corner of the widget, click Edit. 

3. In Which metrics to display dropdown box, select and Analytics metric whose graph you want to see on the Dashboard. 

For more information about the meaning of the metrics, see http://support.google.com/analytics/ and Sitefinity Tools » 

Sitefinity Analytics. 

4. If you want to display a comparison between two metrics, select Compare with checkbox and use the dropdown box to select 

the second metric in the comparison. 

5. In Title input field, the system automatically displays the title of the first metric. 

This title is displayed in the widget above the graph. 

You can change the title by entering a new one. 

6. In Link to more reports, enter the link to the page of the Analytics module. 

For example, enter ~/Marketing/Analytics 

7. Click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

RECENT ITEMS 

Use this widget to display recently modified items and pages, filtered by owner, status, or content type. 

To configure the display of recent items and pages, perform the following: 

1. Drag the Recent items widget on the Dashboard. 

2. In the upper-right corner of the widget, click Edit. 

3. Under Content types, choose what kind of content items or pages you want to display in the widget.  

Select one of the following: 

 All content types 

All pages and content items, including dynamic items, are displayed. 

 Selected content types only... 

Select which of the built-in and dynamic content items or pages you want to display. 

4. Under Modified by, select whether you want to display items or pages modified by the currently logged user or all recent items 

and pages. 

http://support.google.com/analytics/
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5. Under Statuses, choose if you want to display items in a particular workflow status. 

Select one of the following: 

 All statuses 

Items in all workflow statuses are displayed. 

For more information, see Types of statuses. 

 Selected statuses only... 

Select one or more workflow statuses. 

For example, you may want to display only items that are Awaiting approval or Awaiting publishing. 

6. Click Settings tab. 

7. Enter the title of the widget. 

For example, enter Items waiting for approval. 

8. Under Pagination, enter the number of items that you want to display in the widget in one page view of the widget. 

9. In Display filter by dropdown box, you can choose to display filtering buttons in the widget. 

Select one of the following: 

 - Don’t display filter - 

No filter buttons are displayed in the widget. 

 Status (Draft, Scheduled, etc.) 

The filter is not displayed, if you have selected to display items and pages with only one status. 

 User (All, My items) 

The filter is not displayed, if you have selected to display items modified by the currently logged user only. 

10. Click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

CONTENT WIDGETS GROUP 

The Content widget group contains widgets which you use to display reusable content you have created on Content tab. 

Section contents 

The following widgets are part of the Content widget group (alphabetically ordered): 

 Blog posts 

Use this widget to display already created blog posts. 

 Blogs list 

Use this widget to display a list of created blogs.  

 Content block 

Use this widget to enter content directly using the text editor and its features. 

 Comments 

 Use this widget to give the users the possibility to leave a comment on a page. Document link 

Use this widget to display a link to a single document on your page. You can choose a document from the already uploaded or 

upload a new document. 

 Download list 

Use this widget to display a list or table of links to documents, where each document can be downloaded. You can choose 

documents from the already uploaded or upload new documents. 

 Events 

Use this widget to display already created events. 

 Feed 

Use this widget to display RSS feed on your website. 

 Form 

Use this widget to display forms that you have created with the form builder. 

 Forums 

Use this widget to display a forums, forum threads, and forum posts. 
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 Image 

Use this widget to display a single image on your page. You can choose an image from the already uploaded or upload a new 

image. 

 Image gallery 

Use this widget to display a gallery of image thumbnails, where each image can be opened individually. You can choose 

images from the already uploaded or upload new images. 

 List 

Use this widget to display already created lists with list items. 

 News 

Use this widget to display already created news. 

 Video 

Use this widget to display a single video on your page. You can choose a video from the already uploaded or upload a new 

video. 

 Video gallery 

Use this widget to display a gallery of video thumbnails, where each video can be played individually. You can choose videos 

from the already uploaded or upload new videos. 

 Dynamic module widgets 

If you have created and activated a dynamic module, the system automatically creates a widget and displays the widget in the 

content widget group. You use the widget to select which of your dynamic content to display on the website and to choose 

how to display the content. 

 Configuring custom hierarchical widgets 

Use this widget to display a dynamic content type that has hierarchy. Using this widget you can display parent and children 

content types. 

 Common behavior of content widgets 

When you drop two content widgets on one page, by default, they share some common behavior, such as paging and filtering. 

You can change the using this procedure. 

 Filter expressions for content items 

Use this list of filter expression examples to create your own filter expressions when you configure widgets. 

| Widgets | Table of contents | 

BLOG POSTS WIDGET 

Use this widget to display already created blog posts. 

PREREQUISITES: You have created at least one blog with at least one post in it. For more information, see Creating and editing 

blogs and blog posts. 

After you have dragged the Blog posts widget on your page, the widget automatically displays all published blog posts. 

To configure the display of the posts, perform the following: 

Click Edit button in the upper-right corner of the widget. 

The Blogs window appears where you can configure the following: 

CONTENT 

In content, you can choose the blogs whose posts you want to display. 

NOTE: If you are using multiple site management and the Blogs module uses data sources from more than one site, you must first 

choose the source from which you want to display blogs. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

In Which blog posts to display? radio button select one of the following: 

 From all blogs 

All posts from all blogs are displayed. 

 From selected blogs only… 

The system displays posts only from the selected blog.  

1. To select the blog, click Select a blog button. 
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A list of all created blogs appears. 

2. Select the blog and click Done selecting. 

 Under Narrow selection you can further specify which posts to display by choosing one of the following: 

 All published posts from selected blogs 

This is selected by default and displays all posts from the blogs selected in the previous step. 

 One particular post only… 

Select one post to display using the Select a blog post button. 

 Selection of posts: 

You can narrow the displayed posts, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display posts and click Done. 

 by Tags… 

Click Select button to select the tags, so that posts tagged with those particular tags will be displayed and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that posts created during that interval will be displayed or choose 

Custom range… and use the From and To input fields to select a time interval. When finished click Done. 

For more information, see Creating and editing blogs and blog posts. 

LIST SETTINGS 

On this tab you choose how to display the posts you have selected. 

 If you select Use paging radio button, the system divides the posts into pages.  

In the input field you specify how many posts per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the posts you have chosen to display. 

In the input field, you specify how many posts you want to display. 

 If you select No limit and paging radio button, the system displays all the posts that you have selected in Content tab. 

 In Sort blog posts dropdown box, select a sorting criterion for the posts. 

 In List template, select the template which is used to display the posts on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

SINGLE ITEM SETTINGS 

On this tab you choose the way to display a post when clicked. 

In Open Single item in… radio button, select one of the following: 

 Auto-generated page 

When a post is clicked, it is displayed in a page which is automatically generated and has the same layout as the current page. 

 Select existing page… 

You select a page from the existing pages with certain layout where the blog post will be displayed when clicked.  

NOTE: In order to display the blog post, the page you have selected must have the Blog posts widget added. 

1. Click Select Page. 

From the treeview, select the page where you want to display the post. 

2. Click Done selecting. 

 In Detail templates, select the template which is used to display the posts on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 
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 If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

FILTERING AND SORTING BLOG POSTS 

You can filter and sort the blog posts, which the widget displays, using both the default and the custom fields of the posts. 

1. To filter or sort the posts, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. Click ControlDefinition » Views » MasterBlogPostsFrontend buttons. 

 To filter the posts, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the posts, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished with all the settings, click Save. 

The Blogs window closes and the Blog posts widget is configured to display the posts you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

BLOGS LIST WIDGET 

Use this widget to display a list of created blogs.  

PREREQUISITES: You have created at least one blog. For more information, see Creating and editing blogs and blog posts. 

After you have dragged the Blogs list widget on your page, to configure the display of the list of blogs, perform the following: 

1. If you are using multiple site management and the Blogs module uses data sources from more than one site, you must first 

choose the source from which you want to display blogs. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Click Edit button in the upper-right corner of the widget. 

The Edit window appears. 

3. Select Which blogs to display?, by choosing one of the following: 

 All blogs 

All created blogs are displayed. 

 Blogs with no more than <number> posts. 

Displays all blogs that have posts exceeding the number, you enter in the input field. 

 Only blogs that have posts not older than <number> months. 

Displays all blogs, whose posts are created prior to the number that you enter in the input field. 

4. Choose how to sort the list of posts, by selecting one of the following: 

 Alphabetically (A-Z) 

Sorts the blogs by their names. 

 By date of the last post (newest on top) 

The blog with the newest post is displayed first. 

5. Select which template to use to display the list. 
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You can create a custom template by clicking Create new template. You can edit an existing template by selecting it and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

6. When you are finished with all the settings, click Save. 

The window closes and the Blogs list widget is configured to display a list of your blogs.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Content widgets group | Widgets | Table of contents | 

CONTENT BLOCK WIDGET 

ENTERING CONTENT 

Use this widget to enter content directly using the text editor and its features. You can use the basic formatting options of the text 

editor. You can type and format text, insert images, documents, and symbols, and paste already formatted text and tables from 

Microsoft Word. 

To do this, click Edit button in the upper-right corner of the widget. 

The Edit window appears where the text editor is displayed. 

For more information, see The text editor. 

USING SHARED CONTENT 

With the Content block widget you can reuse already created and shared content and you can also share the content that you have 

entered using the text editor. Shared content is stored in the Content blocks module. 

1. Click Edit button in the upper-right corner of the Content block widget. 

2. To display shared content, click Select from existing shared content button. 

A list of all created content blocks appears. 

3. If you are using multiple site management and the Generic content module uses data sources from more than one site, you 

must first choose the source from which you want to display content blocks.  

To do this, click Default source in the upper-right corner of the window, 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

4. Select the content block you want to use and click Done selecting. 

The shared content appears. You cannot edit a content that is shared, unless you explicitly open it for editing. 

5. To edit a shared content, perform one of the following: 

 Editing all instances of the shared content 

a. In case, you have just selected the shared content, click Edit this content button, otherwise, in case the Content 

block widget is not opened for editing, click Edit button in the upper-right corner of the widget. 

You can edit the content. 

IMPORTANT: The changes you make to the shared content apply to all pages, where the content is displayed. For 

more information, see Editing content blocks » Status of pages after editing a shared content block. 

b. Click Save changes. 

The Content block widget closes and the content item is updated. 

 Editing only the current content 

a. Click Unshare » Yes, Unshare this content. 

The system creates a local version of the shared content block. You can edit and save this copy without affecting 

other pages where the shared content is displayed. 

b. Click Save. 
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The Content block widget closes. 

SHARING CONTENT 

1. Drag the Content block widget on the page and click Edit button in the upper-right corner of the widget. 

2. Enter content using the text editor. 

3. When finished, click Share this content across pages button. 

4. Enter a name for the shared content and click Share this content. 

5. Click Save changes. 

The Content block widget closes. The content is shared and appears in the Content bocks module. 

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

NOTE: When the content block widget is displaying shared content, its title bar looks in the following way: 

 

NOTE: If you are using multiple site management and the Generic content module uses data sources from more than one site, 

when you share a content block, is saved in the data source of the current site. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

EXCLUDING A WIDGET FROM THE SITE SEARCH 

You can exclude a particular Content block widget from the site search.  

You do this by clicking Advanced button and entering true in ExcludeFromSearchIndex field. 

For more information, see Search indexes. 

| Content widgets group | Widgets | Table of contents | 

COMMENTS WIDGET 

Use this widget to give the users the possibility to leave a comment on a page. Drop the widget anywhere on the page that you 

want users to be able to leave and read comments. You can then see the comment in the comments module. For more 

information, see Comments and ratings. 

The Comments widget is different than the comments that a user can leave for an individual item, such as news. You can switch 

on and off comment for different items in the respective item’s module. For example, you can to switch on and off comments for 

an event when you create or edit the event. 

After you have dragged the Comments widget on your page, you must configure it to display comments.  

1. Click Edit button in the upper-right corner of the widget. 

The Page Comments window appears. 

2. Select the templates that the widget uses to display comments.  

You can change or create new templates for the following: 

 Comments template 

 Comments list view template 

 Submit comment view template 

You can edit the way the widget displays the comments, by clicking Edit selected template. For more information, see Sitefinity 

Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and editing widget templates. 

3. Click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 
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DOCUMENT LINK WIDGET 

Use this widget to display a link to a single document on your page. You can choose a document from the already uploaded or 

upload a new document. 

After you have dragged the Document link widget on your page you must configure it to display a link to a document.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Document window appears. 

2. Choose between the following: 

 Select document 

The system displays recent documents. 

a. In the right side of the window, select the library where the document you want to display is located. 

The system displays all documents and libraries in this library. 

You can display all uploaded documents by clicking All document or other files. 

For more information, see Uploading and editing documents and files. 

b. Click the document you want to display. 

c. Click Done. 

 Upload document 

a. To upload a document, drag and drop it in the window or click Select document or other file from your computer, 

browse your computer to find the document you want to upload and click Open. 

You can select only one document. 

b. In Library, select the library where you want to put the document, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

NOTE: If you want to store the document in a new library, you must create it. To do this, click Create new library. 

c. You can change the Title of the document. 

d. Change the categories and the tags which the document is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

e. If you have added any custom fields for documents, all created fields, appear after the Categories and tags section. 

For more information about creating custom fields and hiding default fields, see Custom fields.  

NOTE: Some of the above fields may not be displayed when you upload a document, if the view has been modified. 

To modify the view, click Administration  Settings  Advanced  ContentView  DocumentsBackend  Views  

SingleDocumentUploadDetailsView  Sections. 

f. Click Upload. 

NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you 

must first choose the source from which you want to display documents or where a document, uploaded from your computer, 

will be saved. 

To do this, use the dropdown button in the upper-right corner of the window. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

3. To change the selected document, click Change document button and perform Step 2. 

4. To edit the document, click Edit all properties. 

The Edit properties window opens. Perform procedure Editing the properties of documents and files. 

5. Click Settings tab. 

6. In Display icons radio button, select what kind of icon you want to display with the document link. 

7. When you are finished, click Save. 

The Document window closes and the Document link widget is configured to display the file you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 
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For more information about advanced configuration options, see Advanced configuration of widgets. 

DOWNLOAD LIST WIDGET 

Use this widget to display a list or table of links to documents and files, where each document or file can be downloaded. You can 

choose documents or files from the already uploaded or upload new. 

After you have dragged the Download list widget on your page you must configure it to display documents and files.  

To do this, click Edit button in the upper-right corner of the widget. 

In the Download list window that appears, configure the following: 

SELECTING THE DOCUMENTS AND FILES TO DISPLAY 

On Documents & Files tab you select which documents and files to display in the list. 

NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you must 

first choose the source from which you want to display documents. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

Perform the following: 

1. Select one of the following: 

 All published documents and files 

All documents and files that are uploaded and published will be displayed in the list. 

 From selected library… 

The Download list displays documents and files only from a certain library. 

a. To select a library, click Choose. 

The Choose library window appears 

b. Select the library, whose documents and files you want to display, and click Done selecting. 

For more information, see Uploading and editing documents and files.  

 Upload new… 

To upload a new document or file, click Upload and perform procedure Uploading documents and files » Step 5 to Step 

10. 

2. Under Narrow the selection you can further specify which documents or files to display by choosing one of the following: 

 All published documents from selected library 

This is selected by default and displays all documents and files selected in the previous step. 

 Selection of documents 

You can narrow the displayed documents or files, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display documents and files and click Done. 

 by Tags… 

Click Select button to select the tags, so that documents and files tagged with those particular tags will be displayed 

and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that documents and files uploaded during that interval will be 

displayed or choose Custom range… and use the From and To input fields to select a time interval. When finished 

click Done. 

3. In Sort documents and files, select a sorting criterion for the list of documents and files. 

CHOOSING HOW TO DISPLAY THE DOCUMENTS AND FILES 

On Settings tab you select the way the list of documents and files is displayed.  

1. In Select type radio button group, choose one of the following: 
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List 

 

In Fine tune the selected type the Display icons radio button group appears. 

Select the size of the icons that you want to be displayed in the list or select No icons. 

On the webpage, the documents and files are displayed in a list with their names, file types, and file 

sizes. 

If you have added description of the document or file, it is displayed as tooltip text when you hover over 

the name of the document or file. 

You can download the files by clicking their names. 

NOTE: You can edit the way the widget displays the download list, by clicking Edit Thumbnail list 

template. For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

Table 

 

In Fine tune the selected type the Display icons checkbox appears. 

Select the checkbox, if you want to display document and file icons in the table next to the Download 

link. 

The documents and files are displayed in a table, containing file names, file types, file sizes, date of 

upload of files, and a Download link. 

You can download the files by clicking the Download link. 

NOTE: You can edit the way the widget displays the download list, by clicking Edit Thumbnail list 

template. For more information, see Sitefinity Designer’s Guide » Widget templates» Using the Widget 

templates editor » Creating and editing widget templates. 

List+Detail 

page 

 

In Fine tune the selected type the Position of the Download link on the Detail page checkbox groups 

appears. 

Select one of the following: 

 Bellow the description 

On the details page the link for the download of the document or file appears bellow the file name 

and the description (if you have added a file description). 

 Above the description 

On the details page the link for the download of the document or file appears bellow the file name 

and above the description (if you have added a file description). 

The documents and files are displayed in a list. The list contains the file names.  

If you have added description of the document or file, it is displayed as tooltip text when you hover over 

the name of the document or file. 

NOTE: You can edit the way the widget displays the download list, by clicking Edit Thumbnail list 

template. For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

When you click the name of a document or file, a page with details opens.  

On the details page, the system displays the name of the file. The link for downloading the file, which is 

displayed where you have selected above. Bellow the Download link, the file type and file size are 

displayed. 

NOTE: You can edit the way the widget displays the detailed page, by clicking Edit Detail page template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates 

editor » Creating and editing widget templates. 

Table+Detail 

page 

 

In Fine tune the selected type the Display icons in the table checkbox appears, which you select if you 

want to display document and file icons in the table next to the Download link, and Position of the 

Downloaded link on the Detail page checkbox group appears, where you select one of the following: 

 Bellow the description 

On the details page the link for the download of the document or file appears bellow the file name 

and the description (if you have added a file description). 

 Above the description 

On the details page the link for the download of the document or file appears bellow the file name 

and above the description (if you have added a file description). 
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The documents and files are displayed in a table, containing file names, file types, file sizes, date of 

upload of files, and a Download link. 

If you have added description of the document or file, it is displayed as tooltip text when you hover over 

the name of the document or file.  

NOTE: You can edit the way the widget displays the download list, by clicking Edit Thumbnail list 

template. For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

When you click the name of a document or file, a page with details opens.  

On the details page, the system displays the name of the file. The link for downloading the file, which is 

displayed where you have selected above. Bellow the Download link, the file type and file size are 

displayed. 

NOTE: You can edit the way the widget displays the detailed page, by clicking Edit Detail page template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates 

editor » Creating and editing widget templates. 

For more information about adding details to a document or file, see Editing properties of documents and files » Step 7. 

2. In Fine tune the selected type, perform the following: 

 If you select Use paging radio button, the system divides the list of documents and files into pages.  

In the input field you specify how many documents or files per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the documents and files. 

In the input field, you specify how many documents or files you want to display.  

 If you select No limit and paging radio button, the system displays all the documents and files that you have selected in 

Documents & Files tab. 

FILTERING AND SORTING DOCUMENTS AND FILES 

You can filter and sort the documents and files, which the widget displays, using both the default and the custom fields of the 

documents or files. 

1. To filter or sort the documents and files, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. In MasterViewName input field, check which view the widget uses. 

3. Click ControlDefinition » Views buttons. 

4. Choose for which view, you want to apply filtering or sorting by selecting the view that the widget uses. 

5. Filter or sort the documents and files in the following way: 

 To filter the documents and files, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the documents and files, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished, click Save. 

The Download list window closes and the Download list widget is configured to display links to the documents you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 
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EVENTS WIDGET 

Use this widget to display already created events. 

PREREQUISITES: You have created at least one event. For more information, see Creating and editing events. 

After you have dragged the Events widget on your page you must configure it to display events and calendars.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Events window appears. 

1. Under What events functionality to use? you must choose how your events will function. 

NOTE: If you are using multiple site management, regardless of what functionality you choose, under Settings, you must first 

choose the source from which you want to display events. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. Choose how to display events by selecting one of the following: 
 

List + single 

item 

The system displays a list of events, when you click an event, you can see its details. 

Under Settings, perform the following: 

1. In Display… radio button select one of the following: 

 All upcoming, current, and past events 

 Upcoming events only 

 Current events only 

 Past events only 

 Upcoming and current events 

 Current and past events 

2. Under Narrow the selection you can further specify which events to display by choosing one of the 

following: 

 By calendar 

Click the Select button to select the calendars from which you want to display events and click 

Done. 

 All published events 

This is selected by default and displays all events selected in the previous step. 

 Selection of events 

You can narrow the displayed events, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display events and 

click Done. 

 by Tags… 

Click Select button to select the tags, so that events tagged with those particular tags will 

be displayed and click Done. 

 By Authors… 

 Click the Select button to select the authors of events from which you want to display 

events and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that events created during that interval will 

be displayed or choose Custom range… and use the From and To input fields to select a 

time interval. When finished click Done. 

3. In Open Single item in… radio button, select one of the following: 

 Auto-generated page 
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When an event is clicked, it is displayed in a page which is automatically generated and has the 

same layout as the current page. 

 Select existing page… 

You select a page from the existing pages with certain layout where an event will be displayed 

when clicked.  

NOTE: In order to display the event, the page you have selected must have the Events widget 

added. 

a. Click Select Page. 

From the treeview, select the page where you want to display the event. 

b. Click Done selecting. 

4. Under , perform the following: 

 If you select Use paging radio button, the system divides the events into pages.  

In the input field you specify how many events per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the events 

you have chosen to display. 

In the input field, you specify how many events you want to display. 

 If you select No limit and paging radio button, the system displays all the events that you have 

selected in Content tab. 

5. In Sort events dropdown box, select a sorting criterion for the events. 

6. Under Templates, perform the following: 

 In List template, select the template which is used to display the events on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing 

templates by selecting them and clicking Edit. 

 In Detail templates, select the template which is used to display the events on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing 

templates by selecting them and clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

7. If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

Single item only The system displays only one event in detail. 

Under Settings, perform the following: 

1. Select the event to be displayed by choosing one of the following: 

 Current opened event item 

 Selected particular event item... 

Select the event and click Done selecting. 

2. Under Templates, perform the following: 

 In List template, select the template which is used to display the events on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing 

templates by selecting them and clicking Edit. 

 In Detail templates, select the template which is used to display the events on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing 

templates by selecting them and clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

3. If you want users to be able to add the event to their Outlook, Google Calendar, and iCal, select 

Allow users to add events to their calendar checkbox. 
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4. If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

Calendar The system displays all events in a calendar view and events from different calendars are color coded. 

Under Settings, perform the following: 

1. In Display… radio button select one of the following: 

 All upcoming, current, and past events 

 Upcoming events only 

 Current events only 

 Past events only 

 Upcoming and current events 

 Current and past events 

2. Under Narrow the selection you can further specify which events to display by choosing one of the 

following: 

 By calendar 

Click the Select button to select the calendars from which you want to display events and click 

Done. 

 All published events 

This is selected by default and displays all events selected in the previous step. 

 Selection of events 

You can narrow the displayed events, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display events and 

click Done. 

 by Tags… 

Click Select button to select the tags, so that events tagged with those particular tags will 

be displayed and click Done. 

 By Authors… 

 Click the Select button to select the authors of events from which you want to display 

events and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that events created during that interval will 

be displayed or choose Custom range… and use the From and To input fields to select a 

time interval. When finished click Done. 

3. Under Page for Single item, select the page where the event will open when clicked by choosing 

Select button, selecting the page and clicking Done selecting. 

4. Under Calendar appearance, perform the following: 

a. In Default view dropdown, select whether you want the calendar to display a Month, a Week, 

or a Day. 

b. Choose, if you want the users to be able to change the view by selecting Allow users to change 

view mode checkbox. 

c. You can allow users to create events or calendars, by selecting Allow users to create events 

and Allow users to create calendars checkboxes, respectively. 

5. Under Templates, perform the following: 
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 In Calendar template, select the template which is used to display the events on the calendar 

view. 

You can create a custom template by clicking Create new template. You can edit existing 

templates by selecting them and clicking Edit. 

 In Quick create template and Full create template select the templates which are used when a 

user creates and event or calendar. 

You can create a custom template by clicking Create New Template. You can edit existing 

templates by selecting them and clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget 

templates editor » Creating and editing widget templates. 

6. If you want users to be able to add the event to their Outlook, Google Calendar, and iCal, select 

Allow users to add events to their calendar checkbox. 

FILTERING AND SORTING THE EVENTS 

You can filter and sort the events, which the widget displays, using both the default and the custom fields of the events. 

1. To filter or sort the events, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. Click ControlDefinition » Views » EventsFrontendList buttons. 

 To filter the events, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the events, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished with all the settings, click Save. 

The Events window closes and the Events widget is configured to display the event you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

FEED WIDGET 

Use this widget to display RSS feed on your website. 

PREREQUISITES: You have created at least one feed. For more information, see Feeds. 

After you have dragged the Feed widget on your page you must configure it to display a feed. 

1. To do this, click Edit button in the upper-right corner of the widget. 

The Feed window appears. 

2. Select the feed to be displayed on the page by clicking Select a feed button. 

From the list of feeds that appears, select one feed and click Done selecting. 

NOTE: The Feed widget can display only one feed, if you want to display more feeds, add more Feed widgets to your page. 

3. Choose how to display the feed by selecting one of the following in Insert… radio button group: 

 Links both in the page and in the browser address-bar 
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The system displays a clickable link on the page that leads to the RSS feed. The browser also automatically detects the 

RSS feed published by the page, and displays  link in the address bars of Mozilla Firefox, Safari, and Google Chrome or 

in the toolbar of Internet Explorer. 

 Link in the browser address-bar only 

The system does not display a clickable link on the page, but the browser automatically detects the RSS feed published by 

the page, and displays  link in the address bars of Mozilla Firefox, Safari, and Google Chrome or in the toolbar of 

Internet Explorer. 

 Link in the page only 

The system displays a clickable link on the page that leads to the RSS feed. 

4. In Text to display input field, enter the text which is displayed as title of the feed. 

By default the title of the feed is displayed, or if the feed was created when creating a blog, the name of the blog is displayed. 

5. In Icon radio button group, select the type of icon that is displayed with the feed. 

6. If you click More options, you can configure the following: 

 You can add a tooltip text for the feed that is displayed when you hover over the RSS link. 

 You can assign a CSS class name to the feed in case you want to style the link later. 

 You can choose to open the feed in a new window, by selecting Open this link in a new window checkbox. 

7. When you are finished, click Save. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

FORM WIDGET 

Use this widget to display all kind of forms you have created with the form builder. 

PREREQUISITES: You have created at least one form. For more information, see Creating and editing forms. 

After you have dragged the Form widget on your page you must configure it to display a form. 

1. To do this, click Edit button in the upper-right corner of the widget. 

The Select a form window appears displaying a list of all created forms. 

2. Select the form you want to display on the page. 

If you want to display more than one form, you must add the Form widget more than one times. 

3. Click Settings. 

4. Under Confirmation options, select if you want to Use custom confirmation. 

This way the form displayed with the current form widget will have a confirmation different than the one configured in the 

form’s settings. For more information, see Designing a form Step 4. 

5. In this radio button group, you choose what happens after a user submits the form.  

Select one of the following: 

 Show message for success 

A textbox appears, where you define the success message that appears when a user submits the form. 

 Redirect to a page… 

After submitting the form the system redirects the user to another page of the website. 

In the input field that appears, enter the URL of the page from your website, which you want to open when the form is 

submitted. For example, About-us. 

6. When you are finished, click Done selecting. 

The Select a form window closes and the Form widget is configured to display the form you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 
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you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

FORUMS WIDGET 

Use this widget to display a forums, forum threads, and forum posts. 

After you have dragged the Forums widget on your page you must configure it to display forums, threads, and posts.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Forums window appears. 

2. Under What forum functionality to use? you must choose how your forum will function. 

NOTE: If you are using multiple site management, regardless of what functionality you choose, under Settings, you must first 

choose the source from which you want to display forums. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

3. Choose how to display forums by selecting one of the following: 
 

Full forum 

functionality 

The forums and their posts are displayed in three levels. On the first page, the system displays a list of 

selected forums, when the user clicks a forum, a list of all threads in this forum appear. The user is 

given the opportunity to create a new thread. When the user clicks a thread, a list of all posts in the 

thread appears and the user is given the opportunity to post a reply. 

In Settings, perform the following: 

 Select which forums to display. 

In Display… radio button group, select one of the following: 

 All forums 

All created forums will be displayed in the list of forums. 

 Forums from selected groups: 

Only forums from one or more forum groups will be displayed. 

i. To select the group(s), click Select groups. 

A list of all created forum groups appears.  

ii. Select one or more groups and click Done. 

 Selected forums... 

Only one or more selected forums will be displayed. 

i. To select the forum(s), click Select forums. 

A list of all created forums appears.  

ii. Select one or more forums and click Done. 

 Select the page that displays the information about the author of each post. 

This page will be displayed when the user clicks the name of the author of a post. 

IMPORTANT: The page must have the Users list widget added to it. 

i. Click Select a page. 

ii. Form the list of all pages, select the page that will be displaying the user profile information 

and click Done selecting. 

 Choose whether you want to display a breadcrumb of the forum levels by selecting Show 

breadcrumb checkbox.  

A breadcrumb starting with Forums > Forum groups > Forums… will be displayed. 

If you want to display a full breadcrumb, starting from your home page, select Include full path 

starting from Home page checkbox. 

 If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 
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Forum list only The page where you have added the widget displays only a list of forums. When you click a forum in the 

list, the forum threads open in another page that you have to specify. 

 Select which forums to display. 

In Display… radio button group, select one of the following: 

 All forums 

All created forums will be displayed in the list of forums. 

 Forums from selected groups: 

Only forums from one or more forum groups will be displayed. 

i. To select the group(s), click Select groups. 

A list of all created forum groups appears.  

ii. Select one or more groups and click Done. 

 Selected forums... 

Only one or more selected forums will be displayed. 

i. To select the forum(s), click Select forums. 

A list of all created forums appears.  

ii. Select one or more forums and click Done. 

 Select the page that displays the threads of a forum. 

 When a user clicks a forum in the list of forums, the threads open in a separate page that you have 

to prepare in advance. 

IMPORTANT: The page must have the Forums widget added to it. 

i. Click Select a page. 

ii. Form the list of all pages, select the page that will be displaying the threads and click Done 

selecting. 

Threads only The page where you have added the widget displays only a list of threads of one or more forums. When 

you click a thread in the list, the posts open in another page that you have to specify.  

 Select the forums from which you want to display threads. 

In Display… radio button group, select one of the following: 

 Auto: threads from the currently open forum 

If a user has reached this page by clicking a forum on another page, the threads of this forum 

are automatically displayed. 

 Threads from selected forums only 

Only threads from one or more forums will be displayed. 

i. To select the forum(s), click Select forums. 

A list of all created forums appears.  

ii. Select one or more forums and click Done. 

 All threads from all forums 

All created forum threads appear in the list. 

 Select the page that displays the posts of a thread. 

When a user clicks a thread in the list of threads, the posts open in a separate page that you have 

to prepare in advance. 

IMPORTANT: The page must have the Forums widget added to it. 

i. Under Page for Posts of each thread, click Select a page. 

ii. Form the list of all pages, select the page that will be displaying the posts and click Done 

selecting. 

 Select the page that displays the information of the author of each thread. 

This page will be displayed when the user clicks the name of the author of a thread. 

IMPORTANT: The page must have the Users list widget added to it. 
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i. Click Select a page. 

ii. Form the list of all pages, select the page that will be displaying the user profile information 

and click Done selecting. 

Posts of one 

thread only 

The page where you have added the widget displays only a list of posts of a particular thread.  

 Select posts from which thread to display. 

In Display… radio button group, select one of the following: 

 Auto: posts from the currently open thread 

If a user has reached this page by clicking a thread on another page, the threads of this forum 

are automatically displayed. 

 Posts from selected thread... 

Only posts from one thread will be displayed. 

i. To select the thread, click Select thread. 

ii. A list of all created threads appears.  

iii. Select one thread and click Done. 

 Select the page that displays the information of the author of each post. 

This page will be displayed when the user clicks the name of the author of a post. 

IMPORTANT: The page must have the Users list widget added to it. 

i. Click Select a page. 

ii. Form the list of all pages, select the page that will be displaying the user profile information 

and click Done selecting. 

 If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

4. To edit the way forums, threads, and posts are displayed, expand Templates for forum parts. 

Using the dropdown boxes, choose which template is used to display lists of forums, threads, and posts. 

You can edit existing templates by selecting them and clicking Edit selected template button or you can create new templates, 

by clicking Create new templates button. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

5. If you are in multiple site mode and you want to configure a forum RSS feed, different than the default, you must click 

Advanced button in the lower-right corner of the widget and then enter the URL or the relative path of the feed in 

RssFeedPath field. 

6. When you are finished, click Save. 

The Forums window closes and the widget is configured.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

DISPLAY THE REPLY BUTTONS IN FORUM THREADS AND FORUM POSTS TO UNAUTHORIZED USERS 

The Forums widget does not allow users that are not logged in to reply to forum threads and posts. The reply buttons are visible 

only after the user is logged in. To display these buttons unauthorized users, you must configure the Advanced option in the 

Forums widget. When an unauthorized user clicks the reply button, he or she will be redirected to the frontend login page and 

after a successful login, redirected back to the initially forum post or thread to post the reply. 

To display the forum thread and forum post reply buttons to unauthorized users, perform the following: 

1. Create a frontend login page with a Login widget. 
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2. Place the Forum widget on a page of your website 

3. Set the URL of the frontend login page, by performing one of the following: 

 If you have a single site, click Administration » Settings » Advanced » Project » DefaultSite and fill out one of the 

following fields: 

 If you know the GUID of the frontend login page, enter it in FrontEndLoginPageId. 

 If you only know the absolute URL of the frontend login page, enter it in FrontEndLoginPageUrl. 

 If you have a multisite license, perform the following: 

a. Expand the selector in the upper-left corner of the page and click Manage sites. 

b. Click the Actions button of the site and in the dropdown menu, click Properties. 

c. Expand Advanced section. 

d. Under Address for public users login, select Select a page… radio button, click Select a page button and select the 

frontend login page. 

| Content widgets group | Widgets | Table of contents | 

IMAGE WIDGET 

Use this widget to display a single image on your page. You can choose an image from the already uploaded or upload a new 

image. 

After you have dragged the Image widget on your page you must configure it to display an image.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Image window appears. 

2. Choose between the following: 

 Select image 

The system displays recent images. 

a. In the right side of the window, select the library where the image you want to display is located. 

The system displays all images and libraries in this library. 

You can display all uploaded images by clicking All images. 

For more information, see Uploading and editing images. 

b. Click the image you want to display. 

c. Click Done. 

 Upload image 

a. To upload an image, drag and drop it in the window or click Select image from your computer, browse your computer 

to find the image you want to upload and click Open. 

You can select and display only one image. 

b. In Library, select the library where you want to put the image, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

NOTE: If you want to store the image in a new library, you must create it. To do this, click Create new library. 

c. You can change the Title of the image. 

d. In Alternative text input field, enter text that is used for accessibility reasons and by search engines. 

e. Change the categories and the tags which the image is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

f. If you have added any custom fields for images, all created fields, appear after the Categories and tags section. 

For more information about creating custom fields and hiding default fields, see Custom fields.  

NOTE: Some of the above fields may not be displayed when you upload an image, if the view has been modified. To 

modify the view, click Administration  Settings  Advanced  ContentView  ImagesBackend  Views  

SingleImageUploadDetailsView  Sections. 

g. Click Upload. 
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NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you 

must first choose the source from which you want to display images or where an image, uploaded from your computer, will be 

saved. 

To do this, use the dropdown button in the upper-right corner of the window. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

3. To change the selected image, click Change image button and perform Step 2. 

4. To edit the image, click Edit all properties. 

The Edit image window opens. Perform procedure Editing images. 

5. Click Settings tab. 

6. If you want to display the image in size different than its original size, in Image size, select the width to which you want to 

resize the image. 

In the dropdown box, all predefined image sizes appear. For more information, see Thumbnails. 

If you select Custom size… you can create a custom thumbnail by performing procedure Thumbnails  Step 4 to Step 10. 

7. Expand Margin. 

Enter in pixels the margins that you want to surround the image when displayed on the site. 

8. If you want the user to be able to view the image in its original size by clicking it, select the Clicking the resized image opens 

the image in its original size checkbox. 

9. When you are finished, click Save. 

The Image window closes and the Image widget is configured to display the image you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

IMAGE GALLERY WIDGET 

Use this widget to display a gallery of image thumbnails, where each image can be opened individually. You can choose images 

from the already uploaded or upload new images. 

After you have dragged the Image gallery widget on your page you must configure it to display images.  

To do this, click Edit button in the upper-right corner of the widget. 

The Image Gallery window appears, containing two tabs. 

IMAGES TAB 

On Images tab you select which images to display in the gallery. 

NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you must 

first choose the source from which you want to display images. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

1. Select one of the following: 

 All published images 

All images that are uploaded and published are displayed in the gallery. 

 From selected library… 

The Image gallery displays images only from a certain library. 

a. To select a library, click Choose. 

The Choose Image Library window appears 

b. Select the library, whose images you want to display, and click Done selecting. 

 Upload new images… 

To upload new images, click Upload and perform procedure Uploading images » Step 5 to Step 10. 

2. Under Narrow selection you can further specify which images to display by choosing one of the following: 
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 All published images from selected library 

This is selected by default and displays all posts from the blogs selected in the previous step. 

 Selection of images: 

You can narrow the displayed images, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display images and click Done. 

 by Tags… 

Click Select button to select the tags, so that images tagged with those particular tags will be displayed and click 

Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that images uploaded during that interval will be displayed or choose 

Custom range… and use the From and To input fields to select a time interval. When finished click Done. 

3. In Sort images, select a sorting criterion for the images in the gallery. 

SETTINGS TAB 

On Settings tab you select the way the images in the gallery are displayed when opened.  

Select one of the following: 
 

Thumbnails + 

Detailed page 

 

The image gallery displays the images as thumbnails. The description of the images is displayed in tooltip 

text. When clicked, the image is displayed in a bigger size in the same page together with image title, the 

user that has uploaded the image, the date of upload, and the description. 

In Fine tune the selected type, perform the following: 

1. Select one of the following: 

 If you select Use paging radio button, the system divides the list of image thumbnails into pages.  

In the input field you specify how many image thumbnails per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the image 

thumbnails. 

In the input field, you specify how many image thumbnails you want to display.  

 If you select No limit and paging radio button, the system displays thumbnails of all the images that 

you have selected in Images tab. 

2. Select the Size of thumbnails. 

In the dropdown box, all predefined thumbnail sizes appear. For more information, see Thumbnails. 

3. Select the Size of the image. 

In the dropdown box, all predefined image sizes appear. 

If you select Custom size… the Width input field appears where you enter the desired width in pixels. 

4. If you want to open the individual images in the same page, select Open Single item in existing page... 

5. If you want to display links to the previous and the next image, select Show links to the previous and 

next image as… checkbox. 

You use the radio buttons, which appear, to select how to display the links. Choose one of the following: 

 Text Links 

 Thumbnails of previous and next image 

NOTE: You can edit the way the widget displays the list of images, by clicking Edit Thumbnail list template 

and the detailed display of an image by clicking Edit Detail page template. For more information, see Sitefinity 

Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and editing widget 

templates. 

Thumbnails + 

Overlay 

(lightbox) 

The image gallery displays the images as thumbnails. The description of the images is displayed in tooltip 

text. When clicked, the image is displayed in a bigger size as an overlay of the page together with its 

description. 
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 In Fine tune the selected type, perform the following: 

1. Select one of the following: 

 If you select Use paging radio button, the system divides the list of image thumbnails into pages.  

In the input field you specify how many image thumbnails per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the image 

thumbnails. 

In the input field, you specify how many image thumbnails you want to display.  

 If you select No limit and paging radio button, the system displays thumbnails of all the images that 

you have selected in Images tab. 

2. Select the Size of thumbnails. 

In the dropdown box, all predefined thumbnail sizes appear. For more information, see Thumbnails. 

3. Select the Size of the image. 

In the dropdown box, all predefined image sizes appear. 

If you select Custom size… the Width input field appears where you enter the desired width in pixels. 

NOTE: You can edit the way the widget displays the list of images, by clicking Edit Thumbnail list template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor 

» Creating and editing widget templates. 

Thumbnail 

strip + Image 

on the same 

page 

 

The image gallery displays a horizontal strip of image thumbnails. When you click an image from the strip, a 

preview of the image is displayed above the thumbnail strip.  

In Fine tune the selected type, perform the following: 

1. If you select Use limit checkbox, the system displays only a limited number of the images. 

In the input field, you specify how many images or files you want to display.  

2. Select the Size of thumbnails. 

In the dropdown box, all predefined thumbnail sizes appear. For more information, see Thumbnails. 

3. Select the Size of the image. 

In the dropdown box, all predefined image sizes appear. 

If you select Custom size… the Width input field appears where you enter the desired width in pixels. 

4. If you want to display links to the previous and the next image, select Show links to the previous and 

next image checkbox. 

NOTE: You can edit the way the widget displays the list of images, by clicking Edit Thumbnail list template 

and the detailed display of an image by clicking Edit Detail page template. For more information, see Sitefinity 

Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and editing widget 

templates. 

Simple list 

 

All images are displayed in a large size. The description of the images is displayed in tooltip text. 

In Fine tune the selected type, select one of the following: 

 If you select Use paging radio button, the system divides the list of images into pages.  

In the input field you specify how many images per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the images. 

In the input field, you specify how many images you want to display.  

 If you select No limit and paging radio button, the system displays all the images that you have selected 

on Images tab. 

NOTE: You can edit the way the widget displays the list of images, by clicking Edit Thumbnail list template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor 

» Creating and editing widget templates. 

If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

FILTERING AND SORTING THE IMAGES 
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You can filter and sort the images, which the widget displays, using both the default and the custom fields of the images. 

1. To filter or sort the images, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. In MasterViewName input field, check which view the widget uses. 

3. Click ControlDefinition » Views buttons. 

4. Choose for which view, you want to apply filtering or sorting by selecting the view that the widget uses.  

5. Filter or sort the images in the following way: 

 To filter the images, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the images, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished, click Save. 

The Image Gallery window closes and the Image gallery widget is configured to display the images you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

LIST WIDGET 

Use this widget to display already created lists with list items. 

PREREQUISITES: You have created at least one list with at least one list item in it. For more information, see Creating and 

editing lists. 

After you have dragged the List widget on your page, to configure the display, perform the following: 

Click Edit button in the upper-right corner of the widget. 

The Edit window appears where you can configure the following: 

CONTENT 

In content, you can choose the lists from which you want to display list items. 

1. If you are using multiple site management and the Lists module uses data sources from more than one site, you must first 

choose the source from which you want to display lists. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

2. In Which lists to display radio button select one of the following: 

a. Click Select lists button. 

A list of all created lists appears. 

b. Select one or more lists and click Done selecting. 

SETTINGS 

On this tab you choose the way to display the lists and list items. 

Select one of the following: 

 Simple list 

The system displays all items, grouped in lists. This is a list of the titles of the list items, which cannot be clicked. 

 Expanded list 



 

199 

The system displays all items, grouped in lists. Below each item, the system displays its content. 

 Expandable list 

The system displays all items, grouped in lists. This is a list of the titles of the list items. When you click a list item, its content 

appears. 

 Anchor list 

The system displays all items, grouped in lists. This is a list of the titles of the list items. Below the list the system displays the 

content of the items. When you click an item, the system takes you to its content. 

 Page list 

The system displays all items, grouped in lists. This is a list of the titles of the list items. When you click an item, the system 

opens its content on a separate page. 

For each option that you choose, you can select a template that will be used to display the list. You can edit existing templates. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

When you are finished with all the settings, click Save. 

The Edit window closes and the List widget is configured to display the lists you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Content widgets group | Widgets | Table of contents | 

NEWS WIDGET 

Use this widget to display already created news. 

PREREQUISITES: You have created at least one news item. For more information, see Creating and editing news. 

After you have dragged the News widget on your page you must configure it to display selected news. 

To do this, click Edit button in the upper-right corner of the widget. 

The News window appears where you can configure the following: 

CONTENT 

In content, you can choose which news of all the created news you want to display. 

In Which news to display? radio button select one of the following: 

 All published news 

All created news are displayed. 

 One particular news item only… 

The system displays one news item.  

1. To select the news you want to display, click Select news button. 

A list of all news appears. 

2. Select the news item and click Done selecting. 

 Selection of news: 

You can narrow the displayed news, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display news and click Done. 

 by Tags… 

Click Select button to select the tags, so that news tagged with those particular tags will be displayed and click Done. 
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 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that news created during that interval will be displayed or choose Custom 

range… and use the From and To input fields to select a time interval. When finished click Done. 

LIST SETTINGS 

On this tab you choose how to display the news you have selected. 

 If you select Use paging radio button, the system divides the news into pages.  

In the input field you specify how many news per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the news you have chosen to display.  

In the input field, you specify how many news you want to display. 

 If you select No limit and paging radio button, the system displays all the news that you have selected in Content tab. 

 In Sort news dropdown box select a sorting criterion for the news. 

 In List template, select the template that is used to display the news on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

SINGLE ITEM SETTINGS 

On this tab you choose the way to display the news. 

In Open Single item in… radio button, select one of the following: 

 Auto-generated page 

When a news item is clicked it is displayed in a page which is automatically generated and has the same layout as the current 

page. 

 Select existing page… 

You select a page from the existing pages with certain layout where a news item will be displayed when clicked.  

NOTE: In order to display the news, the page you have selected must have the News widget added. 

1. Click Select page. 

From the treeview, select the page where you want to display the news. 

2. Click Done selecting. 

 In Detail templates, select the template which is used to display the news on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

 If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

FILTERING AND SORTING THE NEWS 

You can filter and sort the news, which the widget displays, using both the default and the custom fields of the news. 

1. To filter or sort the news, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. Click ControlDefinition » Views » NewsFrontendList buttons. 

 To filter the news, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the news, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  
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For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished with all the settings, click Save. 

The News window closes and the News widget is configured to display the news you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

VIDEO WIDGET 

Use this widget to display a single video on your page. The widget uses Telerik RadMedia Played, which is an HTML5 video player. 

It supports WebM (.webm), Ogg (.ogv), and MP4 (.mp4) file formats. You can choose a video from the already uploaded or 

upload a new video. 

PREREQUISITE: Your video library must support HTML5 mode. For more information, see Sitefinity Installation and 

Administration Guide  Settings  Libraries and Storage  Libraries upload mode. 

After you have dragged the Video widget on your page you must configure it to display a video.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Video window appears. 

2. Choose between the following: 

 Select video 

The system displays recent video. 

a. In the right side of the window, select the library where the video you want to display is located. 

The system displays all videos and libraries in this library. 

You can display all uploaded videos by clicking All videos. 

For more information, see Uploading and editing videos. 

b. Click the video you want to display. 

c. Click Done. 

 Upload video 

a. To upload a video, drag and drop it in the window or click Select video from your computer, browse your computer to 

find the video you want to upload and click Open. 

You can select and display only one video. 

b. In Library, select the library where you want to put the video, by clicking Change. 

The tree with all created libraries appears. Select the library and click Done. 

NOTE: If you want to store the video in a new library, you must create it. To do this, click Create new library. 

c. You can change the Title of the video. 

d. Change the categories and the tags which the video is assigned to, by clicking Categories and tags. 

For more information, see Adding categories and tags to a content item. 

e. If you have added any custom fields for videos, all created fields, appear after the Categories and tags section. 

For more information about creating custom fields and hiding default fields, see Custom fields.  

NOTE: Some of the above fields may not be displayed when you upload a video, if the view has been modified. To 

modify the view, click Administration  Settings  Advanced  ContentView  VideosBackend  Views  

SingleVideoUploadDetailsView  Sections. 

f. Click Upload. 

NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you 

must first choose the source from which you want to display videos or where a video, uploaded from your computer, will be 

saved. 

To do this, use the dropdown button in the upper-right corner of the window. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 



 

202 

3. To change the selected video, click Change video button and perform Step 2. 

4. To edit the video, click Edit all properties. 

The Edit video window opens. Perform procedure Editing videos. 

5. Click Settings tab. 

6. In the dropdown box, select the Aspect ratio of the video. 

7. When you are finished, click Save. 

The Video window closes and the Video widget is configured to display the video you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

PLAYING YOUTUBE VIDEOS AND PLAYLISTS 

You can configure the Video widget to play a YouTube video or a YouTube playlist. 

To do this, perform the following: 

1. Open the widget for editing and in the lower-right corner, click Advanced button. 

 If you want to play a single YouTube video, in YouTubeVideoURL, enter the URL of the video. 

 If you want to play a YouTube playlist, in YouTubePlaylistID, enter the YouTube playlist ID. 

2. Save your changes. 

SWITCHING THE MEDIA PLAYER MODE BACK TO SILVERLIGHT 

If you want to switch the player mode of the Video widget back to Silverlight, perform the following: 

1. Open the widget for editing and in the lower-right corner, click Advanced button. 

2. In MediaPlayerMode, enter Silverlight. 

3. Change the libraries mode to Silverlight. 

For more information, see Sitefinity Installation and Administration Guide  Settings  Libraries and Storage  Libraries 

upload mode. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

VIDEO GALLERY WIDGET 

Use this widget to display a gallery of video thumbnails, where each video can be played individually. The widget uses Telerik 

RadMedia Played, which is an HTML5 video player. It supports WebM (.webm), Ogg (.ogv), and MP4 (.mp4) file formats. 

PREREQUISITE: Your video library must support HTML5 mode. For more information, see Sitefinity Installation and 

Administration Guide  Settings  Libraries and Storage  Libraries upload mode. 

You can choose videos from the already uploaded or upload new videos. 

After you have dragged the Video gallery widget on your page you must configure it to display videos.  

To do this, click Edit button in the upper-right corner of the widget. 

The Video Gallery window appears, containing two tabs. 

VIDEOS TAB 

On Videos tab you select which videos to display in the gallery. 

NOTE: If you are using multiple site management and the Libraries module uses data sources from more than one site, you must 

first choose the source from which you want to display videos. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

1. Select one of the following: 

 All published videos 

All videos that are uploaded and published are displayed in the gallery. 
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 From selected library… 

The Video gallery displays videos only from a certain library. 

a. To select a library, click Choose. 

The Choose Library window appears 

b. Select the library, whose videos you want to display, and click Done selecting. 

For more information, see Uploading and editing videos. 

 Upload new videos… 

To upload new videos, click Upload and perform procedure Uploading videos » Step 5 to Step 10. 

2. Under Narrow the selection you can further specify which videos to display by choosing one of the following: 

 All published videos from selected library 

This is selected by default and displays all videos selected in the previous step. 

 Selection of videos 

You can narrow the displayed videos, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display videos and click Done. 

 by Tags… 

Click Select button to select the tags, so that videos tagged with those particular tags will be displayed and click 

Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that videos created during that interval will be displayed or choose 

Custom range… and use the From and To input fields to select a time interval. When finished click Done. 

3. In Sort videos, select a sorting criterion for the videos in the gallery. 

SETTINGS TAB 

On Settings tab you select the way the videos in the gallery are displayed when opened.  

1. In Select video gallery type area, select one of the following: 

 Thumbnails + Detailed page 

The video gallery displays the videos as thumbnails. The description of the video is displayed in tooltip text. When clicked, 

the video is displayed in its original size in the same page together with video title, the user that has uploaded the video, 

the date of upload, and the description. 

 Thumbnails + Overlay (lightbox) 

The video gallery displays the videos as thumbnails. The description of the videos is displayed in tooltip text. When 

clicked, the video is displayed in its original size as an overlay of the page together with its description. 

2. In Fine tune the selected type, perform the following: 

 If you select Use paging radio button, the system divides the thumbnail list of videos into pages.  

In the input field you specify how many video thumbnails per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the video thumbnails. 

In the input field, you specify how many video thumbnails you want to display.  

 If you select No limit and paging radio button, the system displays all the videos that you have selected in Videos tab. 

3. Select the size of the thumbnails that the videos in the gallery will use. 

4. Perform one of the following: 

 If you have chosen Thumbnails + Detailed page, choose one or more of the following checkboxes: 

 Show options for embedding 

 Allow full size 

 If you have chosen Thumbnails + Overlay (lightbox) page, select if you want to allow displaying the full sized video.  
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5. You can edit the way the widget displays the list of videos, by clicking Edit Thumbnail list template and the detailed display of 

a video by clicking Edit Detail page template. For more information, see Sitefinity Designer’s Guide » Widget templates » Using 

the Widget templates editor » Creating and editing widget templates. 

6. If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

FILTERING AND SORTING THE VIDEOS 

You can filter and sort the videos, which the widget displays, using both the default and the custom fields of the video. 

1. To filter or sort the videos, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. In MasterViewName input field, check which view the widget uses. 

3. Click ControlDefinition » Views buttons. 

4. Choose for which view, you want to apply filtering or sorting by selecting the view that the widget uses. 

5. Filter or sort the videos in the following way: 

 To filter the videos, in FilterExpression input field, enter the desired filtering expression. 

You can use both default and custom fields. The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the videos, in SortExpression input field, enter the desired sorting expression. 

You can use both default and custom fields. The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: To see all custom and default fields, perform procedure Creating a new custom field » Step 1 and Step 2. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished, click Save. 

The Video Gallery window closes and the Video gallery widget is configured to display the videos you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

DYNAMIC CONTENT WIDGETS 

If you have created and activated a dynamic module, the system automatically creates a widget and displays the widget in the 

content widget group. You use the widget to select which of your dynamic content to display on the website and to choose how to 

display the content. 

PREREQUISITES: You have created at least one dynamic content item. For more information, see Dynamic modules. 

After you have dragged the widget on your page, the widget automatically displays all published dynamic items. 

To configure the display of the items, perform the following: 

Click Edit button in the upper-right corner of the widget. 

The Edit window appears where you can configure the following: 

CONTENT 

In content, you can choose which dynamic items of all the created items you want to display.  

NOTE: If you are using multiple site management and the dynamic module uses data sources from more than one site, you must 

first choose the source from which you want to display items. 

For more information, see Sitefinity Installation and Administration Guide » Multiple site management. 

In Which <item name> to display? radio button select one of the following: 

 All published <item name> 
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All created items are displayed. 

 One particular <item name> only… 

The system displays one item.  

1. To select the item you want to display, click Select <item name> button. 

A list of all items appears. 

2. Select the item and click Done selecting. 

 Selection of <item name>: 

You can narrow the displayed items, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display items and click Done. 

 by Tags… 

Click Select button to select the tags, so that items tagged with those particular tags will be displayed and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that items created during that interval will be displayed or choose Custom 

range… and use the From and To input fields to select a time interval. When finished click Done. 

LIST SETTINGS 

On this tab you choose how to display the item(s) you have selected. 

 If you select Use paging radio button, the system divides the items into pages.  

In the input field you specify how many items per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the items you have chosen to display. 

In the input field, you specify how many items you want to display. 

 If you select No limit and paging radio button, the system displays all the items that you have selected in Content tab. 

 In Sort <item name> dropdown box, select a sorting criterion for the items. 

 In List template, select the template which is used to display the items on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

SINGLE ITEM SETTINGS 

On this tab you choose the way to display the items. 

In Open Single item in… radio button, select one of the following: 

 Auto-generated page 

When an item is clicked, it is displayed in a page which is automatically generated and has the same layout as the current 

page. 

 Select existing page… 

You select a page from the existing pages with certain layout where an item will be displayed when clicked.  

NOTE: In order to display the dynamic item, the page you have selected must have your dynamic widget added. 

1. Click Select Page. 

From the treeview, select the page where you want to display the item. 

2. Click Done selecting. 

 In Detail templates, select the template which is used to display the items on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 
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 If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

FILTERING AND SORTING THE ITEMS 

You can filter and sort the dynamic items, which the widget displays, using fields of the item. 

1. To filter or sort the items, click Advanced button in the lower-right corner of the window. 

The advanced editing mode opens. 

2. Click ControlDefinition » Views » DynamicContentMasterView buttons. 

 To filter the items, in FilterExpression input field, enter the desired filtering expression. 

The field supports AND and OR Boolean operators.  

For example, enter Visible = true AND Status = Live 

For more information, see Filter expressions for content items. 

 To sort the items, in SortExpression input field, enter the desired sorting expression. 

The field supports operators ASC for ascending and DESC for descending.  

For example, enter PublicationDate DESC 

NOTE: If on one page, you want to have more than one dynamic module widget, either from the same module, or from different 

dynamic modules, you must tell the system how to distinguish them by setting the UrlKeyPrefix.  

To do this click Advanced button, in the lower-right corner of each of the dynamic widgets. In UrlKeyPrefix field, enter a prefix of 

your choice. For example, if the widgets are from two different modules, you can enter the name of the module. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

When you are finished with all the settings, click Save.  

The Edit window closes and the widget is configured to display the dynamic items you have selected.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the widget, 

the Save to all translations button appears. If you click it, the current widget configuration will be saved to all translations, else, if 

you click Save, the widget configuration is saves only to the current translation, but the pages are still synchronized. If your pages 

are synchronized, you can have different widget configurations, but you cannot have different widgets. 

| Content widgets group | Widgets | Table of contents | 

DYNAMIC HIERARCHICAL WIDGETS 

If you have created and activated a dynamic module, the system automatically creates a widget and displays the widget in the 

content widget group. You use the widget to select which of your dynamic content to display on the website and to choose how to 

display the content. 

PREREQUISITES: You have created at least two dynamic content types that have hierarchy. For more information, see Dynamic 

modules. 

Use this widget to display a dynamic content type that has hierarchy. Using this widget you can display parent and children content 

types. For example, you can display forums and when a forum is clicked, the system displays forum threads. 

After you have dragged the widget on your page you must configure it to display parent and children content types.  

1. To do this, click Edit button in the upper-right corner of the widget. 

2. Under Behavior, choose which items to display.  

You can choose to display only parent items, only children, or the full functionality – when a parent item is clicked, its children 

are displayed. 

3. Under Settings, choose which items to display, by choosing one the following: 

 All published <item type> 

All created items are displayed. 

 One particular <item type> only… 

The system displays one news item.  

a. To select the news you want to display, click Select <item type> button. 

A list of all items appears. 
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b. Select the item and click Done selecting. 

 Selection of <item type>: 

You can narrow the displayed news, using categories, tags, and dates. 

Select one or more of the following: 

 by Categories… 

Click the Select button to select the categories from which you want to display items and click Done. 

 by Tags… 

Click Select button to select the tags, so that items tagged with those particular tags will be displayed and click Done. 

 by Dates… 

Click Select button. 

Select one of the predefined time intervals, so that items created during that interval will be displayed or choose 

Custom range… and use the From and To input fields to select a time interval. When finished click Done. 

4. If, under Behavior, you have chosen to display a single content type, you must also select the page in which the items open by 

default. 

To do this, under Page for <item type>, click Select, select a page and click Done selecting. 

NOTE: The page that you select must have a widget for displaying the content type. 

5. Choose the Paging, limit and sorting for the content type that you have chosen in Step 2. 

For each content type, perform the following: 

a. Choose how to display the items, by selecting one of the following: 

 If you select Use paging radio button, the system divides the events into pages.  

In the input field you specify how many events per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the events you have chosen to 

display. 

In the input field, you specify how many events you want to display. 

 If you select No limit and paging radio button, the system displays all the events that you have selected in Content 

tab. 

b. In Sort items dropdown box, select a sorting criterion for the items. 

6. Choose the Templates to be used for each content type you have chosen in Step 2. 

For each content type, perform the following: 

a. Select the template for displaying the single item. 

b. Select the template for displaying the list of items. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit selected template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

7. If you want to display buttons for social sharing, select Enable social share buttons. 

This enables your users to share the items, for example, on Facebook. 

To configure which buttons to display, see Social sharing. 

The Forums window closes and the widget is configured.  

NOTE: If your site is multilingual and the page you are editing is synchronized with another translation, when you edit the 

widget, the Save to all translations button appears. If you click it, the current widget configuration will be saved to all 

translations, else, if you click Save, the widget configuration is saves only to the current translation, but the pages are still 

synchronized. If your pages are synchronized, you can have different widget configurations, but you cannot have different 

widgets. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Content widgets group | Widgets | Table of contents | 

COMMON BEHAVIOR OF CONTENT WIDGETS 

When you drop two content widgets on one page, by default, they share the following behavior: 
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 Paging 

 Switching to detail mode and back to list 

 URL filtering (by date through the Archive widget, or by a classification through the Tags or Categories widget) 

This means that clicking a page in one widget also changes the page in the other. Clicking a single item in one widget switches the 

other to detail mode, filtering by date or classification filters both widgets. 

If you do not want the widgets to behave in this way, perform the following for each widget: 

1. Click the Edit button in the upper-right corner of the widget. 

2. Click Advanced button in the lower-right corner of the widget. 

3. In field UrlKeyPrefix, for each widget enter a different string. 

When you perform an action like paging, filtering, or opening the detail mode, this string is added to the URL. If you perform 

the action on one widget, the system does not perform it on the other widgets on the page, however if you have performed 

the action on one widget and then perform it on another, the system returns the first widget in its original state. 

To overcome this, perform Step 4. 

4. In any of the widgets, in field UrlEvaluationMode, enter QueryString. 

This is applied automatically to all other widgets. 

NOTE: The Forums widget does not support QueryString. If you have such widget on the page, you cannot perform this 

step. 

5. Click Save » Save. 

| Content widgets group | Widgets | Table of contents | 

FILTER EXPRESSIONS FOR CONTENT ITEMS 

Following is a list of examples of filter expressions’ syntax. You can use these examples to create your own filter expressions when 

you configure the widgets. 

FILTER BY CATEGORY 

Visible = true AND Status = Live AND Category.Contains("{Taxonomy ID}") 

Visible = true AND Status = Live AND Category.Contains("{Taxonomy ID}") AND 

Category.Contains("{Taxonomy ID}") 

Visible = true AND Status = Live AND (Category.Contains("{Taxonomy ID}") OR 

Category.Contains("{Taxonomy ID}")) 

NOTE: You can view the ID of each classification by adding the Tags widget to a page, clicking its Edit button, deleting the 

contents of field TaxonomyID, and clicking Save. 

FILTER BY TAGS 

Visible = true AND Status = Live AND Tags.Contains("{Taxonomy ID}") 

Visible = true AND Status = Live AND (Tags.Contains("{Taxonomy ID}") OR Tags.Contains("{Taxonomy 

ID}") ) 

FILTER BY CUSTOM FIELDS (FOR NUMBER CUSTOM FIELD) 

Visible = true AND Status = Live AND CustomFiledName > 0 

Visible = true AND Status = Live AND CustomFiledName = 7 

FILTER BY NEWS TITLE 

Visible = true AND Status = Live AND Title.Contains("News Title") 

Visible = true AND Status = Live AND Title.Contains("news") 

FILTER BY NEWS CONTENT 

Visible = true AND Status = Live AND Content.Contains("ipsum") 
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Visible = true AND Status = Live AND Content.Contains("long established fact") 

FILTER BY AUTHOR 

Visible = true AND Status = Live AND Author = "author" 

Visible = true AND Status = Live AND Author != " author" 

Visible = true AND Status = Live AND Author.Contains("author") 

Visible = true AND Status = Live AND Author.Contains("author") 

FILTER BY PUBLICATION DATE 

Visible = true AND Status = Live AND PublicationDate <= DateTime.UtcNow // Shows all 

Visible = true AND Status = Live AND PublicationDate < DateTime.UtcNow // Shows all 

Visible = true AND Status = Live AND PublicationDate > DateTime.UtcNow // Shows none 

FILTER BY DATE LOGGED 

Visible = true AND Status = Live AND DateLogged.HasValue AND DateLogged.Value.Date = 

DateTime.UtcNow.Date 

// Will filter only items where the data component of the value specified in the DateLogged 

field matches the date component of DateTime.UtcNow 

Visible = true AND Status = Live AND EventStart > (01/01/2014) AND EventEnd < (04/01/2014) 

//WILL FILTER EVENTS THAT START FROM 1ST OF JANUARY 2014 AND END TILL 4TH OF JANUARY 2014. NAVIGATION 

WIDGETS GROUP 

The Navigation widget group contains widgets that you use to display website navigation, language selector, and archive of 

content items you have created on Content tab. 

Section Contents 

The following widgets are part of the Navigation group: 

 Navigation 

Use this widget to display website navigation. The Navigation widget displays only visible pages. 

 Old Navigation 

The old Navigation widget is supported and visible, only if you first install it. 

 Archive 

Use the Archive widget to display published content items grouped by date on your page.  

 Language selector 

Use the Language selector widget if you use multiple languages for your website. The widget allows the user to switch 

between the different language versions of a page. 

 Breadcrumb 

Use the Breadcrumb widget to display the path to the current page. This helps your users to navigate the website.  

 Site selector 

Use the Site selector widget to give the users the opportunity to select one of your sites. Available only with multiple sites. 

| Widgets | Table of contents | 

NAVIGATION WIDGET 

Use this widget to display website navigation. The widget displays only visible pages. 

You first configure the Navigation widget when you drop it on a page, then you can use the widget template to customize its 

behavior and appearance, then you can apply a CSS to style it. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Styling and configuring the Navigation widget » 

Customize the Navigation widget. 
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After you have dragged the Navigation widget on your page you must configure it to display navigation links.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Navigation window appears. 

2. Choose which pages to display in the navigation, by selecting one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

a. To select the page, click Select page button. 

b. In the treeview that appears, select the parent page and click Done selecting. 

 All pages under currently opened page 

The system displays links to pages that are children of the currently opened page. 

 All sibling pages of currently opened page 

The system displays links to pages that are siblings of the currently opened page. 

 Custom selection of pages… 

The system displays links only to pages that you select. 

a. To select pages for the navigation, click Select pages button. 

The Select Pages window appears. 

b. Select one of the following tabs: 

 From this site 

In the treeview that appears, select the checkboxes of the pages, which you want to be part of the navigation. 

 From other sites 

i. Enter the URL of the page. 

ii. In Name input field, enter the name to be displayed in the navigation. 

iii. Click Add button. 

The page is added to the list of external pages. 

You can add as many pages as needed. To remove a page, click the respective  button. 

c. When finished, click Done selecting. 

NOTE: You can select both external pages and pages from Sitefinity. 

3. Select the template used for the navigation. 

In Template dropdown box, choose one of the following: 

 Horizontal (one-level) 

The system displays links to the pages horizontally (one next to the other). There is no hierarchy (no links to children 

pages). 

 Horizontal with dropdown-menus 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all 

children pages in a dropdown menu. 

 Horizontal with tabs (up to 2 levers) 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all 

children pages in a tabstrip. 

 Vertical (one-level) 

The system displays links to the pages vertically. There is no hierarchy. 

 Tree (vertical with sub-pages) 

The system displays links to the pages in a vertical tree with all its nodes expanded. The Tree navigation type enables you 

to view the hierarchy of the website. 

 Sitemaps in columns 

The system displays links to top level pages horizontally. If a top level page is a parent page or a group page, containing 

other pages, they are displayed in a column below their parent page. Only the first two levels of hierarchy are displayed. 
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 Sitemaps in rows 

The system displays links to top level pages vertically. If a top level page is a parent page or a group page, containing 

other pages, they are displayed in a row below their parent page. Only the first two levels of hierarchy are displayed. 

4. To apply a CSS, enter the name of the class in CSS class 

You can choose a class name for each navigation. You can then set particular style for this navigation widget or apply a 

specific responsive design. 

SETTING THE LEVELS OF NAVIGATION 

For navigation templates that have more than one level of navigation, you can setup the depth of the navigation nodes. 

Under Levels to include, select one of the following: 

 All 

When you select a parent or a group page, the system always displays its children pages. 

 <Number> 

The system displays the children pages only up to the level you have selected in the dropdown box. 

For example, if you have selected 2, the system displays only top level pages and their children. 

You can also setup how many navigation levels to display in your navigation, using the widget template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Styling and customizing the Navigation widget » Setting 

the levels of the Navigation widget. 

RESPONSIVE DESIGN OF THE NAVIGATION WIDGET 

You can apply responsive design for the Navigation widget only. This way its appearance will be different for different devices, 

used to view the website. 

You can do this, using Sitefinity Responsive Design feature. To do this, in the main menu, click Design » Responsive & Mobile 

Design. 

For more information, see Sitefinity Designer’s Guide » Displaying pages on mobile devices » Step 7. 

You can also apply responsive design to the Navigation widget, using the widget template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Styling and customizing the Navigation widget 

»Creating responsive design without Sitefinity Responsive Design feature. 

DISPLAYING THE PARENT NODE IN THE NAVIGATION WIDGET 

If you have selected to display all nodes under a particular parent page, you can choose whether you want to display the parent 

node in the beginning of the navigation. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Styling and customizing the Navigation widget » 

Displaying the parent node in the Navigation widget. 

OLD NAVIGATION WIDGET 

DISPLAYING THE OLD NAVIGATION WIDGET 

In Sitefinity 6.1 a new Navigation widget is introduced. It is highly customizable and provides extended capabilities for modifying 

its design. The old Navigation widget will be continued to be supported. 

To use the old Navigation widget, perform the following: 

1. In the main menu, click Administration » Settings » Advanced. 

2. In the navigation tree on the left, click Toolboxes » Toolboxes » PageControls » Sections » NavigationControlsSection » Tools. 

3. Click Create New button. 

4. In Control CLR Type or Virtual Path, enter 
Telerik.Sitefinity.Web.UI.NavigationControls.NavigationControl, Telerik.Sitefinity 

5. Enter a Name and a Title. 

For example OldNavigation and Old Navigation 

6. In CssClass, enter sfNavigationIcn 

7. Click Save Changes button. 
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The widget is added to the Navigation widget group and you can use it on your pages. 

USING THE OLD NAVIGATION WIDGET 

Use this widget to display website navigation. The widget displays only visible pages. 

After you have dragged the Navigation widget on your page you must configure it to display navigation links.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Navigation window appears. 

2. In What type of navigation to use? area, choose the type of navigation by selecting one of the following: 

 Horizontal 

The system displays links to the pages horizontally (one next to the other). There is no hierarchy (no links to children 

pages). 

 Horizontal with dropdown menus 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all 

children pages in a dropdown menu. 

 Horizontal with tabs 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all 

children pages in a tabstrip. 

 Vertical 

The system displays links to the pages vertically. There is no hierarchy. 

 Tree (vertical with sub-levels) 

The system displays links to the pages in a vertical tree with all its nodes expanded. The Tree navigation type enables you 

to view the hierarchy of the website. 

 Sitemap divided in column 

The system displays links to top level pages horizontally. If a top level page is a parent page or a group page, containing 

other pages, they are displayed in a column below their parent page. Only the first two levels of hierarchy are displayed. 

 Sitemap divided in rows 

The system displays links to top level pages vertically. If a top level page is a parent page or a group page, containing 

other pages, they are displayed in a row below their parent page. Only the first two levels of hierarchy are displayed. 

 Custom Navigation 

Select this option to choose different than the predefined navigation types. 

3. When you are finished, click Save. 

The Navigation window closes and the Navigation widget is configured to display the navigation links you have selected.  

4. To style your navigation, perform procedure Style the navigation widget. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Navigation widgets group | Widgets | Table of contents | 

HORIZONTAL NAVIGATION 

The system displays links to the pages horizontally (one next to the other). There is no hierarchy (no links to children pages).  

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 Custom selection of pages… 

The system displays links only to pages which you select. 

1. To select pages for the navigation, click Select pages button. 
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The Select Pages window appears. 

2. Select one of the following tabs: 

 From this site 

In the treeview that appears, select the checkboxes of the pages, which you want to be part of the navigation. 

 From other sites 

a. Enter the URL of the page. 

b. In Name input field, enter the name to be displayed in the navigation. 

c. Click Add button. 

The page is added to the list of external pages. 

You can add as many pages as needed. To remove a page, click the respective  button. 

3. When finished, click Done selecting. 

NOTE: You can select both external pages and pages from Sitefinity. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation, if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 

 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

HORIZONTAL NAVIGATION WITH DROPDOWN MENUS 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all children 

pages in a dropdown menu. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 In Levels to include, select one of the following: 

 All existing levels 

When you select a parent or a group page, the system always displays its children pages. 

 <Number> level(s) 

The system displays the children pages only up to the level you have entered in the input field. 

For example, if you have entered 2, the system displays only top level pages and their children. 

 In Open dropdown menu on, select one of the following: 

 Mouse over 

The dropdown menu with children pages opens when you hover over the parent page. 

 Click 

The dropdown menu with children pages opens when you click the parent page. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation, if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 
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 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

HORIZONTAL NAVIGATION WITH TABS 

The system displays links to the pages horizontally. If you select a parent page or a group page, the system displays all children 

pages in a tabstrip. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 In Levels to include, select one of the following: 

 All existing levels 

When you select a parent or a group page, the system always displays its children pages. 

 <Number> level(s) 

The system displays the children pages only up to the level you have entered in the input field. 

For example, if you have entered 2, the system displays only top level pages and their children. 

 In Open dropdown menu on, select one of the following: 

 Mouse over 

The dropdown menu with children pages opens when you hover over the parent page. 

 Click 

The dropdown menu with children pages opens when you click the parent page. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation, if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 

 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

VERTICAL NAVIGATION 

The system displays links to the pages vertically. There is no hierarchy. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

3. Choose whether to display the selected page or not by selecting the Show the selected page in navigation checkbox. 

 All pages under currently opened page 

The system displays links to pages that are children of the currently opened page. 
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Choose whether to display the currently opened page or not by selecting the Show the currently opened page in navigation 

checkbox. 

 All sibling pages of currently opened page 

The system displays links to pages that are siblings of the currently opened page. 

Choose whether to display the currently opened page or not by selecting the Show the currently opened page in navigation 

checkbox. 

 Custom selection of pages… 

The system displays links only to pages that you select. 

1. To select pages for the navigation, click Select pages button. 

The Select Pages window appears. 

2. Select one of the following tabs: 

 From this site 

In the treeview that appears, select the checkboxes of the pages, which you want to be part of the navigation. 

 From other sites 

a. Enter the URL of the page. 

b. In Name input field, enter the name to be displayed in the navigation. 

c. Click Add button. 

The page is added to the list of external pages. 

You can add as many pages as needed. To remove a page, click the respective  button. 

3. When finished, click Done selecting. 

NOTE: You can select both external pages and pages from Sitefinity. 

 All sibling pages of currently opened page 

The system displays links to all pages that are on the same level as the page that is opened. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 

 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

TREE NAVIGATION 

The system displays links to the pages in a vertical tree with all its nodes expanded. The Tree navigation type enables you to view 

the hierarchy of the website. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 In Levels to include, select one of the following: 

 All existing levels 

When you select a parent or a group page, the system always displays its children pages. 

 <Number> level(s) 

The system displays the children pages only up to the level you have entered in the input field. 

For example, if you have entered 2, the system displays only top level pages and their children. 
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 Select the following checkboxes: 

 Show all levels expanded initially 

The system displays all levels of pages expanded. The parent pages cannot be collapsed.  

 Allow collapsing 

The system displays only top level pages. All pages that are parent pages can be expanded. 

 Show all levels expanded initially and Allow collapsing 

The system displays all pages expanded, but parent pages can be collapsed. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation if later you want to set a CSS for that particular navigation. Enter the 

name in Wrapper CSS class input field. 

 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

SITEMAP NAVIGATION DIVIDED IN COLUMN 

The system displays links to top level pages horizontally. If a top level page is a parent page or a group page, containing other 

pages, they are displayed in a column below their parent page. Only the first two levels of hierarchy are displayed. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 

 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

SITEMAP NAVIGATION DIVIDED IN ROWS 

The system displays links to top level pages vertically. If a top level page is a parent page or a group page, containing other pages, 

they are displayed in a row below their parent page. Only the first two levels of hierarchy are displayed. 

In Fine tune the selected type area, select one of the following: 

 Top level pages 

The Navigation widget displays links to pages that are at top level in the structure of pages and have no parent. 

 All pages under particular page 

The system displays links to pages that are children of only one particular page. 

1. To select the page, click Select page button. 

2. In the treeview that appears, select the parent page and click Done selecting. 

 To apply a CSS, click Design settings. 

 You can choose a class name for each navigation if later you want to set a CSS for this particular navigation. Enter the 

name in Wrapper CSS class input field. 
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 If you want to apply a template that is different from the predefined, enter the path to the template. You must have 

uploaded the template in your project templates. For more information, see Sitefinity Designer’s Guide » Website 

templates file structure. 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

STYLE THE NAVIGATION WIDGET 

1. Write the CSS file. 

Following is an example CSS file named main.css containing class named University: 

.RadTabStrip_University li { 

 border-bottom: 1px solid #e3e3e3; 

 height: 25px; 

 line-height: 25px; 

 font-size: 11px; 

 font-family: Arial; 

 padding: 0px; 

 margin: 0px; 

} 

 

.RadTabStrip_University li a.rtsLink { 

 color: #4e4e4e; 

 display: block; 

 width: 100%; 

 text-align: left; 

 background-image: url(../Images/arrow.jpg); 

 background-repeat: no-repeat; 

 background-position: 10px 10px; 

 text-indent: 3px; 

} 

 

.RadTabStrip_University li a.rtsLink:hover { 

 color: White; 

 background-color: #013300; 

} 

 

.RadTabStrip_University li .rtsTxt { 

 text-align: left; 

} 

2. Register the theme in Sitefinity. 

For more information, see Sitefinity Designer’s Guide » Themes » Registering a theme. 

The following screenshot displays the registered theme, named test and the path to the theme and its main.css file: 

 

3. Apply the theme to the template that will hold your navigation. 

For more information, see Designer’s Guide » Themes » Applying a theme. 



 

218 

The theme you have registered appears in the dropdown box. 

4. Add the Navigation widget to the template. 

5. When you configure the widget, in Design settings » Wrapper CSS class, enter the name of the CSS class you have created. 

For example, enter University, which is the name of the CSS class that you defined in Step 1. 

Following is an example of how the navigation looks like: 

 

| Configuring the Navigation widget | Navigation widgets group | Widgets | Table of contents | 

CONFIGURING THE ARCHIVE WIDGET 

Use the Archive widget to display published content items grouped by date on your page.  

EXAMPLE: You can display all the news created so far, grouped according to the year they were published. If you have news 

published since 2008, then the Archive widget displays a list that contains the years 2008, 2009, and 2010. When you click a year, 

the system displays the news published in this year. 

To configure the Archive widget, perform the following: 

1. Drag the Archive widget on your page and perform one of the following: 
 

To display an 

archive of: 

Procedure 

Blog posts  Add the Blog posts widget to the page. 

 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.Blogs.Model.BlogPost. 

Events  Add the Events widget to the page. 

 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.Events.Model.Event. 

News  Add the News widget to the page. 

 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.News.Model.NewsItem. 

Images  Add the Image gallery widget to the page. 

 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.Libraries.Model.Image. 

Videos  Add the Video gallery widget to the page. 

 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.Libraries.Model.Video. 

Documents  Add the Download list widget to the page. 
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 Click the Edit button in the upper-right corner of the Archive widget. 

 In ContentType input field enter Telerik.Sitefinity.Libraries.Model.Document. 

For more information, see Widgets. 

2. In edit mode of the Archive widget, in DateBuildOptions input field, enter one of the following: 

 YearMonthDay 

Groups the content items according to the year, the month, and the date they were published. 

 YearMonth 

Groups the content items according to the year and the month they were published. 

 Year 

Groups the content items according to the year they were published. 

3. In edit mode of the Archive widget, in ShowItemCount, enter one of the following: 

 True 

After the date the system displays in brackets the number of published items for this date. 

 False 

The system does not display the number of items for this date. 

4. Click Save. 

The system saves the setting and closes the editing mode of the Archive widget.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Navigation widgets group | Widgets | Table of contents | 

LANGUAGE SELECTOR WIDGET 

Use the Language selector widget if you use multiple languages for your website. The widget allows the user to switch between 

the different language versions of a page. 

PREREQUISITES: You are in multilingual mode. For more information, see Languages. 

After you have dragged the Language selector widget on your page you must configure it to display language links.  

1. To do this, click Edit button in the upper-right corner of the widget. 

The Language selector window appears. 

2. In the Display language selector as… radio button group, choose how to display the links to different languages, by selecting 

one of the following: 

 Horizontal list 

Displays the language links one next to the other. 

 Vertical list 

Displays the language links one under another. 

 Drop-down menu 

Displays the language links in a dropdown box. 

3. If you want the current language to be also included in the list of links, select the Include the current language in the selector 

checkbox. 

4. In What to do with languages without translations? radio button group, choose how the widget behaves when there is an 

added language, for which the page has no translation. 

Select one of the following: 

 Hide the link to the missing translation 

The system displays only links to existing translations. 

 Redirect to home page of language for missing translation 

The system displays links to all added languages, but for the languages for which there is no translation, the system 

redirects to the homepage of the respective language. 

For more information about language translations, see Create a language translation of a page. 
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5. When you are finished, click Save. 

The system saves the setting and closes the editing mode of the Language selector widget.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Navigation widgets group | Widgets | Table of contents | 

BREADCRUMB WIDGET 

Use the Breadcrumb widget to display the path to the current page. This helps your users to navigate the website.  

To configure the Breadcrumb widget, perform the following: 

1. After you have dragged the widget on your page, click Edit button in the upper-right corner of the widget. 

The Edit window appears. 

2. In What to include in the breadcrumb?, choose one of the following radio buttons: 

 Full path to the current page. 

The system displays the full path to the current page, starting from the homepage. 

 Path starting from a specific page... 

The system displays the path from a selected page to the current page.  

a. Click Select a page button. 

b. Select a page from the site map and click Done selecting. 

You must select a page that is a parent of the current page. 

3. Select whether you want to: 

 Show Home page link 

This displays the home page at the beginning of the breadcrumb. 

 Show current page in the end of the breadcrumb 

This displays the current page as a link at the end of the breadcrumb. 

 Show group pages in the breadcrumb. 

A group page is a container for pages and does not have its own content. It redirects to its first child page. 

4. In Label, enter whether you want to display text before the breadcrumb. 

For example, You are here: 

5. In Template, select the template that is used to display the breadcrumb on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit selected template. 

6. For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates.If you have an ecommerce site and you want the currently open product to be displayed in the 

breadcrumb, open the advanced mode of the widget by clicking Advanced and in AllowVirtualNodes field enter true. 

7. Click Save. 

The Edit window closes and the widget is configured. 

| Navigation widgets group | Widgets | Table of contents | 

SITE SELECTOR WIDGET 

The Site selector widget is available only if you have multiple sites. Use it to give the users the opportunity to select one of your 

sites. For example, if you are selling electronics and you have separate sites for air conditioners and mobile phones, on you home 

page you can have a Site selector widget.  

To configure the Site selector widget, perform the following: 

1. After you have dragged the widget on your page, click Edit button in the upper-right corner of the widget. 

The Edit window appears. 

2. In Display as…, choose one of the following radio buttons: 

 Drop-down menu 

The system displays all sites in a dropdown box. 
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 List of links 

The system displays all sites as links.  

3. In Label input field, enter a label for the dropdown box or the links list. 

4. To display the current site in the selector, select Include the current site checkbox. 

5. If you sites have multiple languages, you can choose to display each language version of a site as a separate site in the 

selector. 

To do this, select Display each language version as a separate site checkbox and choose how to label the language versions in 

the selector: 

 Show site names and languages 

 Show languages only 

6. In Template, select the template that is used to display the selector on the webpage. 

You can create a custom template by clicking Create new template. You can edit existing templates by selecting them and 

clicking Edit selected template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

7. Click Save. 

The Edit window closes and the widget is configured. 

| Navigation widgets group | Widgets | Table of contents | 

SCRIPTS AND STYLES WIDGETS GROUP 

The Scripts and Styles widgets group contains widgets that you use to apply style to the page or to enhance the page with 

additional functionality. 

Section contents 

The following widgets are part of the Navigation group: 

 CSS 

Use the CSS widget to apply Cascading Style Sheets (CSS) to your page. CSS are used to style your webpage in terms of font, 

colors, spacing, etc. 

 JavaScript 

Use Java Script widget to embed JavaScript code in your page. JavaScript is used to enhance the functionality of your website. 

 Google Analytics 

Use this widget to add Google Analytics tracking code to your page. You use Google Analytics to track your website traffic and 

marketing effectiveness.  

| Widgets | Table of contents | 

CSS WIDGET 

Use the CSS widget to apply Cascading Style Sheets (CSS) to your page. CSS are used to style your webpage in terms of font, 

colors, spacing, etc. 

RECOMMENDATION: We recommend that you use the CSS widget to set only page specific CSS. To set CSS to the entire 

website, we recommend you to use themes. For more information, see Sitefinity Designer’s Guide » Themes. 

To apply a CSS to your page, perform the following: 

1. Drag the CSS widget anywhere on the page and click Edit button in the upper-right corner of the widget. 

The CSS window appears. 

NOTE: If you add CSS widget in a page template, the CSS file is applied to all the pages that use this template. If you add it 

on one particular page, the CSS file is applied only to this page. 

2. Add the CSS code in one of the following ways: 

 If the CSS file (files with .css extension) you want to apply is already uploaded, on Link to a CSS file tab, perform one of 

the following: 
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 In URL input field, enter the URL of an already uploaded CSS file. 

 Click Select…button, browse the uploaded files to select the CSS file you want to apply, and click Done. 

For more information about uploading files, see Sitefinity Installation and Administration Guide » File management. 

 If you want to add custom CSS code, on Write CSS tab, enter the CSS code in the textbox. 

3. In Media radio button, select the media type for which the embedded CSS is intended. 

Select one of the following: 

 All 

Includes all types of media 

 Select media types… 

A list of checkboxes appears. 

For more information about different media types, see World Wide Web Consortium specifications » Media types » 7.3 

Recognized media types on  http://www.w3.org/TR/CSS2/media.html. 

4. When you are finished, click Save. 

The CSS window closes and the system embeds the link to the CSS file or the code you have written in the head tag of the 

page. 

| Scripts and Styles widgets group | Widgets | Table of contents | 

JAVA SCRIPT WIDGET 

Use Java Script widget to embed JavaScript code in your page. JavaScript is used to enhance the functionality of your website. For 

example, you can use JavaScript to validate user input. 

To add a JavaScript code to your page, perform the following: 

1. Drag the Java Script widget on the page and click Edit button in the upper-right corner of the widget. 

The Java Script window appears. 

NOTE: If you add Java Script widget in a page template the JavaScript is applied to all the pages that use this template. If 

you add it on one particular page, the JavaScript is applied only to this page. 

2. Add the JavaScript code in one of the following ways: 

 If the JavaScript file (files with .js extension) you want to apply is already uploaded, on Link to a Java Script file (.js) tab, 

perform one of the following: 

 In URL input field, enter the URL of an already uploaded JavaScript file. 

 Click Select…button, browse the uploaded files to select the JavaScript file you want to apply, and click Done. 

For more information about uploading files, see Sitefinity Installation and Administration Guide » File management. 

 If you want to add custom JavaScript code, on Write Java Script tab, enter the JavaScript code in the input field. 

3. In Where to include in HTML? radio button, select one of the following. 

Select one of the following: 

 In the head tag 

The JavaScript is executed immediately when a page starts to load. 

 Where the widget is dropped 

The JavaScript is executed when the widget is being loaded. 

 Before the closing body tag 

The JavaScript is executed at the end of the page’s loading process. 

For example, this option is often used to embed page tracking code, such as Google Analytics, because if this code is 

executed, it means that the user has not closed the page before the page has been fully loaded. 

4. When you are finished, click Save. 

The Java Script window closes and the system embeds the link to the JavaScript file or the code you have written where you 

have specified in Where to include in HTML radio button. 

| Scripts and Styles widgets group | Widgets | Table of contents | 

http://www.w3.org/TR/CSS2/media.html
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GOOGLE ANALYTICS WIDGET 

You use this widget to add Google Analytics tracking code to your page. You use Google Analytics to track your website traffic and 

marketing effectiveness. The tracking code that you insert in Google Analytics widget helps Google Analytics to get information 

about your website. For more information about Google Analytics, see  www.google.com/analytics. 

To gather data about your website traffic, perform the following: 

1. Sign up in Google Analytics. 

2. Register your website in Google Analytics. 

3. Obtain a tracking code from Google Analytics. 

For more information, see the Google Analytics » Getting Started Guide on 

 http://www.google.com/support/analytics/bin/static.py?hl=en&page=guide.cs&guide=19779.  

4. Drag Google Analytics widget anywhere on the page you want to track. 

NOTE: If you add Google Analytics widget in a page template the tracking is applied to all the pages that use this template. If 

you add it on one particular page, the tracking is available only for this page. 

5. Click Edit button in the upper-right corner of the widget.  

The Google Analytics window appears. 

6. Paste the tracking code in the textbox. 

You can find an example of the tracking code that you need to paste in Google Analytics widget on the Google Analytics Help 

page, in section Adding the tracking code » Step 1 on  

 http://www.google.com/support/analytics/bin/answer.py?hl=en&answer=55488. 

7. Click Save. 

The Google Analytics window closes. 

For more information, see Google Analytics Help on  http://www.google.com/support/analytics/  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Scripts and Styles widgets group | Widgets | Table of contents | 

LOGIN WIDGETS GROUP 

The Login widgets group contains widgets that you use to provide your website users with the ability to login, to display the 

currently logged user and login or logout links. 

Section contents 

The following widgets are part of the Login group: 

 Login 

Using the Login widget, your website users will be able to login to your website. The widget displays a username and 

password login fields and additional login options that you have configured. 

 Login name 

Use the Login name widget to display the name of the currently logged user. 

 Login status 

Use the Login status widget to display the login and logout links on your website.  

 Change password 

Use the Change password widget to allow your users to change their password, in case they have, for example, a user has 

forgotten his or her password.  

| Widgets | Table of contents | 

LOGIN WIDGET 

Using the Login widget, your website users will be able to login to your website. The widget displays a username and password 

login fields and additional login options that you have configured. 

http://www.google.com/analytics
http://www.google.com/support/analytics/bin/static.py?hl=en&page=guide.cs&guide=19779
http://www.google.com/support/analytics/bin/answer.py?hl=en&answer=55488
http://www.google.com/support/analytics/
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IMPORTANT: Depending on which authentication mode you are using, you have to use different widgets. If you are in claims-

based authentication mode, use the Login widget. If you are in forms authentication, use the Login (backward compatibility) 

widget. For more information about authentication modes and how to switch between them, see Sitefinity Installation and 

Administration Guide » Authentication and single sign-on. 

NOTE: In claims-based mode, you can use functionality for changing password. For more information, see Change password 

widget. 

To setup login on your website, perform the following: 

1. Drag the respective Login widget on the page and click the Edit button in the upper-right corner of the widget. 

The widget configuration opens in advanced mode. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

2. When you are finished, click Save. 

The Edit window closes. 

NOTE: The login fields cannot be displayed in page editing mode. To see a preview, exit the page editing mode and click Live site 

link in the upper-right corner of the page. 

NOTE: If you are experiencing problems with the login when an SSL certificate is installed on the login page, click Administration » 

Settings » Advanced » Security. In AccessControlAllowOrigin, enter *. If this does not solve your problem, return its value to null. 

| Login widgets group | Widgets | Table of contents | 

LOGIN NAME WIDGET 

Use the Login name widget to display the name of the currently logged user. 

Perform the following procedure: 

1. Drag the Login name widget on the page and click the Edit button in the upper-right corner of the widget. 

The widget configuration opens in advanced mode. 

2. By default the Login name widget displays the first and the last name of the user, who is currently logged in. You can change 

that in FormatString input field. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

NOTE: The widget displays the name of the user only when the user is logged in. 

3. When you are finished, click Save. 

The Edit window closes. 

| Login widgets group | Widgets | Table of contents | 

LOGIN STATUS WIDGET 

Use the Login status widget to display the login and logout links on your website.  

Perform the following procedure: 

1. Drag the Login status widget in the page and click the Edit button in the upper-right corner of the widget. 

The widget configuration opens in advanced mode. 

By default the Login status widget displays a Log in link, when the user is not logged, and a Log out link, when the user is 

logged in. 

2. Depending on where you have dropped the Login status widget, perform one of the following: 

 If you have the Login and the Login status widgets on different pages, you must enter the URL of the page, where the 

Login widget is dropped, in LoginUrl input field. This way, when an unlogged user, clicks the Log in link, the Login page is 

displayed. 

 If you have the Login and Login status widgets on one page, to avoid displaying both the Log in link from the Login status 

widget and the Login button from the Login widget, you can hide the Login status widget from users that are not logged 

in. This way only the Log out link is displayed only to users that are logged in. 

To do this, perform the following: 

a. Click More in the upper-right corner of the Login status widget. 

b. In the dropdown menu, click Permissions. 
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c. In View a widget section, click Change. 

d. Under Advanced, select Explicitly deny this to selected roles and users... checkbox. 

e. Click Add Roles or Users button. 

f. Select Anonymous and click Done selecting. 

3. By default, when the user clicks Log out, the page is refreshed. To redirect the user to another page, in LogoutAction input 

field, enter Redirect and in LogoutUrl input field, enter the URL of the page where you want to send the user after a logout. 

For more information about advanced configuration options, see Advanced configuration of widgets. 

4. When you are finished, click Save. 

The Edit window closes. 

NOTE: The login status cannot be displayed in page editing mode. To see a preview, exit the page editing mode and click Live site 

link in the upper-right corner of the page. 

| Login widgets group | Widgets | Table of contents | 

CHANGE PASSWORD WIDGET 

Use the Change password widget to allow your users to change their password, in case, for example, a user has forgotten his or 

her password.  

NOTE: The change password functionality works only in claims-based authentication mode. For more information about 

authentication modes and how to switch between them, see Sitefinity Installation and Administration Guide » Authentication and 

single sign-on. 

PREREQUISITES: You have added and configured the Login widget. 

To give your users the opportunity to change their password in case they have forgotten it, perform the following: 

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

2. Click Advanced link. 

3. In the treeview on the left click Security » Membership providers » Default » Parameters and perform the following: 

 Click enablePasswordReset, in Value input field, enter true, and click Save changes. 

 Click requiresQuestionAndAnswer, in Value input field, enter false, and click Save changes. 

4. In the treeview on the left click Notifications » Profiles » Default. 

Configure the SMTP settings of the default provider. 

The DefaultSenderEmailAddress is the email address which will appear to the user when the system sends an email with 

instruction about how to change the password.  

Click Save changes. 

5. Restart Sitefinity Project Manager. 

6. Create a new page and add the Change password widget on it. 

7. Open the page where the Login widget is located. 

8. Click the Edit button of the Login widget and perform the following: 

 In ChangePasswordPageUrl input field, enter the URL of the page where the Change password widget is located. 

 In ShowLostPaswordLink, enter true. 

 Click Save. 

9. Publish the page. 

When a user is logging to your website, the Forgot your password? link appears. If a user clicks it, he or she must enter the 

email address that was used when registering. The system sends an email, containing a link to the page where the Change 

password widget is located.  

| Login widgets group | Widgets | Table of contents | 
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SEARCH WIDGETS GROUP 

The Search widgets group contains widgets that you use to display a search box and search results on your website. You use the 

Search and Search results widgets to provide the users of your website to search for content. 

Section contents 

The following widgets are part of the Search group:  

 Search 

Use the Search widget to add and configure a search box to a page. After you have created one or more search indexes, you 

use the Search widget to select indexes to be used for the search. 

 Search results 

Use the Search results widget to configure where and how to display the results of a search that a user performed on your 

website. 

| Widgets | Table of contents | 

SEARCH WIDGET 

Use the Search widget to add and configure a search box to a page. After you have created one or more search indexes, you use 

the Search widget to select indexes to be used for the search. 

PREREQUISITES: You have created at least one search index. For more information, see Search indexes. 

To configure the Search widget, perform the following: 

1. After you have dragged the Search widget on your page, click Edit button in the upper-right corner of the widget. 

The Search window appears. 

2. In Where to search? dropdown box select the search index, which you want to use for this search box. 

The list contains all created search indexes. For more information, see Search indexes. 

The search index is a predefined set of search content. For example, you can create a search index that contains all news. 

When a user enters a search word, it will be applied to all news items on your website. 

3. In Where to display search results? you must select the page where the search results will be displayed.  

You can select the same page, where the search box is located, or you can select a different page. 

To select a page, perform the following: 

a. Click Select a page… button. 

b. Form the list of pages that appears, select a page and click Done selecting. 

The page appears in Search window. If you want to change it, click Change… button. 

IMPORTANT: The page, where you choose to display the search results, must have the Search results widget added to it. 

4. Click Save. 

The Search window closes and the Search widget is configured to display the search box.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Search widgets group | Widgets | Table of contents | 

SEARCH RESULTS WIDGET 

Use the Search results widget to configure where and how to display the results of a search that a user performed on your 

website. 

PREREQUISITES: You have created at least one search index and have added the Search widget somewhere on your website.  

To configure the Search results widget, perform the following: 

1. After you have dragged the Search results widget on your page, click Edit button in the upper-right corner of the widget. 

The Search Results window appears. 

2. Select one or both of the following: 

 Show searchbox above the results 
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 Show searchbox below the results 

If you display the search results on the same page as the search box (where you have dropped the Search widget), you do 

not need to select any of the above, since the search box will be always displayed. 

3. Under Template select the template which is used to display the news on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

4. If you are using a search index that has indexed custom fields or the fields of any dynamic content type, perform the 

following: 

a. Click Advanced. 

b. Enter the fields in SearchFields input field, separated by commas.  

c. If you want the search phrase to be highlighted in these fields, enter them also in HighlightedFields input field. 

d. Click Save. 

5. When you are finished, click Save. 

The Search Results window closes and the Search results widget is configured to display the search results.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Search widgets group | Widgets | Table of contents | 

USERS WIDGETS GROUP 

The Users widgets group contains widgets that you use to display lists of users, user registration form and provide the user with 

the ability to change profile information, such as password or email. 

Section contents 

The following widgets are part of the Users group: 

 Profile 

Use the Profile widget to provide the users of your website with the opportunity to view or change their profile information, 

such as password or email. 

 Users list 

Use the User list widget to display lists of users. You can display users of different profile types or different roles. For example 

you can display only forum users and you can choose to display only their nicknames. 

 Registration 

Use the Registration widget to provide the users of your website with the opportunity to register. 

 Account activation 

Use this widget when the account of the user is not immediately activated, but must first be confirmed. You must add the 

Account activation widget on the confirmation page. 

| Widgets | Table of contents | 

PROFILE WIDGET 

Use the Profile widget to provide the users of your website with the opportunity to view or change their profile information, such as 

password or email. 

To configure the Profile widget, perform the following: 

1. After you have dragged the Profile widget on your page, click Edit button in the upper-right corner of the widget. 

The Profile window appears. 

2. Under This profile is in… section, select the mode in which you want to display the user profile information.  

Select one of the following: 

 Read mode only 

Displays information about the user, which is read-only and cannot be edited. 
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 Edit mode only 

Displays information about the user, where all fields are editable. 

 Both: Read mode that can be edited 

Displays information about the user, which is read-only. The information becomes editable, if the user clicks Edit Profile or 

Change Password links. 

3. When you are finished, click Save. 

The Profile window closes and the Profile widget is configured to display information about the user.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Users widget group | Widgets | Table of contents | 

READ MODE 

The system displays information about the user, which is read-only and cannot be edited. 

In Fine tune the selected type, make the following settings: 

1. Select one of the following: 

 User logged to his/her account 

The system displays information about the user that is currently logged in. 

 Selected user 

The system displays information of a user different than the user that is currently logged in. 

To select the user whose details are displayed, perform the following: 

a. Click Select a user button. 

A list of all existing users appears. 

b. Select the user and click Done selecting. 

2. If you have more than one user profiles created, a dropdown box appears where you must select the profile which information 

you want to display.  

The system displays information only from the selected profile. 

EXAMPLE: You have created profile type Forum, where in addition to the basic user information, there is a field Nickname 

that each forum user completes. If in the dropdown you select Forum profile type, only the nickname of the user is displayed. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

3. In Template, select the template that is used to display the user information on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

NOTE: The Auto generated fields template displays all fields defined in the profile type and uses the settings that you defined 

for each custom or default field in the settings of the profile type. These are the settings that you defined on the Appearance 

tab of each field. 

For more information about custom fields, see Custom fields. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

4. You can choose a class name for the Profile widget if later you want to set a CSS style for this particular widget. 

To do this click More options and enter a name for the class in Css class input field. 

| Configuring the Profile widget | Users widget group | Widgets | Table of contents | 

EDIT MODE 

The system displays information about the user, where all fields are editable. 

In Fine tune the selected type, make the following settings: 
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1. If you have more than one user profiles created, a dropdown box appears where you must select the profile which information 

you want to display.  

The system displays information only from the selected profile. 

EXAMPLE: You have created profile type Forum, where in addition to the basic user information, there is a field Nickname 

that each forum user completes. If in the dropdown you select Forum profile type, only the nickname of the user is displayed. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

2. In Template, select the template that is used to display the user information on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

NOTE: The Auto generated fields template displays all fields defined in the profile type and uses the settings that you defined 

for each custom or default field in the settings of the profile type. These are the settings that you defined on the Appearance 

tab of each field. 

For more information about custom fields, see Custom fields. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

3. Choose what to display when changing password. 

Select one of the following radio buttons: 

 Show message above the form 

Select if you want to display a message to the user when password is successfully changed.  

Enter the message in the text box. 

 Open a specially prepared page... 

Select if you want to display a page to the user when password is successfully changed.  

Click Change page button, select the page and click Done selecting. 

4. In CSS class input field, you can choose a class name for the Profile widget if later you want to set a CSS style for this 

particular widget. 

| Configuring the Profile widget | Users widget group | Widgets | Table of contents | 

READ MODE THAT CAN BE EDITED 

The system displays information about the user, which is read-only. The information becomes editable if the user clicks Edit Profile 

or Change Password links. 

1. If you have more than one user profiles created, a dropdown box appears where you must select the profile which information 

you want to display.  

The system displays information only from the selected profile. 

EXAMPLE: You have created profile type Forum, where in addition to the basic user information, there is a field Nickname 

that each forum user completes. If in the dropdown you select Forum profile type, only the nickname of the user is displayed. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

2. Choose templates for the following: 

 ‘Read mode’ template 

This is the template for the user information when the profile is in read-only mode. 

 ‘Edit mode’ template 

This is the template for the user information displayed after the user clicks Edit Profile. 

 Template for not logged users 

This is the template displayed to a user who attempts to change profile without being logged in. 

 'Change password' template 

This is the template displayed to a user who attempts to change password. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit template. 
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For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

NOTE: The Auto generated fields template displays all fields defined in the profile type and uses the settings that you defined 

for each custom or default field in the settings of the profile type. These are the settings that you defined on the Appearance 

tab of each field. 

For more information about custom fields, see Custom fields. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

3. Depending on whether you want the user to edit profile and change password on the same page or on new pages, perform 

one of the following: 

 If you want to edit profile information and change password on the same page, perform the following: 

a. Choose templates for ‘Edit mode’ template and 'Change password' template. 

These are the templates displayed after the user clicks Edit Profile or Change Password links. 

b. Expand More actions and select what to display after changes have been saved. 

Select one of the following radio buttons: 

 Stay in the same screen but display a message above the form... 

In the text box, enter the message that is displayed when changes are saved. 

 Open a specially prepared page... 

Click Select a page button, from the tree select the page that opens when changes are saved, and click Done 

selecting. 

 If you want to edit profile information and change password on separate pages, select Open Edit and Change password 

in selected existing pages... checkbox. 

The ‘Edit mode’ template and 'Change password' template dropdown boxes disappear. 

a. To select the page that is displayed when the user clicks Edit Profile link, under Page for editing profile, click Select a 

page button, select a page from the tree, and click Done selecting. 

b. To select the page that is displayed when the user clicks Change Password link, under Page for changing password, 

click Select a page button, select a page from the tree, and click Done selecting. 

4. You can choose a class name for the Profile widget if later you want to set a CSS style for this particular widget. 

To do this click More options and enter a name for the class in Css class input field. 

| Configuring the Profile widget | Users widget group | Widgets | Table of contents | 

USERS LIST WIDGET 

Use the Users list widget to display lists of users. You can display users of different profile types or different roles. For example you 

can display only forum users and you can choose to display only their nicknames. 

After you have dragged the Users list widget on your page, perform the following: 

Click Edit button in the upper-right corner of the widget. 

The User list window appears where you can configure the following: 

USERS 

On this tab, you can choose the users which you want to display in the list. 

1. In Which users to display? dropdown box, select the profile type of the users which you want to display. 

For example you can display only forum users. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

2. Select which users you want to display in the list, by choosing one of the following radio buttons: 

 All registered users 

 One user only 

Click Select a user… button, select the user which you want to display, and click Done selecting. 

 Users by roles...  
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Click Select roles… button, select one or more roles, and click Done selecting. 

Only users belonging to the selected roles will be displayed in the list. 

LIST SETTINGS 

On this tab you choose how to display the users you have selected. 

 If you select Use paging radio button, the system divides the users into pages.  

In the input field you specify how many users per page you want to display. 

 If you select Use limit radio button, the system displays only a limited number of the users you have chosen to display. 

In the input field, you specify how many posts you want to display. 

 If you select No limit and paging radio button, the system displays all the users that you have selected in Users tab. 

 In Sort users by dropdown box, select a sorting criterion for the users. 

 In List template, select the template which is used to display the users on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

SINGLE ITEM SETTINGS 

On this tab you choose the way to display a user when clicked. 

In Open Single user profile in… radio button, select one of the following: 

 Auto-generated page 

When a user is clicked, the information is displayed in a page which is automatically generated and has the same layout as the 

current page. 

 Select existing page… 

You select a page from the existing pages with certain layout where the user will be displayed when clicked.  

NOTE: In order to display the user, the page you have selected must have the Users list widget added. 

1. Click Select page. 

From the treeview, select the page where you want to display the user. 

2. Click Done selecting. 

 In Detail templates, select the template which is used to display the users on the webpage. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

NOTE: The Auto generated fields template displays all fields defined in the profile type and uses the settings that you defined 

for each custom or default field in the settings of the profile type. These are the settings that you defined on the Appearance 

tab of each field. 

For more information about custom fields, see Custom fields. 

For more information about profile types, see Sitefinity Installation and Administration Guide » Users, roles, and permissions » 

Managing user profiles. 

When you are finished with all the settings, click Save. 

The User list window closes and the Users list widget is configured to display the users you have selected.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Users widget group | Widgets | Table of contents | 

REGISTRATION WIDGET 

Use the Registration widget to provide the users of your website with the opportunity to register. 

After you have dragged the Registration widget on your page, perform the following: 

Click Edit button in the upper-right corner of the widget. 

The Registration window appears where you can configure the following: 
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GENERAL 

On this tab, perform the following: 

1. In Roles, which the user will be assigned to… choose whether the user is assigned to any roles. 

Click Select roles... button, select the roles to which you want to assign the user and click Done selecting. 

For more information about roles, see Sitefinity Installation and Administration Guide » Managing users, roles, and permission 

» Managing roles. 

2. In Registration form template dropdown, choose the template for the registration form. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

3. In When the form is successfully submitted... choose what to display after the registration form have been completed by the 

user. 

Select one of the following radio buttons: 

 Show a message 

In the text box, enter the message that is displayed when form is submitted. 

 Open a specially prepared page... 

Click Select a page button, from the tree select the page that opens when registration is complete, and click Done 

selecting. 

4. In CSS class input field, you can choose a class name for the Registration widget if later you want to set a CSS style for this 

particular widget. 

ACCOUNT ACTIVATION 

On this tab, perform the following: 

1. Choose when to activate the account of the user who completed the registration form. 

Select one of the following radio buttons: 

 Immediately 

The account is activated when the user clicks Register button in the registration form. 

 After a confirmation 

a. Under Confirmation page, select the page that opens when the user clicks the confirmation link in the email. 

The page must have the Account activation widget added to it. 

b. Click Select a page… button, select the page from the tree, and click Done selecting. 

c. Select a template for the email that the system sends to the user for account confirmation. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting 

them and clicking Edit template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » 

Creating and editing widget templates. 

2. If, after the user account has been activated, you want to send a confirmation email, select Send an email for successful 

registration checkbox. 

In 'Success' email template, select the template for the email that the system sends to the user when the account has been 

successfully activated. 

You can create a custom template by clicking Create New Template. You can edit existing templates by selecting them and 

clicking Edit template. 

For more information, see Sitefinity Designer’s Guide » Widget templates » Using the Widget templates editor » Creating and 

editing widget templates. 

When you are finished with all the settings, click Save. 

The Registration window closes and the Registration widget is configured to display the users you have selected.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Users widget group | Widgets | Table of contents | 
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ACCOUNT ACTIVATION WIDGET 

Use this widget when the account of the user is not immediately activated, but must first be confirmed. You must add the Account 

activation widget on the confirmation page. The confirmation page can be the same page, where the Registration widget is added 

or another page. 

PREREQUISITES: When configuring the Registration widget, on Account activation tab you must have selected After a 

confirmation radio button. For more information, see Registration widget. 

To configure the Account activation widget, perform the following: 

1. Drag the widget on the same page that you have chosen in Registration widget, on Account activation tab, after you have 

selected After a confirmation radio button. 

2. Click the Edit button in the upper-right corner of the Account activation widget. 

The advanced configuration mode appears. 

3. In SuccessMessage input field, enter a message that will be displayed to the user after the registration is confirmed and the 

account is activated. 

4. Click Save. 

The advanced configuration mode of the widget closed 

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Users widget group | Widgets | Table of contents | 

SOCIAL WIDGETS GROUP 

The Social widgets group contains widgets that you use to display Facebook feed and Facebook like and send buttons on the pages 

of your website. 

Section contents 

The following widgets are part of the Social group: 

 Facebook feed 

Use the Facebook feed widget to display the most recent Facebook activity on your website. The feed displays activities when 

someone likes, shares, or comment content on your website. 

 Facebook like 

Use the Facebook like to let users share your website with friends on Facebook. When the user clicks the Like button on a 

page of your website, a story appears in the user's friends' News Feed with a link back to your website. Using the widget, you 

can also display a Send button that lets the users send your website in Facebook. 

 Twitter feed 

Use this widget to display a Twitter feed on your website.  

 Page sharing 

Use this widget to give the opportunity to your users to easily share the page they have opened. 

| Widgets | Table of contents | 

FACEBOOK FEED WIDGET 

Use the Facebook feed widget to display the most recent Facebook activity on your website. The feed displays activities when 

someone likes, shares, or comment content on your website. To generate activity, you must add on your site elements such as the 

Like button. For more information about the content displayed in the Facebook feed widget, see Activity Feed at  

http://developers.facebook.com/docs/reference/plugins/activity/.  

To configure the Facebook feed widget, perform the following: 

5. After you have dragged the widget on your page, click Edit button in the upper-right corner of the widget. 

The Facebook activity feed window appears. 

6. In Domain, enter the domain of your website. 

7. Use the Height and Width input fields to define the size of the feed window in pixels. 

8. Choose how the feed will look like by selecting the Color scheme, the Font, and the Border Color of the widget. 

http://developers.facebook.com/docs/reference/plugins/activity/
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9. When a user clicks a feed, choose whether to open it in a new window or in the same window. 

10. If you select Show header checkbox, the Recent Activity header will appear on top of the feed. 

11. If you select Show recommendations checkbox, the feed is split in two halves. The top displays activities of the logged user’s 

friends; the bottom displays recommendations from your site. If there is not enough friend activity, the top half is filled with 

recommendations. 

12. If you have the Facebook feed widget on more than one page of your website and you want to track which instance of the 

widget generates more traffic to your website, you can append an additional parameter to each link by entering this parameter 

in Label for tracking referrals input field. 

For example, if you have the Facebook feed widget on your Home page and your Categories page, you can enter hole in the 

widget on your Home page and enter categories in the widget on your Categories page.   

13. When you are finished with all the settings, click Save. 

The Facebook activity feed window closes and the widget is configured to display Facebook feeds.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Social widgets group | Widgets | Table of contents | 

FACEBOOK LIKE WIDGET 

Use the Facebook like to let users share your website with friends on Facebook. When the user clicks the Like button on a page of 

your website, a story appears in the user's friends' News Feed with a link back to your website. Using the widget, you can also 

display a Send button that lets the users send your website in Facebook. For more information about the content displayed in the 

Facebook like widget, see  http://developers.facebook.com/docs/reference/plugins/like/ and  

http://developers.facebook.com/docs/reference/plugins/send/. 

To configure the Facebook like widget, perform the following: 

1. After you have dragged the widget on your page, click Edit button in the upper-right corner of the widget. 

The Facebook like window appears. 

2. In URL to Like, select one of the following: 

 Current page 

The page that is liked or shared is the page where the widget is dropped. 

 Other page… 

The page that is liked or sent is different than the page, where the widget is dropped. 

Perform the following: 

a. Click Select a page. 

b. Select one of the following: 

 If you want the users to like or send a page from your website, click From this site, select the page, and click 

Done selecting. 

 If you want the users to like or send an external page, click From other sites, enter the external page URL, and 

click Done selecting. 

3. Use the Width input field to define the size of the widget in pixels. 

4. Choose how the feed will look like by selecting the Layout style, the Color scheme, the Font, and the Button Label of the 

widget. 

5. Choose whether to display profile pictures below the Like button by selecting Show profile pictures below the button (in 

Standard Layout style). 

These are the profile pictures of the friends of the user, who also like the page.  

6. Choose whether to display a send button by selecting Show send button. 

7. If you have the Facebook like widget on more than one page of your website and you want to track which instance of the 

widget generates more traffic to your website, you can append an additional parameter to each link by entering this parameter 

in Label for tracking referrals input field. 

For example, if you have the Facebook like widget on your Home page and your Categories page, you can enter hole in the 

widget on your Home page and enter categories in the widget on your Categories page.   

http://developers.facebook.com/docs/reference/plugins/like/
http://developers.facebook.com/docs/reference/plugins/send/
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8. When you are finished with all the settings, click Save. 

The Facebook like window closes and the widget is configured to display Facebook like button.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Social widgets group | Widgets | Table of contents | 

TWITTER FEED WIDGET 

Use this widget to display a Twitter feed on your website.  

To do this, perform the following: 

1. Login to your Twitter account. 

2. Open Settings and in the left pane, click Widgets » Create new. 

3. Create your widget. 

For more information, see Twitter’s developer documentation on https://dev.twitter.com/docs/embedded-timelines. 

4. When finished with the widget settings, click Create widget. 

Twitter generates a code snippet for the widget. 

5. Copy the code. 

6. In Sitefinity drag the Twitter feed widget on your page and click its Edit button. 

7. Paste the code from Twitter and click Save. 

The Twitter feed window closes and the widget is configured to display the feeds you have selected.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

If you are upgrading and already have the Twitter feed widget configured on your page, you can change its settings using 

procedure Twitter feed widget (backward compatibility). 

TWITTER FEED WIDGET (BACKWARD COMPATIBILITY) 

Use this widget to display a Twitter feed on your website.  

After you have dragged the Twitter feed widget on your page you must configure it to display selected tweets. 

To do this, click Edit button in the upper-right corner of the widget. 

The Twitter feed window appears where you can configure the following: 

CONTENT 

In content, you can choose which tweets you want to display. 

1. Choose the source of the feed by selecting one of the following: 

 Profile 

Displays the Twitter feed of a particular Twitter user. 

 Search 

Displays the Twitter feed resulting from a particular search query in Twitter. 

 Favorites 

Displays the favorite feeds from a particular user. 

 List 

Displays the Twitter list of a particular user. 

In Title and Subtitle input fields, enter the title and the caption of the Twitter feed window. 

2. Choose how often to refresh the Twitter feed, by selecting one of the following: 

 Load new tweets automatically 

Refresh the Twitter feed every time when a new feed in published. 

 Check for new tweets every... 

Select the time interval on which to refresh the Twitter feed. 

3. Choose how many tweets to display in the feed, by entering the number in Number of displayed tweets input field. 

https://dev.twitter.com/docs/embedded-timelines
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4. Choose what to display with the feeds, by selecting one or more of the following checkboxes: 

 Timestamp 

 Avatars 

 Hash tags 

APPEARANCE 

On this tab, choose how the tweets will look like. 

1. Choose the size of the feed, by selecting one of the following: 

 Auto 

The feed window is automatically sized. 

 Fixed… 

Enter the size of the feed window in pixels and choose whether the scrollbar is included in these sizes or not. 

2. Choose the color scheme of the twitter feed by selecting one of the following: 

 Default 

The feed is displayed in its default Twitter colors. 

 Custom 

For each element of the feed widow, choose the color from the color pickers. 

3. Click Save. 

When you are finished with all the settings, click Save. 

The Twitter feed window closes and the widget is configured to display the feeds you have selected.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Social widgets group | Widgets | Table of contents | 

PAGE SHARING WIDGET 

Use this widget to give the opportunity to your users to easily share the page they have opened. If you drop the Page sharing 

widget on the page, a list of icon of social networks will appear as page sharing options. 

To configure the Page sharing widget, perform the following: 

1. After you have dragged the widget on your page, click Edit button in the upper-right corner of the widget. 

The Page sharing window appears. 

2. To add or remove sharing option for the page, select or deselect the checkboxes. 

You can add various social networks as well as an e-mail link. 

3. Choose how to display the sharing options: 

 As Small icons. 

 As Icons with text. 

For Facebook, Twitter and Google+ choose whether you want to display a counter that shows the number of people who 

also shared the same item. 

4. Click Save. 

The Page sharing window closes and the widget is configured to display the sharing options you have selected.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Social widgets group | Widgets | Table of contents | 

CLASSIFICATIONS WIDGETS GROUP 

The Classifications widgets group contains widgets that you use to display lists of categories and tags on your website. You use the 

categories and the tags to filter the content of the pages. 

Section contents 

The following widgets are part of the Navigation group: 
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 Categories 

Use the Categories widget to filter the content of a page. You use the widget together with another widget from the Content 

widgets group, such as News or Events widgets. When the user clicks a category, the news or events are filtered according to 

this category. 

 Tags 

Use the Tags widget to filter the content of a page. You use the widget together with another widget from the Content 

widgets group, such as News or Events widgets. When the user clicks a tag, the news or events are filtered according to this 

tag. 

| Widgets | Table of contents | 

CATEGORIES WIDGET 

Use the Categories widget to display categories on your page. The categories are then used to filter content. By clicking different 

categories from the treeview displayed on the webpage, you can filter the content of the page. By using hierarchy of categories, 

you can filter content items according to more general or more specific criterion. 

PREREQUISITES: You have created at least two categories. 

For more information about when and how to use categories, see Using categories.  

To configure the Categories widget, perform the following: 

1. After you have dragged the Categories widget on your page, click Edit button in the upper-right corner of the widget. 

The Edit window appears in advanced mode. 

2. In BaseUrl input field enter the URL name of the page which content you want to filter using categories. 

This page can be either the same page on which the Categories widget is, or it can also be another page. 

For example, you can display the categories on one page of your website, but if the user clicks a category, the system opens 

another page and filters its content.  

NOTE: You enter the URL name in the following format ~/<URL name of page>. For example, if the title of the page is 

About us, the automatically generated URL name is about-us (in case you have not changed it), then in BaseUrl input field you 

enter ~/about-us.  

You can find out the URL name of a page in the address bar of the browser, when a page is opened in content editing mode. 

The URL name is the name after the name of the project (http://…/<project name>/<page-name>/…) or you can see the 

URL name in the properties of the page. For more information, see Editing the properties of a page. 

3. To configure how the widget displays the categories, in RenderAs input field, enter one of the following: 

 HorizontalList 

The widget displays only top level categories in a horizontal list. 

 VerticalList 

The widget displays only top level categories in a vertical list. 

 Cloud 

The system displays only top level categories in a horizontal list. The more items belong to a category, the larger font the 

system uses to display this category. 

4. To filter the items in a category according to their content type, you use input field ContentType: 
 

To display only: In ContentType field, enter: 

Blog posts Telerik.Sitefinity.Blogs.Model.BlogPost 

Events Telerik.Sitefinity.Events.Model.Event 

News Telerik.Sitefinity.News.Model.NewsItem 

Images Telerik.Sitefinity.Libraries.Model.Image 

Videos Telerik.Sitefinity.Libraries.Model.Video 

Documents Telerik.Sitefinity.Libraries.Model.Document 
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For example, when you click a category and you want only events classified with this category to be displayed, in ContentType 

enter Telerik.Sitefinity.Events.Model.Event. 

NOTE: To show categories that are assigned only to a specific dynamic content type, in field DynamicContentType, enter 
Telerik.Sitefinity.DynamicTypes.Model.<Module_name>.<ContentType_name> 

5. Click Save. 

The system saves the setting and closes the editing mode of the widget.   

For more information about creating categories, see Creating a category. 

For more information about how to add a category to a content item, see Adding categories and tags to a content item. 

For more information about configuring other properties, see Advanced configuration of widgets. 

CONFIGURING CATEGORIES WIDGET TO DISPLAY CUSTOM CLASSIFICATION 

To display a custom hierarchical list classification, you can use the Categories widget. After you have created a custom 

classification, perform the following: 

1. Drag the Categories widget on your page and click Edit button in the upper-right corner of the widget. 

The Edit window appears in advanced mode. 

2. Delete the contents of field TaxonomyId and click Save. 

A list of all created classifications and their IDs appears. 

3. Copy the TaxonomyId of the classification which you want to display. 

4. Click Edit button in the upper-right corner of the widget. 

5. Paste the ID of the classification in TaxonomyId field. 

6. In field FieldName, enter the classification name of the custom taxonomy. 

For example, Geographic regions. This is different than the single item name, for example, Geographic region. 

The purpose of this property is to specify which hierarchical taxonomy will be used, because there might be more than one. 

7. To further configure the widget, perform Step 2 to Step 4 of the above procedure. 

| Classifications widgets group | Widgets | Table of contents | 

TAGS WIDGET 

Use the Tags widget to display tags on your page. The tags are then used to filter content. By clicking different tags from the list of 

tags displayed on the webpage, the user can filter the content on the page. 

PREREQUISITES: You have created at least two tags. 

For more information about when and how to use tags, see Using tags. 

To configure the Tags widget, perform the following: 

1. After you have dragged the Tags widget on your page, click Edit button in the upper-right corner of the widget. 

The Edit window appears in advanced mode. 

2. In BaseUrl input field enter the URL name of the page which content you want to filter using tags. 

This page can be either the same page on which the Tags widget is, or it can also be another page. 

For example, you can display the tags on one page of your website, but if the user clicks a tag, the system opens another 

page and filters its content.  

NOTE: You enter the URL name in the following format ~/<URL name of page>. For example, if the title of the page is 

About us, the automatically generated URL name is about-us (in case you have not changed it), then in BaseUrl input field you 

enter ~/about-us.  

You can find out the URL name of a page in the address bar of the browser, when a page is opened in content editing mode. 

The URL name is the name after the name of the project (http://…/project name/page-name/…) or you can see the URL name 

in the properties of the page. For more information, see Editing the properties of a page. 

3. To configure how the widget displays the tags, in RenderAs input field, enter one of the following: 

 HorizontalList 

The widget displays tags in a horizontal list. 

 VerticalList 
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The widget displays tags in a vertical list. 

 Cloud 

The system tags in a horizontal list. The more items are tagged with a tag, the larger font the system uses to display this 

tag. 

4. To filter the items tagged with a particular tag according to their content type, you use input field ContentType: 
 

To display only: In ContentType field, enter: 

Blog posts Telerik.Sitefinity.Blogs.Model.BlogPost 

Events Telerik.Sitefinity.Events.Model.Event 

News Telerik.Sitefinity.News.Model.NewsItem 

Images Telerik.Sitefinity.Libraries.Model.Image 

Videos Telerik.Sitefinity.Libraries.Model.Video 

Documents Telerik.Sitefinity.Libraries.Model.Document 

For example, when you click a tag and you want only events tagged with this tagged to be displayed, in ContentType enter 
Telerik.Sitefinity.Events.Model.Event. 

NOTE: To show tags that are assigned only to a specific dynamic content type, in field DynamicContentType, enter 
Telerik.Sitefinity.DynamicTypes.Model.<Module_name>.<ContentType_name> 

5. Click Save. 

The system saves the setting and closes the editing mode of the widget.  

For more information about creating tags, see Creating a tag. 

For more information about how to tag a content item, see Adding categories and tags to a content item. 

For more information about configuring other properties, see Advanced configuration of widgets. 

CONFIGURING TAGS WIDGET TO DISPLAY CUSTOM CLASSIFICATION 

To display a custom simple list classification, you can use the Tags widget. After you have created a custom classification, perform 

the following: 

1. Drag the Tags widget on your page and click Edit button in the upper-right corner of the widget. 

The Edit window appears in advanced mode. 

2. Delete the contents of field TaxonomyId and click Save. 

A list of all created classifications and they IDs appears. 

3. Copy the TaxonomyId of the classification which you want to display. 

4. Click Edit button in the upper-right corner of the widget. 

5. Paste the ID of the classification in TaxonomyId field. 

6. In field FieldName, enter the classification name of the custom taxonomy. 

For example, Geographic regions. This is different than the single item name, for example, Geographic region. 

The purpose of this property is to specify which hierarchical taxonomy will be used, because there might be more than one. 

7. To further configure the widget, perform Step 2 to Step 4 of the above procedure. 

| Classifications widgets group | Widgets | Table of contents | 

EMAIL CAMPAIGNS WIDGETS GROUP 

The Email Campaigns widgets group contains widgets that you use to display subscription and unsubscription forms to the visitors 

of your website. 

Section contents 

The following widgets are part of the Email Campaigns group: 
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 Subscribe form 

Use the Subscribe form widget to allow the visitors of your website to subscribe to your email campaign. 

 Unsubscribe form 

Use the Unsubscribe form widget to allow the visitors of your website to unsubscribe from the email campaign that they have 

been subscribed to. 

| Widgets | Table of contents | 

SUBSCRIBE FORM WIDGET  

Use this widget to display to the visitors of your website a form for subscribing to an email campaign. 

PREREQUISITES: You have created at least one mailing list to which to add the new subscriber. For more information, see 

Creating a mailing list. 

After you have dragged the Subscribe form widget on your page you must configure it to display the subscription form. 

To do this, click Edit button in the upper-right corner of the widget. 

The Subscribe form window appears where you can configure the following: 

1. Select a mailing list, to which the new subscriber will be added. 

2. In Widget title input field, enter what will be displayed above the names and email fields of the form. 

For example, enter Want to know more about are latest products? or Subscribe to our email campaign. 

3. In Widget description textbox, enter, if needed, explanatory text or a description of the email campaign. 

The text is displayed under the Widget title. 

For example, enter Keep up with the latest products, upgrades and financing options... 

4. When you are finished with all the settings, click Save. 

The Subscribe form window closes and the widget is configured to display the subscription form.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Email campaigns widgets group | Widgets | Table of contents | 

UNSUBSCRIBE FORM WIDGET 

Use this widget to display to the visitors of your website a form for unsubscribing from an email campaign, which they have been 

subscribed to. 

PREREQUISITES: You have created at least one mailing list to which visitors can subscribe and unsubscribe. For more 

information, see Creating a mailing list. 

After you have dragged the Unsubscribe form widget on your page you must configure it to display the unsubscription form. 

To do this, click Edit button in the upper-right corner of the widget. 

The Unsubscribe window appears where you can configure the following: 

1. In the text editor, enter the text displayed when a user unsubscribes from an email campaign. 

2. Use Insert dynamic data in the text dropdown box to insert different placeholders in your email campaign, such as the name 

and the email of the subscriber or different properties of the mailing list.  

For example, your message can start like this Dear <First name of subscriber>, you have successfully 

unsubscribed from our monthly newsletter. The message can appear like this: Dear John, you have successfully 

unsubscribed from our monthly newsletter. 

3. When you are finished with all the settings, click Save. 

The Unsubscribe form window closes and the widget is configured to display the form.  

For more information about advanced configuration options, see Advanced configuration of widgets. 

| Email campaigns widgets group | Widgets | Table of contents | 

ADVANCED CONFIGURATION OF WIDGETS 

You use this mode to configure individual properties of the widget.  
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PREREQUISITE: To edit properties of a widget in advanced mode, you must be an advanced user or a developer. 

OPENING ADVANCED MODE 

1. To open Advanced configuration mode, click Edit button in the upper-right corner of the widget. 

The Simple configuration mode appears. 

NOTE: Widgets that do not have simple configuration mode, are opened for editing directly in advanced mode.  

In this case, skip Step 2 and Step 3. 

2. Click Advanced button in the lower-right corner of the window. 

The edit window appears in advanced mode, where all the properties of the widget are listed. 

The following screenshot shows the Advanced configuration mode of the News widget: 

 

3. To go back to simple mode, click Simple button. 

DISPLAY OF PROPERTIES 

You can switch between the following views: 

  (Alphabetically). 

The system displays the properties in alphabetic order. 

  (Categorized). 

The system displays the properties in categories. You can expand and collapse each category individually by clicking it or you 

can expand and collapse all categories at once by clicking Expand all or Collapse all links respectively. 

EDITING PROPERTIES 

For more information about what each property means and what to enter in the input fields, see CompositeControl Properties ( 

http://msdn.microsoft.com/en-us/library/system.web.ui.webcontrols.compositecontrol_properties.aspx) on Microsoft Developer 

Network. 

NOTE: Each widget has the CssClass property. You use it to apply a custom CSS class to the widget. This way, each individual 

widget can be styled differently. 

| Widgets | Table of contents | 

PERSONALIZATION OF THE WEBSITE CONTENT 

Personalization allows different content to be served to different types of users (user segments). You can build set of rules on 

which the user segments are based. You can then create different versions of the pages of your website.  

You must first create the user segments and then personalize your pages. User segments are defined by particular 

characteristics, such as location or IP address. You can then use the preview tool to view the website from different user 

perspectives. 

Section contents 

 Creating user segments 

 Editing and deleting user segments 

http://msdn.microsoft.com/en-us/library/system.web.ui.webcontrols.compositecontrol_properties.aspx
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 Personalization preview tool 

| Table of contents | 

CREATING USER SEGMENTS 

User segments are different groups of users that are served different content (different versions of a page). You create user 

segments based on certain rules that apply to the users. For example, one segment can be users that are located in London, 

another segment can be users from the US who visit the site between 5 PM and 10 PM. 

To help you determine the user segments and make sure they are not empty, you can refer to Sitefinity Tools » Sitefinity Analytics 

to see a detailed picture of your site visitors. 

To create a user segment, perform the following: 

1. In the main menu, click Marketing » Personalization. 

The Personalization page appears. 

2. Perform one of the following: 

 If you have not created any user segments, the system displays the following in the center of the screen: 

 

 If you have already created one or more segments, the system displays a list of all created segments and the following 

button in the toolbar of Personalization page: 

 

3. Click Create a user segment. 

The Create a user segment page appears. 

4. Enter a name and a description for the user segment. 

The name and the description are used for your convenience only and are not displayed anywhere on the frontend. 

5. Create the rules that will determine this user segment, by clicking Add a characteristic button. 

The Add a characteristic box appears. It contains a set of predefined characteristics from which you can choose. 

6. Choose a characteristic according to which you want to filter your users. 

For more information, see User characteristics. 

7. Click Save. 

The selected characteristic appears under For users with these characteristics... section. 

8. To add more characteristics, click one of the flowing buttons: 

 If you want the users to be filtered either by the first, or the second characteristic, click the Add a characteristic button 

under the OR separator. 

 If you want to apply the first characteristic and then the second one, click Add a characteristic button under the AND 

separator. 

EXAMPLE: You want to form a user segment, containing users from London who have used keyword dog, first choose 

Location characteristic, then under AND, choose Search keywords characteristic. 

If you want to form a user segment, containing users either from London, or from Paris, first choose Location characteristic, 

then under OR, choose another Location characteristic.  

You can also create more specific user segments, using both OR and AND logical operators. For example, either users who 

have visited a specific page, or users from London or Paris, and from all of these users filter only those who have visited the 

site between 10 AM and 5 PM. 

9. To immediately use the segment, select This user segment is active checkbox. 

10. Click Save changes. 

The user segment is created and can be used to personalize pages. 

For more information, see Personalize a page. 
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NOTE: After you have created a segment, you can set its priority. This is useful, if, for example, you have different user segments 

with overlapping characteristics, or you have broader and more specific user segments. Setting their priority tells the system the 

order in which to apply user segments to the users of the website.  

To change the priority of a segment, on Personalization page, click the Actions link of the segment and in the dropdown menu 

select Up or Down. The segment with highest priority is at the top of the page. 

| Personalization of the website content | Table of contents |  

USER CHARACTERISTICS 

The following table lists all available characteristics that you can choose to describe a user or user segment, together with their 

meaning and what you have to enter after choosing a characteristic: 
 

Characteristic Meaning Input 

IP address The IP address of the user. A paragraph box opens, where you must enter all IP addresses of 

users that will be included in the user segment, each one on a new 

line. 

Landing URL The page which the user have entered 

your website from. 

In the input field, enter the URL of the page. 

Location Where the user is physically located In Add location field, type the location and click Add button.  

You can type, for example, a country name or a city name. 

Profile fields The fields of a user profile.  

Can be applied only to registered 

users. 

For more information about profile 

fields, see Sitefinity Installation and 

Administration Guide » Users, roles, 

and permissions » Managing users » 

Managing user profiles. 

The Field dropdown box contains all fields available in the user 

profile.  

1. Select a field. 

2. In the next dropdown box, select a logical operation. 

3. Enter a value for the user profile field and click Add. 

You can add more than one condition for the profile fields. 

Referral URL The URL of the page, which contains a 

link to your site and from where the 

user has come to your site. 

In the input field, enter the URL of the page. 

Roles The Sitefinity role that the user is 

assigned to. 

For example, Designers or Customers.  

For more information, see Sitefinity 

Installation and Administration Guide 

 Users, roles, and permissions  

Managing roles. 

Select the roles, which you want to apply the personalization rule to. 

All uses belonging to the selected roles will be served personalized 

content.  

Search 

keywords 

The search keywords that the user has 

used to search for your site 

In the input field, enter the keywords, separated by commas. 

Time of day The time interval when the user have 

used your site. 

Use the From and To dropdown boxes to define the time interval. 

Purchases The purchases that the user has made 

from your website 

You can choose to narrow the purchased products by the following: 

 Departments 

Select the checkboxes of the desired departments. 

 Price range 

Use the From and To input fields to define the price range of the 

purchased products. 

 Tag 
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Type the tag of the purchased product or click Select from 

existing and click Add button. 

 Type of product 

Select the checkboxes of the desired product types. 

 Particular product 

Select the checkboxes of the desired products. 

Only users that have purchased products with the specified 

characteristics will be included in the user segment. 

For more information about products, departments, or product types, 

see Sitefinity Ecommerce Guide. 

Visit duration The duration of the user session Use the From and To input fields to define the duration of the user 

visit in the selected unit of measurement. 

Use the Period of visitation dropdown box to select the time interval 

for the user session statistics. 

For example, you can select only users that during the last week have 

had user sessions between 1 and 2 minutes. 

Visited page A page that was visited by the user Only users who have visited a certain page are included in the user 

segment. 

Choose one of the following: 

 Select page… 

Select a page from the sitemap. 

 Enter URL… 

Enter the URL of a page from your site. 

PREREQUISITES: The following fields are available only with Sitefinity license for Marketo. For more information, contact 

sales@sitefinity.com.  

For more information, see Sitefinity Installation and Administration Guide  Synchronization of data  Synchronizing Sitefinity 

with Marketo  Configuring Marketo based personalization. 

 

Marketo lead 

score 

 

A number, representing the Marketo 

lead score of a user. 

In the field, enter a number representing Marketo lead score. 

For example, 100. 

Marketo field A field from a user profile in Marketo. In Lead field, enter the name of the Marketo field from the Marketo 

user profile. Then, enter the value of the field.  

For example, Company is equal to Telerik 

| Creating user segments | Personalization of the website content | Table of contents |  

EDITING AND DELETING USER SEGMENTS 

 To edit a user segment, perform the following: 

1. In the main menu, click Marketing » Personalization. 

2. Click the segment that you want to edit. 

3. Perform procedure Creating user segments » Step 4 to Step 9. 

4. When you are finished, click Save changes. 

 To delete a user segment, perform the following: 

1. In the main menu, click Marketing » Personalization. 

mailto:sales@sitefinity.com
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2. Click the Actions link of the segment that you want to edit. 

3. In the dropdown menu, click Delete. 

A dialog box appears where you must confirm the deletion. 

The system deletes the segment and all the personalized pages that use this segment. 

| Personalization of the website content | Table of contents |  

PERSONALIZATION PREVIEW TOOL 

You use this tool to preview how your entire site looks like from the perspective of a particular user segment. You can also view 

the website from the perspective of one or more particular characteristics only. If you have applied responsive design to your 

website so that it can be viewed on mobile devices, you can also view how the website would look from different user perspectives 

on different predefined mobile devices. 

For more information about characteristics available to define a user segment, see User characteristics. 

For more information about responsive design, see Sitefinity Designer’s Guide » Displaying pages on mobile devices. 

To view the site from a particular user segment’s perspective, perform the following: 

1. In the main menu, click Marketing » Personalization. 

A list of all created user segments appears. 

2. In the toolbar, click View site as… button. 

The personalization preview tool opens. 

3. You can browse and edit the contents of the site directly in the preview.  

For more information, see Browse and edit. 

4. In the right pane, you can choose the perspective from which you view the site. 

You can view the site in the following ways: 

 From the perspective of a user segment. 

To do this, click By user segment. 

To change the segment, use the User segment dropdown box, where you can see a list of all created segments. 

 From the perspective of a user with certain characteristics. 

To do this, click Custom. 

A list of all available characteristics appears. 

Configure the characteristics that you want to test. 

For more information, see User characteristics. 

5. After you have chosen the user segment perspective or the characteristics, you can choose if you want to view the website as 

it will appear on a mobile device. 

To do this, select one of the predefined devices in Device preview dropdown box. 

6. Click View. 

The site appears from the selected perspective and as it will appear on the selected device. 

| Personalization of the website content | Table of contents |  

BASIC SETTINGS 

You can modify the settings entirely through the Sitefinity backend UI. All Sitefinity-specific settings are taken out of the project’s 

web.config file and put into separate configuration files in the App_Data/Sitefinity/Configurations folder. The web.config 

file includes only standard ASP.NET configurations. This means that Sitefinity upgrades do not override client configuration 

settings.  

To open the Basic Settings page, in the menu at the upper part of the screen, click Administration » Settings. 

The Basic Settings  page appears. 

Section contents 

On the Basic Settings page, you can configure the following: 

 Time zone 
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In this section, you can adjust the time zone that Sitefinity is using, by selecting it from the Time zone dropdown box. 

Sitefinity automatically handles daylight saving time changes. 

 Languages 

Use this section to add different languages for your public website. You can also add different languages for the backend of 

your website. 

 Text editor 

You can configure which functions to appear in the text editor. 

 Comments 

Use this section to configure general settings for comments that are left on the website. 

 Storage providers for libraries 

Using storage providers for libraries, allow you to store images, videos, documents and other files in a separate storage from 

the database. 

 Email Campaigns 

Use this procedure to configure email setting – SMTP stand for Simple Mail Transfer Protocol. The settings are needed for the 

system to send emails with email campaigns to subscribers. 

 Twitter applications 

Use this page to add and configure registered Twitter applications to Sitefinity. Through Sitefinity backend you can use the 

Twitter API to publish tweets. 

 Social sharing 

You can add sharing options for your content. For example, you can give your users the opportunity to share a news item in 

Google+. 

 Staging & Synchronization 

In this section, you setup the server(s) that data will be published to when you synchronize your environment. 

For more information, see Sitefinity Installation and Administration Guide » Synchronization of data » Synchronizing data 

between two servers » Configuring the servers for synchronization. 

 Thumbnails 

For each image in a library, you can generate thumbnails with different sizes and then choose which size to display on the 

website. 

If you need to configure other settings, you must click Advanced link. 

The Settings  page appears. 

The Settings page has the following structure:  

 Treeview with a list of all configuration sections. 

 Element section for editing configuration elements. 

 List of properties that could be configured in the backend. 

For more information, see Sitefinity Installation and administration guide » Settings. 

BASIC SETTINGS AND MULTIPLE SITES 

If you are using Sitefinity with multiple sites, you can configure the Basic settings in the following way: 

 Settings set per site 

You can set basic setting for each individual site. 

These settings include: 

 Time zone 

 Comments 

 Social sharing 

 Globally set settings 

All other settings, you can configure using the Global settings. 

All sites inherit the setting from the global settings.  

To open the global settings, on Basic Settings page, click link Global settings. 
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NOTE: If you want each site to have settings different from the ones inherited from the global settings, select the site, using the 

site selector in the upper-left part of the screen, click Administration » Settings » Brake inheritance. 

| Table of contents | 

LANGUAGES 

In Sitefinity you can localize pages and content items by creating as many language versions as required. You can create different 

languages for the frontend of your website as well as for the backend. Frontend and backend languages can be created 

independently.  

IMPORTANT: If you plan to use more than 5 frontend languages in your site, we recommend you to persist multilingual fields in 

separate database tables. If you plan to use more than 10 languages, you must persist multilingual fields in separate database 

tables. You must also use fetch strategy. For more information, see Sitefinity Installation and administration guide » Settings » 

Configuring Sitefinity to persist multilingual fields in separate tables for each language. 

To open the language settings, in the main menu, click Administration » Settings. 

The Basic Settings page appears where you click Languages. 

ADDING FRONTEND LANGUAGES 

Under Languages you can see all frontend languages that you have installed. 

1. To add a new language, click Add languages… button. 

The Select languages window appears, displaying a list of all available languages. If you want to add different language 

cultures, click Show cultures. 

2. Select one or more languages or cultures and click Done. 

The selected languages are added under Languages section. 

You must have one default language. This is the language that your website opens in. For each additional language, the 

system displays the Set as default link and Delete link. You cannot delete a default language. 

When you have added more than one language, the Multilingual URLs section appears. 

NOTE: If you are using multisite management, the newly added language is not assigned to any of the sites. You need to do 

this manually for all sites. For more information, see Sitefinity Installation and Administration Guide » Multiple site 

management » Multiple site management in multilingual mode » Adding languages to individual sites. 

NOTE: In multilingual mode, you cannot choose how multilingual URLs appear. They are added as directories. 

3. Select how the URLs of the pages will appear in each of the added languages. 

Choose between the following: 

 Directories 

You use one domain, where different language versions are represented with different directories that are automatically 

created. 

 Different domains 

You use different domain names for each language. The system displays an input field for each language that you have 

added. 

In each field, enter the respective domain name. 

4. When you are finished, click Save changes. 

After you have added a language, you can translate pages and content items in this language. 

ADDING BACKEND LANGUAGES 

You can see the default language for the backend under Default language for the backend system. 

1. To add more backend languages, click Manage backend languages » Add languages… 

The Select languages window appears, displaying a list of all available languages. If you want to add different language 

cultures, click Show cultures. 

2. Select one or more languages or cultures and click Done. 

The selected languages are added under Languages for the backend section. 
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You must have one default language. This is the language that your website backend opens in. For each additional language, 

the system displays the Set as default link and Delete link. You cannot delete a default language. 

3. Click Close languages for the backend system link. 

4. Click Save changes. 

After you have added a backend language, you must install an existing language pack or translate the interface labels and 

messages. For more information, see Sitefinity Installation and administration guide » Backend languages and labels. 

| Basic settings | Table of contents | 

TEXT EDITOR 

You can configure which functions to appear in the text editor. For example, which buttons to display when a user opens the editor 

to leave a comment on the website. You can define your custom toolsets and set different tool sets for different modules. 

To edit the tool sets used for all modules and to leave comments, perform the following: 

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

2. Click Text editor. 

 To change the tool set used for all backend modules, click the Edit link of Default tool set.  

An XML list of all tools appears. You can add or remove tools by inserting or deleting.  

Click Save. 

 To change the tool set used for all comments, click the Edit link of Tool set for comments.  

An XML list of all tools appears. You can add or remove tools by inserting or deleting. 

Click Save. 

 To change the tool set used for all forums, click the Edit link of Tool set for forums.  

An XML list of all tools appears. You can add or remove tools by inserting or deleting. 

Click Save. 

 To create a custom tool set and apply it to a particular module, perform the following: 

For example, you may want the text editor for entering news to be simpler and has less functions. 

a. Click Create a tool set button. 

The default tool set appears as a base for creating your custom tool set. 

b. Add or remove tools from the XML list by inserting or deleting.  

c. Enter a Tool set name and click Save. 

3. Click Save changes and refresh your browser. 

For more information, see  http://www.telerik.com/help/aspnet-ajax/editor-toolbar-intro.html.  

APPLY A CUSTOM TOOL SET TO A MODULE  

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

2. Click Advanced. 

3. In the tree of the left expand the module for which you want to use a custom text editor. 

For example, expand News. 

4. To configure the tool set used to enter content, click Controls » <Module name>Backend » Views » <Module 

name>BackendInsert » Sections » MainSection » Fields » Content. 

5. In Rad Editor toolset configuration input field, enter Custom. 

6. In Rad Editor custom toolset configuration key input field, enter the name of the custom tool set you have created. 

7. To configure the tool set used to edit content, click Controls » <Module name>Backend » Views » <Module 

name>BackentEdit » Sections » MainSection » Fields » Content. 

8. In Rad Editor toolset configuration input field, enter Custom. 

http://www.telerik.com/help/aspnet-ajax/editor-toolbar-intro.html
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9. In Rad Editor custom toolset configuration key input field, enter the name of the custom tool set you have created. 

10. Click Save changes and refresh your browser. 

| Basic settings | Table of contents | 

COMMENTS 

Use this page to manage setting for comments left about content items. Website visitors can leave comments about blog posts, 

events, and news. When creating a content item, you can specify if you want users to be able to leave comments for this particular 

item. 

You can change the following settings: 

1. Under Who can post comments, select one of the following: 

 Anyone 

 Only registered users 

Use this option only if you have user registration on your website. 

2. If you want comments not to be publically visible until the responsible user publishes them, select Comments have to be 

approved before appear on the site checkbox. 

If you select this checkbox, comments that are left on the website are initially saved in status Hidden. 

3. If you want users to complete a CAPTCHA when leaving a comment, select Use spam protection image (captcha) checkbox. 

4. If you want to disable comments for older content items, select Automatically close comments for items older than <number> 

days checkbox. 

The form for leaving comments will be hidden from the website for content items created before the days you have specified. 

5. Select the fields that are displayed in the form for leaving comments. You can choose to display one or more of the following 

fields: 

 Name 

 Email 

 Website 

 Message 

When you select a field, you can choose whether you want to make the field mandatory by selecting the Required checkbox 

that appears. 

6. When finished with the settings, click Save changes button. 

You can make additional configurations of comments, using the advanced settings. To open advanced settings of comments, on 

Basic Settings page, click Advanced and in the navigation on the lift, click Comments. 

| Basic settings | Table of contents | 

STORAGE PROVIDERS FOR LIBRARIES 

Using storage providers for libraries, allow you to store images, videos, documents and other files in a separate storage from the 

database. This is useful when you need to store big chunk of data. Storing it in the database is not cost effective, because as it has 

to be processed by Sitefinity and results in excessive calls to the database. In these cases, it may be easier to keep the metadata 

information for the files in the database and store the actual files in the file system or in a cloud storage. The metadata is always 

stored in the database, while the binary data, known as BLOB (Binary Large Object) may be stored differently – in the database, 

on the file system, or in a cloud storage. 

Each blob storage provider in the system has a unique name. Each library is associated with a single blob storage provider, which 

is specified when the library is created and which is used to manage the storage of the items in that library.  The library keeps the 

name of its blob storage provider. The blob storage provider can also be set for individual library items, but currently this is not 

supported by the user interface. 

You configure storage providers in the following way: 

1. In the main menu, click Administration » Settings. 

The Basic Settings page appears. 
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2. Click Storage providers for Libraries. 

By default two storage providers exist: 

 Database 

Items are stores in your projects database. 

This provider is the default. 

 File System 

Items are stored in your projects folder ~\App_Data\Storage\FileSystem. 

To make this the default storage, click Set as default. 

CREATE A NEW STORAGE PROVIDER 

1. To create a new storage provider, click Add storage provider button.  

The Add a provider window appears. 

2. Enter a name for the provider. 

3. In Provider type dropdown, select one of the following: 

 Database 

a. Click Continue. 

b. On the next screen, select a database where you want to store the files. 

The dropdown box contains all databases that you have configured. 

 File System. 

a. Click Continue. 

b. Enter the folder path where you want to store the files. 

 Windows Azure 

For more information, see Sitefinity Installation and Administration Guide » Settings » Configuring Windows Azure storage 

provider. 

4. To check if you have access to the database or the folder, click Test settings. 

A test status message appears. 

5. Click Done. 

The new storage provider appears in the list of providers. 

EDITING STORAGE PROVIDERS 

 To edit the properties of a storage provider, click it. 

You can change the database or the folder where the files are saved, but you cannot change the type of the provider. 

 To delete a provider, in the list of all providers, click the Remove link of the provider. 

NOTE: You cannot delete the storage provider that is set as Default. 

| Basic settings | Table of contents | 

EMAIL CAMPAIGNS SETTINGS 

Use this procedure to configure email setting – SMTP stands for Simple Mail Transfer Protocol. The settings are needed for the 

system to send emails with campaigns to subscribers.  

You configure SMTP settings in the following way: 

1. In the main menu, click Administration » Settings. 

The Basic Settings page appears. 

2. Click Email Campaigns. 

The SMTP settings appear. 

3. In Notifications SMTP Profile, enter the notification profile that you want to use for sending email campaigns. 

To create and configure notification profile, perform the following: 

a. In the main menu, click Administration » Settings » Advanced. 
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b. In the treeview on the left, click Notifications » Profiles » Create new » SmtpSenderProfileElement. 

c. Configure the following properties: 
 

DefaultSenderEmailAddress Enter the email address that will appear to the recipients. 

Host Enter the name or IP address of the host used for notifications. 

Port Enter the port used for notifications. 

UseAuthentication Select if you want to authenticate when you login to the server. 

Username and Password Enter the credentials of the account that you use to connect to the server 

Use SSL Select if you want Sitefinity to use Secure Sockets Layer (SSL) to encrypt the connection. 

ProfileName Enter a name for the profile. 

d. Click Save changes. 

4. You can immediately check how the settings work, by entering a test email and clicking Send check message button. 

5. If you want to track messages that are not delivered to the subscribers, select Track bounced messages checkbox. 

6. When finished, click Save changes. 

| Basic settings | Table of contents | 

TWITTER  

Use this page to add and configure registered Twitter applications to Sitefinity. Through Sitefinity backend you can use the Twitter 

API to publish tweets. For example, your blog posts can be published as tweets. To do this you need to register a Twitter 

application in Twitter and add it in Sitefinity. 

NOTE: Sitefinity application is added as an application by default and you can use it to tweet. You must register additional 

applications only if you do not want to use Sitefinity. You can, for example, add the name of your website as an application.  

Even if you do not register your own application, you must assign users to Sitefinity application – Step 6 and Step 7 of the 

following procedure. 

To register an application, perform the following: 

1. Click Register an application in Twitter link. 

The Register an Application form opens.  

For more information, see twitter developers page on http://dev.twitter.com/. 

2. Fill out the registration form. 

NOTE: In Application Name input field, enter the name of your website. 

When you complete your application registration, Twitter will generate a Consumer key and Consumer secret for your 

application. 

3. On Sitefinity’s Basic Settings page, click Add a registered Twitter application button. 

4. Enter the Application Name, the Consumer Key and Secret, generated by Twitter. 

5. Click Save. 

The application appears in the list of registered applications.  

You can delete an application by clicking its Actions button and selecting Delete. 

6. To associate Twitter users with an application, click the Actions link of the respective application and then click Associate 

Twitter User. 

You must associate at least one user, because there must be a Twitter user from whose account the tweets will be published. 

You can add more than one user to an application. 

For example, you can register an application MyNews, but you can associate two accounts with that application – sports and 

weather. Some people may follow only the sports other may follow only the weather. 

http://dev.twitter.com/
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Twitter opens, asking you to grant access to the application to your Twitter data.  

7. Enter the login credentials of the user, which you want to associate and click Allow. 

The user appears under ASSOCIATED USERS on Basic Settings page. 

NOTE: You can register and use your own bit.ly account. To do this, register at https://bitly.com/ and obtain the Account name 

and the API Key, which you then enter in Sitefinity, by clicking the default Sitefinity account under URL Shortening section. 

| Basic settings | Table of contents | 

SOCIAL SHARING 

You can add sharing options for your content. For example, you can give your users the opportunity to share a news item in 

Google+. 

To add or remove sharing options for your content, perform the following: 

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

2. Click Social sharing. 

3. Select the sharing options you want to display to your website users. 

4. Select how you want to display the sharing options, by choosing one of the following: 

 Small icons 

 Icons with text 

5. When finished, click Save changes. 

| Basic settings | Table of contents | 

GOOGLE MAPS 

This setting allows you to use Google maps as provider for the maps used to for defining addresses. You can add an Address field 

to your dynamic module content items and Google maps will display a map where you can pinpoint the address. For more 

information, see Address custom filed. 

To configure Google maps, perform the following: 

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

2. Click Google Maps. 

3. Click Get Google Maps v3 API Key link, and follow the procedure to obtain the API Key. 

4. In Google Maps v3 API Key input field, enter the provided key. 

5. Click Save changes. 

| Basic settings | Table of contents | 

THUMBNAILS 

For each image in a library, you can generate thumbnails with different sizes and then choose which size to display on the website. 

For example, you can have an image with original size 400x400 px uploaded in a library. You can generate one thumbnail 200x200 

px and another 100x100 px. On one page you can display the small thumbnail and on another – the larger, and whenever the 

image is clicked, you can display the original size. 

You first set the predefined thumbnail sizes, then for each root library you choose what type of thumbnails to generate, and, 

finally, when configuring the widgets, you choose which thumbnails to display. 

To configure the image thumbnail sizes, perform the following: 

1. In the main menu, click Administration » Settings. 

The Basic settings page appears. 

https://bitly.com/
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2. Click Thumbnails. 

All defined Image thumbnails appear. 

For each thumbnail size, you can see its size and how many libraries it is applied to. 

3. To create a new thumbnail size, click Add image thumbnail size. 

4. Enter a name for the thumbnail size. 

5. In Resize image thumbnail dropdown box, you can choose whether you want to crop or resize the images in the library to fit 

the predefined size. 

Select one of the following: 

 Resize to fit area 

Enter in pixels the dimensions of the predefined thumbnail, by filling out Max width and Max height input fields. 

When the proportion of the original image dimensions is different from this of the predefined thumbnail, the images are 

resized so that the longer side of the image fits the respective side of the thumbnail. Images are aligned up and to the left 

of the predefined thumbnail. 

 Crop to area 

Enter the dimensions of the cropped area in Width and Height fields. 

The original image is cropped from all sides evenly, so that it fits the thumbnail size. 

6. If you want original images that are smaller than the predefined thumbnail to be resized to fit the thumbnail, select Resize 

smaller images to bigger dimensions checkbox. 

7. Choose the Quality of the image thumbnail that you want to generate. 

8. If you want to use this thumbnail size as a default when you create an image library, select When creating an image library 

select this size by default checkbox. 

9. Click Done. 

You can select more than one thumbnail size as a default. 

10. If required, enter a name for developer that will be used in code and for generating the URL of the thumbnail.  

The name must be unique. 
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